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Preface

What is E-leaning

E-leaning is Learning Management System (LMS) that universities, com- munity colleges, K-12
schools, businesses, and even individual instructors use to add web technology to their courses.
More than 8 Universities in Rwanda currently use E-leaning to deliver online courses and to
supplement traditional face-to-face courses.

The name E-leaning has two meanings. First, it‘s an acronym (what isn‘t these days?) for
Modular Object-Oriented Dynamic Learning Environment.

Who Is This Book For?

This book is for people who want to teach a course using E-leaning. You can use E-leaning to
teach a fully online course or to supplement a face-to-face course in a traditional setting. It
doesn‘t matter if you teach at a primary school, a secondary school, in higher education, or in a
corporate setting; you can use the tools and features available in E-leaning to create an effective
class.

How to Use This Book

This book is written for instructors learning how to use E-leaning. It‘s not just a how-to manual,
however. Using E-leaning won‘t make your course better by itself. Only by applying effective
educational practices can you truly leverage the power of E-leaning.

The E-leaning interface can be customized a great deal. The descriptions and screenshots in this
book illustrate the default interface without any customization. If you have changed the order
of the blocks in your course or if the system administrator has changed the look and feel
of the main interface, your system will look different from the screenshots here.

Chapter 1 discusses what Learning Management Systems have to offer and what features makes
E-leaning special for eLearning.

Chapter 2 gets us started using E-leaning. We‘ll sign up for an account, review the basic interface,
get used to some of the conventions, and start a course.




Chapter 3 covers how to add static content (named as resource in E-leaning) to your course.

Chapter 4 delves into Learning Management, including understanding and using roles, arranging
students into groups, and how to obtain reports of student activity

Chapter 5 gets us familiarized with the text editors in E-leaning.

Chapter 6 to 16 covers individual tools in the basic E-leaning package. We‘ll discuss how and
when to use forums, hold chat sessions, send messages, give quizzes, set assignments, develop
shared glossaries and databases, create pathed lessons, collaboratively develop web pages, create
blogs, set up surveys and polls, and record student grades. Each chapter covers how to add the
tool to your course, discusses the options available, and gives you some creative ideas for
effectively using the tool in your class.

Chapter 17 pools all the disparate tools into a comprehensive whole and shows some of the
creative ways teachers have used E-leaning.

Chapter 18 covers how to administer an entire E-leaning site. A system administrator usually
handles these functions, but if you‘re on your own, there‘s a lot of power behind the curtain.

You can use this book in a couple of different ways. First, you can read it cover to cover.
Hopefully, you‘ll find it so compelling that you won‘t be able to put it down until you‘ve
finished it. Or you can use it like a reference manual. The beginning of each tool chapter covers
the how-to‘s and the options. If you get lost, flip to the appropriate chapter and take it from the
beginning.




Chapter 1: Introduction

If you teach, you‘ve probably heard for years about the revolution the Internet was supposed to
bring to teaching and learning. As with so many promises of revolution, the changes haven‘t
materialized. Instead, there has been a slow evolution toward using the Web to enhance teaching
and learning. A suite of tools called Learning Management Systems (LMSs) supports this new
practice. You can use LMSs to enhance your teaching by taking advantage of the Internet
without replacing the need for a teacher.

WHAT IS A LEARNING MANAGEMENT SYSTEM?

LMSs are web applications, meaning that they run on a server and are accessed by using a web
browser. Your E-leaning server is probably located in your university or department, but it can
be anywhere in the world. You and your students can access the system from any place with an
Internet connection.

At their most basic, LMSs give educators tools to create a course web site and provide access
control so only enrolled students can view it. LMSs also offer a wide variety of tools that can
make your course more effective. They provide an easy way to upload and share materials, hold
online discussions and chats, give quizzes and surveys, gather and review assignments, and
record grades. Let‘s take a quick look at each of these features and how they might be useful:

Uploading and sharing materials:

Most LMSs provide tools to easily publish content. Instead of using an HTML editor and
then sending your documents to a server via FTP, you simply use a web form to store
your syllabus on the server. Many instructors upload their syllabus, lecture notes, reading
assignments, and articles for students to access whenever they want.

Forums and chats:
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Online forums and chats provide a means of communication outside of classroom
meetings. Forums give your students more time to generate their responses and can lead
to more thoughtful discussions. Chats, on the other hand, give you a way to quickly and
easily communicate with remote students. They can be used for project discussions
between groups of students or for last-minute questions the day before an exam.

Quizzes:

Online quizzes can be graded instantaneously. They are a great tool for giving students
rapid feedback on their performance and for gauging their comprehension of materials. Many
publishers now provide banks of test questions tied to book chapters. Gathering and reviewing
assignments:

Online assignment submissions are an easy way to track and grade student assignments.
In addition to grading student assignments yourself, research 1 indicates that using an
online environment for student peer reviews increases

student motivation and performance.

Recording grades:

An online gradebook can give your students up-to-date information about their
performances in your course. Online grades can also help you comply with new privacy
rules that prohibit posting grades with personal identifiers in public places. LMS
gradebooks allow students to see only their own grades, never another student‘s. You can
also download the grades into Excel for advanced calculations.

While you could find or write programs to do all of these things on your own site, a LMS
combines all of these features in one integrated package. Once you‘ve learned how to use a LMS,
you‘ll be free to concentrate on teaching and learning instead of writing and maintaining your
own software.

Over the past years, LMS systems have matured rapidly and are now considered critical software
for many colleges and universities. The LMS market is now a multimillion dollar market and is
growing quickly.

Why Should You Use a LMS?

Good question. After all, we‘ve run classes for thousands of years without the use of computers
and the Web. —Chalk and talkl is still the predominant method of delivering instruction. While
traditional face-to-face meetings can still be effective, applying the tools listed above opens up
new possibilities for learning that weren‘t possible twenty years ago. Currently, there is a lot of
research into how to effectively combine online learning and face-to-face meetings in what are
called —hybridl courses or —blended learning.|




1J. Brindley, C. Walti & Lisa Blaschke: Creating Effective Collaborative Learning Groups in an
Online Environment — June 2009

Hybrid courses combine the best of both worlds. Imagine moving most of your content delivery
to an online environment and saving your course time for discussion, questions, and problem
solving. Many instructors have found they can save time and increase student learning by
allowing students to engage in the material outside of class. This allows them to use face-to-face
time for troubleshooting.

Online discussions give many students the opportunity to express themselves in ways they
couldn‘t in a regular class. Many students are reluctant to speak in class because of shyness,
uncertainty, or language issues. It‘s a boon to many students to have the ability to take their time
to compose questions and answers in an online discussion, and instructors report much higher
participation levels online than in class.

There are a number of other reasons to think about using a LMS in your courses:

Student demand

Students are becoming more technically savvy, and they want to get many of their course
materials off the Web. Once online, they can access the latest information at any time and
make as many copies of the materials as they need. Having grown up with instant
messaging and other Internet communication tools, many students find that online
communication is second nature.

Student schedules

With rising tuition, many students are working more hours to make ends meet while they
are in school. About half of all students now work at least 20 hours a week to meet
school expenses. With a LMS, they can communicate with the instructor or their peers
whenever their schedules permit. They can also take quizzes or read course material
during their lunch breaks. Working students need flexible access to courses, and a LMS
is a powerful way to give them what they need.

Better courses

If used well, LMSs can make your classes more effective and efficient. By moving some
parts of your course online, you can more effectively take advantage of scheduled
face-to-face time to engage students® questions and ideas. For example, if you move your
content delivery from an in-class lecture to an online document, you can then use lecture
time to ask students about what they didn‘t understand. If you also use an online forum,
you can bring the best ideas and questions from the forum into your classroom. We‘ll
discuss lots of strategies and case studies for effective practice throughout the book.
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You probably heard all of this in the early _90s. So, what‘s changed? Today, LMSs are more
mature and easier to use than they‘ve been at any time in the past. The underlying technology is
becoming more robust, and programmers are writing good web applications. In the past, most
systems were built as departmental or even personal projects and then commercialized. The
leading commercial package, Blackboard, started out as a small college project and has since
grown to be a market leader.

However, market leadership does not automatically mean that a given application is the best or
most reliable piece of software. Driven by the need for increased profitability, the market leader
has struggled to manage its growth, and some would argue that product quality has suffered as a
result.

WHAT MAKES E-LEANING SPECIAL?

| had tested a lot of LMS's (Learning Management Systems) especially the open source ones but
E-leaning stands out at a tall height because of the sound educational philosophy, great
community and the most importantly always eager to improve upon the mistakes based on the
feedbacks by a lot of community members around the world.

Great documentation

One of the basic things missing in most of the other open source LMS's is the lack of appropriate
documentation whereas E-leaning is the winner in terms of the documentation also. You will
find tones of documents on each and every topic related to E-leaning and if by chance you are
not able to find any relevant topic then you can ask the community members to help you out
through E-leaning forums.

Great Collection of Modules

E-leaning has got a large database of Modules to enhance the learning requirements of each
individual. You can find modules for changing the Course formats, Add different activities,
Blocks, themes etc.

Responsive Interface Design

Since the latest LTS version E-leaning has introduced the responsive design of themes based on
the Bootstrap framework which makes all themes are compatible on all devices. You need not to
worry about the look and feel of your E-leaning site on various devices used by the students.

If you are still thinking about the features then you should give it a try to delve deep into the vast
sea of E-leaning. In the rest of the book, we‘ll discuss how you can use E-leaning‘s many




features to enhance your teaching and provide your students with a powerful learning
environment.

SUMMARY

In this chapter, we‘ve taken a brief introduction about the Learning management systems (LMS)
and their usage. We‘ve also become conversant with special features of E-leaning which makes it
the most popular open source LMS. In the next chapter we will take a look on the basics of E-
leaning like interface, creating an account on E-leaning site and course formats etc.

Chapter 2: How can | use E-leaning

Now that we‘ve taken a look at all the special features of E-leaning, and it has certainly raised
your expectations level to a much higher level. E-leaning has a lot of nifty capabilities, but they
are only useful if they are applied in the service of effective course design. In this chapter we will
explore different ways in which you can deploy E-leaning to develop an effective course design.

If you are a professor in higher education, you are an expert in your field. You know more about
your discipline than 99 percent of the rest of humanity. Universities do a great job helping people
become domain experts and researchers. They do a poor job of teaching those experts how to
teach. Unfortunately, the very process of becoming an expert makes it more difficult to teach
novices. Cognitive research has shown that as people become more expert, they lose the ability
to explain why and how they do certain basic tasks. The higher the level of expertise, the less
conscious access you tend to have to the fundamentals of what you do. To achieve expertise, you
need to develop a level of automatic performance for basic skills so you can concentrate your
mental resources on the more difficult tasks.

Much of our preparation of teachers assumes teaching comes naturally. Since we‘ve all been to
school, we must know how to teach. Unfortunately, this isn‘t the case. Creating effective learning
environments requires training and careful preparation.

In this chapter, we hope to give you some ideas and background from which you can develop
your courses. We‘ll spend some time talking about learning environments in general, and then
we‘ll talk about how to apply everything you‘ve learned so far to your courses. We‘ll also
provide some design patterns for different types of courses that research and experience have
shown to be successful.
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WHAT IS A LEARNING ENVIRONMENT?

Since we‘re developing an instructional environment, it would be a good idea to have a definition
of what we‘re hoping to develop. What makes a web-based learning environment different from
a web site? How is a web learning environment different from Amazon or Wikipedia?

The answer is: learning goals and feedback.

Learning environments have very specific goals for students. Most other web environments are
there for users to achieve their own goals. They provide information, a way to buy things, or a
way to connect with other people. People come to these environments of their own volition and
can participate at whatever level they choose.

Learning environments are unique because they provide goals for students to achieve, goals they
are currently unable to meet on their own. Your course objectives define a set of goals for
students, goals they would not normally set for themselves. These goals define how students will
interact with the material, other students, and you.

For example, if you are teaching a large survey course, the course goal will be to introduce the
main concepts of the field to your students. In an advanced theory course, you will want students
to demonstrate the ability to reason critically about advanced topics, and possibly synthesize their
own ideas. These goals should be just beyond what your students can achieve right now. They
may not even know what goals to set for themselves, so you need to at least suggest goals and
performance levels for them.

The second defining feature of learning environments is feedback. Feedback is critical for
students to monitor their progress as they pursue the course goals. Goal-oriented feedback is one
of the critical defining aspects of a learning environment. If a student doesn‘t receive feedback,
he has no way of knowing if he is closer to achieving the goals of the class or not. Other types of
information environments can‘t provide feedback to their users because the users, not the
environment, define their own goals. The only exception is an online game, which defines
external goals and measures the player‘s progress toward them.

Feedback in a learning environment can take many forms. Tests and quizzes are frequently used
tools for measuring student progress. They can provide feedback to students in the form of right
and wrong answers or a percentage score. Homework can also provide feedback to students
about their understanding of the materials. Less formal feedback might include interaction
with students in class, conversations with experts, or applying new knowledge in a work
setting. The key is to structure the feedback in useful ways so students can measure themselves
against the course goals.
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These two features make learning environments unique. E-leaning provides you with tools to
implement these ideas in unique ways. E-leaning‘s educational philosophy guides how those
tools are designed and can influence how you structure your learning environment.

COURSE DESIGN PATTERNS

Design patterns are abstract solutions to recurring design problems. The term was originally used
in architecture, but it has been applied more recently to software design. In architecture, the
placement of doors, gates, windows, and other elements are design patterns that recur in many
buildings. The idea of a lobby in a large office building is a design pattern. Over time, these
patterns become almost invisible to us as we are continually exposed to them. Changing a pattern
can lead to the discovery of an entirely new way of interacting with a space.

Instructional design patterns are similar. There are abstract solutions to the design challenges that
occur in many courses. We can abstract four basic course types in higher education:

Introductory survey course

These tend to be large lecture courses designed to expose students to basic concepts, vocabulary,
and foundational ideas.

Skills development course

These courses are designed to apply the ideas introduced in the beginning courses. Labs,
recitations, workshops, and second-level courses tend to fall into this category. While there is
discussion of theory, applying the theory to problems is the core of the course.

Theory/discussion course

In more advanced courses, students are expected to think critically about research and theory.
Application is typically secondary to the discussion of the theory itself.

Capstone course

Many programs have some sort of summative experience that enables students to demonstrate
what they have learned in their course of study.

While there are variations and combinations of these course archetypes, these categories cover
most of the courses taught in most universities.

Understanding the abstract problem types is the first step toward designing a solution pattern. We
also need principles of quality that will help us decide which patterns will be more likely to result
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in a better solution. Every professor develops a response to the course archetypes. The question
is which solutions are more likely to result in a quality course?

Fortunately, the American Association for Higher Education (AAHE) has come up with some
recommendations for high-quality university courses. The AAHE has published 12
recommendations in 3 categories:

Culture:

* High expectations
» Respect for diverse talents and learning styles
» Emphasis on early undergraduate years

Curriculum:

» Coherence in learning

» Synthesizing experience

» Ongoing practice of learned skills

* Integration of education with experience

Instruction:

« Active learning

» Assessment and prompt feedback
» Collaboration

» Adequate time on task

* Qut-of-class contact with faculty

It would be impossible to apply all 12 of these principles in every class. But a course that
integrates as many of these principles as possible will likely be of higher quality than one that
doesn‘t.

Fortunately, many of the tools in E-leaning lend themselves well to realizing these quality
principles. Let‘s take a look at how to apply the tools in E-leaning to meeting these quality
principles in the four class types.

Introductory Survey Course

The introductory survey course tends to be a large lecture course. The primary goal is to expose
students to the basic concepts and vocabulary of a field of study. In the best case, this course
helps students develop a basic conceptual structure that serves as the foundation for more
advanced courses.




There tend to be two primary, related problems to address in these courses. First, their large size

makes it difficult to assess open-ended assignments such as projects and reports. Second, student
motivation is difficult to maintain due to the course‘s large size and its nature. Students who are

required to take the course may find it difficult to engage in the subject matter, and long lectures
are hard for anyone to get excited about.

A survey course might focus on quality measures like assessment and prompt feedback, adequate
time on task, ongoing practice of learned skills, active learning, and high expectations. So how
can we use the E-leaning tools and the above principles to create a successful survey course?

Groups

The key to success in a large class is the strategic use of groups. To promote active
learning, create a group project that students must complete by the end of the semester.
Such a project cuts down on the number of submissions you need to grade and provides
students with opportunities for collaboration. E-leaning has a number of tools to help
student groups communicate and collaborate, including forums and wikis, which we*ll
explore below.

Resources

Posting your lecture notes before each lecture will help students stay engaged by giving
them a structure for taking notes. Before each lecture, post an outline of the upcoming
class to help students plan ahead for that class. Use the data from a short quiz or choice to
target your lecture to the areas students find most difficult or interesting.

Alternatively, move yourself from being the source of information in the course to being
a helpful tutor. Post your lecture notes, your lecture in MP3, and any reading
assignments. Then use the face-to-face time to answer questions, demonstrate problem
solving, and provide feedback to students on their work. Moving the information delivery
portion of the course online will free up your face-to-face time to provide valuable
coaching and support for your students, even in large lecture courses. This will promote
active learning and prompt feedback within your course.

Quizzes

Use the quiz tool to provide a small quiz for each reading assignment. This will reward
students for completing the reading and allow them to test their understanding of the
material. Each quiz should be relatively low-stakes, but all of them taken together could
add up to a significant part of the student‘s score. These small quizzes will provide
assessment, prompt feedback, and help students spend adequate time on task. Again, be
sure to use the data from the quiz to modify your lecture, or class discussion, to focus on
the areas where students need more support.




Forums

Glossar

A mix of class forums and group forums can be an effective tool for collaboration, active
learning, and out-of-class contact with faculty. Forums for questions to the instructors and
for general course discussion are great for class discussions. Each group should also have a
discussion area for reading groups and lectures. Be sure to seed the discussion each week
with a good question that will require students to apply the concepts they‘ve learned during
that week. Bring the best questions and discussions to the attention of the whole class to
help motivate students. Create a class forum for the submission of final group projects.
Everyone can see the projects, and each group needs to post the project only once. You can
make this a Q & A forum, so students can‘t see other students® postings until they post
their own.

ies

A good glossary is critical when students are learning a new vocabulary. You can use the
glossary to promote active learning by assigning a different group to create definitions
for each week or topic. You and the other students can rate submissions based on their
usefulness. Be sure to turn on autolinking to get the most benefit.

Databases

Wikis

While large courses can be difficult to manage, they also provide many minds for
collaborative work. In introductory courses, the database module can be a very useful
tool. Students can create databases of important figures in the field, collect data for
course projects, post quiz questions, or simply create small biographies of themselves.
You can leverage the large numbers of students in the course to create rich resources for
the students to use as they study.

Each group should have a group wiki for their course project that they can submit at the
end of the semester. Using a wiki this way promotes active learning and collaboration.

Lessons

Learning vocabulary is difficult without a lot of practice. To provide another opportunity
for assessment and feedback, create a series of vocabulary flash cards in the lesson
module to help students drill themselves on the new concepts. You could also replace
static lectures with lessons on important topics, which will provide students with
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immediate feedback on the topic, rather than reading something and then receiving
feedback later.

Messaging

Students in large-format courses can easily get lost. If students get into trouble with the
course material, or simply lose motivation, they may disengage from the course and risk
failure. The messaging system gives you a useful tool for communicating with students
who are not engaging with the course site. Filter your students by last login, and send
regular messages to those who haven‘t visited the course site in a while. This will let
them know you are interested in their success and encourage them to reengage.

Roles and capabilities

In a large-format course, it can be difficult to manage all of the forums, glossaries, and
databases yourself. Giving students a level of responsibility for different areas of the
course can increase motivation and engagement. Give each group of student‘s moderator
privileges on a different forum each week. Students will study harder to make sure they
know what they are talking about when it is their turn to moderate. Giving other groups
capabilities to approve glossary entries or database entries will give them a sense of
ownership in the course.

Combine these tools to create an effective learning environment. Each week or topic should have
lecture notes, a glossary, a quiz or quizzes, and a forum. At the beginning of the course, post the
course glossary, the course forum, and your syllabus. At the end of the course, post the final-
project forum.

Skills Development Course

The skills development course is generally the second-level class in a course of study. The aim of
this course is to give students the opportunity to apply the basic concepts learned in the survey
course and explore one aspect of the field in more detail. These are usually workshop or lab
courses that focus on a project or the repetitive application of important skills. The goals of this
course type include development of automaticity in some skills, refining skill performances, and
beginning to develop flexibility in skill application.

Skills development courses require continuous feedback and assessment. Engaged students need
feedback so they can know if they are performing the skills correctly. They also need resources
to help them troubleshoot when they cannot solve a problem on their own. You can create an
effective practice environment for skills development with the following tools in E-leaning:
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Resources

As students practice on their own, they will need information resources to help them
diagnose their mistakes. If you can post demonstrations, step-by-step instructions, or
other aids for students as they practice on their own, you‘ll make it easier for them to
succeed and eliminate a lot of repetitive questions.

Forums

Forums provide valuable opportunities for your students to help each other. Set up a
forum for each topic or week and have students ask each other for assistance with course
assignments. Allow post ratings in these forums to reward students who provide
assistance to their classmates. This encourages collaboration and gives students an
important out-of-class communication channel for support.

You can also use the forums for students to post their work and receive feedback from
their peers. With a well-structured scoring guide and good exemplars, students can help
each other improve their work with well-reasoned critiques.

Quizzes

If your class is focused on math skills, you can use the calculated-question type to
provide your students with unlimited practice opportunities. Create a library of questions
for each topic and let students take the quiz as many times as they‘d like. Each time, they
will see a different set of questions. Other types of courses can use the quiz module to
test the students® ability to apply basic concepts, provide graduated practice, and provide
an opportunity to practice other types of skills.

Lessons

Well-constructed lessons give students the opportunity to apply their skills and receive
immediate feedback. Each page in the lesson should challenge students to use the skills
they are developing in the course, and either provide direct feedback or allow them to
explore the consequences of their actions in a simulation type of environment.

Databases

There is a lot of evidence to suggest people learn effectively when they are producing
new materials for other people. In a skills course, you can use the database to give
students a place to create practice assignments for each other, which you can then use in
quizzes or lessons to provide additional practice, and spread the work of developing a
good course.

Roles and capabilities




As student‘s progress in their capabilities, they can take on more responsibility for their
own learning. In a skills course, you may want to give groups of students the ability to
develop a quiz for other students, pulling questions from pools developed by you, by a
publisher, or ones they write themselves. Set up new lessons for them to add new lesson
pages, developing new practice opportunities for other students.

Theory/Discussion Course

A discussion course focuses on readings and the discussion of ideas. These are usually senior or
graduate-level courses that focus on discussions of theory and research. There is little practical
application. Instead, ideas are discussed, debated, and critiqued. The emphasis is on reasoning,
presenting evidence from the research literature, and critical thinking.

Student motivation is typically not a problem in these courses. Students who take advanced
courses are usually interested in the subject. However, it can be difficult to create opportunities for
active learning and provide prompt feedback. Fortunately, there are a few E-leaning tools that can
help you overcome these issues:

Blogs

Critical thinking and analysis of theory typically require periods of private reflection
along with public discussion. Encourage students to actively engage in these activities by
providing them with the opportunity to blog about the course topics. Having students
keep a blog in E-leaning rather than a journal on paper allows you to give them feedback
on their entries without interrupting the writing process. You can encourage students to
use their blogs by bringing the most insightful or interesting entries for discussion in
class or a forum.

Databases

One of the hallmarks of most theory courses is a large amount of reading, usually from
original research. To help your students keep on top of the reading, create a database and
ask them to submit a short summary or abstract of the papers they read. This strategy will
reward them for keeping up with the reading and encourage them to actively engage with
the reading. It will also provide the students (and you) with an annotated bibliography at
the end of the course.

Choice

As stimulation for conversation, include a choice each week. Poll the class about a
controversial point in the reading or discussion. Combine this with a forum asking
students to explain their responses.




Forums

Wikis

Forums are one of the keys to a successful discussion course. Forums allow students to
compose their thoughts and focus on the content of their responses. Encourage careful,
well-reasoned postings in the forum by scoring posts. Encourage more active engagement
by assigning groups of students as moderators for different topics.

A class wiki can be used to create a shared understanding of the ideas under discussion.
After each discussion, students should be encouraged to share their notes on the course
wiki for other students to learn from their perspectives on what was important or
interesting. At the end of the semester, students will have a synopsis of the entire class to
take with them.

Roles and capabilities

In a theory course, the collaborative construction of knowledge and artifacts is the most
powerful method for engaging students. Students can create activities, artifacts, and other
materials for each other, developing their critical-reasoning abilities through the creative
development of learning materials for other students. In a theory course, you can override
the student role at the course level to enable students more permissions throughout the
course, then set role overrides in those areas where you need to restrict their access. This
encourages students to actively construct the course web site for each other.

Capstone Course
Capstone courses are usually focused around a final project that requires students to demonstrate
what they have learned during their course of study. In graduate school, these courses are focused

around

a thesis or dissertation. In undergraduate study, students are expected to produce a paper

or other artifact. These project-based courses present challenges for both the instructor and
students. Students need to be able to apply skills they may have learned several years ago, and
may have not used since. Instructors need to ensure the project is stimulating and interesting. E-
leaning can provide activities to meet these challenges:

Assignments

You can help students structure the task by assigning a set of deliverables over the course
of the semester. Each deliverable should be a one- or two-week project you collect with
an assignment. For example, if students are writing a paper, you could collect an
annotated bibliography, a subject proposal, an outline, a couple of early drafts, and a final
draft.

Messaging
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Use messaging as a private feedback channel so students can discuss their work. As they
work on each section of the project, they will need to ask questions about the assignment
and their performance. A record of all discussions is kept in the message history for each
student.

Blogs

Part of a student‘s capstone experience is reflecting on what he has learned over the
course of study. Blogs can act as a tool for reflection and as a project notebook.
Encourage students to use their blogs for both activities.

SUMMARY

This chapter enlightens few design patterns in which you can deploy E-leaning to develop an
effective course design for your class. These design patterns are abstract starting points for
designing a solution that works in your class. We‘ve tried to recommend patterns that we have
seen work, or that other researchers have reported to be successful. They are not the final word
on effective course design by any means. But they can provide a useful starting place when
thinking about how to use E-leaning to promote learning in your course.
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Chapter 3: E-leaning Basics

In this chapter we will get a brief introduction about the E-leaninginterface and the options you
have while setting up your course. Then we will start adding some content to your course.

GETTING STARTED

As mentioned in Chapter 1, E-leaning is a web-based tool you can access through a web browser.
This means that in order to use E-leaning, you need a computer with a web browser installed and
an Internet connection. You also need to have the web address (called a Uniform Resource
Locator, or URL) of a server running E-leaning. If your institution supports E-leaning, it will
have a server with E-leaning up and running. You can then get the server address from the
system administrator. If you don‘t have access to a server with E-leaning installed, and you‘d like
to set up your own, you can download a E-leaning package from http://Itecrwanda.com/.

The E-leaning Interface
When you will first visit your E-leaning site you will see the front page of the E-leaning Site with
the list of the courses which are available for the students.

Take a moment and familiarize yourself with the interface. In the Header bar the name of your E-
leaning site is displayed along with a link to Login to the E-leaning site in the extreme right
corner.

On the left hand side of the screen you will see some blocks which are enables by the admin of
your E-leaning site. By default it will show the navigation block in collapsed form. On the right
hand side of the screen you will see the Calendar block.

There are a number of useful blocks installed by default on a E-leaning server. Your system
administrator may install additional optional blocks to add different functionality as per the
requirements of your institution.

Languages

In the upper-left corner, besides the Site name, you may see a drop-down menu with language
options. As of November 2014, E-leaning has been translated into over 126 languages by the
developer community. The number of languages is now so large that E-leaning only loads one
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language by default. Your system administrator can download additional language packs to
provide support for new languages. E-leaning also supports UTF-8, a standard for the display of
non-Latin character sets, like Chinese or Arabic characters. The language features can be useful
for learning foreign languages or supporting students from different countries.

Moodle 2.7

How to Use Moodle 2.7

o Site news WA e
San Mon Tue Wed Thu Iri Sat
(No news has been posted vel
4

Home [ |

Figure 2-1: Moodle’s Front Page

Anyone who uses E-leaning can select the language in which E-leaning‘s labels and instructions
will appear. For example, if you choose to view the site in French, the labels and help files will be
translated into that language. E-leaning does not translate usergenerated content—such as forum
posts—automatically, though it‘s possible to create Multilanguage content.

You can choose the language settings for the front page and for each course you visit. As an
instructor, you can also force students to use a given language. This is a useful feature if you‘re
teaching a language course and want the entire course to be in that language. Or you can simply
confuse the heck out of your students by choosing some really obscure language and have them
guess what everything means.

The system administrator can decide not to display the language drop-down menu on the front
page. If you want to change the language and find that you cannot, contact your system
administrator.

E-leaning’s Help System and Documentation
Throughout E-leaning, you will see a question mark in a yellow circle. This is a link to E-
leaning‘s very extensive help system. Although you shouldn‘t need it very frequently after you
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read this book, the community has worked hard to provide you with a help system that is tied to
what you are doing at that moment.

When you click the question mark icon, a new pop up window will open with the help file for the
item you are asking about (see Figure 2-2).

Course full name R

The full name of the course is displayed atthe top of each page in

the course and in the list of courses.

Figure 2-2 A help popup

In addition to the help system, if you are logged in as a teacher or an administrator, you‘ll find a
—E-leaning Docs for this pagel link at the bottom of each page. Clicking this link will take you
to the corresponding page on http://docs.Itecrwanda.com/. E-leaning Docs is the documentation
for E-leaning, written by the E-leaning community.

CREATING AN ACCOUNT

In the extreme top right corner of your E-leaning site you will find a Hyperlink which says "You
are not logged in (Log In)". You can also find the same link in the Footer of your site just above
the E-leaning Logo. Click the link and E-leaning will present you with the login to the site page
as shown in the Figure 2-3.

Your username and password will depend on how your system administrator set up the system.
E-leaning has a number of options for user authentication, including email-based self-
registration, where you create your own account. If you are logging in to a server run by your
university or department, check with the E-leaning administrator to see if you need to create an
account. As use of E-leaning grows, more institutions are automatically creating accounts for all
of their users, so you may already have a login.




Forgotten your username or password?

Cookies must be enabled in your browser (%)

Some courses may allow guest access course

Log in Is this your first time here?

Hi! For full access to courses you'll need to take a minute to

Username  aqmin create a new account for yourself on this web site. Each of the
individual courses may also have a one-time "enrolment key",
Password | 4eeseesee Log in which you won't need until later. Here are the steps
1. Fill out the New Account form with your details.
@ Remember username 2. An email will be immediately sent to your email address.

Read your email, and click on the web link it contains.
Your account will be confirmed and you will be logged in
- Now, select the course you want to participate in.
If you are prompted for an "enrolment key" - use the one that
your teacher has given you. This will "enrol" you in the
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7. You can now access the full course. From now on you will
only need to enter your personal username and password (in
the form on this page) to log in and access any course you
have enrolled in

Log in as a guest

Create new account

Figure 2-3 Login to the site

If you need to create a new account:

N

4,
5.

Click the "Create New Account” Button.

Fill in the new account form by creating a username and password for yourself.

Enter a valid email address. The system will send you an email to confirm your account.
You won‘t be able to log in again until you confirm your account.

Click —Create my new account.l.

Within a few minutes, you should receive an email at the account you specified on the form.

Click the link in the email (or copy/paste it into the address window in your browser) to confirm
your account.

You now have a verified account. Your account isn‘t automatically associated with the courses
you‘re teaching. Most likely, your system administrator will assign you the role of teacher in the

courses you‘re teaching.
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Figure 2-4 Creating New Account

Editing Your User Profile

Once you have successfully confirmed your account and logged in, you will find yourself back at
the main page along with one additional block on the Left hand side of the screen with title
"Administration™. The links in this block will depend on the permissions available for your
account.

If you look at the upper-right corner as well as in the footer of the site, you‘ll see that the Login
link has changed. It now says —You are logged in as: Your Name" highlighted as a clickable
Link. So, just click on your name.

E-leaning will then present you with your personal profile details page, like the one shown in
Figure You‘ll see your profile summary, interests, your courses and the first and last time you
logged in.

In the navigation block you will find the links for the Forum posts, Messages, Blogs, Badges
under the My Profile sub tree.

In the left side under the Administration Block you will find the links related to your profile
settings e.g. changing password, Preferences for the badges and Blogs and Edit your profile.

2!
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Admin User
&

Email address  ®FF"FF"
Firstaccess Tuesday, 19 August 2014, 2:55 PM (86 days 12 hours)
Lastaccess Friday, 14 November 2014, 2:46 AM (35 secs)
LastIP address  C:0:0:0:0:0:0:1

Figure 2-5 A profile

Let‘s take a moment and edit your profile to customize the page and help other people get to know
you.

To edit your profile:

» Click on the Edit profile link in the administration Block on the left hand side under My
profile settings tree.

» E-leaning will take you to the edit profile page where you can update your details, interest,
preferred language etc. On the Edit profile page, the fields with a red star next to them are
required fields; they must contain some data in order for you to submit the form.

» By default only the General section of your profile is expanded, You can expand all the
sections by clicking the Expand all link in the right corner of the page.

« If you wish, you can change the first name and surname the system has stored for you.

* You can edit any of the following fields:

o Email address: Make sure this is an address you check frequently and that it is
correct. E-leaning has a lot of important email features, and you wouldn‘t want to
miss out because your email address has a typo or is not an address you check
frequently.

o Email display: You can choose who can see your email address. Your choices are
to hide your email from everyone, allow only the people in your courses to see it,
or display it to everyone who logs in to the site. If you choose to hide your email
from other people, they will not be able to send you email directly from E-leaning.
0 Email format:

Here you can select whether mail sent from E-leaning is formatted using

HTML or is sent in plain text. Most modern email clients can receive and properly

3(
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display HTML mail, although this may be a setting you have to enable in your
email preferences. If you have a slow connection, or you simply prefer your email
plain and simple, the plain-text option is probably a good choice.

o Email Digest type: This is the daily digest setting that forums will use by default.

= No digest - you will receive one e-mail per forum post;

= Digest - complete posts - you will receive one digest e-mail per day
containing the complete contents of each forum post;

= Digest - subjects only - you will receive one digest e-mail per day containing
just the subject of each forum post.

= You can also choose a different setting for each forum if you wish. o Forum
auto-subscribe: E-leaning forums are a powerful communication tool for
classes. You have the option of —subscribingl to forums, which means that
new forum posts will be sent to you via email. This is a great way of keeping
current with your course discussions without having to log in and look at the
forums every day. Of course, if your discussions really get cooking, you‘ll
end up with a lot of email, but at least it won‘t be spam.

o Forum tracking: If you choose to enable forum tracking, E-leaning will highlight
posts added since the last time you read the forum. This is a useful way of quickly
identifying new content in a forum.

o Text Editor: This option lets you choose whether to use the Site's default Text editor
or else you can choose from Atto, Tiny MCE HTML editor to enter text or to use
plain text. E-leaning‘s HTML editor is an easy way to enter formatted text into your
course site. We will cover the specifics of
How it works in Chapter :5 o Time zone: The time zone setting can be very

important, especially if you‘re working with an international audience or if you will

be traveling. Be sure to set the time zone to your local time, not the server‘s local

time.

o Preferred language: Setting your language here makes it your default language for
all pages.

o Description: The description box gives you a place to tell your E-leaning
community a little about yourself. If you don‘t feel comfortable writing a
description, just put a space in here so you‘re allowed to submit the form.
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Figure 2-6 Editing a profile




The remaining optional fields allow you to include personal details about yourself, including
your photo or a representative image and contact information. Your picture will appear by
your postings in the forums, in your profile, and on the Participants page. You can also add
your Phonetic name, Alternate Name, Interests, and other personal details.

When you‘re done, click the —Update profilel button at the bottom of the page.

To upload a new profile picture:

» Prepare the picture you want to use by converting it to a JPG or PNG if you
haven‘t already. It should be smaller than the maximum upload size of your
site.

* You can directly drop the image file onto the user profile area of else you
can

manually add them by clicking the icon. It will open the file browser where you
can upload the profile picture by choosing "Upload a file" and navigating to the file and
click upload.
* You can enter a picture description as well for your profile picture for the
benefit of anyone using a screen reader.

* Click the —Update profilel button at the bottom of the page. E-leaning will
crop your picture into a square and shrink it to 100x100 pixels.

E-leaning provides you with a number of ways to personalize your experience and share
information about yourself with other people. Your profile will be linked to your forum posts and
other contributions around the site. The picture from your profile will be your icon, so pick
something that represents who you are on the E-leaning site or a shot of your good side.

Now let‘s take a look at a course, the main organizing feature of E-leaning.

A FIRST LOOK AT A COURSE

On the left side of the front page, you‘ll see the —My Coursesl tree under the Navigation Block,
which includes a list of all the courses you are teaching or taking as a student, as shown in Figure.
You can access your courses by clicking on the course name in the block.




Home
My home
Site pages
My profile
"~ My courses
Moodle

Figure 2-7 Navigation Block

Let‘s start with the upper-left corner of the course page, as shown in Figure 2-8. There you‘ll see
the name of your course as entered when the course was created. Your system administrator
either entered your course name by hand or she got it from your institution‘s course database.
(Read the —Course Settingsl section later in this chapter if you need to change the name.)

Moodle Demo Course

HONY TO DESIGN AND FACILITATE AN ONLINE COURSE

MODULE 1 :: Introduction & Warming up

Figure 2-8 Course Page

Below the course name is a navigation bar that fills with the hyperlinked names of pages as you
navigate from one page to another. Frequently, the best way to return to your course page is to
click on the course short name in the navigation bar. For example, in Figure 2-7, you would click
on "My Courses" to go back to the "My Home" from another page in the course.
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*** "My home is a customizable "dashboard" page for providing users with links to their courses
and activities within them, such as unread forum posts and upcoming assignments.”

Below the navigation bar are three columns. The far-left and far-right columns contain tool
blocks, while the center column contains your course content and activities. The topmost tool
block on the left is the Navigation block. From here, you and your students can:

« Access your customized dashboard "My home" which can be set as the default home page
if your administrator has enabled it for you.

« Navigate to different site pages including the Site Blogs, Site Badges,

« Navigate to your profile details like: Forums posts and discussions you are involved into,
your personal blog, messages, your private file and your badges.

- Getdetails about the current course like participants, badges and the topics within the course.

« Navigate to your courses in which you are enrolled as a teacher, student or any other role.

Beneath the Navigation Block is the Administration block.

« Assuming you‘ve been assigned the role of teacher, you‘ll find links to set your course
options, assign roles, perform backups of the course, and manage student grades.

« You can also switch role as a Student to have a look upon How any resource or activity will
be visible to students.

« You can also edit settings related to your profile like changing password, messaging settings,
blog settings and badges settings.

In the far right column you will find the Search Forums Block through which you can search
within the forums along with some search filters mentioned under the advanced search link.

The other blocks on the right side provide reports on the activity within the course. The Latest
News block lists the latest items added to the News forum, such as important news stories that
pertain to the subject you‘re teaching. The Upcoming Events block lists events you‘ve created in
the calendar, such as exams and holidays, together with assignment and quiz deadlines. At the
bottom of the block are links to view the calendar and add new events. And the Recent Activity
block, which lists recent course activity, such as forum postings and uploads.

The middle column is where the action is. This is where you add all of your content and activities,
such as forums, quizzes, and lessons for students to access. Before we get to that, however, you
need to make a choice about the format in which to present your course.
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Figure 2-9 Administration Block

Course Formats

Unlike some LMSs that force you into one format, E-leaning provides you with a number of
options for the general format of your course. You can choose to order your course
chronologically by week, conceptually by topic, or socially with a big forum as the central
organizing principle.

The course format determines the layout of the course page. By default there are four course
formats in E-leaning:

« Single activity format - The single activity format only has 1 section, and allows the teacher
to add one activity only to the course. When the single activity format is selected, a drop
down menu appears for the teacher to choose the activity they wish to use. The best uses of
this format are for displaying a single activity or resource (such as a Quiz or SCORM
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package) on the course page. This format has replaced the SCORM format from the earlier
E-leaning versions as SCORM can also be chosen as an activity in this format.

Social format - This format is oriented around one main forum, the social forum, which
appears listed on the main page. It is useful for situations that are more free form. They may
not even be courses. A forum is displayed on the course page

Topics format - The course is organized into topic sections that a teacher can give titles to.
Each topic section consists of activities, resources and labels. This is great to use if your
course is objective based and each objective may take different amounts of time to complete.
Weekly format - The course is organized week by week, with a clear start date and a finish
date. E-leaning will create a section for each week of your course. You can add content,
forums, quizzes, and so on in the section for each week. This format is best suited if you
want all your students to work on the same materials at the same time, this would be a good
format to choose.

* meoodieI’

19 September - 25 September

b Badoss N2 news has boon posied yot

¥ Seplenbs

26 September - 2 October ey e Thalm i 50 Movaes

Figure 2-10 Course page in weekly format

To set the course format:

Click "Edit Settings" under the course administration tree in the Administration block.
Select the course format from the drop-down list under the Course Format Section which is
collapsed by default.

Enter the parameters for your course:

——
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How to use E-leaning

For the weekly format, set the start date and the number of weeks.

For the topic format, set the number of topics.

For the social format, set the course start date. You don‘t need to worry about the
number of weeks or topics.

For the Single activity format choose the type of the activity which you wish to
use.

*** When changing the existing course format to "Single activity" make sure that you
removed all extra activities from the course including the "News forum™. Note that sections
structure may be modified.

E-leaning allows you to switch between formats if you find that a given format isn‘t working for
you. Simply follow the preceding instructions and select a different format. You can also add or
remove topics or weeks at any time. So you don‘t have to worry too much about locking
yourself into a format before you really understand the system.

Course Settings

The settings page, as shown in Figure 2-11, where you set the course format, also gives you
access to a number of important course options. You‘ll find it is important to take a moment to
review the settings for your course to ensure that it behaves the way you want it to.

To change your course settings:

» Click Edit Settings in the Administration block under the course administration sub tree
on your course page.
* Review each of the general options to ensure they are appropriate for your course:

o

Course Full name: This is the name that is displayed on the top header of every
page in your course and also in the course listings page. The name should be
descriptive enough so students can easily identify the course in which they are
working, but it shouldn‘t be too long. For example, use —English 400—Beowulfl
and not —ENG400—Beowulf and the heroic poems of the ancient world.|

Course Short name: Enter the institutional shorthand for your course. Many
students recognize —Eng101,| but not —Introduction to composition.l The short
name also appears in the navigation bar at the top of the page.

Course Category: Your system administrator may have created course categories,
such as department or college labels, to help students and teachers find their
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courses. Depending on how your system is set up, you may be able to categorize
your course by department, subject, or other organizational principle.

Visible: You can hide the course from students in case it is under preparation or
some modification by using this setting. If it‘s Hidden then only teachers and Site
administrators can access this course.

3¢
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Edit course settings
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Figure 2-11 Editing the Course Settings
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How to use E-leaning

Course start date: The start date is the day the course is first active. If you are
using a weekly course format, the first week will start on the date you set here.
The start date is also used in course reports as the earliest possible date for which
you can obtain logs, activity, and participation reports. In general, if your course
does have a real starting date, then it makes sense to set this date to that, no
matter what course format you are using.

o Course ID number: The course ID number is used to provide a link between E-
leaning and your institution‘s backend data systems. Most Student Information
Systems (SIS) has a unique identifier for each course. E-leaning has its own unique
identifier, which is different from the SIS ID. This field is used by E-leaning to
store the SIS unique ID so E-leaning will know which course the SIS is talking
about when synchronizing courses and enrollments.

o Course Summary: The summary appears in the course listings page. A good one-
paragraph summary will help communicate the essence of your course to your
students.

o Course Summary Files: If you wish to add some images to the course summary
then you can add it here which will be displayed in the list of the courses together
with the summary.

o Course Format:

= Course Format: This is where you can set the course format as discussed
previously.

= Number of Sections: Use this to set the number of sections your course will
have. If you need to change this later, you can. Increasing the number
results in sections being added to the bottom of your course page; reducing
the number results in sections being removed from the bottom of your
course page, and any content in them hidden.

= Hidden sections: When you hide an upcoming topic section to prevent your
students from jumping ahead, you can choose to display the title as a
collapsed section or simply hide the topic altogether. Displaying the
collapsed sections gives your students a road map of the upcoming topics
or weeks, so it‘s probably a good idea to leave this on the default setting.

= Course Layout: You can change the course layout to display whole course
on a single page or else to split it into several pages.

0 Appearance:

= Force Language: If you want to take your course in a specific language you
can force it here. If you do so, your students cannot change languages
within the course. For example for language teaching course like German,
French etc.

= News items to show: Use this setting to determine the number of course
news items displayed on the course page.




How to use E-leaning

= Show gradebook to students: This setting allows you to select whether
students can see the gradebook.
If set to No, it doesn‘t stop instructors from recording grades, but

simply prevents the students from seeing them.

= Show activity reports: This setting allows students to view their activity
history in your course. This is useful if you want students to reflect on their
level of participation. o Files and Uploads:

= Maximum upload size: This setting limits the size of files you or your
students upload to the course. Your system administrator sets the maximum
size for the system, but you can choose to make the limit smaller than the
system maximum. You can also further limit the size of files that your
students upload as assignment submissions and for other activities. (We°‘ll
cover them as they come up later in the book.) o Guest access:

= Allow Guest access: This setting determines whether a user can access the
course as a guest, without being required to enroll.

= Password: A password allows guest access to the course to be restricted to
only those who know the password. Guests will be required to supply the
password each time they access the course. 0 Groups:

= Group Mode: Here you can define the group mode at the course level by a
pull down menu. "No groups", "Separate groups" and "Visible groups" are
the choices. The selected setting will be the default group mode for all
activities defined within that course. The group setting can affect what users
see in the Participants list and who they can interact with in activities.

= Force Group Mode: If the group mode is "forced™ at a course-level, then this
particular group mode will be applied to every activity in that course. This
will override any activities that may have a special group setting.

= Default grouping: If groupings are enabled, a default grouping for course
activities and resources may be set. Groupings are used in case if you want
to make an activity (such as an assignment or a quiz) visible to only one set
of users within a course, you need first to put the users into a group and then
put them into a grouping. A single grouping can house one group or several
groups. We will discuss about Groupings in the later chapter. o Role
Renaming: You can rename the roles used in your course. For example, you
may wish to rename the Teacher role as "Facilitator", "Tutor" or "Guide".
These new role names will appear within the course.

For example on the participants and the override permissions pages.

[ Once you‘ve made all your selections, click the —Save changesl button.

Enrolling Students in the course

To select the Enrollment options for your course, click and expand the Users tree under the
course administration tree in the Administration Block. Then, click on "Enrolled users". It will
show the list of the participants enrolled in your course including their details like First Name,
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Surname, Email address, Last access, Assigned Roles within the course, and the Enrollment

method.

Enrol users

ARSI

Rec

N rOES

Enroiment options

OVET user's nid grades If possibe

shigent usar

"""" @amail.com

Finish enroliing users

To enroll users to your course:

Figure 2-12 Enrolling Users in course

«  Click "Enroll users" in the top right side as shown in the image.
+ In the pop up window, first choose the role to be assigned from the drop down menu. Let‘s

say that you want to assign Student role to your users.

« To limit the Enrollment duration for some specified time, expand the Enrollment tree and

set the Enrollment duration.
+  Click on the Names of the users to Enroll them as a Student in your course.
«  After finishing click "Finish enrolling users".

Editing Mode (“Turn Editing On” Button)
Now you are having your own course in preferred format and settings along with your students,
we'll look at how to add content.
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To start the process, you‘ll first need to turn editing on which will allow you to add
resources and activities to your course. At the top right of the page of any course you are
teaching, you‘ll see a button labeled, surprisingly enough, —Turn editing on.I Clicking on this
button will present you with a new array of options. You can also switch on the editing mode
from the Administration Block under Course Administration tree.

19 September - 25 September

yLInig moocie

) Badges

- T2 September - 2 October [1v9.0CH% IWS00R PO ¥

Fig 2-13 Blank Weekly Course with Editing Mode turned On

Starting at the top of the screen, let‘s look at what turning editing on enables you to do. At the

top of each section, you‘ll see an icon of a gear like * . When you click it, you are presented
with a Summary text area. You can use this to change the default section name and summarize
each topic or weekly section in your course. You should keep the summary to a sentence or two
for each block to avoid making the main page too long. Click —Save changes| button when
you‘ve added your summary. You can go back and change it later by clicking the gear icon
again.

You will find the following icons as mentioned in the table in a single course section.

Icon Function

Edit Settings. This icon is used to edit the settings of the particular item like editing the
settings of a label.
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How to use E-leaning

Drag and Drop Icon - Move any item in a different section/week or change the order of
the sections in the course layout.

Highlight Icon- the highlight icon allows you to highlight a section as current.

Eye Icon. Used to show or hide a section or week or any single activity.

Pencil Icon - Used to change the Title of a file as displayed on the course page.

Edit=  |Drop down menu to reveal the below mentioned icons.

Move right or left. You can move blocks to the left- or right-hand columns. You can
also use this to indent items in the middle column.

Groups Icon - the groups icon allows you to change between no groups or
separate/visible groups

Duplicate Icon- the duplicate icon allows you to copy an activity or resource. It's done
directly on the course page.

Roles icon - allows you to assign roles locally in the item.

Delete icon - will permanently delete something from the course

Table 2-1 Icons used in E-leaning

Use these icons throughout E-leaning to customize the interface for your needs.

Edit~ A
g Edit setlings
+ A sourc
< Move right
@ Hide
‘r; Duplicate
+A 1+ Assign roles Burc
X Delete

Figure 2-14 Edit Menu of an activity
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How to use E-leaning

In addition to the icons for manipulating blocks and activities, each section in

the middle column has a link "Add an activity or resource
Add an activity or resource .
: - " to add tools for adding resource content such as web pages
and links to web sites and activities such as forums, quizzes, lessons, and assignments. If you like
the native separate activity and resource drop down menu like in E-leaning 1.9 then you can
switch Off the activity chooser from the course administration tree by clicking "Activity Chooser
Off".

By adding the resources available in the E-leaning you can create content directly within E-
leaning or link to content you‘ve uploaded. We‘ll describe each of these tools briefly now, and
cover them in depth in the next chapter:

* Book: The first tool, —Bookl creates a Book resource on your course page which can be
used for creating a multi-page resource with Chapters and subchapters.

» File: A picture, a pdf document, a spreadsheet, a sound file, a video file. You can also
directly drag and drop the files onto the course home page to add them as a resource.

3¢l A% A0ty Of 14

T

Cancel

Figure 2-15 "Add an activity or resource" menu

» Folder: For helping organize files and one folder may contain other folders.

* IMS Content Package: Add static material from other sources in the standard IMS content
package format.
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» Label: Can be a few displayed words or an image used to separate resources and activities
in a topic section, or can be a lengthy description or instructions.

» Page: The student sees a single, scrollable screen that a teacher creates with the robust
HTML editor.

« URL: You can send the student to any place they can reach on their web browser, for
example Wikipedia.

All the resources are known as the Static activities in E-leaning as they are for sharing the
information with the student in a single direction whereas the activities allows you to add
interactive tools to your course.

An activity is a general name for a group of features in a E-leaning course. Usually an activity is
something that a student will do that interacts with other students and or the teacher. There are 14
different types of activities in the standard E-leaning. The bulk of this book is dedicated to
describing how each of these tools works and how to apply them in your course.

Table 2-2 explains each tool very briefly. We‘ll learn more about these tools as they come up
later in the book.

Activity Description
Type

Assignments | Enable teachers to grade and give comments on uploaded files and assignments
created on and off line.

Chat Allows participants to have a real-time synchronous discussion.
Choice A teacher asks a question and specifies a choice of multiple responses.
Database Enables participants to create, maintain and search a bank of record entries.

External Tool Allows participants to interact with LTI compliant learning resources and
activities on other web sites.

Feedback For creating and conducting surveys to collect feedback.

Forum Allows participants to have asynchronous discussions.
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Glossary Enables participants to create and maintain a list of definitions, like a dictionary.

Lesson For delivering content in flexible ways.

Quiz Allows the teacher to design and set quiz tests, which may be automatically
marked and feedback and/or to correct answers shown.

SCORM Enables SCORM packages to be included as course content.

Survey For gathering data from students to help teachers learn about their class and
reflect on their own teaching.

Wiki A collection of web pages that anyone can add to or edit.

Workshop Enables peer assessment.

Table 2-2 Activity types in E-leaning

ADDING CONTENT TO THE COURSE:

By now, you‘re probably wondering, —When the heck do I get to add stuff to my course?l
We‘ve provided a lot of background so you‘ll understand some of the available options. But, now
it‘s the time to start building your course.

Let‘s start with a news item to announce to everyone that your online materials are coming soon.
The Site News is a special type of forum (for a full description of forums, see Chapter 6). It is
automatically created when the course is first generated.
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News forum
General news and announcoemenis

* Your new discussion topic

Subject*
Message® Pacagaph v
Path p
Subscription Everyone &= sutscribed o this forur
Attachment
-
Mail now

Post 1o forum

There are required Helds in this form marked *

Naxeum o fod new Ses Utimded maceses siiatheems 1

QU can Srag and Grog Nes Nere 10 Bdd Mem

Figure 2-16 Add a new discussion topic

Everyone in the course can read the postings and the news is automatically emailed to them. It‘s
a good tool for making general announcements and sending reminders to students about

upcoming assignments.

To add a news item:

1. Click the "News Forum" link near the top of your course page.

——
2
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2. Click the —Add a new topicl button. You‘ll see the page to add a new topic, as shown
in Figure 2-16.

Enter the subject of the announcement and the message to your class.

If you want to attach any files also then you can attach with the post.

By default all E-leaning notifications are sent out after a specified time configured by
your Site Administrator. So, if you need to send the News urgently before that time has
elapsed then you can check the box "Mail Now" to send it immediately.

Click the —Post to Foruml button. You will be returned to the News Forum page.

7. Click on your course name in the navigation bar at the top to return to your course page.

e W

o

SUMMARY

In this chapter, we‘ve looked at how to create an account and personalize your profile. We‘ve
become acquainted with E-leaning‘s user interface and tools, and we‘ve chosen a course format.
In the next chapter, we‘ll start adding different types of content to your new E-leaning course.

Chapter 4: Managing Content in E-leaning

ADDING CONTENT TO E-LEANING

The first thing most people want to do when they create a course in E-leaning is add some
content, such as a syllabus or a course outline. As we explained in Chapter 2, you can add
content to your course using the —Add an activity or resourcel link in the central section of your
course.

Since E-leaning 2.3, the Add a resource and Add an activity menu's are clubbed together in a
single menu with link Add and activity or resource. When you click on the link then it will open
a popup menu for you to choose which resource or activity you want to choose. In this chapter,
we‘ll use all of the tools under the resource menu. Future chapters will cover the tools in the
—Add an activityl menu.

5(
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*#* Remember that you need to turn editing on to see the —Add an activity or resourcel link.

The first tool, —Bookl creates a Book resource on your course page which can be used for
creating a multipage resource with Chapters and subchapters. The following two, —Filel and
—Folder,| are used to manage content developed in other programs, such as Word or
PowerPoint. You can also add content from other web sites and take advantage of the rich library
of information available on the Web. You can also drag and drop files onto the course page
directly to add them as a file resource. The next resource, —IMS Content Packagel enables you
to add prepackaged content from sites around the Web. The next tool "page” can be sued to
create a web page resource within the course by using the text editor. And finally the last tool
"URL" can be used to provide a weblink as a resource.

Let‘s begin by creating a simple label for your course.

Adding a Label

Labels enable you to add additional text or graphics to your course page. Labels can be used to
add banners to courses, label sections of resources and activities, or provide quick instructions on
the front page of your course.

To add a label from the Course page:

1. Click the —Turn editing onl button.

2. Click the "Add and activity or resource" link in the course page in the section where you
want to add the label.

3. Inthe popup menu select Label under the resources menu.

4. Create your label using the HTML editor (see the following section —Using E-leaning
Text editorl for more details on this). You can use Label to insert Images, Videos, Audio
files in your course.

5. Select whether to make your label visible by selecting Show or Hide from the visible menu
which is collapsed by default.

6. After you have created your label, click the —Save and return to coursel button.
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Adding a new Label to Topic 3

~ General

Label text*

- Common module settings

Visible now |=

Save and retum 1o course Cancel

Figure 3-1 Add label

Once you have created a label, the full text of the label will appear in the section where you
created it.

***You can use a hidden label to provide information only for other teachers on your course,
since students are unable to see hidden items.

*** |f you want to use a label to identify a grouping of resources and activities within a section,
you can indent the links under the label using the arrows adjacent to each resource or activity
link. This will give your grouping some visual separation from the rest of the content.

Composing a Page =
The page module enables a teacher to create a web page resource using the text editor. A page
can display text, images, sound, video, web links and embedded code, such as Google maps.

A page may be used

——
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To present the terms and conditions of a course or a summary of the course syllabus
To embed several videos or sound files together with some explanatory text

*** Advantages of using the page module rather than the file module include the resource
being more accessible (for example to users of mobile devices) and easier to update.

Adding a new Page

* General

Rame*

Description® Paragragh

Path p

Display cescription on course
page

* Content

Page content* Persarich

Patvp

» Appearance

Figure 3-2 Composing a page

*** Using the page resource is advantageous instead of uploading a wordprocessed
document, particularly if the document contains text that is just to be read and not
downloaded.

*** For large amounts of content, it's recommended that a book is used rather than a page.

Composing a page resource is very easy:

Click the —Turn editing onl button.

——
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Click the "Add and activity or resource"” link in the course page and select "Page" in the
popup menu. E-leaning will then display the page to compose a text page like the one in
Figure 3-2.

Enter a name for the text page. The name you give the page will be displayed in the content
section on your course page. Students will access your page by clicking on the name. Be
sure to give the page a descriptive name so students will know what they are accessing.
Write a description of the page in the description field.

Add the contents in the Page content field. You can use the features of the Text editor to
add media, images, links and more.

Under the Appearance section, you can control if you want to hide the page name and
description to be displayed onto the course page.

Under "Common Module settings™ you can completely hide the page from students by
choosing Hide under the Visible drop down menu. You can also hide the page at a later
stage by clicking the Eye icon/disable from the course home page.

In the ID number field, you can mention the ID number for identifying the activity for grade
calculation purposes. If the activity is not included in any grade calculation then the ID
number field may be left blank.

Scroll down to the bottom of the page and click the "Save and return to course". If you want
to have a look onto the just composed webpage then you can click on "Save and Display"
to display it directly.

Adding URL to the course ™

The URL module enables a teacher to provide a web link as a course resource. Anything that is
freely available online, such as documents or images, can be linked to; the URL doesn‘t have to
be the home page of a website. The URL of a particular web page may be copied and pasted or a
teacher can use the file picker and choose a link from a repository such as Flickr, YouTube or
Wikimedia (depending upon which repositories are enabled for the site).

You can also add the URL's to any other resource/activity by using the text editor.

To add a URL to the course home page:

Click the —Turn editing onl button.

Click the "Add and activity or resource” link in the course page and select "URL" in the
bottom of the popup menu. All settings may expanded by clicking the "Expand all/Collapse
all" link top right.

In the name field whatever you type will form the link learner‘s click on to view the URL
so it is helpful to give it a name that suggests its purpose.

In the description field: Add a description of your page here. Click "Show editing

——
o
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tools icon" to display the rich text editor, and drag the bottom right of the text box
out to expand it.

Adding a new URL to Topic 4¢

~ General

Name*

Description”

Display description on course
page

~ Content

External URL* Choose a link
» Appearance

URL variables

Figure 3-3 Add URL resource

« If the display description in the course page is checked then the description you entered
above will be visible under the name of the URL.
* In the content field enter the URL of the external site you want to link to or else click the
"Choose a link™ button to open the file picker and choose a URL YouTube, Picasa etc.
» Under the Appearance section which is collapsed by default you will find options to control
how the URL is displayed.
o Display: This setting, together with the URL file type and whether the browser
allows embedding, determines how the URL is displayed. The options in the drop
down menu are:

= Automatic - The best display option for the URL is selected automatically
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= Embed - The URL is displayed within the page below the navigation bar
together with the URL description and any blocks
= Open - Only the URL is displayed in the browser window
= Inpop-up - The URL is displayed in a new browser window without menus
or an address bar.
o Pop-up width/height: If your URL is to be displayed in a pop-up, specify the width
and height here
o Display URL description: To show the resource name and/or description when
clicking to access the URL, simply tick the appropriate checkboxes.

« URL Variables: This section allows you to pass internal information as part of the URL.
This is useful if the URL is actually an interactive web page that takes parameters, and you
want to pass something like the name of the current user, for example.

* Under "Common Module settings" you can completely hide the page from students by
choosing Hide under the Visible drop down menu.

* Inthe ID number field, you can mention the ID number for identifying the activity for grade
calculation purposes.

» Click "Save and return to course" to save and return to the course home page. If you want
to have a look onto the just composed URL then you can click on "Save and Display” to
display it directly.

*** |f your site administrator has enabled the feature drag and drop upload of text/links then a
link can also be dragged into a section of the course and given a name.

Creating a folder resource

The folder module enables a teacher to display a number of related files inside a single folder,
reducing scrolling on the course page. A zipped folder may be uploaded and unzipped for
display, or an empty folder created and files uploaded into it.

A folder may be used:

« Foraseries of files on one topic, for example a set of past examination papers in pdf format
or a collection of image files for use in student projects

« To provide a shared uploading space for teachers on the course page (keeping the folder
hidden so that only teachers can see it)

To add a folder to the course page, you need to first get it zipped or compressed using some file
compression tool. The way you do this depends on your computer and operating system. You
can use the open source file compression tool 7 zip (http://www.7-zip.org/).

'
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Adding a new Folder to Topic 2

~ General
Name*

Description®

Display description on course
page

- Content

Files

Dispiay tolder contents

Show subfolders expanded ()

Figure 3-4 Create Folder

There are two methods of adding a folder to your course.

+  First Method:
o Click the "Turn editing on' button at the top right of the course page.
o Drag and drop the folder onto the course section where you'd like it to appear.
o Click the button of the action you would like to take with the folder (in our case,
"Unzip™) and click "Upload"
o If necessary, edit the title of the folder by clicking the pencil icon and you're done.
« Second Method:
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Click the "Turn editing on' button at the top right of the course page.

Click 'Add an activity or resource' link, then in the activity chooser; select folder
and click the "Add" button. All settings may expanded by clicking the "Expand
all” link top right.

For General Section: Add name and description of the folder you want to display
to your students.

For Content Section: You can either drag and drop a zipped/compressed folder into
the box with an arrow or click the Add button to open the File picker menu in order
to choose a file from your computer or a repository.

When the folder thumbnail appears, click on it and select "Unzip™ as shown in Fig
3-4.

For Display folder contents section: Decide here whether to have the folder
displayed on a separate page (the default) or in line with or without subfolders
expanded or collapsed.

Click "Save and return to course" to save and return to the course home page.

Creating a file resource

When you wish to share with your students a simple file such as a Word-processed document or
slideshow (e.g. created in MS Word, MS Powerpoint, or Open Office) you use the file resource
type. It allows you to upload and display a variety of resources on your course. How your
students access them depends on your choices in File resource settings.

*** Your students will only be able to open your files if they have the appropriate software on
their own devices.

To add a file to your course:

«  First method:

o

©)
@)

@)

Click the "Turn editing on' button at the top right of the course page.

Drag and drop the file onto the course section where you'd like it to appear.

If necessary, edit the title of the file by clicking the pencil icon, or edit other options
by clicking the editing icon.

And you're ready with a file resource to share with your students.

« Second Method:

@)
@)

Click the "Turn editing on' button at the top right of the course page.

Click 'Add an activity or resource’ link, then in the activity chooser, select file then
click the Add button

In the general section provide a name and description for our file to be displayed
on the course page.

——
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In the content section you can either drag and drop files into the area specified by the arrow
if you are using an appropriate browser, or click on "Add" and use the File picker to upload
your file.

Adding a new File to Topic 2@

» General

Name*

Descrption*

Display description on course
page

Content

ialect Mas

Figure 3-5 Add file resource

Appearance Section: o Display:

= Automatic - Make the best guess at what should happen (probably what is
wanted 99% of the time).

= Embed - Show the E-leaning page with heading, blocks and footer. Show
the title/description of the item and display the file directly in the page as
well (good for images, flash animations, videos?, PDFs).

= Force download - user clicks on the file, then the web browser pops up with
the 'where do you want to save this file' box.

= Open - No E-leaning heading, blocks, footer or description - just show the
file in the web browser (e.g. shows image, PDF, flash animation, taking up
the whole browser window)

——
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= In pop-up - Same as ‘Open’, but opens a new browser window to show this
file (without the E-leaning heading, blocks, etc.)
o Show Size/Type: To show the file size and/or type on the course page and also on
the resource page, simply tick the appropriate checkboxes.
o Display resource name/description: To show the resource name and/or description
when clicking to access the file, simply tick the appropriate checkboxes
o Below the Display resource name/description you will find a link: "Show More"
When you click on the link then you will additional options for controlling the
appearance of the resource such as:
= Pop-up width/height: If your file is to be displayed in a pop-up, specify the
width and height here
= Use filters on file content: If you wish included media such as images and
mp3 to appear embedded in the files then select "all files" or "HTML files
only", according to your file types.
« Click Save and return to course to return back to the course home page.

=
Adding an IMS content package

IMS Content Packages are resources packaged to an agreed specification, making it possible for
a package to be reused in different systems without needing to convert it to a different format.
Content-authoring software often provides the option of pack- aging as an IMS Content Package.
You may have IMS Content Packages from a different LMS system or have purchased some IMS

Content Packages as course content.

To add an IMS Content Package:

«  Click the 'Turn editing on' button at the top right of the course page.

« You can add an IMS Content package to a course by choosing it from the "Add an activity
or resource” link.

« In the general section provide a name and description for IMS content package to be
displayed on the course page.

« In the Content section, drag and drop your IMS Content package into the box with the
arrow or else click the button "Choose a file" to locate and add your IMS Content package
via the File picker

«  Click Save and return to course to return back to the course home page.

——
| —
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& Adding a new IMS content package to Topic 2=

~ General
Name~

Description*

Display description on course

page
~ Content
Package file Chosse ate.  \tagmuem size for new Mles. 2MB
You can drag and drop fles here 1o add them
Archive packages v

Figure 3-6 Adding IMS content package to course

« And you're done with the IMS content package in your course.

Adding a book resource

The Book module makes it easy to create multi-page resources with a book-like format, with
chapters and subchapters. The book module allows you to have main chapters and sub chapters,
but it goes no deeper.
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Books can contain media files as well as text and are useful for displaying lengthy passages of
information which can be broken down into sections. You can use the book module to present
information in a well-structured, user-friendly format to your students.

Book module also allows you to import individual web pages or folders of web pages from
Administration >> Book Administration >> Import Chapter which makes it useful for group
work.

For Example: Each student creates a simple web page about your school and the teacher, (that's
you!) uploads the pages to the book. Voila! You and your students have created a useful,
interesting resource for new students and their parents. You could do this to create a class cook
book and nutrition guide, a resource about local civic organizations, triangles in our daily lives,
world leaders, you name it.

| Adding a new Book to Topic 2

General
Name*

Description®

Display description on course
page

Appearance

Figure 3-7 Creating a book resource

A book may be used

« To display reading material for individual modules of study
« As a staff departmental handbook
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As a showcase portfolio of student work

Whole books and individual chapters may be printed by selecting the relevant link in
Administration > Book administration.

To Add a book to your course page:

A teacher can add a book by choosing it from the "Add an activity or resource” link.
In the general section provide a name and description for the Book.
In the appearance section:
o Chapter formatting: You can choose how to format the chapters of the book. The

options are:

= None - chapter and subchapter titles are not formatted at all, use if you want
to define special numbering styles.
= Numbers - chapters and subchapters are numbered (1, 1.1, 1.2, 2,

)

= Bullets - subchapters are indented and displayed with bullets. [ Indented -
subchapters are indented.

Custom Titles: Normally the chapter title is displayed in the table of contents (TOC) AND
as a heading above the content. If this checkbox is ticked, the chapter title is NOT displayed
as a heading above the content. A different title (perhaps longer than the chapter title) may
be entered as part of the content.

Click "Save and display" to proceed further to add some chapters and subchapters in the
just composed book.

E-leaning will take you to a new page where you can add a new chapter to the book.

On add new chapter page Provide a title of the chapter.

If you've already created a chapter then you can mark this chapter as a subchapter. Please
note that this checkbox will remain disabled when you are adding the first chapter of the
book.

Add your chapter content in the Content field neatly formatted with the help of the HTML
editor tools.

Click Save Changes in the bottom of the page.

Then you will see the first chapter of the Book you had just created. To navigate within the
chapters of the book there is an additional block available in the left side i.e. Table of Contents.
And if you have still the Editing Mode On then you will see some icons in the TOC block where
you can edit the settings of the chapters of your book.

——
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« To update/edit the content of the chapter click the gear icon.

« To add more chapters/subchapters to the book, click the "Plus™ icon.

« To delete a chapter click the "Cross icon".

« To hide the chapters from being visible to the students click the disable eye icon.
You can also download the complete book in the IMS content package format by clicking
Administration >> Book Administration >> Generate IMS CP link.

To add Multilanguage content
E-leaning allows you to publish resources in multiple languages. The language of the resource
will change when the user changes their selected E-leaning language.

If you want the content of your course to be displayed in more than one language, you can create
content in multiple languages and the Multilanguage content filter will ensure the language
displayed is the one selected by the user.

*** TIP: Your system administrator needs to enable the Multilanguage content filter for these
instructions to work.

Let‘s add a page resource with multiple languages:

- First create your content in different languages. You can use the Google Input Tools for
typing in different languages.
« Add a page resource as mentioned in previous section.

+ In the page content section click the icon to expand the editor toolbar to show all
the available tools.

« Then, click in the HTML editor to enable the HTML code editing mode.

+ Enclose each language block in the following tags, where xx and yy are twoletter language
codes (as shown in the languages drop-down menu on the front page of your E-leaning
site):
<span lang="xx" class="multilang">your content in lang xx here</span> <span
lang="yy" class="multilang">your content in lang yy here</span>

Adding Media files to your course

Adding media content can help you communicate some ideas and processes more easily than text
alone. Imagine trying to teach a language if the students aren‘t able to hear it spoken. Or how
much easier it would be to learn how volcanoes work if you could see a video or an animation.

6
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Fortunately, E-leaning makes it easy to add rich media content to your course. The E-leaning
media filters automatically recognize your media type and put the right sort of link into your web
page so students can access it easily.

To add a new media file:

« Let‘s say you want to add a .swf (ShockWave Flash) file, which is saved in your computer,
containing some animation about the solar system.

+  Click the Turn Editing Mode On Button on your course page if you are not in editing mode.

- Drag and drop the file from your computer onto your course window in the topic/section
where you want to add the multimedia file. Make sure that it doesn't exceed the file size
limit of your site.

«  Change the title of the file as you want to show it to your students and you've successfully
added a media file onto your course page.

*** |n case the file is not displaying correctly, then you may have to adjust the appearance
settings of the file.

MANAGING AND UPDATING YOUR CONTENT

Uploading content is only half the battle of content management in E-leaning. You‘ll need to
ensure that your uploaded content is current, and you‘ll occasionally want to replace or delete
files. Fortunately, E-leaning has some useful features to help you manage your content once it‘s
on the server.

v Course agministration

Figure 3-8 Course Administration Block

6!
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Creating an alias/shortcut

When an uploaded file or a file from the Private files, Dropbox, File system or EQUELLA
repositories - is re-used elsewhere on E-leaning, the teacher has the option to make a copy (a
new, unconnected version) or to create a shortcut or alias. If an alias is created, then when the
original file is updated, it will change in all instances of the alias. So a teacher might add course
notes to their private files for example, and then add them into a number of courses. When the
teacher makes an alteration in the file in their private files, this alteration will be reflected in all
instances of the course notes.

An alias cannot be made in the following areas of E-leaning:

+ an assignment submission

+ aforum post attachment

« aworkshop submission

+ aquiz essay

 adatabase activity file field

This is to prevent cases such as a student uploading an item for assessment and then subsequently
changing the original in their private files. When a student uses a file from their private files in
one of these instances, they do not see the options to "copy" or "create an alias".

Tracking Versions

One of the biggest challenges you will face in keeping your content organized is dealing with
versioning. As the semester progresses, you may have multiple versions of your syllabus that
reflect changes to the calendar. Or you may have multiple versions of a presentation that has
evolved over the years. There are a couple of strategies you can use to track versions and ensure
that your students are accessing the correct version.

The easiest way is to develop a naming scheme for your files. While many people will attach a
version number, we recommend using a date stamp. A date stamp lets people know just how
recent the version is, and you don‘t have to track the current version number. To add a date
stamp, simply add the date on which you saved the version to the end of the filename. For
example, the first version of a syllabus for your fall course may be called Syllabus_8 30.pdf.
Later in the semester, you may post a revised version named Syllabus_9 21.pdf. Date versioning
helps you keep track of the version on the server and the latest version on your computer.

6t
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EFFeECTIVE CONTENT PRACTICES

There are a few effective practices that can make life easier for you and your students. First, there
are file format tricks to ensure your students can download and use your content. Second, make
sure the bit size of your files is as small as it can be, so your students won‘t grow old waiting to
download tomorrow ‘s lecture notes. Third, there are creative ways to use static content in your
courses to help you and your students succeed.

File Formats

Every file you create and save on your computer has a specific file format. For example, Word
files are saved in .doc or .docx format, and can be opened only in a compatible version of Word.
However, this can cause problems if your students don‘t have the same version of Word you do.
A solution is to continue to create your documents in Word but save them as Rich Text Format,
or RTF, a format that a wide variety of word-processing programs can open. In most versions of
Word, you can save a file as RTF by following these steps:

* Select —Save Asl from the file menu.
» Choose Rich Text Format (RTF) from the file type drop-down. [J Save
the RTF copy of your document.

There are a number of file formats for displaying text and images that almost everyone can open,
regardless of their computing platform, and you should strive to use these wherever possible.
These formats include RTF, Hypertext Markup Language (HTML), Portable Display Format
(PDF), and picture formats, including PICT, TIFF, JPEG, GIF, and PNG.

Table 3-1 describes some common file formats.

File type |Description Software needed to use the file

RTF A word-processor format that is readable by a Most modern word processors will
wide range of applications. You can save Word |read RTF, including
and PowerPoint documents as RTF. OpenOffice.org Writer.

HTML The language of the Web. Every web page Any web browser. Some word
displayed in a browser is created in HTML. E-  [processors will also read HTML
leaning has a built-in HTML editor you can use toj[documents.
create documents directly in E-leaning.
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file size limits. Your students will need to
download the entire video, which may be a
problem with a slow dial-up connection.

PDF PDF is a file format created by Adobe Systems  |Acrobat Reader is a free download

for document exchange. PDF files may be created from Adobe.

with Acrobat (not the reader but the professional

package) or the OpenOffice.org suite.
PowerPoint |As the most widely used presentationcreation PowerPoint, PowerPoint viewer, or
(ppt) software, PowerPoint files are OpenOffice.org Impress.

natural candidates for upload. The presentations

are easy to share, but be careful about file size

and access.
Pictures  [There are a lot of graphic file formats. Generally, |GIF, JPEG, and PNG require a
(PICT, only GIF, JPEG, and PNG are viewable directly [prowser. Other formats require
TIFF, in a browser. appropriate external viewers.
JPEG, GIF,
PNG)
Audio files |Audio files can be large, depending on your bit  [Your students will need media
(WAYV, rate and compression format. Be sure the file size player software. Many students will
MP3, is smaller than the maximum file upload size for |be able to play audio in MP3
RAM, E-leaning. Check with your system administrator. [format.
MOV)
Video files |Your E-leaning server may not accept a large To view a video, your students will
(MOV, video file. Before you attempt to upload a large  [need a media player that can play
WMV, RV)|video file, ask your system administrator about  [the appropriate format. Know

whether your movies can play in
QuickTime, Windows Media
Player, or RealPlayer.

Table 3-1 Common file formats
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Reducing file sizes

As important as creating files your students can open is making sure those files are a manageable
size. Graphics are usually the biggest offenders, and they crop up in some unlikely places. There
are three strategies that will give you the best results for the effort.

Strategy 1: Save your PowerPoint presentations as PDF

Big PowerPoint files are often the worst file-size offenders. It‘s too easy to add cool transitions,
clip art, and images that expand a simple hour-long presentation into a Gigabyte behemoth that
takes an hour to download. Not a good use of time for something that students will simply print
out and bring to class.

We recommend exporting your presentation as PDF using OpenOffice.org
(http://www.openoffice.org/download/index.html). Students will get the benefits of the outline of
the lecture, including graphics, and be able to print copies of the presentation slides, and the file
will be quick and easy to download.

Strategy 2: Scan articles as text, not images

There are many good articles that just aren‘t available in electronic format. If you want to avoid
printing an entire reader, scanning articles is an easy way to give your students access to
important resources. Many libraries now have electronic reserve services that will scan them for
you.

Scanning articles can result in very large files because most scanner software, by default, scans
everything as a graphic. So when you scan a page, you‘re really creating a picture of the page
that is much larger than a text version. The computer has to store information about every dot on
the page, not just information about the characters and their placement.

The solution is to use a software tool called Optical Character Recognition, or OCR. This great
tool recognizes the shape of the letters and gives you a text version of the article. You can then
manipulate the text version in the same way you‘d edit any other text document. It has the added
advantage of being accessible to screen readers for students with visual disabilities.

You can use the open source tool Capture2Text (http://capture2text.sourceforge.net/) for optical
character recognition.

Strategy 3: Reduce your image size and use compression

Finally, if you have digital images, it‘s very important to optimize their size and resolution for
sharing over the Web. Modern digital cameras and scanners can produce amazing, crystal-clear
images, but at a price of very large file sizes.

6!

——
| —


http://www.openoffice.org/download/index.html
http://www.openoffice.org/download/index.html
http://www.openoffice.org/download/index.html
http://capture2text.sourceforge.net/
http://capture2text.sourceforge.net/

How to use E-leaning

Most cameras and scanners come with free utilities that enable you to manipulate images. Other
programs such as Photoshop are fully featured, professional packages with lots of tools. To
reduce your file size, you only need some very simple tools, provided by most image-
manipulation software.

To reduce the image size you can also make use of some open source tools available like Image
Resizer for Windows (https://imageresizer.codeplex.com/) or batch image compression tool for
windows (http://sourceforge.net/projects/bir/)

By reducing the size of your files, you‘ll make life easier for yourself and your students. But the
smallest, most portable files in the world don‘t mean much if your students can‘t use them
successfully in your class. Next, we‘ll discuss some interesting ways you can use content to make
your E-leaning class a valuable resource for your students.

Creative Content

E-leaning allows you to upload just about any file that resides on your computer. However, the
key to a successful content strategy is knowing what content helps your students be
successful and what is unnecessary or confusing. Below are two best practices for adding content
to your course. These practices work well in a range of course designs, but there are others that
might work just as well for your particular course.

Uploading lecture notes

One of the easiest ways to use E-leaning to increase student learning is to upload your lecture
notes before the lecture. Providing access to your lecture outlines before a class meeting gives
your students a tool to help prepare for class and structure their class notes. If students know
which topics you consider important enough to include in your lecture, they are more likely to
pay attention to those areas in any assigned readings. During class, they can use the lecture notes
as a basic outline and concentrate on elaborating the main ideas with examples. Lecture notes are
also a useful tool for students whose first language is different from that of the speaker. If they
get lost during a lecture, they can refer to the notes to get back on track.

If you use PowerPoint in your lectures, a simple way to create and upload lecture notes is to save
your slides as an RTF file. The RTF file eliminates graphics and other extras and provides the
students with a plain-text outline. It will be easy to download and print for class.

External web sites
Effectively using the Web means you don‘t have to create or photocopy everything you want to
use in your class. There is a lot of quality content available on the Web, if you know where to
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look and how to evaluate it. A full discussion about vetting online resources is beyond the scope
of this book, but your institution‘s librarian can recommend some sources to get you started.

Most newspapers and news magazines have online versions you can bring into your class for
discussions of current events. Universities, schools, and nonprofit organizations publish huge
amounts of content available for you to use free of charge. In addition, there is a growing open
content movement, which publishes content available for anyone to use.

Most open content is published under a Creative Commons license, which allows users to choose
the type of public license they want to use (http://creativecommons.org). Authors can use the CC
licenses to license their work for use through any combination of attribution (their name stays
attached), with a share-alike license (you can share any derivative works as long as you use the
same license), or noncommercial use (you can‘t use the materials for commercial purposes). The
Creative Commons site also has a search engine for content that has been licensed using a CC
license.

*** This book has been licensed under the Creative Commons attribution and sharealike license.

In addition to the general content released by people under the Creative Commons licenses, some
universities have begun publishing course materials for use by the general public. These
collections are known as OpenCourseWare (OCW) repositories. MIT has the most well-known
collection, but other universities are following suit. Some of the bigger collections are:

« MIT (http://ocw.mit.edu) - MIT offers a comprehensive collection of courses from
accounting to zoology. Some of their courses have video lectures available in addition to
the syllabus, lecture notes, and problem sets.

« Utah State University (http://ocw.usu.edu) - Utah State offers a good collection of basic
courses with an emphasis on biological and irrigation engineering and instructional
technology.

» Johns Hopkins Bloomberg School of Public Health (http://ocw.jhsph.edu) - This is a
collection of public health courses from one of the world‘s leading medical schools.

« UK Open University (http://openlearn.open.ac.uk) - The OU offers full-text versions of
their content, instead of just course outlines and notes.

In addition to the institutional collections, there are a growing number of user-created content
sites available on the Web. These sites allow anyone to create, change, remix, and catalog
content. While the quality of the content can vary wildly, there is a large and growing body of
excellent content available for you to use. Some of these sites are:

*  Wikipedia (http://www.wikipedia.org) - An online encyclopedia developed by thousands
of volunteers. Anyone can create and edit documents.
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»  Wikibooks (http://en.wikibooks.org) - A sister project of Wikipedia. It aims to create open
textbooks that are freely available to the whole world.

This list is by no means exhaustive. Simply using Google as a tool in your class vastly expands
the amount and variety of content available to your students.

SUMMARY

Ultimately, the content you develop and share in your E-leaning course is up to you. Static E-
leaning content provides resources for students as they engage in the learning process. In this
chapter, we‘ve looked at how to upload and create content for your E-leaning course. In the
following chapters, we‘ll discuss some of the dynamic activities you can add to your class to
make it truly compelling.
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Chapter 5: Managing Your Class

Now that we have covered the basics of setting up a course and adding content, we need to take a
look at some of E-leaning‘s underlying capabilities. At first glance, this may seem like
administrivia, but understanding roles and groups is one of the keys to unlocking E-leaning‘s full
potential as a learning environment. A person‘s role in a course determines what he can do—in
other words, what capabilities he has. It‘s a very powerful system, but it does have a bit of
underlying complexity. You can use groups to create student workgroups, recitation sections, or
any other arbitrary grouping you need to realize your learning design.

We will start by discussing roles, since anyone who wants to do something in your course need to
be assigned a role.

UNDERSTANDING AND USING ROLES:

The roles and permissions system in E-leaning provides you with a huge amount of flexibility for
managing how students and other people interact with your course. The new roles system
supports guest, student, non-editing teacher, editing teacher, course creator, and administrator
roles out of the box; it also allows you to create and customize roles, and to change what a given
role can do in each activity. For example, you can now create permissions in individual forums,
which allows you to let students act as moderators in one forum while you retain the moderator
role in all of the other forums in your course.

Arole is a collection of permissions defined for the whole system that you can assign to specific
users in specific contexts. The combination of roles and context define a specific user's ability to
do something on any page.

For many people it seems a bit daunting to understand roles, but don‘t worry. Using roles and
permissions is something you can take slowly. You can start the usual way, assigning people as
students, teachers, and other roles specified by your institution. Later, when your course design
grows more elaborate, you can begin to experiment with overrides and assigning specific roles in
specific contexts.
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E-LEANING'S DEFAULT ROLES DESCRIPTION

The description of each standard role in E-leaning including the basic description and short name

is given in Table 4-1.

Short Name

Administrator

Authenticated Us

Authenticated user
on front page

editing teacher

Non-editing

Description

Administrators have full access to the entire site and to all courses.
They can do all the necessary changes in the configuration files.

Guests have minimal privileges and usually cannot enter any
content except a teacher allows for it.

All logged-in users in the E-leaning site in any role.

All users logged in to the frontpage course. Since E-leaning‘s front
page is also a course with ID=1 where you can add some activities
where the users can participate if they have assigned this role.

Editing teachers can do anything within a course, including
changing activities and grading students.

Non-editing teachers can teach in courses and grade students, but
not alter any activities.

Students can participate in courses and participate in activities
within the course.

Managers can access courses and modify them, without
participation.

Table 4-1 E-leaning’s default role description

We‘ll start simply, by assigning users to predefined roles in your course. Then we‘ll take a look
at the roles and capabilities system and later discuss how to use the advanced features.
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Now, before we start using roles let‘s get some basics about Context, Permission, Role and
Capability

« Context: A functional area of E-leaning. Contexts have a hierarchy. Examples of contexts
include a course, activity module, or resource.

« Permission: Permissions are paired with each capability. There are four possible
permission values: Allow, Prevent, Prohibit and Not set /Inherit. (It is called notset when
defining roles and inherit when overriding permissions.)

« Role: A named set of permissions those are associated with each capability. For example.
The "Teacher" and "Student" roles come with the standard E-leaning install.

«  Capability: A configurable aspect of program behavior. E-leaning has 100s of capabilities.
Each capability has a computer friendly name like mod/forum: rate and a human-friendly
name like "Rate posts."

ASSIGNING ROLES IN YOUR COURSE:

Most of the time, students will enroll themselves or be added automatically by your university‘s
enrollment system, so there shouldn‘t be much need for you to manually enroll students.
However, if you need to add a teaching assistant, an outside guest, or a student who is having a
problem with financial aid, you must manually enroll them, i.e., assign them a role in your E-
leaning course.

7!
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Manual enrolments

Enrolled users Not enrolled users

Enrolled users (1) 3 < Add Not enrolled users (1)
Admin User [|xx:<zxzs==czxx‘v] student user (.v*xx*:xxazxxx )

Assign role
Student E|

Enrolment duration

Unlimited E‘

Starting from
Today (21/11/14) E\
Remove »

Search Search

Figure 4-1 Assigning a role

*** By default, teachers are only allowed to assign the roles of non-editing teacher, student, and
guest. If you want to assign the role of teacher, you will need to ask your system administrator
for this to be allowed.

To assign a user the role of student:

» Click Course Administration > Users > Enrolled Users in the administration block.

« It will display all of the enrolled users in your course.
» Click "Enroll users™ in the top right side as shown in the image.

o In the pop up window, first choose the role to be assigned from the drop down
menu. Let‘s say that you want to assign Student role to your users.

o To limit the Enrollment duration for some specified time, expand the Enrollment
tree and set the Enrollment duration and starting date.

o Click on the Names of the users to Enroll them as a Student in your course. o After
enrolling the students click "Finish enrolling users".

*** Users must have an account on your E-leaning site before you can assign them a role in your
course. If they don‘t appear in either the existing or potential users list, they will need to create an
account before they can be assigned a role.
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Students will have access to your course as soon as you assign them a role. They won‘t need to
have an enrollment key or to confirm the enrollment.

REMOVING STUDENTS

If a student drops your class, you‘ll want to remove the student from your E-leaning course as
well. Leaving a student enrolled in your E-leaning course when she is not on the official roster
makes grading and class management much more difficult. When you record grades or look for
student assignments, extra students on the roll gets confusing. The nonparticipating student will
also have access to your discussion boards and other potentially sensitive information.

Fortunately, removing students is easy. Simply click the “* "delete” icon besides the Enrollment
method column in the extreme right on the Enrolled Users page of your course.

TEMPORARILY SUSPENDING A USER ACCOUNT

There may be times when you are not sure about the status of the students and you want to
disable them for a while before removing them completely from your course. In that case, to
suspend a user from the course:

. Click the ™ icon in the Enrollment method column against the Students name that you want
to suspend.

« Under the Status drop down menu change the status from "Active" to "Suspended” and
you're done.

MANAGING ENROLLMENT METHODS FOR YOUR COURSE

If your university/institution doesn‘t have an automatic enrollment system, then ensuring that
only students who are officially enrolled in your course have access to your E-leaning course can
be tricky.

Some of you may want to make courses accessible for guest users also so that they can also take
a sneak preview of the course which can be used especially for corporate training. You may also
want to let the students within your E-leaning site to be capable to enroll themselves in your
course. For all these you have to configure the enrollment methods for your course.

To manage the enrollment methods:
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«  Click Course Administration > Users > Enrolled Methods in the administration block.

« It will display all the available enrollment methods including the number of students
enrolled using the method in your course and options to add new enrollment methods (New
enrollment methods have to be first enabled by site administrator along with the capability
to add, then only you will be able to add them).

« The enrollment methods which are shown as grayed out are currently disabled. You can
delete any enrollment method by clicking the delete icon.

« To enable the Guest access of enrollment for the course, simply click the "Eye " icon
besides the Guest access enrollment method.

« To let the students enroll themselves in your course, turn on the "Self Enrollment (Student)"
method by clicking the "Eye" icon.

« You can also set an enroliment key for self-enrollment method and directly add the students
to a group by setting the Group enrollment key.

CAPABILITIES AND PERMISSIONS

Now it‘s the time to learn about the Capabilities and permissions. As we discussed earlier there
are 4 key concepts to understand.

« Role: A named set of permissions that is associated with each capability. For example. The
"Teacher" and "Student" roles come with the standard E-leaning install.

- Permission: Permissions are paired with each capability. There are four possible
permission values: Allow, Prevent, Prohibit and Not set /Inherit. (It is called notset when
defining roles and inherit when overriding permissions.)

«  Capability: A configurable aspect of program behavior. E-leaning has 100s of capabilities.
Each capability has a computer friendly name like mod/forum:rate and a human-friendly
name like "Rate posts."

« Context: A functional area of E-leaning. A context is the scope within which a role
assignment is valid. Contexts are organized in a hierarchy, where lower (more specific)
contexts inherit capabilities from higher (less specific) contexts. The contexts in E-leaning
in order of inheritance are:

System: All contexts in the site, including site settings and user administration
Site: The site front page course and its activities o Course category: All courses in
a category o Course: A single E-leaning course
Module: A module instance within a course (a specific forum, quiz, wiki, etc.)
Block: A specific block instance within a course (at the time of this writing this
feature is not fully implemented)

o User: A user‘s profile or personal activities

Roles are made up of a matrix of capabilities and permissions that determine what a user can do
within a given context. For example, a user may have course creator privileges at the site level
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but be unable to post to a particular forum in a certain course. The permissions determine
whether someone can use a capability. Permissions may be set to one of four values:

+ Inherit: The default setting. If a capability is set to inherit, the user‘s permissions remain
the same as they are in a less specific context or another role where the capability is defined.
For example, if a student is allowed to attempt quiz questions at the course level, his role
in a specific quiz will inherit this setting.

« Allow: This enables a user to use a capability in a given context. This permission applies
for the context that the role gets assigned plus all lower contexts. For example, if a user is
assigned the role of student in a course, she will be able to start new discussions in all
forums in that course (unless a forum contains an override with a prevent or prohibit value
for the capability).

« Prevent: Prevent disables a capability for a user in a given context but does not disallow it
in a more specific context. You can prevent students from adding attachments to forum
posts in your course, but allow them to do so in one particular forum.

« Prohibit: Prohibit is rarely needed, but occasionally you might want to completely deny
permissions to a role in a way that cannot be overridden in any lower context.

*** Keep in mind that permissions are set within a role, and then people are assigned to roles in a
given context. A person can be assigned to more than one role, depending on the context, or even
multiple roles within the same context.

OVERRIDE PERMISSIONS

Overrides are specific permissions designed to override a role in a specific context, allowing you
to "tweak" your permissions as required.

Overrides may be used to "open up™ areas by giving users extra permissions. For example, an
override may be used to enable students to rate forum posts.

The way to achieve this is through a role override. As long as the capabilities you want to allow
your students to have in your course (or within a module in your course) aren‘t prohibited at a
higher level, you can override the permissions. Within your course, for example, you can
override roles at the course level or in a particular activity. If you want to change what students
can do anywhere in your course, override the role at the course level. If you want to create a
different set of permissions for a given activity, override the role in the activity itself. Overrides
may also be used to prevent actions, such as starting new discussions in an archived forum.

*** Qverriding roles is itself a permission. By default, teachers are unable to override roles so
this ability must first be granted by your system administrator for the course or site as
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appropriate. They must also set which roles can be overridden by the teacher role. If you don‘t
see the —Override rolesl link in the Roles tab, ask your system administrator.

Users Privileges

# Role

Privileges

-View all Courses
-View all Users

- Course progress

2 DVCA

-View all Courses
-View all Users

- Course progress

3 Director of Quality
Assurance

View all Courses
-View all Users

- Course progress

3 Dean of Faculty

-View Faculty Course
- Assign Course to Lecturers
- Modify Course Name and Code

- Faculty Report

4 Head of Department

View Department Course
- Assign Course to Lecturers in department Level
- Modify Course Name and Code

-Department Report

5 Lecturer

Teachers can do anything within a course, Including Changing

The activities, and grading students.
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6 Student Students generally have fewer privileges within a course like
-Download Course Materials

-View and Submit assignment

-Chat

-Etc

Locations for overriding permissions

Since E-leaning has got a very fine grain control of the permissions systems, so initially you may
be sometimes confused by the permission system interface. To change the permissions for
specific contexts the locations are:

«  Front page context: Administration > Front Page settings > Users > Permissions
«  Course category context (when used):Category > Administration > Permissions [ Course
context: Administration > Course administration > Users > Permissions

Override permissions for role 'Student’ in Course: using moodle®

The highlighted cells in the table below show the permission (if any) that will be inherited. Apart from the capabilities whose
permission you actually want to alter, you should leave everything set to Inherit

Filter
forum Clear
Capability Permission (2 Risks

Activity: Forum

Add a new forum © £ 4
moed/forum:addinstance Inherit (Not set) Allow Prevent Prohibit

A

Activity: Forum

Add news © E -
mod/forum:addnews Inherit (Not set) Allow Prevent Prohibit
Add question © E E 3
mod/forum:addquestion Inherit (Not set) Allow Prevent Prohibit
Allow force subscribe ) 3 , 3
mod/forum:allow forcesubscribe Inherit (Allow ) Aliow Prevent Prohibit
Create attachments © -
mod/forum:createattachment Inherit (Allow)  Allow Prevent Prohibit
Delete any posts (anytime) © E E 3
mod/forum:deleteanypost Inherit (Not set) Allow Prevent Prohibit

——
o
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Figure 4-2 A role Override

« Module context: (from the chosen module) Administration > Module administration >

Permissions
« Block context: (from the chosen block) Administration > Block administration >

Permissions
«  User context: (from the user's profile) Administration > Roles > Permissions

Overriding permission in activity

The override interface will only show you the capabilities for the context you are overriding. So
if you want to allow students to rate forum posts, you can override the student role in a particular
forum. You will only see the forum capabilities in the interface, as shown in Figure 4-2.

To override permission for a forum activity:

» Open the activity for which you want to create the override.

* Click Administration > Forum Administration> Permissions.

* You can see the list of all roles having permission in the activity and even add a specific
role for that permission.

* In the top dropdown menu —Advanced role overridel field select the role for which you
want to create the override.

Permissions in Course: using moodle

anced role ovemde

Cagpabiity Risks Roles with permission Prohibited
Block: Recent activity

EN A0 and L atad moduiss 0 (el & Y Aulhenlic3as user

Cohor sync

External database

Fiat tile [CSV)

Mansg
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Figure 4-3 Permissions in a course

» Modify the permissions for the override on this activity.
* Click the —Save changesl button. Anyone with the role you have just overridden will now
have those capabilities in this activity when they next log in to E-leaning.

Overrides allow you to create a lot of variation in the way students interact with an activity.
However, before digging into the overrides system itself, be sure you have a clear understanding
of what you are trying to achieve educationally with the override.

STUDENT GROUPS

E-leaning has an unusual but effective way of managing small student workgroups within your
course. You can define groups at the course level, then set each activity to a group mode or leave
it available to everyone. The group mode you choose may also determine the behavior of the
module. Think of groups as a filter. If you are a member of a group within a course, and an
activity is set to group mode, E-leaning will filter out any work from anyone who is not part of
your group. You are all looking at the same activity, but you can‘t interact with anyone who is
not in your group.

Course Help Forum

This forum is for discussion about this course.

Visible groups | Al participants |
Add a new Group A
Group B
Discussion Started by Group Replies
| love Moodle Admin User 0

Figure 4-4 Visible groups in a forum
Group levels
A group or grouping can be used on two levels:
« Course level - The group mode defined at the course level is the default mode for all

activities defined within that course. To use groups you need first to set a group mode in
Administration>Course administration>Edit settings.
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« Activity level - Each activity that supports groups can also have its own group mode
defined. If the course setting "Force group mode" is set to "Yes" then the option to define
the group mode for individual activities is not available. If it is set to "No", then the teacher
may change the group mode:

Group Modes

There are three group mode options:

 Nogroups - Everyone participates as part of the class. Groups are not used.

» Separate groups - Each group can see only their own work. They can‘t see the work of other
groups.

» Visible groups - Each group does their own work, but they can see the work of the
other groups as well, as shown in Figure 4-4.

Once the group mode is set for the course or activity, students will interact with your E-leaning
course as they normally would. The only difference will be the people they meet in certain
activities, such as forums. For example, if you set the group mode of a forum to separate groups,
E-leaning will create a forum for each group. Each student will see the same link to the forum,
but she will be able to access only the discussions for her particular group. You need to create the
forum only once; E-leaning takes care of creating the individual group forums.

Why use groups?

* You are a teacher in a course where you have several classes and you want to filter your
activities and gradebook so you only see one class at a time.

* You are a teacher sharing a course with other teachers and you want to filter your activities
and gradebook so you don‘t see the students from your colleagues® classes.

* You want to allocate a particular activity, resource or topic section to just one class or set
of users and you don‘t want others to see it.

Creating a group

» Click the 'Create group' button in Administration > Course administration > Users > Groups

« Add a group name and optional description (displayed above the list of group members on
the participants page), enrolment key and picture (displayed on the participants page and
next to forum posts)

» Click the 'Save changes' button
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» Select the group to which you want to add participants, then click the 'Add/remove users
button

» In the "Potential members" list, select the users you want to add to the group.
Multiple users may be selected using the Crtl key.

» Click the Add button to add the users to the group.

Group name*

Group 1D number

Group description Peragrevh

Enroiment key

Hide picture -

New picture

Saye changes Cance

Figure 4-5 Creating a Group

An optional group ID number (an advanced setting) may be added for matching the group against
external systems. Group 1D numbers are not displayed anywhere on the site. Within a course, all

group ID numbers must be unique. Thus it's not possible to create a group with a duplicate group
ID number.

Icon Group Mode
No Groups

Separate Groups

Visible Groups

Table 4-2 Group Mode Icons
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Add/remove users: Test group

MO mesmbers Polenta) memibers SeCitd user's membershe

Studtent (1) Toacher (1)

Figure 4-6 Adding/Removing users

Auto-create groups
Groups may be created automatically via the 'Auto-create groups' button in Administration >
Course administration > Users > Groups.

In the General Section

A naming scheme can be created automatically. # is replaced by sequential numbers, and @ by
letters. For example:

«  Group @ will create group with a naming scheme Group A, Group B, Group C ... [
Group # will create group with a naming scheme Group 1, Group 2, Group 3. ..

You can specify if you would like to create

« X number of Groups or
+ each group contain x number of students

In the Group Members Section

» Select members from ... allows you to choose from roles or available cohorts.

8t
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Auto-create groups

~ General
Naming scheme*
Auto create based on Number of groups 1=
Group/member count*
~ Group members
Select members with role Susem |»
Allocate members Ranaomly v

Prevent jast small group

» Grouping

Preview Submit Cance

Figure 4-7 Auto creating groups

» Allocate Members dropdown allows you to allocate group members in different ways.

» The Prevent last small group checkbox will allocate additional members to an existing
group rather than create a new group with fewer members than x.

In the Grouping Section

Grouping of auto-created groups and Grouping name allows you to create a new grouping
and allocate the new auto-created groups to be created to it. Prior to creating the groups, you can
view the groups.

BACKUP AND RESTORE

After spending a lot of time setting up your course and delivering it to your students, you‘ll want
to make sure you don‘t lose your work. Fortunately, E-leaning gives you a backup tool to create
archives of your courses. Backups can also be used to copy course resources and activities from
one course to another.
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A course can be saved with some or all of its parts by using the course backup. Typically, the site
administrator will set a schedule of automated course backups for the whole site. A teacher with
editing privileges can create a backup or download an existing backup for safe keeping, or for
use on another E-leaning site.

Backing up a course

To backup a course

« Go to Administration > Course administration > Backup

- Initial settings - Select activities, blocks, filters and other items as required then click the
Next button. Users with appropriate permissions, such as administrators and managers, can
choose whether to include users, anonymize user information, or include user role
assignments, user files, comments, user completion details, course logs and grade history
in the backup.

« Schema settings - Select/deselect specific items to include in backup, then click the Next
button.

« If desired, select specific types of activity to be backed up by clicking the link 'Show type
options'.

- Confirmation and review - Check that everything is as required, using the Previous button
if necessary, otherwise click the 'Perform backup' button [1 Complete - Click the Continue
button

——
| —
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Figure 4-8 Backing up a course

A backup file (with distinctive .mbz extension to avoid confusion with .zip files) is then saved in
the course backup area. Backup file names are of the form backup-E-leaning2course-coursename-
date-hour.mbz, ending in -nu.mbz when backed up with no users and -an.mbz with anonymized
names.

*** Anonymize user information is a backup feature which "protects user identities” by making
each user anonymous. If this box is checked in the backup initial settings, E-leaning will
substitute aliases for real names.

Automated course backup

(This section is only for Site Administrators, Teachers can skip this.)

A site administrator can configure a schedule for automated course backups in Administration >
Site administration > > Courses > Backups > Automated backup setup.

Automated course backups runs the same functions as individual course backups. It's a good idea
to schedule backups at the time when your server isn't usually busy. Running the backup tool
over all the courses can be processor-intensive, so you shouldn't run it when there are a lot of
students trying to access the server. You should always alert users with an announcement on the
first page that if they log on during the backup hours they may notice a decrease in performance.

8!
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*** |In order to configure scheduled backups, you have to first set up the CRON job on your site
to run periodically.

To set the backup schedule:

* Go to Administration > Site administration > Courses > Backups > Automated backup
setup.

» Set backup_auto_active to enabled.

+ Select the days of the week to run the backup.

» Set the execution time for the backup process. For most servers, early morning will be the
best time. Keep in mind the time zone your server is using.

» Set the "Save to..." path. If you can, choose a backup path on another machine or on a
different drive than the one E-leaning is on. You don‘t want to lose your backups at the
same time you lose your E-leaning site if the drive fails. If you leave the field blank, then
backup zip files will be saved in the backup folder of each course files folder. On a Linux
server the path might look like: /home/(your user or domain)/public_html/archive/ or if it's
below the publicly accessible folders: /nome/(your user or domain)/archive/ if the path is
not recognized a red X is shown after saving, otherwise a green check.

Automated backup setup

Figure 4-9 Automated Backup settings

9(
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» Choose whether to skip the backup of hidden courses or courses which have not been
modified within a specified number of days, or not modified since the last backup.
» Click the "Save changes" button.

Once you've set up your backup schedule, E-leaning will automatically create archives of all the
courses on the server at the time you specified. Once the backup is complete, E-leaning will send
you an email describing the status of the backup.

RESTORE A COURSE

A course backup file (.mbz) may be restored from within any existing course for which you have
permission. During the restore process, you will be given the option to restore as a new course or
into an existing course.

Import a backup file

Files Chaose aMe

v

You tan drag and drop files here 1o add them

Course backup areac

Fliename Time Size Download Restore

Manage backup fies

User private backup area

Figure 4-10 Restoring a course

To restore a course:

» Go to Administration > Front page settings > Restore (if you have front page permissions)
or Administration > Course administration > Restore (if you have an empty course to
restore into.)
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» Upload the backup file or choose a file in the course backup area or user private backup
area and click Restore

« Confirm - Check that everything is as required then click the Continue button

» Destination - Choose whether the course should be restored as a new course or into an
existing course then click the Continue button

« Settings - Select activities, blocks, filters and possibly other items as required then click the
Next button

» Schema - Select/deselect specific items and amend the course name, short name and start
date if necessary then click the Next button

» Review - Check that everything is as required, using the Previous button if necessary, then
click the 'Perform restore' button

« Complete - Click the continue button

Creative uses

The backup and restore processes can offer the teacher and administrators many creative
solutions.

Duplicating courses or specific activities in one course to another course (similar to Import)

« Updating a production E-leaning site course, with material from a localhost site course

« Transferring a course to a new E-leaning site.

« In earlier versions of E-leaning, a way of rolling a course forward without past student
activity

«  Creating a blank activity, save just that activity and then restore it to the course or another
course one or more times.

REPORTS

Once your course is up and students are working, E-leaning provides you with detailed logs and
participation reports of student activity.

The logs and participation reports are useful for tracking students® activity in a class. If a student
doesn‘t spend time with the material, he will have difficulty succeeding in the course. Frequently,
students who don‘t do well simply haven‘t spent the time working with the material.

If you analyze your course reports on a regular basis, you can monitor when your students
engage with the course material. You won‘t be able to tell exactly how long they spent with a
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certain activity or resource because the logs report only the time of access. Of course, you can
guess how long a student spent with a resource by noting the time when the student began the
next activity.

Logs and participation reports can also tell you which resources and activities students find most
valuable. For example, if you upload all your PowerPoint slides for students to take notes on in
class, but no one accesses them, you might want to find out why.

To access course reports:

» Click Reports in the Administration block.
» On the Reports page, choose from the following:
Logs
Select any combination of group, student, date, activity, and actions, then click
the —Get these logsl button.

You can see what pages the student accessed, the time and date she accessed it,
the IP address she came from, and her actions (view, add, update, delete), as
shown in Figure 4-11

You can choose to display the logs on a page or download them in text, ODS, or
Excel format.

*#* The Logs page contains active links enabling you to access the student‘s
profile page or a particular page that the student was viewing. The IP address link
provides an estimate of the students location.
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Figure 4-11 Viewing logs of a course

Live Log
If you‘d like to track the latest activity on your course, select Live Logs. It shows

you all the activity, teachers and students, for the last hour.

Activity Report
A course activity report, showing the number of views for each activity and
resource (and any related blog entries), can be viewed by managers, teachers and

non-editing teachers

*** The length of time that the activity report covers is determined by the
loglifetime setting in Administration > Site administration > Courses > Backups >

General backup defaults.

Course Participation
To generate a participation report:

——
| —
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a. Select an activity module, the time period to look back over, to show only
student reports, and the actions you are interested in (views, posts, or all actions),
then click the Go button.

b. A list of all instances of the selected activity module in the course will be
generated. Select one, then click the Go button.

The participation report, as shown in Figure 4-12, lists the number of times each student has done
the action selected.

Activity module = Assignment: History of India E| Look back = 1 weeks F’ Show only | Teacher E‘ Show actions | All actions E‘ Go

Groups

All participants E’

Assignment Views
Assignment Posts

1
First name / Surname All actions Select
Admin User No
Select all Deselect all Select all'No
With selected users...
Choose E' 0] oK

Figure 4-12 Course participation report

If you wish, you can select particular users and send them a message. Select —Add/send
messagel from the drop-down menu and click the OK button.

SUMMARY

In this chapter we have taken a detailed look on the E-leaning‘s roles and permissions system
along with student‘s group modes, managing enrollment methods and backup and restoring a
course. E-leaning has the best roles and permissions system which makes you capable of taking
fine control over the permissions available to your participants. In the next chapter we will take a
look on the E-leaning‘s text editors: Atto and TinyMCE.

9!
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Chapter 6: Using E-leaning Text Editors

E-LEANING TEXT EDITORS

The text editor (sometimes referred to as the 'HTML editor’) has many icons to assist the user in
entering content. Many of these icons and functions should be familiar to anyone who uses a
word processor.

Some examples of where you will see the text editor include: Editing Section headings,
description of an activity, writing an answer to a quiz question or editing the content of many
blocks.

The default text editor in E-leaning is the Atto editor, built specifically for E-leaning. There is
also a version of the TinyMCE editor and a plain text editor.

Text editors can be enabled, disabled or a different one set to default from Administration > Site
administration > Plugins > Text editors > Manage editors. The order of priority may also be
specified here.

An individual user can select an editor in their profile from Administration > My Profile settings
> Edit profile.

So, let‘s start getting familiarized with the E-leaning‘s text editors one by one starting with Atto.

ATTOHTML EDITOR

Atto is a JavaScript text editor built specifically for E-leaning. Atto is the default text editor in E-
leaning from 2.7 onwards.

Atto is implemented as a standard E-leaning text editor plugin. Most of the code is written in
JavaScript as a standard E-leaning YUI module.

ot
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Figure 5-1 Atto text editor row-1

Description Row-1 Atto Text Editor:

1:Expand 2.Style 3.Bold 4.Italic
5.Bulleted list  |6.Numbered list 7.Add link 8.Unlink
9.Add image 10.Add media 11.Manage embedded files

VAP OV DO W WY @Y LW &

Figure 5-2 Atto text editor row-2

Description Row-2 Atto Text Editor:

1. Underline 2. Strikethrough 3. Subscript 4. Superscript

5. Align left 6. Align center 7. Align right 8. Increase indent

9. Decrease indent 10. Equation editor 11. Special character 12. Table

13. Clear formatting 14. Undo/redo 15. Undo/redo 16. Accessibility checker

17. Screen reader helper 18. HTML/code view

EQUATION EDITOR

If either the MathJax or the TeX notation filters are enabled (in Administration > Site
administration > Plugins > Filters > Manage filters) then an equation editor (button 10
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in the above pic) button is provided in the toolbar for launching the equation editor.

Equation editor

Operators Arrows Greek Symbols Advanced
* = o St + [5+]
= X (%) L] =
&= e} — - ~ ~
A = = ~ b 0

Edit equation using TeX

Equation preview
]

An arrow indicates the position that new elements from the element library will be inserted

Save equation

Figure 5-3 Equation Editor

You can use the equation editor to insert operators, arrows, symbols and mathematical equations
without knowing about using the TeX notations. It will automatically convert the symbols into
the TeX notations. It is a huge enhancement for Mathematics teachers who used to struggle
initially to learn the TeX notations.

*** Your site administrator may specify which plugins to display and in which order in your
editor window.
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Plugins for Atto

You site administrator can also increase the functionality of your Atto text editor by adding
additional plugins from the E-leaning plugins community site. You can add plugins to add
Chemistry editor, Computer Science Editor, word count and many more.

TINYMCE EDITOR

TinyMCE is the default text editor in the earlier E-leaning versions prior to E-leaning 2.7. It is a
nice text editor because of the intuitive text experience and its rich feature set of tools which are
very easy to use.

You can select the TinyMCE editor as your default text editor in your profile from
Administration > My Profile settings > Edit profile.

The TinyMCE editor first appears with just one row of buttons. Clicking the icon top left will
expand it to three rows.

For those who are not familiar with the tool bar, here are the buttons as grouped in their rows.

***Remember that the site administrator can edit or provide additional buttons.

Paragraph v

09 < DO OO OO LY B

Figure 5-4 TinyMCE Editor Row-1

Description Row-1 TinyMCE Text Editor:

1:Expand 2.Formatting  [3.Bold 4.1talic
5.Bulleted list ﬁ!:'”mbered 7.Add link 8.Unlink
9.Stop auto linking 10.Add image 11.Add emoticon 12.Add media

13.Manage embedded
files

——
©°
| —
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Figure 5-5 TinyMCE Editor Row-2
Description Row-2 TinyMCE Text Editor:

1:Undo 2.Redo 3.Underline 4.Strikethrough

5.Subscript 6.Superscript 7.Align left 8.Align center

9.Align right 10.Decrease 11.Increase 12.Text color
indent indent

13.Background color 14.Left to Right  [15.Right to Left

Figure 5-6 TinyMCE Editor Row-3
Description Row-3 TinyMCE Text Editor:

1:Font family 2.Font size 3.Edit HTML 4.Find

6.Insert non-breaking  [7.Insert special
Space character

5.Find/replace 8.Insert table

9.Clean up messy
code

13.Toggle full
screen

11.Paste as plain text |12.Paste from MS

10.Remove formatting \Word

Plugins for TinyMCE

Similar to Atto Text editor your site administrator can enhance the tools by adding the plugins for
TinyMCE editor also. You can also insert files, images, equations, emoticons by using the
TinyMCE editor also.

——
| —
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FILE PICKER

The file picker enables files to be selected and displayed in E-leaning - for example, when an
editing teacher clicks Add an activity or resource > File, or when a forum participant adds an
attachment to a post.

Usually the file is copied into E-leaning from wherever you have chosen it from (e.g. a repository
or your computer), though for certain repositories, such as the Youtube videos repository, a link
Is created, and in some situations an alias/shortcut may be created.

An "add" button appears which is clicked on to access the file picker:

Select files

+ 1 Add. 44l Create folder

» il Files

Figure 5-7 Add files button in file picker

Getting files from the file picker

When the file picker screen appears, a number of links are listed down the side. These are links to
Repositories which hold files you might want to use. There is also a link Upload a file which you
would click on to add a file yourself from your computer.

Which repositories are included depends on which ones have been enabled by the administrator
and also the context in which you access the file picker. For example, if you have reached the file
picker by clicking on the media icon in the TinyMCE text editor then you might see the Youtube
videos repository link.

il

——
| —



File picker

How to use E-leaning

Server files
Recent files
Upload a file
Private files

Attachment:
URL downioader

Th
T
:‘
T
&
2

Save as:
Wikimedia

Flickr public Author: .

IABr;\;se..‘

Choose license: | All rights reserved

[ Upload this file |

Figure 5-8 Upload a file in file picker

Viewing your files in the file picker

There are three ways to view files in the File picker, depending on your personal preference:

* View as icons This shows the files as easily identifiable thumbnails:

File picker

Server files @
» (@ Private files
Recent files

Upload a file

Private files i

URL downioader

Wikimedia
Slides Ambersweet
Flickr public oranges.jpg

t 6P 2P DD

E
i

Introduction.rtf

Figure 5-9 Viewing files as icons

* View as table This shows the files with details such as license, date uploaded, size etc.:

——
| —
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File picker X
T Server files @ |3§§’§{
» [ Private files
T Recentfiles ‘ :}
Name Last modified Size Type
[; Upload a file ‘
Slides 25/06/12, 15:55
T Private files E
_ “ finead 250612, 19:13 256.8KB Image {JPEG)
; URL downloader ¥8 Ambersweet oranges.jpg
D Wikinedia Bl iiicionar 25006112, 15:55 331 byles  RTF document
** Flickr public

Figure 5-10 Viewing files as table

* View as a list This shows the files in a hierarchical list:

File picker %
T Server files = [ae.= E
T Recent files v E Private files 3
& upload a file » [ Siides
T Private files "B Ambersweet oranges.pg
B s | oo
D wikimedia
**  Flickr public

Figure 5-11 Viewing files as list

FILE REPOSITORIES

Repositories in E-leaning enable users to upload files, access previously uploaded files and to
easily bring content into E-leaning from external repositories, such as Flickr or Google Docs.
Enabled repositories are available in the File picker.

——
| —
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*** Note that you cannot upload files into a repository from E-leaning. It is only a single way
data transfer i.e. Repository to E-leaning.

Standard repositories:

Repositories enabled by default

« Upload a file - you use this for browsing for and uploading a file from your computer or
USB.

«  Server files - this give access to files elsewhere on E-leaning according to your permissions.

« Recent files - the last 50 files you have uploaded, according to the context. [J Private files
- your own personal storage area for files.

« Youtube videos - search for and display Youtube videos

«  URL downloader - download files, images from a particular URL

«  Wikimedia - search for and display media from Wikimedia

Additional repositories may be enabled by a site administrator

« Alfresco - link to or copy files from Alfresco into E-leaning

« Amazon S3- The Amazon S3 repository enables users to copy files from Amazon S3 into
E-leaning.

« Box - bring files in from your Box account

+  Dropbox - bring files in from Dropbox

« Embedded files - re-use files embedded into the current text area

+  EQUELLA - link to files in an EQUELLA installation

+  File system - access files uploaded to a folder on your server (by, e.g. FTP)

«  Flickr public - search for and display images from Flickr

«  Flickr - search for and display images from your personal Flickr account

« Google Drive - bring files from your Google Drive account

« Legacy course files - use the old system from 1.9 of "course files"

« Merlot.org - bring resources in from Merlot.org

« Oohoo - Capture repository - allows users to record video, sound and take a photo
WITHOUT a streaming server.

« Picasa web album - search for and display images from your Picasa account

« PoodLL repository - record audio or video directly into your E-leaning HTML areas

«  OneDrive bring in files from your Microsoft OneDrive (formerly known as Skydrive)

+  WebDAYV -bring in files using webdav

——
| —
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SUMMARY

The usual way to edit or create text that is part of the visual content of a course is using the Text
editor. In this chapter we‘ve familiarized with the text editors: Atto and TinyMCE available in E-
leaning along with the file picker and file repositories.

In the next chapter, we will get conversant with the communication tools available in

E-leaning like Messaging, Chat and Forums.

Chapter 7: Chat, Messaging and forums

E-leaning provides good communication tools which helps you to create an interaction with your
students in different ways. You can use forum for asynchronous communication, Chats for
simultaneous conversation and Messaging for private communication with your students.

So, let‘s start with Chat:

CHAT

The chat activity module enables participants to have text-based, real-time synchronous
discussions. This is a useful way to get a different understanding of each other and the topic
being discussed — the mode of using a chat room is quite different from the asynchronous forums.
The Chat module contains a number of features for managing and reviewing chat discussions.

The chat may be a one-time activity or it may be repeated at the same time each day or each
week. Chat sessions are saved and can be made available for everyone to view or restricted to
users with the capability to view chat session logs.

Chats are especially useful when the group chatting is not able to meet face-to-face, such as:

« Regular meetings of students participating in online courses to enable them to share
experiences with others in the same course but in a different location

« Astudent temporarily unable to attend in person chatting with their teacher to catch up with
work

« Students out on work experience getting together to discuss their experiences with each
other and their teacher

« Younger children using chat at home in the evenings as a controlled (monitored)
introduction to the world of social networking

« A question and answer session with an invited speaker in a different location

il
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Sessions to help students prepare for tests where the teacher, or other students, would pose
sample questions

Why use chat?
Chat has an advantage over a Forum in that it takes place in Real Time. It is especially beneficial
when the group chatting is not able to meet face to face. Examples might be:

Regular meetings of staff on large or split campuses to discuss student or curriculum issues;
Regular meetings of students doing online courses to enable them to share experiences with
others on the same course but potentially in a different city (or country)

A teacher working with his students even though he is out of school

A student temporarily unable to attend in person chatting with their tutor to catch up with
work.

Students out on work experience getting together to discuss their experiences with each
other and their tutor

Younger children using chat at home in the evenings as a controlled(monitored)
introduction to the world of social networking

Why NOT use chat?

Unless a tutor/moderator is permanently present in the chatroom -or unless the chat is
hidden and revealed at certain times, it is difficult to control what is said once a chat has
started.

Younger students particularly may find it difficult to stay on task and be prone to adding
non-useful comments or "beeping™ others for the sake of it.

In some situations, a forum might be preferred as it allows for reflection before posting and
gives a period of time where the post might be edited.

Creating Chat
To create a chat in your course:

Turn on the editing mode by clicking the Turn editing Mode button.

In the section you wish to add your chat, click the "Add an activity or resource" link (or, if
not present, the "Add an activity" drop down menu) and choose Chat.

In the "Name of this chat room" field whatever you type here will form the link learners
click on to enter the chat so it is helpful to give it a name that suggests its purpose - for
example "Student council discussion™ or "Field trip planning meeting™.

In the description box - type the description of the chat. Include precise instructions for
students regarding the subject of the chat. Click the icon on the left to expand the toolbar,
and drag the bottom right of the text box out to expand it.

In the "Chat sessions” section which is collapsed by default, you will find options for:

il
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0 Next chat time:

The day and hour of the next chat session. This will appear in the calendar
so students know the schedule but it doesn't stop them accessing the
chatroom at any other time.

If you don't want them in the chatroom at other times, then hide it (with the
eye icon) or use Conditional activities to restrict access.

If you don't wish to schedule chat times then ignore this and choose from
the next settings.

*** For courses involving users across different time zones, it is useful to
know that the time you set here will be adjusted to match the time zone of the
user viewing it.

o Repeat/publish sessions: There are four options for scheduling future chat sessions:

Don't publish any chat times- there are no set times and students are
welcome to chat at any time.

No repeats - publish the specified time only- only the Next chat time will
be published. This could be used to schedule special events or meetings or
simply to help learners identify a common time in which they can expect to
find other learners in the chat room.

At the same time every day- Daily chats are useful for scheduling daily
office hours or work sessions with learners.

At the same time every week--This setting will schedule a chat for the
same day and time every week, which could be useful for instance for
meeting and reviewing key ideas and questions related to the week*s
content/assessment. o Save past chat sessions:

Choose from the dropdown how many days to save - or save everything by
selecting Never delete messages

If you have any concerns about discussions that might take place in your
chat room, you may want to keep transcripts to check the suitability of what
is discussed. If your learners are using the chatroom to collaborate on a
group project you won't want to delete the messages until the project is
complete.

il
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Adding a new Chat to 7 November - 13 November

General
Name of this Chat room*

Description*

g wt

Cieplay descrnphion on course
page

Chat sessions

Common module settings

Figure 6-1 Adding a new chat activity

o Everyone can view past sessions: Decide here whether or not allow everyone to
view past chat sessions. (Teachers can always view past sessions)
* Inthe "Common Module Settings" section:
o You can show/hide the chat activity from the visible drop down menu. o Provide
an 1D number for grading purpose.
o The group mode setting has 3 options:
= No groups - There are no sub groups, everyone is part of one big community
= Separate groups - Each group member can only see their own group, others
are invisible
= Visible groups - Each group member works in their own group, but can also
see other groups o A grouping is a collection of groups within a course. If a
grouping is selected, students assigned to groups within the grouping will
be able to work together.
» Click "Save and display" to show up the Chat activity.

il
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Using Chats

« Entering the chat: As you click the chat link on the course page you see two or three
options:

o Click here to enter the chat now - this takes you to the chat using the chosen site
default chat method - for example Ajax.

o Use more accessible interface - this gives a simpler chat room without frames and
JavaScript.

o View past sessions - if this has been enabled and the user is allowed to view past
chat sessions, this takes them to a list of past sessions with links to the chat.

01:48 Admin User Admin User has just entered this chat

Admin User
01:48 student user student user has just entered this chat
student user
student user 01:49 Talk Beep
Hello Teacher

Admin User
Hello Student

Send Themes »

Figure 6-2 An ongoing chat

» Joining in a chat session:

o In normal view, the screen is in two parts with the participants on the right, the
messages on the left and a box at the bottom into which users type their message
and press "Send" to make their contribution:

o Users can change the appearance of the messages by clicking on "Themes" next to
the "Send" button. Bubbles appears thus:

o The chat module contains some features to make chatting a little nicer.

= Smilies - Any smiley faces (emoticons) that you can type elsewhere in E-
leaning can also be typed in here and they will be displayed correctly.

il
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= Links - Internet addresses will be turned into links automatically.

= Emoting - You can start a line with /me to emote. For example, if your
name is Kim and you type /me laughs! Then everyone will see "Kim
laughs!"

= Beeps - You can send a sound to other people by hitting the "beep” link next
to their name. A useful shortcut to beep all the people in the chat at once is
to type "beep all".

= HTML - If you know some HTML code, you can use it in your text to do
things like insert images, play sounds or create different colored and sized
text.

Chat Reports
To view previous chats (if you have permission) click on the 'View past chat sessions' link.
Teachers can also access past chat sessions from the Chat administration in the Settings block.

«  This will bring up a listing of each chat session under the current chat topic. The listings
include the time the chat started and ended, which users participated, and how many
messages each user sent.

« Inorder for students to see past sessions, the teacher or an administrator must setup the chat
to allow everyone to view past chat sessions.

Effective Chat Practices

While the chat module may not be very feature-rich at this point, it can still be an effective
learning tool.

The key to a successful chat is good moderation. The nature of the chat room makes it difficult to
track different conversations. If everyone in the class is talking at the same time, the conversation
will go by too quickly. It‘s important to set some ground rules to make the chat useful for
everyone. Try to keep everyone on the same track of the conversation. If the conversation starts
to get out of control, gently try to bring people back to the main flow.

Creative Chat Practices

Online office hours
Many students may not be able to come to your office hours, particularly working students, who
have arranged their schedules to make it to class. The chat room is an easy way to allow your
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students to contact you during a scheduled time to ask a quick question about an assignment or a
lecture.

Group chats

If you‘ve set up student groups, each group can have its own chat. Set up a chat room and set the
group mode to separate or visible groups. Each group can then use its chatroom for
communication between group members.

Last-minute exam preparation

You could set up a chat room a week or even a night before an examination for students to
discuss any study questions. Students who are working at the last minute will appreciate the
opportunity to ask each other questions about the material.

MESSAGING

"Messaging" refers both to automatic alerts from E-leaning about new forum posts, assignment
submission notifications etc., and also to conversations using the instant messaging feature.

Message alerts

« Users can receive message alerts from E-leaning in a number of ways and for a number of
reasons: users may for instance receive instant messages via the Messages block; students
may be messaged by their course tutor via the People block; teachers might receive
automatic notifications of assignment submissions and admins might receive notification
of problems with the site.

« How these messages and others are received can be set by each user from the Messaging
link in their profile. Check boxes allow the user to select how they wish to be notified of
incoming messages.

Instant messaging

If enabled for the site, users in E-leaning have the option to send each other message. Messages
can be sent from the following places:

« asadmin in Bulk user actions
+ as ateacher from the People block
« asany logged in user from the Messages block or Online Users block
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« as any logged in user by clicking on the profile of another user (if admin has allowed
profiles to be viewed)

Message nawngaton

Offline contacts {1)

student

search

Message

user - Admin User

Monday, 17 November 2014

Send message

ss | New Mmessanes (1)

student user

conact

Hello Teaches, | want

n learning History

Figure 6-3 Sending a message

Sending messages

To send a message to an individual:

«  From the Messages block or from your profile

o

Click on the blue link Messages in the Messages block or click the Messages link
from Navigation > My profile and then type a name into the Search people and
messages box. To narrow the search down further, click the blue Advanced link to
search for a person "only in my courses" or with keywords in messages o Type the
message in the box and click the Send a message button.

student user
Messages

Figure 6-4 Message Block

——

'
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«  From the Online users block o Click the name of one of the people currently online and
click the Send message link in their profile.
o Type the message in the box and then click on the Send a message button.
« To read and reply to a message o If the Messages block shows you have a message, click
the envelope icon
(with the number of messages) o Type your reply into the box

and then click on the Send a message button.

o If you receive a popup notification of a message, click Go to message to read and
reply to it.

To send a message to selected course participants

«  Click on the Participants link in the People block on the course page.

«  Select participants from the list or use the "Select all" button at the bottom of the list.
« Choose "Add/send message" from the "With selected users..." drop-down menu.

«  Type the message then click the "Preview" button.

- Assuming you are satisfied with the message, click the "Send" button.

Managing contacts

People may be added to your list of contacts (or blocked from contacting you) by clicking the
Add contact (or Block contact) icon under their name in the Messages window.

By default the contact list is empty. In order to send a message or to create a shortcut to the
person you are sending, search for them in the search box.

Message history
A record of messages sent to/from a person may be obtained by clicking the "History" icon by
their name or by clicking Recent messages/All messages when they are displayed on the page.

Effective Messaging Practices
Messaging aids private communication with students. It is a useful alternative to email because
you can track all correspondence in one place and avoid clogging your email inbox.
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Creative Messaging Practices

Tutorial support

Students frequently find the messaging system a useful way of sending private questions to their
tutors. There are times when a student doesn‘t want to ask a question in a public forum.
Messaging provides students with a private communication channel. Tutors can also use the
messaging system to send messages to one or more of their students. If the students for each tutor
are in a group, the tutor can use the Groups filter on the participants list to find all of his students
and send them a private message.

Encouraging participation

The message system, combined with the participants list, is a great tool for encouraging students
to stay engaged with your course. On the participants list you can easily filter students based on
how long they have been inactive. At the top of the page, one of the options is to select students
who have been inactive for any length of time from a day to five months. In a normal class of
10-15 weeks, if once a week you send a message to students who have been inactive for a week,
you can remind them to participate in the course. This will keep them more engaged and improve
their performance and retention.

FORuUMS "

Forums are a powerful communication tool within a E-leaning course. Think of them as online
message boards where you and your students can post messages to each other while easily
keeping track of individual conversations. Forums are the primary tool for online discussion and
are the central organizing feature in the social course format. You‘ve already posted your first
message to a forum while editing the Site News forum back in Chapter 3. When you posted your
news item, you were posting to a special forum used in every course for announcements and
news.

Forums allow you and your students to communicate with each other at any time, from anywhere
with an Internet connection. Students don‘t have to be logged in at the same time you are to
communicate with you or their classmates. Figure 6-5 demonstrates how conversations are
tracked through time, and readers can review the history of a conversation simply by reading the
page. The technical term for this type of communication is asynchronous, meaning —not at the
same time.| Asynchronous communications are contrasted with synchronous forms such as chat
rooms, instant messaging, or face-to-face conversations.




How to use E-leaning

Because forums are asynchronous, students can take their time composing replies. They can draft
and rewrite until they are happy with the results instead of feeling under pressure to respond
immediately. A lot of research indicates that more students are willing to participate in an
asynchronous forum than are willing to speak up in class. For students whose primary language
is not that of the course, people with communicative disabilities, and the just plain shy, forums
offer a chance to take as much time as they need to formulate a reasonable reply. Other students,
who might be afraid of embarrassing themselves by making a mistake when they speak up in
class, can double check their responses before they send them in. The asynchronous nature of the
forums creates many opportunities for you not only to replicate the conversations you have in
class, but also to create entirely new activities that are difficult in a classroom setting.

Course Help Forum

Figure 6-5 A forum discussion

Before we start creating a forum, it is important to make sure we‘re using the same vocabulary. It
might be useful to think of the forum module as a party. Each forum is a room at the party:
there‘s a living room, a kitchen, and a dining room. In each room, there are groups of people
having discussions. Each discussion has a thread with everyone replying to each other about the
topic. Without people having discussions, a forum is an empty, quiet space. Each forum can
contain one or more discussions, which are comprised of one or more posts and replies.

E-leaning forums also allow subscriptions. When a user subscribes to a forum, all new posts are
automatically sent to the email address stored in the user‘s profile. This makes it easy to keep
track of what‘s happening in the forums without constantly logging in.

Participants can subscribe to a forum to receive notifications of new forum posts. A teacher can
set the subscription mode to optional, forced or auto, or prevent subscription completely. If
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required, students can be blocked from posting more than a given number of posts in a given time
period; this can prevent individuals from dominating discussions.

Forum posts can be rated by teachers or students (peer evaluation). Ratings can be aggregated to
form a final grade which is recorded in the gradebook.

Forums have many uses, such as

« Asocial space for students to get to know each other

«  For course announcements (using a news forum with forced subscription)

 For discussing course content or reading materials

«  For continuing online an issue raised previously in a face-to-face session

- For teacher-only discussions (using a hidden forum)

« A help center where tutors and students can give advice

« A one-on-one support area for private student-teacher communications (using a forum with
separate groups and with one student per group)

- For extension activities, for example _brain teasers‘ for students to ponder and suggest
solutions.

Creating a Forum
Creating a forum is relatively easy. The key to success is choosing the right options for the type
of forum you want to create. In addition to the news forum, E-leaning has five basic forum types:

« Asingle simple discussion - A single discussion topic which everyone can reply to (cannot
be used with separate groups). Students will see the text you have placed in the Forum
introduction setting as the first post of the discussion. Below you will find the replies that
have been posted.

« Each person posts one discussion - Each student can post exactly one new discussion topic,
which everyone can then reply to. The view will be basically the same as in the previous
case, the only difference being the 'Add a new discussion' option. Viewing a forum page,
the student will see the text you have written at the 'Forum introduction' space while
creating the forum, and, if there are any, the discussions that have been started.

« Qand A forum - Students must first post their perspectives before viewing other students'
posts. The Q & A forum is best used when you have a particular question that you wish to
have answered. In a Q and A forum, teachers post the question and students respond with
possible answers. By default a Q and A forum requires students to post once before viewing
other students' postings.

- Standard forum displayed in a blog-like format - An open forum where anyone can start a
new discussion at any time, and in which discussion topics are displayed on one page with
"Discuss this topic" links. In the upper right corner of the home forum screen (above the
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introduction), the student may see the options the teacher has set for subscriptions to the
forum, and the "Jump to' field, with which you can 'jump’ to any part of the course.

- Standard forum for general use - An open forum where anyone can start a new discussion
at any time. In this forum type, students will see the introduction text in a separate space
above the discussion field, in which you will see the information such as the title of the
discussion (which means the forum's title), its author, the number of replies and the date of
the last post.

To add a forum to your class:

+  Click the "Turn Editing Mode" button to enter into the editing mode.

+  Click "Add an activity or resource"” link and choose Forum from the Menu.

«  This will take you to the forum settings page titled "Adding a new forum™.

+ In the general section enter a Short name and in the description field provide instructions
for your students so that they are clear about what they have to do.




How to use E-leaning

Adding a new Forum to 19 September - 25 September
Seneral
Form name
Detcription
Oispiay BuIENDTION On Course
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Figure 6-6 Adding a new forum

If you want to display the description on the course page then check the Display description
on course page checkbox.

Choose the forum type you want to use as specified in the section above.

In the attachments and word count section you can specify the maximum attachment size,
no of attachments and whether to show the word count:

o Choose Maximum attachment size for each forum post in Maximum attachment size
field. Please note that you can‘t exceed the site upload limit set by your administrator.
Select the maximum number of attachments which can be attached in the forum post.
Display Word count specifies whether the word count of each post should be displayed
or not.

In the subscription and tracking section:

——
| —
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o Subscription Mode: When a participant is subscribed to a forum it means they will
receive forum post notifications. There are 4 subscription mode options:

= Optional subscription - Participants can choose whether to be subscribed

= Forced subscription - Everyone is subscribed and cannot unsubscribe

= Auto subscription - Everyone is subscribed initially but can choose to
unsubscribe at any time

= Subscription disabled - Subscriptions are not allowed

o Read Tracking: If enabled, participants can track read and unread posts in the forum
and in discussions. There are three options:

= Optional - Participants can choose whether to turn tracking on or off via a
link in the administration block. Forum tracking must also be enabled in the
user's profile settings.

= Forced - Tracking is always on, regardless of user setting. Available
depending on administrative setting.

= Off - Read and unread posts are not tracked.

In the Post threshold for blocking Section:

o Time period for blocking: Students can be blocked from posting more than a given
number of posts in a given time period.

o Post threshold for blocking: This setting specifies the maximum number of posts
which a user can post in the given time period above.

o Postthreshold for warning: Students can be warned as they approach the maximum
number of posts allowed in a given period. This setting specifies after how many
posts they are warned.

In the Grade section - Choose the category in which this forum will appear if ratings are
enabled.
In the Ratings Section:

o Roles with permissions to rate: Forum posts can be rated using a scale. By default,
only teachers can rate forum posts, though students can be given permission to do
so if desired (see Forum permissions below). This is a useful tool for giving students
participation grades. Any ratings given in the forum are recorded in the gradebook.

o Aggregate type: The aggregate type defines how ratings are combined to form the
final grade in the gradebook. There are five options to choose from:

= Average of ratings - The mean of all ratings

= Count of ratings - The number of rated items becomes the final grade. Note
that the total cannot exceed the maximum grade for the activity.

= Maximum - The highest rating becomes the final grade

= Minimum - The smallest rating becomes the final grade
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= Sum - All ratings are added together. Note that the total cannot exceed the
maximum grade for the activity.

*** If "No ratings" is selected, then the activity will not appear in the gradebook. o Scale:

Select the type of grading used for this activity.

= |If "scale” is chosen, you can then choose the scale from the "scale”
dropdown.

= If using "point" grading, you can then enter the maximum grade available
for this activity.

0 Restrict ratings to items with dates in this range: The teacher can allow only posts
within a certain date range to be rated. This is useful if the teacher wants to keep
students focused on the most recent content and maintain a specific pace within
the forum or course.

* Inthe Common Module section:
o You can Show/hide the activity from the Visible drop down menu.

o You can also set an ID number which provides a way of identifying the activity
for grade calculation purposes. 0 Group Mode: The group mode setting has three

options:
= No groups
= Separate groups - each group can only see their own group; others are
invisible
= Visible groups - each group works in their own group, but can also see other
groups

o Grouping: A grouping is a collection of groups within a course. If a grouping is
selected, students assigned to groups within the grouping will be able to work
together.

If the group mode is set to separate groups:

» Teachers are given the option of adding a new discussion topic for all participants or for a
selected group. If a teacher adds a new discussion topic for a selected group, then only
group members can reply to it. If a teacher adds a new discussion topic for all participants,
then students can't reply to it. (This is to ensure that groups are kept separate.)

«  Students can only start discussions for their own group.

»  Students can only reply to discussions started by other group members or discussions for
their own group started by a teacher.
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If the group mode is set to visible groups:

»  Teachers are given the option of adding a new discussion topic for all participants or for a
selected group. If a teacher adds a new discussion topic for a selected group, then only
group members can reply to it.

«  Students can only start discussions for their own group.

»  Students can only reply to discussions started by other group members or teachers.

Teachers, and other users with the capability E-leaning/site:accessallgroups set to allow, can
view and post in all forum discussions, regardless of the group mode setting.

Course Help Forum

Oiszussian Rtanes by Repews Las: post

Figure 6-7 Viewing a forum

*** Single simple discussions cannot be set to separate groups.

[J Click the —Save changes and return to coursel button. The forum name will now be a link
in the course section where you added it. If you want to go back to change any of the
options, you can click on the gear icon (edit settings) to return to the editing forum page.

Using Forums
If you click on the forum name on the course page, you‘ll see the main forum page, as shown in
Figure 6-7.
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Course Help Forum

........

Figure 6-8 Adding a new discussion topic

Searching Forums

All of the forums within a course are searchable as well as browsable. Performing a forum search
can find useful information easily. All forums within the course are searched simultaneously.

The Search Forums block on your course page enables you to quickly search for a particular
word within a forum post. If you obtain more than one page of results, you may wish to try an
advanced search.

An advanced search enables you to refine your search in any/all of the following ways:

« These words can appear anywhere in the post - One or more words you type in here will
be found in all the places in the post they appear.

« This exact phrase must appear in the post - The phrase you enter must appear exactly as
you enter it.
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+  These words should NOT be included - Identifying words you don‘t want can help narrow
down the resulting list of messages.

« These words should appear as whole words - The search engine will return posts that
contain your words as part of a larger word. For example, if you search for —cat,l posts
with the word —catalogl will be returned. Selecting whole words will look for a space
before and after the words you have entered.

 Posts must be newer/older than this - This narrows down the number of posts according to
time limits.

+  Choose which forums to search - This enables searching within one forum only.

« These words should be in the subject - If you know the subject line of the posts you want,
you can limit your searches by the subject line.

«+  This name should match the author - If you only want posts from certain authors, enter their
names here.

Managing Forums

Once you‘ve created forums for your students, you will need to manage them during your course.
As we discussed earlier, forums are great tools for getting people who don‘t usually talk in class
to participate. If you make your discussions an important part of your class, you can really get
people talking.

Of course, a lot of people talking in a forum mean there‘s more to manage. Forums can quickly
sprout and spread like an unruly weed, unless you do some management and pruning.

Moodle in English » Forums » General help » Moving files

M Moving files

by - Friday, 21 November 2014, 3:22 PM

In "My Private Files," | have several folders containing files. I'd like to move files from one folder
to another. However, there does not seem to be a way to do this. Selecting a file brings up a
window with two options: Download or Delete.

Not sure what version of Moodle: There is no Settings > Site Administration > Notifications
option on any of my pages.

Reply
See this post in context

Figure 6-9 An emailed forum post from moodle.org

Managing expectations
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The first key to managing a forum is managing student expectations. In your syllabus, let
students know how often you intend to respond to questions and posts. Let them know if you will
be checking in once a day or once a week. If you don‘t set expectations, some students will
expect you to be on call 24 hours a day.

Behavior issues

Dealing with rude and unruly students is another challenge of online discussions. Some students
may say things in an online discussion they would never say in person. Rude or hurtful remarks
can shut down a discussion or completely divert the thread of the conversation.

To avoid these situations, make your expectations for student conduct clear in your syllabus and
elsewhere in the site. The use of rating scales can also moderate students‘ behavior if their grade
depends on getting good ratings from you or their peers. Of course, if the situation gets out of
control, your ultimate recourse is to simply delete the students® posts from the forum and then
deal with it as you would any other disciplinary issue.

Archiving forums

When forum threads get very long, you may want to archive them and start up the conversation
again with a good summary. Discussions can be archived one by one or by backing up the
complete forum with user data, then restoring it.

To archive a discussion:

+ Create a forum named —Archive foruml somewhere in your course (the first or last course
section is a good idea) with permissions such that the students should be able to see posts
which had been made without being able to reply any more.

+ In Administration > Forum administration > Permissions click the Prevent icon (X) for the
student role for the capabilities 'Start new discussions' and 'Reply to posts'.

«  Go to the forum containing the discussions you want to archive.

« Enter the discussion by clicking on the discussion name. At the top-right corner of the
screen, you‘ll see a drop-down menu labeled —Move this discussion tol [] Select
—Archive foruml from the list.

«  You‘ll now see the discussion in the archive forum. Click the Forums link in the navigation
bar and select the original forum from the list.

« Post a summary of the archived discussion in the original forum to restart the discussion.

Using an archive forum allows you to keep the discussions manageable, while retaining all of the
detail of the original. It‘s also an easy way to move good discussions from class to class or
semester to semester.




How to use E-leaning

Course Help Forum
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wdas
not discovered until the 1920's Most of s ruins. even its major cies. remain 1o be excavated The ancient Indus Civiization scoipt has not

Figure 6-10 Moving a discussion

Managing discussions is also easier with some help. A number of studies have reported the
benefits of assigning groups of students to moderate duties for discussions around given topics. If
a group of students knows they are responsible for being able to discuss an issue intelligently
with their classmates, they are much more likely to be sure they‘ve done the reading and really
understand the topic. They can be responsible for moving the conversation along, answering
basic questions, and archiving and summarizing a discussion.

To create student moderator groups, assign a small team of students to each forum or discussion.
Be sure to enable ratings for everyone, in order to allow the student group to use ratings.

Quarantining a forum post

If any participant in your course has made an inappropriate post, then in that case rather than
deleting it, you can "quarantine” it by sending it to a hidden forum and then alerting your
superior and the child's guardians. To do this you first need to create a forum "Hidden forum for
Offensive Posts"” (for example) and hide it with its eye.

+  Find the offensive post and click 'split' (between 'edit' and 'delete’)
«  This will take you to a second page where you will be asked to verify the split. Confirm it
by pressing the 'split’ button near the top of the page.

——
| —
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+  The post(s) will now be split. You should see the post/discussion individually on a separate
page. In the right-hand corner will be a dropdown bar and a button that says ‘move.’
«  Choose 'Hidden Forum for Offensive Posts' in the dropdown and click ‘'move.’
*** Make sure you inform the child why their post has been quarantined, as well as your superior
and the child's guardians.

Forum Capabilities
Forum capabilities are more fine-grained than any other module, giving you the ability to create a
wide range of roles:

« Add news: This allows a user to start discussions in a news forum. This applies to news
forums only. This capability is allowed for the default roles of manager, teacher and non-
editing teacher

« Add question: This allows a user to add a question to a Q & A forum. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

« Allow force subscribe: This allows a user to be subscribed automatically to forums where
subscription is automatic or forced. This capability is allowed for the default roles of
teacher, non-editing teacher and student. It is not set for the role of manager.

+  Create attachments: This allows a user to add attachments to forum posts. This capability
is allowed for the default roles of manager, teacher, non-editing teacher and student.

+ Delete any posts (anytime): This allows a user to delete any forum post (at any time). This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

« Delete own posts (within deadline): This allows a user to delete their own forum posts
within a certain time, usually 30 minutes by default (which can be configured by Site
Administrator in Site Policies).

+ Edit any post: This allows a user to edit any forum post at any time. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

«  Export whole discussion: This allows a user to export a forum discussion to any portfolio
enabled for the site. This capability is allowed for the default roles of manager, teacher and
non-editing teacher.

« Export own post: This allows a user to export their own forum posts to any portfolio
enabled for the site. This capability is allowed for the default roles of manager, teacher,
non-editing teacher and student.

«  Export post: This allows a user to export any forum post to a portfolio. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

« Manage subscriptions: This allows a user to manage forum subscriptions. This capability
is allowed for the default roles of manager, teacher and non-editing teacher.

« Movediscussions: This allows a user to move discussions to another forum. This capability
is allowed for the default manager, teacher and non-editing teacher roles

«  Exempt from post threshold: This allows a user to post in a forum without ever being
blocked i.e. it exempts them from the post threshold for blocking (as set in Settings > Forum
administration > Edit settings). This capability is not set for the default role of student and
is allowed for the roles of manager, teacher and non-editing teacher.
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+ Rate posts: This allows a user to rate forum posts for forums which allow posts to be rated.
This capability is allowed for default roles of manager, teacher and non-editing teacher and
is not set for the default student role.

« Reply to news: This allows a user to reply to posts in a news forum only. This capability is
allowed for default roles of manager, teacher and non-editing teacher.

« Reply to posts: This allows a user to reply to forum posts but not applicable for news
forums. This capability is allowed for default roles of manager, teacher, non-editing teacher
and student.

+  Split discussions: This allows a user to split forum discussions. This capability is allowed
for default roles of manager, teacher and non-editing teacher.

- Start new discussions: This allows a user to start forum discussions. This capability is
allowed for the default roles of manager, teacher, non-editing teacher and student.

« View all raw ratings given by individuals: This allows a user to view all ratings given to
forum posts. This capability is allowed for the default roles of manager, teacher and non-
editing teacher.

« View total ratings that anyone received: This allows a user to view total ratings given to
forum posts. This capability is allowed for the default roles of manager, teacher and non-
editing teacher.

«  View discussions: This allows a user to view forum discussions. This capability is allowed
for the default roles of manager, teacher, non-editing teacher, student and guest.

«  View hidden timed posts: This allows a user to create timed posts i.e. set a display start and
end date for a new forum discussion. It also allows a user to view timed posts while they
are hidden. This capability is allowed for default manager, teacher and non-editing teacher
roles and is not set for the default student role.

« Always see Q and A posts: This allows a user to view Q & A forum posts without first
posting. This capability is allowed for the default roles of manager, teacher and non-
editing teacher.

«  View the total rating you received: This allows a user to view their own ratings for forum
posts. This capability is allowed for the default roles of manager, teacher, non-editing
teacher and student.

« View subscribers: This allows a user to view the list of subscribers to a forum. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

Effective Forum Practices

Forums are an important tool in your E-leaning toolbox. They are the primary method for
students to communicate with you and each other. Social constructivism is all about discussion
and negotiated meaning.

Getting students to participate in online forums can be a challenge. If you simply create a forum
and expect students to communicate online, you will be sadly disappointed. Many times
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instructors create a forum, give some vague instructions, and then complain that the students
aren‘t spontaneously communicating with each other.

Starting the discussion

For many students and instructors, starting the discussion is the hardest part. Once people start
talking, at least a few will probably continue the discussion. As you start your class, it would be
useful to have some icebreakers to help students get to know one another and to get used to
discussing issues online.

The most effective icebreakers have a strong prompt to get people started. Ask specific questions
like, —If you could speak to any person, living or dead, who would it be and what three
questions would you ask them?l or, —What is your favorite comfort food and why?l You could
also prompt people to tell stories about themselves. For example, you could ask students to tell a
story starting with —On my last trip the funniest thing I saw or did was...I or —My favorite story
about an animal is....| Whatever you use, make it concrete, compelling, and open-ended.

Encouraging participation

The primary key to student participation in online forums is tight integration with your course
goals. Your forums should give students a chance to practice a skill, to collaborate on a project,
or to act as resources for each other. Of course, it is important to distinguish between the types of
forums and the reasons for using them in your class.

Let‘s take an example to help make this clearer. Suppose you have a weekly reading you want
students to discuss online before meeting face-to-face. There are two possibilities for this forum.
If you want students to use the forum as a practice exercise, you‘ll want to create a place where
students can practice applying the new ideas they encountered in the reading. So you may want
to make each week a discussion of a case study. If you want the forum to be a resource, you may
want each student to post a question about the reading. You can then use the questions as a basis
for discussion in class.

The final strategy for encouraging participation is to engage with the forums yourself. If your
class meets face-to-face, bring up important postings and discussions in class. By merging the
online environment with the face-to-face environment, you show your students that you value
their participation. One of the best examples of merging online discussions with a course
happened in a management course of 400+ students. The instructor assigned groups of students
to small discussion groups. She and her teaching assistants randomly read a subset of the
discussions each week for assessment. The instructor would also bring the best questions and
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discussions to class, frequently devoting half of her lecture to talking about what was happening
online.

Grading forums

Of course, being clear about the goal of the forum is only one step. As we discussed earlier, your
goals for the class may be very different from your students‘ goals. You may want them to
engage with the material because of its intrinsic value. Most students, however, are overworked,
concerned about their grades, and doing only what is required in a large majority of their classes.

To help encourage alignment between your goals and your students‘ goals, you will need to have
a grading strategy for student participation. E-leaning has some great tools to help you create and
manage graded forums. To be successful, you must clearly define your grading criteria. You will
need to grade on quality, not just quantity. A student logging in to say —I agreel once a day is
not adding to the discussion. Someone who posts a thoughtful reply once a week is adding more
to the course. Of course, you will need to balance between grading for quality and allowing a
discussion where everyone is trying to be cleverer to get a grade.

Many students need scaffolding to be able to participate effectively in an academic discussion.
Help your students understand the difference between social forums and academic forums. Do
you want them to support their argument with citations? Do you want them to acknowledge the
other person‘s point of view and then offer a critique? Do they need to support their own
arguments with facts, figures, or appeals to a higher authority?

Once you have established expectations, you can begin to score according to the quality of their
interactions. It is good practice to give students some credit just for participating, but full points
can only be achieved with a high-quality answer.

Creative Forum Uses

There are many creative uses of forums, so we can only present a few of the most common here.
E-leaning forums are so flexible, there‘s really no limit to the types of activities you can develop
to take advantage of the technology.
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Peer assessment

Forums are an often-overlooked tool for peer assessment. Andy Diament, from West Cornwall in
the UK, has used forums for peer assessment. His students were learning database design by
developing a project over multiple weeks. Each week they would work in pairs to complete a
lesson on a new topic. They would then use their new skills to complete a little more of their
project and upload it to the forums for review. Each pair had their work critiqued and the best
work of the week was used as a starting point for the next section of the project. Not only did the
students learn from the peer review process, but they were able to develop their own project
using the best work of the class.

Q & A forums for problem solving

John Rodgers, from Ontario, Canada, uses the Q & A forum type to good effect in teaching
mathematics. The Q & A forum allows a single question post that the students must answer
before they can see other responses. A lesson starts with the instructor asking the students to
solve a math problem, identify and correct a misconception, decode the meaning of symbols from
context, or engage in some other sort of exercise. The students usually spend 20—-40 minutes
working together in small groups to formulate a response. After the students post their answers,
the Q & A forum allows them to see how others in the class have solved the problem. When that
is complete, the students usually are given a series of questions to answer (using the quiz
module) to see if their approach to solving the problem is robust enough. John reports,
—Students are more engaged both in terms of depth (the problems force them to generate a deep
understanding) and breadth within the class (the bottom of the class now engages the content at a
far higher level). The time I can spend as an instructor providing quality mentoring has increased
by an order of magnitude and the use of time has dramatically improved.|

This is a great example not only of using the forums but of using the power of technology to shift
the role of the instructor from delivering information to mentoring students.

Interviews

Bringing outside experts into your class can be difficult. You have to coordinate schedules, tear
them away from their busy lives, and then hope your students are prepared enough to ask
interesting questions. You can eliminate many of these problems by using the forums for
communication between students and experts. The easiest strategy is to invite the expert into
your forums as a regular participant. Simply give her an account and enroll her in your class. She
can then participate in the forum and elsewhere in the course.

However, some people will be reluctant to participate in such an open-ended discussion. As an
alternative strategy, create a forum in which students can submit questions for an interview with
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an expert. They can then vote on the best questions. You select the top 10 questions and send
them via email to the interviewee. Your expert can then respond, via email, when it is convenient
for her. If you post her responses to a new forum, your students can respond to her answers and
even prepare a second round of questions, if your expert is up for it.

Debates

While many instructors frequently hope some level of debate will spontaneously break out
between students around controversial issues or new concepts, it‘s sometimes difficult to get the
ball rolling. Try assigning your students to groups on different sides of an issue. Each post must
be a reasoned argument for their side of the issue, supported by evidence. They can be graded on
how well they reason and support their argument.

Role-playing and storytelling

Tisha Bender, in her book Discussion-Based Online Teaching, discusses the advantages of using
asynchronous discussions for role-playing and storytelling. In one course, she has students adopt
a character from a story or novel and then play out a scene in character using the forum. The rest
of the class watches the new drama unfold in front of them. Students have time to think about
their responses and refine their contributions to better reflect the voice of the character rather
than their own voices. Students are also less reluctant to fully respond as the character in an
online forum, as they avoid the embarrassment of a face-to-face encounter.

Frequently asked questions

How many times do you answer the same question from three different students? Frequently,
many students have the same questions about assignments, difficult concepts, or grades. If
everyone is meeting face-to-face, you can answer the question out loud, but other students may
not be listening to the answer. A fully online environment is harder to manage when the
questions from students arrive via email. Many teachers of fully online courses complain about
the constant barrage of repetitious questions.

We recommend you create a forum in which students can ask questions about the administration
of the course, and separate forums for questions about the subject matter. Have them consult the
forums and the responses before sending you yet another email about the date of the final exam.

Reading study groups

A strategy to encourage students to do their assigned reading is to create reading study group
forums. This strategy works well with groups of three to five students who are collectively
responsible for discussing a reading before class. Each student asks one question about the
reading, and the group must answer all the questions before the start of the class session. This
encourages students not only to read the assignment but to think more deeply about it through the
question-and-answer process.
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Social forum

Although the majority of your forums will focus on the course material, it‘s important for your
students to have an informal way to get to know each other, especially if the course is completely
online. A social forum gives people a place to talk without worrying about being graded or
having to appear really smart. It‘s a good idea to start your social forum with some fun questions.
Ask everyone to post an introduction telling the class where they are from; what they hope to get
out of the class; and their favorite food, favorite movie, or something interesting. The more
interesting the introductory post, the more likely people will respond to it and get a real
discussion going.

SUMMARY

E-leaning provides various channels of communication for you and your students. F orums
are an asynchronous, public method for sharing ideas. Chats are a great way to have
simultaneous conversations online with a group of people. Messaging provides a private channel
for you to communicate directly with your students. Communication is key to success for any
class, and it‘s even more important in an online environment.
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Chapter 8: Quizzes and Question Bank

Feedback on performance is a critical part of a learning environment, and assessment is one of
the most important activities in education. As educators, we can‘t tell what‘s going on inside
students* heads, so we need a way for them to demonstrate what they understand and what they
don‘t. A well-designed test, even a multiple-choice test, can give you valuable information about
students misconceptions. If the feedback is rapid enough, it can also be a critical tool for
students to gauge their own performance and help them become more successful.

E-leaning‘s quiz module is one of the most complex pieces of the system. The community has
added a large number of options and tools to the quiz engine, making it extremely flexible. You
can create quizzes with different question types, randomly generate quizzes from pools of
questions, allows students to re-take quizzes multiple times, and have the computer score
everything.

These features open up a number of strategies that usually aren‘t practical with paper- based
testing. It‘s hard enough to score one batch of quizzes, and nearly impossible to score it 10 times
for each student. When the computer does the work for you, it‘s easy to give students a chance to
practice taking a test or give frequent small quizzes. We‘ll explore how to apply these advantages
later in the chapter. For now, let‘s get started building your first E-leaning quiz.

The quiz activity enables a teacher to create quizzes comprising questions of various types,
including multiple choice, matching, short-answer and numerical.

The teacher can allow the quiz to be attempted multiple times, with the questions shuffled or
randomly selected from the question bank. A time limit may be set.

Each attempt is marked automatically, with the exception of essay questions, and the grade is
recorded in the gradebook.

The teacher can choose when and if hints, feedback and correct answers are shown to students.
Quizzes may be used

« AS course exams

« As mini tests for reading assignments or at the end of a topic

« As exam practice using questions from past exams
« To deliver immediate feedback about performance
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«  For self-assessment
STANDARD QUESTION TYPES

E-leaning offers a variety of question types to choose from to create a quiz. The standard quiz
question types are listed below:

« Calculated: Calculated questions are like numerical questions but with the numbers used
selected randomly from a set when the quiz is taken.

+ Calculated Multichoice: Calculated multichoice questions are like multichoice questions
which choice elements can include formula results from numeric values that are selected
randomly from a set when the quiz is taken.

« Calculated Simple: A simpler version of calculated questions which are like numerical
questions but with the numbers used selected randomly from a set when the quiz is taken

- Embedded Answers (Cloze): Questions of this type are very flexible, but can only be
created by entering text containing special codes that create embedded multiple-choice,
short answers and numerical questions.

- Essay: Allows a response of a few sentences or paragraphs. This must then be graded

manually.

« Matching: The answer to each of a number of sub-question must be selected from a list of
possibilities.

« Multiple Choice: Allows the selection of a single or multiple responses from a pre-defined
list.

« Numerical: Allows a numerical response, possibly with units, which are graded by
comparing against various model answers, possibly with tolerances.

« Random Short answer matching: Like a Matching question, but created randomly from the
short answer questions in a particular category.

«  Short Answer: Allows a response of one or a few words that is graded by comparing against
various model answers, which may contain wildcards.

« True/False: A simple form of multiple choice question with just the two choices "True' and
'False'.

+ Description: This is not actually a question. Instead it is a way to add some instructions,
rubric or other content to the activity. This is similar to the way that labels can be used to
add content to the course page.

*** Besides the standard question types that are part of the core E-leaning distribution, there are
a number of guestion type add-ons in the add-ons database.

CREATIVE QUIZ STRATEGIES

Of course, using the quiz engine effectively takes some work and practice. The first thing to do is
use effective question-design strategies. If you ask good questions, you‘ll get useful data about
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your students® performance and understanding of the material. Of course, the converse is also
true. There is a ton of literature about effective assessment design available. We‘ll just highlight
a few of the most important ideas:

« Tie each question to a course goal. After all, you want to know whether your students are
achieving the goals of the course, so why not ask them directly?

« Try to ask multiple questions about each important idea in the class. This gives you more
data points about a student‘s understanding.

« When writing a multiple-choice question, be sure each wrong answer represents a common
misconception. This will help you diagnose student thinking and eliminate easy guessing.

«  Write questions requiring your students to think at different levels. Include recall questions,
comprehension questions, and application and analysis questions. You can determine
where students are having problems in their thinking. Can they recall the material but not

apply it?

« Test your questions. After you‘ve established an initial question bank, use item analysis to
determine which questions are useful and which aren‘t. As you write new questions, give
them a lower point value and throw in a few to establish their reliability.

Once you have a few well-written test banks, be sure to use the quiz reports and statistics to
monitor your classes‘ performance. The detailed reports and statistics are valuable tools for
measuring your students‘ understanding of the material.

How To CREATE A QuiZ q‘é’(

E-leaning quizzes have two major components: the quiz body and the question pools. Think of
the quiz bodies as containers for various types of questions from the question pools. The body is
what students see when they take the assessment. It also defines how the students interact with
the quiz.

Creating a new quiz is a two-step process. In the first step, you create the quiz activity and set its
options which specify the rules for interacting with the quiz. In the second step you add questions
to the quiz.

The questions in a quiz body can be of any type, chosen manually or at random, and displayed in
a set or random order. The question pools can contain questions arranged in a manner that makes
sense to you.
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You can create pools based on chapters in the textbook, weeks in the semester, important
concepts, or any other organizational scheme. Pools can be reused in multiple quizzes, shared

between classes and courses, and even moved between systems.

v Adding a new Quiz to 14 November - 20 November
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Figure 7-1 Adding a new quiz

To start, we need to create a body for our first quiz.

Creating the Quiz Body
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When you create the quiz body, you are creating a container for the questions and setting the
rules for interacting with the quiz.

To create a quiz body:

«  Click "Turn Editing On™ if you are not in the editing mode already.

+  Click "Add and activity or resource” link in the section where you want to add the quiz and
select "Quiz".

« In the general section on —Adding a new quizl page, as shown in Figure 7-1, o0 Name:
Give the quiz a descriptive name. This name will appear on the home page of the course,
navigation menu and other places which will show or provide links to this quiz.

o Description: Describe the syllabus of the quiz and provide instructions or
background information, chapters etc.

o Display description on course page: If ticked, the quiz description will appear on
the course page directly under the quiz name.

+ Inthe Timing Section:

o Open the quiz: You can specify times when the quiz is accessible for people to
make attempts. Before the opening time the quiz will be unavailable to students.
They will be able to view the quiz introduction but will not be able to view the
questions. Quizzes with start times in the future display both the open and close
date for students.

o Close the quiz: After the closing time, the students will not be able to start new
attempts. Answers that the student submits after the quiz closing date will be saved
but they will not be marked.

*** Even after the quiz has closed students will still be able to see the quiz
description and review their attempts. What exactly they will see depends on the
settings you choose for review options.

o Time limit: By default, quizzes do not have a time limit, which allows students as
much time as they need to complete the quiz. If you do specify a time limit,
several things are done to try and ensure that quizzes are completed within that
time:

= A countdown timer is shown in the quiz navigation block.

=  When the timer has run out, the quiz is submitted automatically with
whatever answers have been filled in so far.

= If a student manages to cheat and goes over the allotted time, no marks are
awarded for any answers entered after the time ran out. o When time
expires: There are three options as to what will happen when the time limit
is up. Choose the one you need from the dropdown menu:

= Open attempts are submitted automatically.
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= There is a grace period when open attempts can be submitted, but no more
questions answered.

= Attempts must be submitted before time expires, or they are not counted
(default). o Submission grace period: If you select "There is a grace
period..." then you can check the box to enable the "Submission grace
period" and specify a period of time during which learners may still submit
the quiz after the time is up.

In the Grade Section:
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Grade category: If you have categories in your gradebook, select the one you wish
the quiz to be in here.

o Attempts allowed: Students may be allowed to have multiple attempts at a quiz.
This can help make the process of taking the quiz more of an educational activity
rather than simply an assessment. If the quiz is randomized then the student will get
a new version for each attempt. This is useful for practice purposes.

o Grading method: When multiple attempts are allowed, there are different ways you
can use the grades to calculate the student's final grade for the quiz.

= Highest grade - the final grade is the highest (best) grade in any attempt

= Average grade - the final grade is the average (simple mean) grade of all
attempts

= First grade - the final grade is the grade earned on the first attempt (other
attempts are ignored)

= Last grade - the final grade is the grade earned on the most recent attempt
only [J In the Layout Section:

o Question order: If 'Shuffled randomly' is selected, then the order of questions in
the quiz will be randomly shuffled each time a student starts a new attempt at the
quiz. The intention is to make it a little harder for students to copy from each other.

o New page: For longer quizzes it makes sense to stretch the quiz over several pages
by limiting the number of questions per page. When adding questions to the quiz,
page breaks will automatically be inserted according to the setting you choose here.
However, you will also be able to move page breaks around by hand later on the
editing page.

o Navigation method*: By choosing Sequential instead of Free, the teacher is forcing
the student to progress through the questions in order without being able to go back
to a previous question or skip to a later one.

In the Question Behavior Section:

o Shuffle within questions: If set to 'yes', then each time the student takes a quiz the
parts of the question will be shuffled randomly.

o How questions behave: The following question behaviors are available when
creating a quiz -

= Deferred feedback: Students must enter an answer to each question and then
submit the entire quiz, before anything is graded or they get any feedback.

= Adaptive mode and Adaptive mode (no penalties): Allows students to have
multiple attempts at the question before moving on to the next question.
This behavior requires that the "Whether correct” box is ticked under
"During the attempt™ in the "Review options™ section, at a minimum.

= Manual grading: Previously used for essay questions (irrespective of what
the quiz is set to) but you can now choose to have every question in the quiz
manually graded, if you wish.

= Interactive mode: After submitting one answer, and reading the feedback,
the student has to click a 'Try again' button before they can try a new
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response. They can be given hints to help them. Once the student has got
the question right, they can no longer change their response. Once the
student has got the question wrong too many times, they are just graded
wrong (or partially correct) and get shown the feedback and can no longer
change their answer. There can be different feedback after each try the
student makes. The number of tries the student gets is the number of hints
in the question definition plus one.

= Immediate feedback: Similar to interactive mode in that the student can
submit their response immediately during the quiz attempt, and get it
graded. However, they can only submit one response, they cannot change it
later.

= Deferred feedback or Immediate feedback with Certainty-based marking
(CBM): With CBM, the student does not only answer the question, but they
also indicate how sure they are they got the question right. The grading is
adjusted by the choice of certainty, so that students have to reflect honestly
on their own level of knowledge in order to get the best mark.

o0 Each attempt builds on the last*: If multiple attempts are allowed and this setting is
set to Yes, then each new attempt contains the results of the previous attempt.
This allows the student on the new attempt to concentrate on just those questions
that were answered incorrectly on the previous attempt. If this option is chosen
then each attempt by a particular student uses the same questions in the same
order, independent of randomization settings. To show a fresh quiz on every

attempt, select No for this setting.

In the Review options Section: This section controls what information students will be
shown when they review their past attempts at the quiz, and during the attempt in adaptive
mode. It is a matrix with check boxes.

The various pieces of information that can be controlled are:

o The attempt: Will show how the student responded to each question.

o Whether correct: Displays whether the students response to each question is correct
or incorrect.

o Marks: Reveals the marks awarded to the student and the grade for the quiz.
Specific feedback: Will show the feedback for the response to the answer as set
when adding the question to the quiz. Each response to a question can have
feedback for both correct and incorrect answers.

o General feedback: Displays the general feedback for the whole question as set when
adding the question to the quiz. You can use the general feedback to give students
some background to what knowledge the question was testing.

o Right answer: Reveals the correct answer to each question, whether the student
answered correctly or not.
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Overall feedback: Displays feedback for the entire quiz as set in the quiz settings.
For each of the above items, you can determine the timeframe when the students
will see them:
= During the attempt: Is only available when _How questions behave® has
been set to _Immediate feedback®, _Immediate feedback with CBM* and
_Interactive with multiple tries‘. If set to one of these options then a
_Check* button will appear below the answer and when clicked the student
will submit that response and then receive immediate feedback.
= Immediately after the attempt: means within 2 minutes of the student
clicking "submit all and finish".
= Later, while the quiz is still open: means after 2 minutes, but before the
close date (if the quiz does not have a close date, this phase never ends).
= After the quiz is closed: means what it says (you never get here for quizzes
without a close date).

In the Appearance Section:

o

o

Show the user's picture: If enabled, the student's name and picture will be shown
on-screen during the attempt, and on the review screen, making it easier to check
that the student is logged in as themself in an invigilated (proctored) exam.
Decimal places in grades: This option determines how many digits will be shown
after the decimal separator when the grade is displayed. A setting of O for example
means that the grades are displayed as integers. This setting is only used for the
display of grades, not for the display or marking of answers.

Decimal Places in Question Grades*: This setting specifies the number of digits
shown after the decimal point when displaying the grades for individual questions.
Show Block during Question Attempts*: If set to yes then normal blocks will be
shown during quiz attempts.

In the Extra Restrictions on Attempt Section:

@)

Require password: If you specify a password in here then participants must enter
the same password before they are allowed to make an attempt on the quiz. This is
useful to give only a selected group of student‘s access to the quiz.

Require network address: You can restrict access for a quiz to particular subnets on
the LAN or Internet by specifying a comma-separated list of partial or full IP
address numbers. This is especially useful for a proctored (invigilated) quiz, where
you want to be sure that only people in a certain room are able to access the quiz.
Enforced delay between attempts: You can set a time (from seconds to weeks)
between the first and second attempt of a quiz. You can also (or alternatively) set a
time from seconds to weeks for subsequent attempts after the second attempt. Thus,
you might allow a student to take the quiz twice immediately with no delay, but if
they want to improve their score with a third attempt, they are forced to wait a week
and use the time for extra revision.

Browser security: The options in this section offer various ways to try to restrict
how students may try to 'cheat’ while attempting a quiz. If "Full screen pop-up with
some JavaScript security" is selected,
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= The quiz will only start if the student has a JavaScript-enabled webbrowser
= The quiz appears in a full screen popup window that covers all the other
windows and has no navigation controls
= Students are prevented, as far as is possible, from using facilities like copy
and paste.
 In the Overall Feedback Section: Overall feedback is text that is shown after a quiz has
been attempted. The text that is shown can depend on the grade the student got. Grade
boundaries can be specified either as a percentage, for example "31.41%", or as a number,
for example "7". If your quiz is out of 10 marks, a grade boundary of 7 means 7/10 or
better.

*** Note that the maximum and minimum grade boundaries (100% and 0%) are set
automatically.

In the Common module settings Section:
o Visible: Show/hide the quiz activity from the students.
o ID Number: Set and ID number to easily identify the quiz activity in the gradebook.
o Group Mode: This setting has 3 options:
= No groups - There are no sub groups, everyone is part of one big community
= Separate groups - Each group member can only see their own group, others
are invisible
= Visible groups - Each group member work in their own group, but can also
see other groups.
Grouping: A grouping is a collection of groups within a course. If a grouping is
selected, students assigned to groups within the grouping will be able to work
together.

Click "Save and Display" to proceed with building the quiz and adding questions to the
quiz.

Building Quiz

Once you have saved your changes, you‘ll see the quiz activity and description with a Edit Quiz
button which will take you to the second editing screen where you will write and select questions
to include in the quiz body. Here you‘ll also categorize your quiz questions and add them to the
quiz body you just created.
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Editing quiz: History Quiz

Empty pege

Figure 7-2 Building Quiz

On the center of the page you'll see the questions you've added to the quiz. Since this is a new
quiz, so there are no questions there.

On the right side of the page, you'll see a block named "Question Bank contents™, when
expanded it will show the contents of the question bank.

Before we start adding questions to our quiz or creating questions, let‘s take a more detailed look
at question bank and categories

Question Bank

Question Bank allows a teacher to create, preview, and edit questions in a database of question
categories. The categories can be limited to being used on the site, course or quiz level. The
questions in a category can be added to a Quiz or to a lesson activity via an export process. You
can access the question bank by creating or editing a quiz activity or via Settings > Course
administration > Question bank.

Select a category

Questions are organized into categories. Initially each course has only one category called
"Default”. It is good practice to create more categories to organize your questions. This not only
makes it easier to find questions, but makes the use of random questions and matching question
easier.

You can create a hierarchy of categories because you can create subcategories inside parent
categories. It is better than keeping all your questions in one big list in the quiz module. The
hierarchy feature enables you to separate categories into sub categories and sub categories into
sub sub-categories etc. indefinitely. Categories and sub categories, etc., are very powerful when
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combined with random questions that can select either from one category or from a category or
any of its sub categories.

Each category has a context which determines where the questions in the category can be used:

- Activity context - Questions only available in the activity module

- Course context - Questions available in all activity modules in the course

- Course category context - Questions available in all activity modules and courses in the
course category

-« System context - Questions available in all courses and activities on the site

To add a category

«  Open the question bank from Settings > Quiz administration > Question Bank > Categories.

Edit categories

Quustion categones for 'Quiz Mistory Quis

Question categonies for ‘Course using moodie

Question cutegocion for ‘Tategory Miscelluneous

Question categocies for ‘System

Figure 7-3 Add/manage question categories
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- Below the list of current categories you will see a form to add a new category.
« Choose the 'parent’ category in which your new category will be placed. The parent
category is the one in which the new category will be placed. "Top" means that this category
IS not contained in any other category.
o Placing your category in another category makes it a sub-category of the parent.
o Choosing 'Top' means that your category is a top level category, not a sub category.
«  Type the name of your new question category in the text box.
« Add an optional meaningful description in the category info area.

+ Click the 'Add Category' button. Your new question category will appear in the list of
current categories.

Adding questions

After creating the categories for questions, now you can add questions from a number of
locations within the editing quiz page:

1. Click the "Add question" button to begin a new question (1 below)

2. Click "Show" (2) to reveal the contents of the question bank (3) and then choose a pre-
made question or click "Create new question” (4)

3. Click (5)"Add a random question™ to add a random question, providing there are questions
in the question bank already.

4. Click "Create a new question™ from the Question Bank, if you are still at the questions tab
of Question Bank.

2) QUESTION BANK @ QUESTION BANK
4 CONTENTS [SHOW] CONTENTS [HIDE)

Category Default for US Film

The default category for questions

Editing quiz: Moodle history

Total of marks 0.00 | Questions 0| This quiz is open Select a cateqory
Maximum grade Defaull for US Film v
Save ~reate a new question f
Create a new question 3)
w’
Beicias 4
3%%7 Empty page .
¥ Also show guestions from
Add a question Add a random question subcategores

Als0 show old questions

Add page here

Figure 7-4 Adding Questions to quiz
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Creating a new question

« To create a new question from scratch, click "Add a question”.

«  From the next screen, choose the question type you want to add.

« Select the Question Category for the question you are creating.

«  Fill in the question form, making sure to give a grade to the correct answer. [J Click "Save
changes".

*** |f you have a very complex question, and you want to check it as you go along, you can
preview it and then click "Save changes and continue editing".

Each question type has its own form and options. We‘ll spend the next few pages detailing the
options for each question type.

Calculated Questions

Calculated questions offer a way to create individual numerical questions by the use of wildcards
(i.e. you can use common variables names as x , y enclosed in curly braces to create the
wildcards {x} and {y}) that are substituted with random values when the quiz is taken.

Answer 1 formula = Grade r .
Tolerance £ a1 Type 1 .
Answer display * | Foomat 0 i =1

Feedback

Figure 7-5 A calculated question answer field

The main purpose of the calculated question is to create multiple versions of a question with
different numerical values. This means you must have at least one wildcard in one of the
answers.

To create a calculated question:

+ Select Calculated from the —Create new questionl drop-down menu.
+ Select the question category.
+  Give the question a descriptive name - this allows you to identify it in the question bank.
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Enter the question text: This should be the question you want the student to answer, and it
must include all the information they need to calculate an answer. Therefore it must contain
at least one wildcard, inside curly braces. For example, if you wanted the student to sum
numbers A and B, the question text might read: "What is {A} + {B}?"

Set the default question grade (i.e. the maximum number of marks for this question).

If you wish, add general feedback for the question. It will be displayed to all the students
after they have completed the question.

In the Answers Section: Enter the formula for the answer (see Figure 7-5). Be sure to use
the same placeholders so E-leaning can substitute the same values.

o Choose the grade that the student will get for this question if they give this answer.
This should be a percentage of the total marks available.

o Determine the tolerance for error that you will accept in the answer. The tolerance
and tolerance type settings combine to give a range of acceptable scores. So, if
tolerance = t, correct answer = x and the difference between the user's answer and
the correct answer is dx, then the tolerance types are as follows:

= Nominal - mark correct if dx <=t

= Relative - mark correct if dx / x <=t

= Geometric - mark correct if dx2 / x2 <= t2 0 The next 2 settings,
"Answer Display" and "Format" determine the precision of the answer. You can
use these to select the number of decimal places or significant figures you want
to use.

o Add some feedback which the student will see if they enter this answer.

You can specify as many answer formulae as you like - click "Add another answer
blank™ to add more.
In the Unit Handling Section you can specify units for the answers. For example, if you
enter a unit of ‘'cm' here, and the accepted answer is 15, then the answers '15cm' and '15'
are both accepted as correct. If you add more than one unit, you can also specify a
multiplier. So, if your main answer was 5500 with unit W, you can also add the unit kW
with a multiplier of 0.001. This means that the answers '5500', '5500W" or '5.5kW" would
all be marked correct. Note that the accepted error is also multiplied, so an allowed error
of 100W would become an error of 0.1kW.
In the Multiple Tries Section: When questions are run using the 'Interactive with multiple
tries' or 'Adaptive mode' behavior, so that the student will have several tries to get the
question right, then this option controls how much they are penalized for each incorrect
try. The penalty is a proportion of the total question grade.
In the Question Tags section you can enter tags for the questions to easily identify them.
Click Save Changes Button.

Page 2: Choose Dataset Properties:

On the Next page you can choose the dataset properties.

Each wildcard that you specify in the answer formula must have an associated set of
possible values - this is its dataset. Each of the wildcards is listed on this page along with
a choice of dataset:
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o private i.e. only used by this question
shared i.e. shared with other calculated questions in the same category

*** Using a shared dataset can save time when you are creating a lot of similar calculated
questions.

« To continue, simply choose your preferred dataset for each wildcard, then click "Next
Page".

Page 3: Edit the datasets

Now we need to create the set of possible values that each wildcard can take. There are two ways
of creating values - you can type them in yourself and add them to the list, or you can have E-
leaning generate them for you.

Adding/deleting your own values:

Adding individual values to the list is easy:

+ Inthe 'Param’ field for each wildcard, enter the value you want

«  Scroll down to the 'Add' section and click the Add button (leaving the number of items set
to 1)

« Repeat the above steps as many times as necessary (the maximum number of items is 100)

To delete values from the list:

- In the 'Delete’ section, select the number of items to delete
« Click the Delete button
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Edit the wildcards datasets

harec wilt tards
Jpoue ihe Qatasett parmnats
item 1o add
Vit zardt [a)
Rangs of Wiues |,
Cecimal placas .

Diszngunon -

Wil cars (x)
Range oF VOIS  Lueus [TV
Decimal places -

Dusnevtion -

Answers tolerance parameters

COENE 11 AIManrs Da0IR0CH (il mheii
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Add
Naxttham to Aag  § UM (e T
T eregety 1y ™0 e wouds it
Jeer IR0
Den i 30 Al
Aga irem M A » il v
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Figure 7-6 Editing calculated question datasets

Letting E-leaning create values
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- Start with the "Range of Values" fields, and enter the lower and upper limits for the values
you would accept

+  Choose a number of decimal places for the value

+  Choose the distribution of values between the limits - 'uniform’ means any value between
the limits is equally likely to be generated; 'loguniform' means that values towards the lower
limit are more likely.

« Now move down to the 'Add' section and click on "force regeneration™

+ In the menu next to the Add button, choose the number of sets of random values (items)
you wish to add to the list.

« Finally, click Add to append the new values to the list

*** |f you want more control over the items that E-leaning adds, you can do them one at
a time and preview the values before you add them. Click the "Get New Item to Add"
button to make E-leaning generate new values in the "Item to Add" section at the top. If
you like them click "Add" for 1 item; if not, click "Get New Item to Add" again to get
new values.

«  Click Save Changes Button to finish things off.

Calculated questions can use more than simple arithmetic operators. The full list of operators
includes abs, acos, acosh, asin, asinh, atan, atanh, ceil, cos, cosh, deg2rad, exp, expm1, floor, log,
log10, loglp, rad2deg, round, sin, sinh, sprt, tan, tanh, atan2, pow, min, max, and pi. Each
function‘s placeholders and other arguments are in parentheses.

For example, if you want students to calculate the sine of one angle and two times the cosine of
another, you would enter sin({a}) + cos({b}*2).

Calculated Multichoice

Calculated multichoice questions are like multichoice questions with the additional property that
the elements to select can include formula results from numeric values that are selected randomly
from a set when the quiz is taken. They use the same wildcards than Calculated questions and
their wildcards can be shared with other Calculated multichoice or regular Calculated questions.

The main difference is that the formula is included in the answer choice as {=...} i.e. if you
calculate the surface of a rectangle {={1}*{w}}.
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The value will be displayed as set by the Correct answer shows (0,1,2 etc.) and Format
(decimals, significant figures) options setup.

So a Choice text could be:

The rectangle surface is {={1}*{w}} cm?.

If {1} = 4.0, {w} = 2.5, Correct answer shows 1 and Format decimals

The choice will display as:

The rectangle surface is 10.0 cm?

Calculated Multichoice setup is similar to that of calculated question type including the handling
of wild cards and available functions.

To add a calculated multichoice question:

Select Calculated Multichoice from the Create New Question dropdown menu.
Repeat steps 2 to 6 as for calculated question type.
In the Answers Section:
0 You can provide multiple choices to choose from with a formula as the option. The

suggested choice formula is ...{={x}+..}...

3

Rest all steps are also same as for calculated question type.
Click "Save Changes" button to save the question.

Calculated Simple

Simple calculated questions offer a way to create individual numerical questions whose response
is the result of a numerical formula which contain variable numerical values by the use of
wildcards (i.e. {x}, {y}) that are substituted with random values when the quiz is taken.

The simple calculated questions offer the most used features of the calculated question with a
much simpler creation interface.
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The only difference between the calculated and calculated simple question is that you can create
the values for the wildcards right within the same page. The steps are exactly same as for
calculated question type.

Description

A Description gquestion page simply shows some text (and possibly graphics) without requiring
an answer. It is more of a label than a question type. When shuffling questions is turned off, this
type of page can provide information to be used by a following group of questions.

Embedded Answers (Cloze)

Embedded answers (Cloze) questions consist of a passage of text (in E-leaning format) that has
various answers embedded within it, including multiple choice, short answers and numerical
answers. Questions of this type are very flexible, but can only be created by entering text
containing special codes that create embedded multiple-choice, short answers and numerical
questions.

To create the embedded answers type question using a graphical editor you can ask your site
administrator to install the TinyMCE Cloze editor plugin or else you can directly create the
embedded answers type questions using the link: http://projects.ael.uni-
tuebingen.de/quiz/htmlarea/index.php

To setup an Embedded Answers (Cloze) type question:

« Select the question category

«  Give the question a descriptive name - this allows you to identify it in the question bank.

- Enter the passage of text (in E-leaning format) into the 'question text' field.

+  Set the 'default question grade’ (i.e. the maximum number of marks for this question).

+  Set the 'Penalty factor'.

« If you wish, add general feedback. This is text that appears to the student after he/she has
answered the question.

« The editor has been modified and allows you to test if your syntax is good. The different
questions elements decoded will be displayed and syntax errors pinpoint. However, it
cannot check if the question decoded is two questions in one because of error syntax.

+ Click Save changes to add the question to the category.
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Essay

An essay question is a free-response text area where students can enter larger blocks of text in
response to your question, as shown in Figure 7-7. These questions are not scored by the
computer, and you will need to grade each answer manually.

It is possible for a teacher to create a template to scaffold the student's answer in order to give
them extra support in the "Response Template" field. The template is then reproduced in the text
editor when the student starts to answer the question.

To create an essay question:

+ Select Essay from the —Create new questionl drop-down menu.

«  Give the question a descriptive name.

«  Enter the question text.

« Enter the default mark for the question.

« If you wish, add general feedback and/or specific feedback.

+ You can also specify the options for the response submission like the editor, input box size
and even you can allow the students to upload the attachments.

Question 1 Write an essay on Harappan civilization

Mot yet answered

Marked out of 1.00 Paragraph -

Path: p

Figure 7-7 An essay question

« To provide the extra support to the students, enter it in the "Response template" section.
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- To provide information to the other teachers about the grading criteria for the essay mention
it inside the "Information for graders" section.
+  Click the —Save changesl button to add the question to the category.

Matching

Matching questions ask students to match multiple question stems to multiple possible answers
(see Figure 7-8). They are useful for testing students* understanding of vocabulary and their
ability to match examples to concepts.

Matching questions have a content area and a list of names or statements which must be correctly
matched against another list of names or statements. For example "Match the Capital with the
Country" with the two lists "Canada, Italy, Japan" and "Ottawa, Rome, Tokyo".

Setting up a matching question in E-leaning is a bit different from setting up other types of
questions.

To create a matching question:

+  Select the question category

«  Give the question a descriptive name - this allows you to identify it in the question bank.

- Enter some instructions in the 'Question text' field to tell the students what they are
matching.

+  Set the 'Default mark’ (i.e. the maximum number of points for this question).

« If you wish, add general feedback. This is text that appears to the student after he/she has
answered the question.

«  Check the 'shuffle’ box if you want the answers in the drop-down menus to be shuffled.
Note: The Quiz display setting must also be set to shuffle within questions for this to work.

« For the first matching item, enter the question and a matching answer.

« Fillin at least two questions and three answers. Click 'Blanks for 3 more questions' to add
more. You can enter as many as 10 items. You can provide extra wrong answers by giving
an answer with a blank question.

«  Set the 'Penalty for each incorrect try'.

+  Click Save changes to add the question to the category.
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Question 1 Match the capitals of states:

Not yet answered

Marked out of 1.00 Rajasthan . Choose El

Andhra Pradesh|Mumba
Jaipur

Hyderabad
Maharashtra G [

Figure 7-8 A matching question

E-leaning will display the question in two columns. The first will contain the questions. The
second will display a drop-down menu for each question with all possible matching answers as
options.

*** Matching questions look better on screen if you put the longer piece of text in the question
and not the match. For example, when creating a matching vocabulary question, put the single
word in the match and the definition sentence in the question. Otherwise the drop down for long
questions will be awkward to use and difficult to read.

Multiple Choice

E-leaning provides teachers with a lot of flexibility when creating this common question type.
You can create single-answer and multiple-answer questions, include pictures, sound or other
media in the question and/or answer options (by inserting HTML) and weight individual
answers.

Question 1 What is Moodle?
Not yet answered
Select one:
Marked out of 1.00
a. A Cat
' b. ADog

- €. A Course Management System

Figure 7-9 A multiple-choice question

There are two types of multiple choice questions - single answer and multiple answer.
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Single Answer Questions- These questions allow one and only one answer to be chosen by
providing radio buttons next to the answers. You will specify non-negative marks for each
answer; usually zero marks for wrong answers, maximum marks for correct answers and partial
marks for partially correct answers.

Multiple Answer Questions- You can select "multiple answers are allowed" in a Multiple Choice
question type. "Multiple answers" questions types in a quiz allow one or more answers to be
chosen by providing check boxes next to the answers. Each answer may carry a positive or
negative grade, so that choosing ALL the options will not necessarily result in good grade. If the
total grade is negative then the total grade for this question will be zero.

Feedback can be associated either with specific answers, or with the question as a whole.
To create a multiple-choice question:

+  Select the question category

« Give the question a descriptive name. The name will be used in the question lists on the
quiz editing page.

- Create the question text. If you're using the HTML Editor, you can format the question just
like a word processing document.

«  Set the 'default question grade’ (i.e. the maximum number of marks for this question).

 If you wish, add general feedback. This is text that appears to the student after he/she has
answered the question.

«  Choose whether students can only select one answer or multiple answers.

« Choose whether to shuffle the answer options and the numbering list to be displayed for
the answers.

«  Write your first answer in the Choice 1 text field. Inserting HTML into this area also makes
it possible to add an image or a sound file.

« Select a grade percentage for the answer. This is the percentage of the total points for the
question that selecting this response is worth. You can select negative percentages as well
as positive percentages. So, selecting a correct response in a multiple answer question may
give you 50% of the possible points, while selecting a wrong answer may take away 10%.
Note that in a multipleanswer question, the grades must add up to 100%.

« If you wish, you can add feedback for each response. It may be a bit more work, but its
good practice to tell the students why each answer is right or wrong using the feedback
area. If students know why an answer is right or wrong, they can analyze their own thinking
and begin to understand why an answer is correct. Your feedback will only be displayed if
you select Show Feedback in the quiz body options.

« Fill in the rest of the response choices in the rest of the form. Any unused areas will be
ignored.
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The option combined feedback for correct/partially correct/incorrect responses is
particularly useful for multiple-response questions, where it is difficult to control what
feedback students see just using the answer-specific feedback.

Set the 'Penalty factor' for each incorrect try. Make note that the 'penalty factor' only applies
when the question is used in a quiz using adaptive mode - i.e. where the student is allowed
multiple attempts at a question even within the same attempt at the quiz.

Click the "Save Changes" button at the bottom of the screen.

Numerical

Numerical questions are a lot like short-answer questions for equations, such as the one shown in
Figure 7-10. You can create a question with an equation, and your student‘s type in a numerical
answer. Students will get credit for answers within the range of answers you specify.

*** Text answers are no longer allowed in Numerical questions.

To create a numerical question:

Select the question category

Give the question a descriptive name - this allows you to identify it in the question bank.
Enter a question in the 'question text' field. This can include an equation - E-leaning has a
couple of text filters that allow you to type an equation and have it properly typeset when
displayed. The Algebra filter is very good for writing common mathematical expressions
in a simple way. You can also use the Equation editor provided in the Atto Text editor.
Set the 'default question grade’ (i.e. the maximum number of marks for this question).
Add general feedback. This is text that appears to the student after he/she has answered the
question.

Now enter the first accepted answer(s) in the Answer field.

Enter an accepted error for this answer. This is the range above or below the answer that
E-leaning will accept as a match. For example, if the correct answer is 5, but you will accept
4 or 6 as answers, your accepted error is 1.

Enter a grade for this answer option.

Enter feedback for the accepted answer. This is the text that the student will see if they
enter a number within the accepted error of the answer.

Repeat for each of the answers you want to accept. You can provide feedback for all wrong
answers by using a wildcard, i.e. the asterisk character (*), as an answer with grade 'None'.

Question 1 What is 5747

Not yet answered

Marked out of 1.00 Answer:

Figure 7-10 A numerical question
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« You can also specify the Units in the Unit Handling Section. For example, if you enter a
unit of ‘cm’ here, and the accepted answer is 15, then the answers '15cm’ and '15' are both
accepted as correct. You can also specify a multiplier. So, if your main answer was 5500
with unit W, you can also add the unit kW with a multiplier of 0.001. This means that the
answers '5500', '5500W" or '5.5kW" would all be marked correct. Note that the accepted
error is also multiplied, so an allowed error of 200W would become an error of 0.1kW.

«  Set the 'Penalty factor' for multiple tries.

+  Click 'Save changes' to add the question to the category.

Random short-answer matching

This is an interesting question type. You take random multiple short-answer questions and their
correct answers and create a matching question out of them. It‘s an interesting way to reuse your
short-answer questions in a new format.

The Random Short-Answer Matching question looks just like a Matching question. The
difference is that the sub-questions are drawn randomly from the Short Answer questions in the
current category.

To create a random short-answer matching question:

+ Select —Random short-answer matchingl from the —Create new questionl dropdown
menu

«  Give the question a descriptive name - this allows you to identify it in the question bank.

«  Enter the question text to tell the students what they are matching, or use the default text

«  Enter the default marks for the questions.

« Provide the General Feedback which will be shown to the students after they have
completed the question.

«  Select the number of questions you want to add to the matching question - make sure this
is less than or equal to the number of short-answer questions available in this category (a
verification will be done when the question is saved).

+  Check Include Subcategories if you wish to choose questions from subcategories also.

« If you wish, you can add feedback for each response in the Combined Feedback Section.

Set the 'Penalty factor' in the Multiple Tries Section.

+ Click Save changes.

Short Answer

In a short answer question, the student types in a word or phrase in response to a question (that
may include an image). Answers may or may not be case sensitive. The answer could be a word
or a phrase, but it must match one of your acceptable answers exactly. It's a good idea to keep the
required answer as short as possible to avoid missing a correct answer that's phrased differently.
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*** You may find it helpful to prototype your short-answer questions to catch common
acceptable answers you hadn‘t thought of. To do this, start by creating a few acceptable answers
and include the question in a quiz for no points. Be sure to tell students you are testing a new
question.

Question 1 What is Moodle?

Mot vet answered

Marked out of 1.00 Answer:

Figure 7-11 A short answer question

Once the quiz is over, review student‘s answers and add their acceptable answers to the list.

To create a short-answer question:

+  Select —Short answerl from the —Create new questionl drop-down menu.

«  Give your question a descriptive name.

«  Create the question text. If you want students to fill in a blank, use the underscore to indicate
where the blank is.

«  Set the 'default question grade’ (i.e. the maximum number of marks for this question).

+ If you wish, add general feedback.

« Choose whether the answers are case-sensitive. Case sensitivity can be tricky where
capitalization is important. Will you accept —george Washingtonl as well as —George
Washingtonl as an answer?

« Fill in the answers you will accept. Give each answer a percentage of the grade if required.
You could give common misspellings partial credit with this option. You can use wildcards
to allow for variants on a word per phrase.

« Add grade for each answer.

+  Create feedback for any and all answers. This will appear if the student enters that answer.

+  Set the 'Penalty factor' in the Multiple Tries Section.

« Click Save Changes to add the question to the category.

True/False Question

In a true/false question a student is given only two choices for an answer in this kind of question:
True or False. The question content can include an image or html code.
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When feedback is enabled, the appropriate feedback message is shown to the student after the
answer. For example, if the correct answer is "False”, but they answer "True" (getting it wrong)
then the "True" feedback is shown.

To create a True/false type question:

«  Select the question category

- Give the question a descriptive name - this allows you to identify it in the question bank.
Enter a question in the 'question text' field.

«+  Set the 'default question grade' (i.e. the maximum number of marks for this question).

« If you wish, add general feedback.

- Select the correct answer - true or false.

+ Finally, provide feedback for each of the answers ‘true’ and ‘false'.

«  Set Penalty Factor for Multiple Tries.

+  Click 'Save changes' to add the question to the category.

Importing Questions

If you have questions from a textbook question bank, or if you don‘t want to use the web
interface to create your questions, you can import them from a text file. E-leaning supports a
range of formats including some proprietary quiz software formats, as well as text files and
provides an easy way to create new importers if you know a little PHP.

Once you get to know a format, it may be easier to type the questions into a text file than to use
the web interface. You can just keep typing instead of waiting for new web pages to load for
each question.

The default formats include:

« Aiken Format: The Aiken format is a very simple way of creating multiple choice
questions using a clear human-readable format. The question must be all on one line. Each
answer must start with a single uppercase letter, followed by a period "' or a bracket ")', then
a space. The answer line must immediately follow, starting with "ANSWER: " (NOTE the
space after the colon) and then giving the appropriate letter.

+ Blackboard: If you‘re converting from Blackboard to E-leaning, you can export your course
and import the question pools into E-leaning using the Blackboard format. Blackboard
format enables questions saved in all Blackboard export formats to be imported via a .dat
or .zip file. For zip files, images import is supported.

+  Embedded Answers (Cloze): The Cloze format is a multiple-answer question with
embedded answers. These questions can be a bit tricky to develop, but they provide a
unique approach. Embedded answers (Cloze) format enables the import of a passage of
text with questions such as multiple-choice and short answer embedded within it.
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- Examview: Examview format enables the import of questions from Examview 4 XML
files. For newer versions of Examview, Blackboard format may be used.

- Gift Format: Gift format enables multiple-choice, true-false, short answer, matching,
missing word, numerical and essay questions to be imported or exported via text file.

- Learnwise Format: This format enables the import of multiple choice questions saved in
Learnwise's XML format.

« Missing Word format: Missing word format enables questions to be imported via text file.

import questions from file

File format

General

Figure 7-12 Importing questions to the quiz

« E-leaning XML format: This is a E-leaning-specific format for importing and exporting
questions. It allows you to import image files used in the questions.

«  WebCT format: WebCT format enables multiple-choice and short answer questions saved
in WebCT's text-based format to be imported.

To start importing questions:

+  Click Course Administration > Question Bank > Import to go to the Import questions page.
+ Select a file format. The help pop up next to the file format drop-down menu contains
further details of each format.

161

——
| —



How to use E-leaning

« Under the General Section: Select the category into which the imported questions will go.
Certain import formats, such as GIFT and E-leaning XML, may include category and
context data in the import file.

«  Choose —Nearest grade if not listedl from the —Match gradesl drop-down menu.
Otherwise, a question will not be imported if its grade is not included in the list of accepted
grades found in the help pop up.

+ Select what should happen if there are no grades or an error is detected in the import
process.

« Upload the file to import in the Import questions from file section and click Import.

Exporting Questions

You can share questions you have created by exporting them to a text file. Possible export
formats are to GIFT, E-leaning XML, and XHTML. In addition, questions may be exported into
Word format using a contributed plugin, Word table format.

These can then be easily used to create paper tests.

To export questions:

«  Click Course Administration > Question Bank > Export to go to the Export questions page.

« Select a file format. The export questions page in the E-leaning documentation contains
links to further information on each export format.

+ Select a category from which the exported questions will be taken. in the General Section.

«  Check if you want the category name to exported and/or the context to be included. This
only applies to some formats and is used to restore this information on import.

+  Click on the export questions to file button.

+ You will be asked to download/save the file to your computer.

Adding Questions to a Quiz

Once you‘ve created your questions, you need to add them to the quiz. On the editing quiz page,
as shown in the figure 7-13, select a number of questions using the checkboxes and then click the
—Add to quizl button below the question list.

To add the individual questions to the quiz, just click the arrow ( <) icon besides the question.

If you want to add all of the questions you created to the quiz, click the —Select alll checkbox in
the top and then click the —Add to quizl button.

*** To ensure all previously made questions are available, make sure to tick the boxes "also
show gquestions from sub-categories/old questions.
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Once you‘ve added a question to the quiz, it appears on the left side of the page in the quiz
question list. The question is still selectable on the right, but you can add it to the quiz only once.
If you select the question in the category list again and add it to the quiz, nothing will happen.

Editing quiz: History Quiz

Figure 7-13 Editing a quiz

If you have created a lot of questions, you may want to sort the question list by type and name.

Once you‘ve added the questions to the quiz, you can change the order of the questions by
clicking the arrow buttons on the right side of the list of quiz questions.

You can also delete a question from the quiz by clicking the delete icon.

You will also need to set the grade for each question. You can set the number of points for each
question in the "Marked Out of :" field. You may want to make certain questions or question
types worth more than others. Remember, the questions will be weighted to match the total
points possible for the quiz you set in the quiz body. You should also set the —Maximum gradel
for the whole quiz on the top of the page in "Maximum Grade" field. This does not have to be
equal to the sum of the grades for the individual questions. The grades achieved by the students
will be rescaled to be out of this maximum grade. When you‘re done, click the —Savel button.

163

——
| —



How to use E-leaning

In the Order and Paging tab you can specify the order in which the questions appear within the
quiz. If you have more than just a few questions, it‘s a good idea to limit the number of questions

displayed per page.

The numbers 10, 20, 30, ... opposite each question indicate the order of the questions. The
numbers increase in steps of 10 to leave space for additional questions to be inserted. To reorder
the questions, change the numbers then click the "Reorder questions” button.

To add page breaks after particular questions, tick the checkboxes next to the questions then click
the "Add new pages after selected questions" button.

You can "repaginate” by setting the number of questions per page. After setting the number of
questions per page, you can move questions so that there are a different number of questions on
each page.

You can preview the quiz by clicking on the Preview tab in the Administration Block as shown
in Figure 7-14. If you answer the questions, you can submit the quiz by clicking the —Submit all
and finishl button and see the feedback and responses your students will see.

Your students will see two scores on the page. The first is the raw score representing the total
points they scored out of the maximum possible points from each question. The second score is
the weighted grade representing the number of points achieved out of the maximum possible
points for the quiz.

If you‘ve enabled feedback after answering, each question will be displayed below the scores
with the answers marked correct or incorrect. If you‘ve enabled the display of correct answers,
they will appear highlighted. In the next section, we‘ll discuss how to manage your quizzes.

Random questions

You can also add random questions to your quiz from the question bank directly. A random
question is a placeholder for a randomly selected question. One of the advantages of a computer-
generated quiz is the ability to generate a quiz from questions randomly selected from a category.
Each random question will pull a question randomly from the question category and insert it into
the quiz. This means that different students are likely to get a different selection of questions.
When a quiz allows multiple attempts for each student then each attempt is likely to contain a
new selection of questions. The same question will never appear twice in an attempt.

164

——
| —



How to use E-leaning

Figure 7-14 Quiz preview

If you include several random questions then different questions will always appear for each of
them. If you mix random questions with nonrandom questions then the random questions will be
chosen so that they do not duplicate one of the nonrandom questions. This means that you need
to provide enough questions in the category from which the random questions are chosen;
otherwise the student will receive a friendly error message. The more questions you provide the
more likely it will be that students get different questions on each attempt.

*** Note the die icon to highlight random question selection.
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To add random questions to the quiz:

+  Select the number of random questions you wish to add from the drop-down menu below
the question list.
«  Click the Add button.

MANAGING QUIZZES

Once students start to take the quizzes, you‘ll have a lot of data available. When attempts have
been made on the quiz, the teacher can click the quiz name and access the reports by clicking the
link "Attempts - (No. of attempts.) It is then possible to filter the reports according to preference.

You can also access quiz results by clicking on the Administration> Quiz administration >
Results. This opens up other links, enabling them to view by grade, by correct response, by
statistics and by manually graded responses:

Grades report

Grade reports show all the students' quiz attempts, with the overall grade, and the grade for each
question. There are links to review all the details of a student's attempt, just as the student would
see it.

There is a setting form at the top of the page that can be used to control what is displayed.

The teacher can select from:

- enrolled users who have attempted the quiz;

- enrolled users who have not attempted the quiz;

- enrolled users who have, or have not, attempted the quiz;
- all users who have attempted the quiz

The results can be downloaded in a variety of formats. At the bottom of the page is a graph
showing the distribution of scores. There are check boxes to allow you to individually regrade or
delete the selected attempts. By clicking on the score link, you are able to look at an individual
student exam.
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Figure 7-15 Quiz results

Responses report

This is very similar to the Grades report, except that it shows the responses the students gave,
rather than the marks they earned. It is also possible to show the question text or the right answer,
to compare with the student's response. This is helpful when the question is randomized.

Statistics report

This report gives a statistical (psychometric) analysis of the quiz, and the questions within it. The
front page of this report gives a summary of the whole test. There are then links to drill down
into a detailed analysis of a particular question.

The full report (overview and detailed analysis of all questions) can be downloaded in a variety
of formats, as can the quiz structure analysis table.

Manual grading report

The Quiz manual grading report makes it easy to manually grade questions in the quiz. The first
screen of the report lists all the questions in the quiz that need to be, or have been, manually
graded (for example essay questions) with the number of attempts. There is an option to also
show the questions that have been automatically graded, which if useful if you ever need to edit
the grades by hand.

*** |f you decide to add additional questions to the quiz, you will need to delete all attempts
before being allowed to do so.

Quiz CAPABILITIES

The quiz module has a range of capabilities that allow you to create a number of student roles:
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« Attempt quizzes: This allows a user to attempt the quiz. Guest users can never attempt
quizzes. This capability is allowed for the student role only.

Quiz structure analysis
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Figure 7-16 Quiz structure analysis report

+ Delete quiz attempts: This allows a user to delete quiz attempts. This capability is allowed
for the default roles of manager and teacher.

« Get a confirmation message when submitting: This allows a user to receive email
confirmation that their quiz attempt has finished successfully. This capability is not set for
any of the default roles.

« Get a notification message when an attempt is submitted: This allows a user, usually a
teacher, to receive email notification of quiz submissions. This capability is not set for any
of the default roles.

+  Grade quizzes manually: This allows a user to change the scores on a quiz, and manually
grade quiz essay questions.

« Ignores time limit on quizzes: This allows a user unlimited time to attempt a quiz which
has a time limit set. This capability is not allowed for any of the default roles.

*** You may wish to allow this capability for those students who are identified as
requiring more time during assessment.

- Manage quizzes: This allows a user to manage quizzes. This capability is allowed for
Administrator and Teacher Role only.

« Preview quizzes: This allows a user to preview quizzes. This capability is allowed for the
default roles of manager, teacher and non-editing teacher.

« Review your own attempts: This allows a user to review their old quiz attempts, separate
from the ability to attempt the quiz. This capability is allowed for the default role of student.
It is not set for all other default roles.
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«  View quiz information: This allows a user to view the quiz introduction but not attempt the
quiz itself. The default Guest role has this capability set to allow.

« View quiz reports: This allows a user to view quiz reports. This capability is allowed for
Administrator, Teacher & Non-Editing teacher roles only.

EFFECTIVE QUIZ PRACTICES

As we‘ve seen, the E-leaning quiz engine is a powerful, flexible tool for monitoring and
diagnosing a student‘s understanding of certain types of knowledge. Using this tool effectively
can boost your course‘s effectiveness and promote student performance. While a computer-
scored quiz is a different evaluation than more openended assessments, it does give valuable
insight into student thinking and can provide formative as well as summative assessment also,
especially when you use good strategies and a little creativity.

Creative Quiz Uses

With the E-leaning quiz engine, it‘s easier to utilize educationally sound assessment strategies
that would be too difficult to implement with paper and pencil. Most people think of tests as an
infrequent, high-stakes activity, such as midterms and finals. Better strategies involve frequent,
low-stakes assessments you and your students can use to guide student performance during the
course of the semester.

Creating a series of mini-tests gives teacher a very flexible system for gauging performance and
keeping students engaged in the class. Here are a few ideas for quick quizzes which can be used
as part of a larger assessment strategy.

Chapter checks

Getting students to complete reading assignments has to be one of the hardest motivational tasks
in education. Reading is critical to understanding most material and fundamental to success in
many classes. The problem for most students is that there is no immediate punishment for
procrastinating on a reading assignment. If they haven‘t done the reading for a class discussion,
they can either keep quiet or skim-read it in class. There‘s almost no need to do the reading for a
lecture course, since the lecturer usually covers most of the material in class anyway.

Creating a mini-test for each reading assignment solves a number of problems. First, it
encourages students to do the reading so they can do well on the quiz. Secondly, it gives the
students feedback on how well they understood the reading assignment. Third, it gives you data
about which aspects of the reading students found confusing, and which they have already
mastered, so you can refocus your class activities.

For a reading mini-test, setting a limited-time quiz that students can take only once is
recommended. Because it‘s a low-stakes activity that students should use for selfassessment, you
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could also display feedback and correct answers. If you‘re concerned about students sharing
answers after they‘ve taken the quiz, randomize the question and answer order. If you have a test
bank, make some of the questions random as well.

As an additional assignment, you could ask students to write down one question about a question
they got wrong and bring it to class.

Test Practice

The key to effective practice is to have a realistic practice environment. Many students worry
about tests, especially high-stakes tests, because they have no idea what to expect. What question
format will you use? How detailed will the questions be? What should students study?

You can help alleviate test anxiety by creating a practice test students can take to help answer
these questions. These tests are usually based on old questions similar to the upcoming test
questions. Using last year*s final as an example test will force you to write new questions every
year. This is a good idea anyway; since you can be sure someone has a copy of last year*s test
and is sharing it with others.

To set up a practice test, you could create a zero-point test with questions from the year before in
random order with random answers. You could also allow students to take the test as many times
as they like so they can test themselves as much as they need. Display feedback, but not correct
answers, so the test presents more of a challenge.

Data gathering

As an expert, you know a lot about your field. Your challenge as a teacher is to translate your
knowledge for a novice who doesn‘t share your conceptual understanding or experience. An
example or lecture you think is brilliant may leave your students completely confused. It can be
hard to tell what students really understand and what‘s leaving them baffled.

A data-gathering quiz is similar to a chapter check, but it takes place after a class meeting or
lecture. Your goal is to quickly get some feedback on your students® understanding of a lecture.
What did they really understand? What do you need to spend more time on? It can be difficult to
gauge what students find difficult and what they find so easy that it bores them.

Setting up a post-class data-gathering quiz is similar to creating a chapter check. Set the quiz for
a limited time, such as a day or two before the next meeting. Allow your students to take it once
and display feedback and correct answers.
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Progressive testing

A very nice example of using the new feedback system with other options is the idea of
progressive testing. To implement this, you need to create a series of increasingly difficult
quizzes. The first quiz should be open to anyone, with the later quizzes protected by a password.
In the feedback for each quiz, decide a cutoff percentage which you feel represents mastery of
the skills tested. If the students® score is greater than the cutoff score, the feedback message
includes a link to the next quiz with the appropriate password.

In this way, students gradually have access to increasingly difficult tests, and it allows them to
concretely demonstrate their progress. But they don‘t become frustrated with questions that are
too difficult.

More ways in which Quizzes may be used are:

+ asunit or course exams

+ as mini-tests for reading assignments or at the end of a topic [ as exam practice using
questions from previous years' exams

+ to deliver immediate feedback for printed workbook activities

- to provide feedback about performance

«  For self-assessment to allow students to generate their own quiz questions for a practice
question bank.

QuUI1Z SECURITY AND CHEATING

Of course, online testing also presents another chance for the cheaters in your classes to try to
game the system. Most online quizzes are meant to be taken at home, or at least outside of
class. Students can download the questions and print them out.

They can take the tests with other students or while reading their textbooks.
Fortunately, you can counter many of these strategies, making them more trouble than they are
worth. Let‘s look at a few strategies for countering most cheating schemes:

Printing and sharing questions

If you display feedback and correct answers, students can print the results page and share it with
their friends. Or they can simply print the questions themselves directly from the quiz. The key
to discouraging this behavior is to randomize the question order and answer order. It makes the
printouts a lot less useful. Creating larger question banks and giving tests with random subsets is
also an effective strategy. If students can print only a small number of questions at a time, they
will need to view the test again and again, and then sort the questions to eliminate duplicates.
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Using the textbook

Students will frequently look up the answer to questions in the textbook or a reading. If you are
giving a chapter-check quiz, then this is what you want them to do. Otherwise, you need to come
up with creative ways to make the textbook less directly useful. Timed quizzes are the single
most effective tool for eliminating this strategy. If you include enough questions and make the
time to take the quiz short enough, students won‘t have time to look up all the answers.

Asking students to apply their knowledge to novel situations can also make a difference.
Synthesis and application questions can‘t be looked up. Students have to understand the material
and apply it creatively to answer the questions. So while they may take the time to review the
text, they will still need to understand what they‘ve read to successfully answer the question.

Working with friends

If your students are on the same campus, they may meet in a lab and try to take the quiz together.
This strategy is easily thwarted with random question order, random answer order, and random
questions pulled from a test bank. If my screen doesn‘t look like yours, then it‘s harder for us to
quickly answer all of the questions. A timed quiz also makes it harder for the two of us to cheat if
we have different questions and only a short amount of time to answer.

Have someone else take the test

The old adage goes, —On the Internet, no one knows you‘re a dog.l And no one knows who is
actually taking the test. Students will sometimes pay classmates, or others who have taken the
course in the past, to take online quizzes for them. There are two ways to counter this strategy.
One, have an occasional proctored exam where students need to show ID. If they haven‘t taken
the quizzes or done the work until then, they will do poorly on the proctored exam. Second, to
eliminate current classmates from taking each other‘s quizzes make them available only for a
short time. You could require everyone to take the test within a two- to four-hour block. If the
test is properly randomized, it will be very difficult to take it more than once during the testing
period. The test-taker will worry about her own grade first, then about her employer‘s grade.

Obviously, there are many strategies students can use to cheat. While it would be naive to
assume there isn‘t cheating, the vast majority of your students want to succeed on their own
merits. The anonymity of the online environment may open up new avenues for the cheaters, but
it‘s not really much different from your face-to-face classes. A few people will go to great
lengths to cheat, but most will be honest as long as it‘s not t00 easy to get away with it. A few
precautions will eliminate most of the cheaters, and the classic strategies will work for the others.
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SUMMARY

Quizzes can be configured to allow multiple attempts. Each attempt at a question is automatically
marked, and the teacher can choose whether to give feedback and/or show the correct answers.

There are many ways to use a quiz.

« Feedback about performance and self-assessment are important parts of a learning
environment. There are several ways to give feedback to students: on each question or
overall. The quiz module can display feedback and scores at different times during the quiz,
using the review options in the Quiz settings.

« You can install additional plugins to gamify your E-leaning quiz to create a variety of
interactive games for participants.

« A wide variety of Quiz reports (in addition to Grades) are available for use by the teacher.
Quiz reports not only can focus on a single student's attempt to answer each question, but
also can perform a robust item analysis of a question's validity based upon aggregated
student responses.

« A single quiz can automatically select random and/or specific questions from different
categories of questions.

« There are different options for scoring (marks-grades) individual questions in a specific
quiz, grading attempts for a quiz and each question type.

« The quiz settings allow different display methods. They can randomize the questions for
each student and or randomize the answers for each student.

+ The teacher can determine the number of questions on each page of questions the student
sees. The teacher can change the position of any question in the quiz. It is possible to put a
label with information any place between questions.

« The teacher can choose how questions behave during the quiz. It can be like a classic test,
where the student gets no feedback while attempting the test, only later. Alternatively, E-
leaning can reveal the grades and/or feedback to the student during the quiz, and perhaps
even give them another chance to answer the question (for fewer marks) having read the
feedback.

Chapter 9: Assignments

Assignments are a refreshingly simple method for collecting student work. They are a simple and
flexible catch-all for things you want to grade that don‘t fall into any of the other tool types.

The assignment module allows teachers to collect work from students, review it and provide
feedback including grades. The work students submit is visible only to the teacher and not to the
other students unless a group assignment is selected.
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The assignment module gives you an easy way to allow students to upload digital content for
grading. You can ask them to submit essays, spreadsheets, presentations, web pages,
photographs, or small audio or video clips. Anything they can store on their hard drives can be
submitted in response to an assignment.

Assignments don‘t necessarily have to consist of file uploads. You can create offline assignments
to remind students of real-world assignments they need to complete. Alternatively, you can ask
students to input their answer directly into the assignment itself.

Assignments are a useful tool you can use in creative ways to collect more authentic responses
from your students than is possible with the quiz engine.

An assignment has an 'available from' date before which no students can submit anything, and a
due date, after which teachers can choose not to accept submissions any more.

Markers can choose to be notified every time a student submits an assignment, or only for late
submissions. Markers can choose to give students feedback in the form of text or uploaded files.

ASSIGNMENT TYPES:

The standard assignment submission options available are:

+  File submissions (students submit a file for assessment)

«  Online text (students can type their responses directly in E-leaning)
«  Submission comments

«  Offline Assignment

ADDING AN ASSIGNMENT ACTIVITY

To create an assignment:

« Toadd a new Assignment activity to your course, first click the Turn Editing On button.
«  Within the required Week or Topic Block click Add an Activity or Resource link. In the
Add an activity or resource dialogue box that appears, select Assignment and click Add.
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The following configuration options are available when creating or editing/updating any
Assignment activity. Only General, Availability and Submission types are open by default; the
others are collapsed. To expand everything, click the "Expand all" link top right.

General Section

The General section allows you to give your assignment a name and description.

Assignment name: Give your Assignment a name (e.g. —Report on Topic 1 Contentl).
The title entered here will be the name that learners see in the course content area. Learners
will click on this name to view the details of the assignment and, if applicable, submit their
work.

Description: Provide instructions for your students here so they are clear what they have to
do. Click the icon on the left to expand the toolbar and drag the bottom right of the text box
out to expand it. You can also provide information or resources related to the assignment,
such as a video clip, an image, or a link to a webpage.

Display description on course page: Enabling this will display the description on the course
page just below the link to the assignment activity.

Availability Section

Allow submissions from: If enabled, students will not be able to submit before this date. If
disabled, students will be able to start submitting right away.

Due Date: This is when the assignment is due. Submissions will still be allowed after this
date but any assignments submitted after this date, are marked as late. To prevent
submissions after a certain date - set the assignment cutoff date.

Cut Off Date: If set, the assignment will not accept submissions after this date without an
extension.

Always show description: If disabled, the Assignment Description above will only become
visible to students at the "Allow submissions from™ date.

Submission Types Section:

Submission types: Here you can decide how you wish students to submit their work to
you. There are four types of assignment submissions as mentioned in the section above:

o Online Text: Learners can type their response directly in E-leaning using the text
editor. It's possible to set a word limit on an online text assignment. Students get a
warning if they try to exceed the word limit.

o File Submissions: Learners can upload and edit one or more files of any type the
teacher can open. If the student uploads a pdf file, the teacher can annotate it within
the browser, and on saving, the annotated file is made available to the student.
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o Submission comments: If Site Administrator has enabled then only students will be
able to send a message to their teacher when submitting their assignment.

o Offline Activity - If you simply uncheck the above three options then it will result
into an offline assignment activity.

*** Note that if Submission comments are enabled by Site Administrator then students will be
able to add a note to their teacher on submitting work. If Blind marking is enabled, student
comments display as from "Participant 01 etc.” to avoid revealing identities. These comments
will appear in the grading table in the Submission comments column.

« Word Limit: If online text submissions are enabled, this is the maximum number of words
that each student will be allowed to submit.

«  Maximum number of uploaded files: Here you can decide the maximum number of files
which may be uploaded by each learner. (It might be helpful to display the number in the
assignment description).

«  Maximum submission size: This setting specifies the maximum size per file of each of the
files that the students can upload as part of their submission. This maximum upload size
may only be equal to or less than the course limit (which in turn may only be equal to or
less than the site limit). The maximum size of each file is displayed to students at the point
where they upload files.

Feedback Type Section:

« Feedback comments: Setting this to yes mean that markers can leave feedback comments
for each submission. It enables the Feedback Comments column in the grading table.

«  Offline grading worksheet: If set to yes, you will have a link to download the grading list
as a spreadsheet. Then you will be able to enter grades and feedback comments offline.
When the teacher has completed their grading offline, they can then upload the spreadsheet,
confirm the changes and the grades and comments will be transferred over into E-leaning's
gradebook

« Feedback files: If enabled, you will be able to upload files with feedback when marking
the assignments. These files may be, but are not limited to marked up student submissions,
documents with comments or spoken audio feedback. [1 Uploading multiple feedback files

It is also possible to upload multiple feedback files as a zip, from the dropdown above the
grading list:

o Download the students' assignments using the "Download all submissions™ link
from the same dropdown menu;
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o Extract the folder offline and add your comments to the student's submissions. Keep
the names the same.

o Select the students' submissions and zip them into a new folder. Important: Don't
just edit them inside their original folder and re-zip this; it will not work. The folder
name does not matter as long as the feedback files have the same names as before.

o Upload this newly zipped folder.

o You will be presented with a confirmation screen displaying your feedback files.

«  Comment Inline: If enabled, the submission text will be copied into the feedback comment
field during grading, making it easier to comment inline (using a different color, perhaps)
or to edit the original text.

Submission Settings Section:

« Require students click submit button: If enabled, students will have to click a Submit
button to declare their submission as final. This allows students to keep a draft version of
the submission on the system.

« Require that students accept the Submission statement: An administrator can define a
"Submission statement”, i.e., a statement where students promise the work is their own and
which they must agree to before submitting their work. If the administrator has given
teachers the option of using a submission statement or not, then it will be available in the
assignment settings screen. When this setting is enabled, students will have to check a
button before they can submit their assignment.

« Attempts reopened: This setting allows the teacher to decide how submissions are
reopened. It determines how student submission attempts are reopened.
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Adding a new Assignment to 7 November - 13 November
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Figure 8-1 Adding a new assignment

« The available options are:
o Never - The student submission cannot be reopened. o Manually - The student
submission can be reopened by a teacher.
o Automatically until pass - The student submission is automatically reopened until
the student achieves the grade to pass value set in the Gradebook (Categories and
items section) for this assignment.
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«  Maximum attempts: If a student is allowed to resubmit, this setting will determine how
many times they can resubmit before they are no longer allowed to do so. After this number
of attempts has been made the student's submission will not be able to be reopened.

Group submission settings Section:

+  Students submit in groups: If this box is ticked, then students are able to collaborate on an
assignment. This might involve for example, working in the same online text area, or one
student uploading an MS PowerPoint which another student downloads, improves and re-
uploads to the common assignment area. A group submission will be shared among group
members and all members of the group will see each other‘s changes to the submission.
When grading, the teacher may choose to give a common grade and feedback to all students
in the group or to give individual grades and feedback to each member.

+ Require all group members submit: If enabled, all members of the student group must click
the submit button for this assignment before the group submission will be considered as
submitted. If disabled, the group submission will be considered as submitted as soon as any
member of the student group clicks the submit button.

«  Grouping for student groups: If a particular grouping is selected here, then the gradebook
will display any other groups and non-grouped students in the "default group”, while
naming the group(s) that are in the chosen grouping. If "none" is selected, then the
gradebook will display the names of all groups and put any non-grouped students in the
"default group"”.

Notifications Section

« Notify graders about submissions: If enabled, you will receive a message whenever a
student submits an assignment, early, on time and late.

+ Notify graders about late submission: If enabled then you will receive a message whenever
a student submits a late assignment.

+  Default setting for "Notify students”: This setting will set the default value for the "Notify
students™ checkbox on the grading form.

Grade Section:

« Grade:
o Select Points or Scale from the dropdown. If you will not be giving a grade for the
assignment, choose No Grade.
o Then select your points or chosen scale.
« Grading Method: Choose the advanced grading method that should be used for calculating
grades in the given context.
o There are 3 options:
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= Simple direct grading (entering a grade or scale item)
= Marking guide
= Rubric

*** To disable advanced grading and switch back to the default grading mechanism,
choose 'Simple direct grading'.

« Grade Category: This setting controls the category in which this activity's grades are placed
in the gradebook. Any custom Grade Categories that have been created within your site or
course will be listed here and will be available for selection. Select the required Grade
Category to add this assignment as a Grade item within this Category.

- Blind marking: If this setting is enabled, then you will not see the names of students who
have submitted their assignments. Instead, you will see randomly generated Participant
numbers. However, after grading the assignment, it is possible for you to see who submitted
what by clicking on "Reveal student identities” in the Assignment settings.

« Use marking workflow: When set to Yes, you will be able to specify the stage they are at
in their grading of individual assignments. One advantage of using marking workflow is
that the grades can be hidden from students until they are set to 'Released’. The actual list
of steps are:

o Not marked (the marker has not yet started) o In marking (the marker has started
but not yet finished)

o Marking completed (the marker has finished but might need to go back for
checking/corrections)
In review (the marking is now with the teacher in charge for quality checking)
Ready for release (the teacher in charge is satisfied with the marking but wait before
giving students access to the marking)

o Released (the student can access the grades/feedback)

« Use marking allocation: If marking workflow is set to Yes, it is possible to enable marking
allocation. This means that you can select other teachers to grade or review the submitted
work of specific students. Colleagues can monitor progress through the displayed marking
workflow states.

Common Module Settings

Common Module settings are same as mentioned in all previous activities. So this time you
should do choose them as an exercise.

Click "Save and return to course” button to make your assignment available.

Your assignment will appear in your course page. It will also be added to your course calendar
and will appear in the Upcoming Events block to remind students when it‘s due.
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*** To see how your assignment appears for your students, select Student from the —Switch
role tol drop-down menu in the top-right corner of the course page, next to the —Turn editing onl
button. The —Return to my normal rolel link at the bottom of each page restores your teacher
status.

ASSIGNMENT CAPABILITIES

The assignment module has only four capabilities:

«  Export own submission - This allows a user to export their own assignment submissions to
a portfolio. This capability is allowed for the default roles of manager, teacher, non-editing
teacher and student.

« Grade assignment - This allows a user to see submissions, add comments to and grade
assignments. This capability is allowed for the default roles of manager, teacher and non-
editing teacher.

«  Submit assignment - This capability allows a user to submit an assignment. This capability
is allowed for the default role of student only.

«  View assignment - This allows a user to view assignments. This capability is allowed for
the default roles of manager, teacher, non-editing teacher, student and guest.

MANAGING ASSIGNMENT SUBMISSIONS

To view your students‘ submissions, click on the assignment name in your course page. You‘ll
see the assignment name and details and a table underneath with details of participants, submitted
number of assignments and the submissions which needs grading. Under the table there is a link
"View/grade all submissions" which show all assignments that have been submitted. Click on
this link.

The assignment submissions page, as shown in Figure 8-2, displays the grading table which
contains columns of information about the student, the status of their submission, a link to grade
their submission, a link to each submission and feedback comments and files. The list may be
sorted by clicking on a particular heading.

By default, 10 submissions are shown per page, though this may be changed at the bottom of the
page.
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Assignment: History of India
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Figure 8-2 Assignment submissions

GRADING ASSIGNMENT SUBMISSIONS

On the grading table page, you can grade the assignments submissions of all students.

Filtering submissions

A dropdown menu accessed from the 'Options’ section allows you to filter submissions so you
can for example quickly see which students have not submitted yet.

Quick grading
Under Options (scroll to bottom of the page) you can determine your preferences for the number
of assignments you wish to display per page. This is also where you can turn on quick grading.

Quick grading allows you to enter grades and a feedback comment (if enabled in Assignment
settings) directly into the grading table. Quick grading is not compatible with advanced grading
and is not recommended when there are multiple markers.

To quick grade submissions:

« You can enter grades and feedback comments using quick grading. It is now possible to
enter grades in decimal format. [1 Enter the grades
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« Scroll to the bottom of the grading table and click 'Save all quick grading changes'
A confirmation screen will appear.

***You will not be able to return a feedback file to your students.

Assignment: History of India

Submission status

on YR itmdind o grmaeg

1ol graced

Grase out of 100

Current grade (n gradeboak

Foncbach comments

Noufy stogents

Figure 8-3 Grading assignment

Students can see their grades and comment in two ways. First, they can click on the assignment
link again. They will see their grades and comments below the submission block. Alternatively,
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they can click on the Grades link in the course Administration block. They will see the grade for
the assignment and can then click on the assignment name to get the written feedback.

EFFECTIVE ASSIGNMENT PRACTICES

The two most basic assignment types, offline and upload, are so generic you may find it difficult
to use them effectively at first. You may find it useful to think about them as two separate
modules sharing a common interface.

Offline assignments are useful for recording grades for real-world activities. You can use this
tool to record scores or feedback for student presentations, class participation, performances,
sculptures, or any other nondigital performance. You can create a scale to give nonnumeric
feedback if you don‘t want to give a numeric score to a creative performance.

Uploaded assignments are probably what most people expect when they think about assignments.
Remember, you can use these assignment types for any sort of digital content. Most instructors
use assignments to collect essays and other word-processing assignments. You can also use them
to collect other types of student work. Students could upload PowerPoint slides prior to a
presentation. You could assign a what-if scenario using a spreadsheet and ask students to submit
it. Students could take a digital photograph of a sculpture or mechanical project and submit it for
evaluation.

As long as the file is smaller than the upload maximum, you can create assignments for any sort
of digital content. Consider the types of work products you want your students to produce during
your course. How many of them could be digital files submitted using an assignment?
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CREATIVE ASSIGNMENT PRACTICES

Table 8-1 shows you which assignment type can be used for which purpose.

S. |Youwant .. You choose ..
No.

1  Students to type shorter Set Online text to Yes. This works well for younger children who
or longer responses  |will only manage a sentence or two and works just as well for
directly online. higher education students who write more.

Advantage - quick for the student to get started; no need to
use a word-processing program and upload the file.
Disadvantage - potential worries that if the internet goes
down, the work students have typed in and not yet saved
might be lost. If the word count is expected to be large,
setting Online text to No and File submission to Yes might
be a better option.

2  |students to submit Set File submission to Yes, set the number of files you will allow
work you can using the Maximum number of uploaded files setting and the file
download in a sizes by using the Maximum submission
specified program size setting.

Advantage - better than students emailing work as the whole
class's work is collated in one space on your course.
Markers can provide comments directly on the student
work.
Advantage - with "Attempts reopened” enabled, teachers
can see the progression through various drafts of a student's
work.

- Disadvantage - assignments must downloaded to be viewed
(but they can be downloaded in bulk) and the teacher needs
the appropriate program to open them.
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students to submit files | Set File submission to Yes, and use Maximum number of uploaded
at different times for a [files to set the maximum number of separate files
project they can upload

[1 Advantage - all project files are in one assignment

area for grading so they get a single grade.
(1 Disadvantage - all project files are in one assignment area for
grading - so they can only have a single grade!

students to write a Set up an assignment allowing online text submission and get
response to a students to use the E-leaning media icon to add video/sound/image
video/sound file/image files.

to grade work students |Uncheck the submission types when setting up the assignment.
have done offline Students won't be required to do anything but you can use the
assignment to grade them for work done outside of E-leaning.

to view, comment on | Set up an assignment allowing file submissions.
and send back students'
assignments + Advantage: useful for teachers who like using the
"comment” options in word-processing programs for
example.
- Disadvantage: if students upload other file types, you have
to download them, comment and then re-upload them.

students to send you a |In the settings, set Submission comments to Yes .
comment or note along

with their uploaded

work
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In the settings set Require students click submit button to Yes.
Students can then control when their draft work is submitted to the
teacher.

In the settings set Require students click submit button to No.
Students can continue to make changes to their assignment and at
no point do they ‘'submit'. If the work will be graded at some point
it is recommended that either Prevent late submissions is set to
Yes to ensure that no changes can be made after the due date, or
all

submissions are locked when grading commences to ensure that the
work is not altered during grading.

« Advantage: the work remains in one place and is constantly
improved, graded (if needed) and improved again.

« Disadvantage: there is no record/history of previous
attempts. The online text assignment does not replicate the
display of a journal or blog where each new entry is
additional to the previous ones.

In the settings, set "Students submit in groups” to Yes. If you just
do this, then once one student has submitted, the assignment will be
flagged as submitted even if the others haven't contributed. If you
want to ensure everyone has an input, set "Require students click
submit button™ to Yes and then change "Require all group members
to submit™ to Yes. The assignment will only be classed as submitted
when each member has contributed, and once one student has
submitted, the remaining member‘s names will be displayed for the
group to see who still needs to add their input.
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11 | to grade students' work In the settings, choose "Blind marking™. When students submit
anonymously assignments, their names will be replaced by randomly generated
participant numbers so you will not know who is who.

12 to read and grade In the settings, choose "Offline grading worksheet". When students
student assignments | have submitted, click "View/grade all submissions"” and you can
offline download their assignments from the link "Download all

submission™ and download the grading sheet from the link
"Download grading worksheet". You can then edit grades and re-
upload the grading worksheet. You can also upload multiple
feedback files in a zip from this drop down menu.

SUMMARY

Assignments are an easy way to gather and track student submissions. Students can submit any
type of electronic file to fulfill the requirements. Instead of collecting un- wieldy stacks of paper,
you can let E-leaning track who has turned in a paper and when. The feedback options provide
you with an easy way to send grades and/or comments back to the students about their work.
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Chapter 10: Workshop

Workshop is a peer assessment activity with many options. Students submit their work via an
online text tool and attachments. There are two grades for a student: their own work and their
peer assessments of other students' work.

Workshop is similar to the Assignment module which we covered in chapter 8 and extends its
functionality in many ways. However, it is recommended that both you (teacher) and your course
participants (students) have at least some experience with the Assignment module before the
Workshop is used in the course.

« Asin the Assignment, course participants submit their work during the Workshop activity.
Every course participant submits their own work. The submission may consist of a text and
attachments. Therefore, Workshop submission merges both Online text and Upload file
types of the Assignment module. Support for team work (in the sense of one submission
per group of participants) is out of scope of Workshop module.

« The submissions are assessed using a structured assessment form defined by the course
facilitator (teacher). Workshop supports several types of assessment forms. All of them
allows multi-criteria assessment in comparison to the Assignment module where only one
grade is given to a submission.

«  Workshop supports peer assessment process. Course participants may be asked to assess
selected set of their peers' submissions. The module coordinates the collection and
distribution of these assessments.

«  Course participants get actually two grades in a single Workshop activity - grade for their
submission (that is how good their submitted work is) and grade for assessment (that is
how well they assessed their peers). Workshop activity creates two grade items in the
course Gradebook and they can be aggregated there as needed.

+ The process of peer assessment and understanding the assessment form can be practiced in
advance on so called example submissions. These examples are provided by the facilitator
together with a reference assessment. Workshop participants can assess these examples and
compare their assessment with the reference one.

« The course facilitator can select some submissions and publish them so they are available
to the others at the end of Workshop activity (in comparison to the Assignment module
where submitted work is available only to the author and the facilitator).
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WORKSHOP PHASES

The work flow for the Workshop module can be viewed as having five phases. The typical
workshop activity can cover days or even weeks. The teacher switches the activity from one
phase to another.

The typical workshop follows a straight path from Setup to, Submission, Assessment,
Grading/Evaluation, and ending with the Closed phased. However, an advanced recursive path is
also possible.

The progress of the activity is visualized in so called Workshop planner tool. It displays all
Workshop phases and highlights the current one. It also lists all the tasks the user has in the
current phase with the information of whether the task is finished or not yet finished or even
failed.

Before creating a workshop activity in your course, lets take an overview on the different phases
within the workshop activity.

Setup phase

In this initial phase, Workshop participants cannot do anything (neither modifies their
submissions nor their assessments). Course facilitators use this phase to change workshop
settings, modify the grading strategy of tweak assessment forms. You can switch to this phase
any time you need to change the Workshop setting and prevent users from modifying their work.

Setup phase

v Setthe workshop
introduction
X Provide
instructions for
submission
 Edit assessment
form
 Prepare example EiEts
submissions

Figure 9-1 Workshop phases
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Submission phase

In the submission phase, Workshop participants submit their work. Access control dates can be
set so that even if the Workshop is in this phase, submitting is restricted to the given time frame
only. Submission start date (and time), submission end date (and time) or both can be specified.

Assessment phase

If the Workshop uses peer assessment feature, this is the phase when Workshop participants
assess the submissions allocated to them for the review. As in the submission phase, access can
be controlled by specified date and time since when and/or until when the assessment is allowed.

Grading evaluation phase

The major task during this phase is to calculate the final grades for submissions and for
assessments and provide feedback for authors and reviewers. Workshop participants cannot
modify their submissions or their assessments in this phase any more. Course facilitators can
manually override the calculated grades. Also, selected submissions can be set as published so
they become available to all Workshop participants in the next phase.

Closed

Whenever the Workshop is being switched into this phase, the final grades calculated in the
previous phase are pushed into the course Gradebook. This will result in the Workshop grades
appearing in the Gradebook and in the workshop. Participants may view their submissions, their
submission assessments and eventually other published submissions in this phase.

Now let‘s add a workshop activity in your course:

22

ADDING A NEW WORKSHOP ACTIVITY

+  With the editing turned on, in the section you wish to add your workshop, click the "Add
an activity or resource" link.
« The "Adding a new workshop™ screen will be displayed [ In the General Section:
o Name: Whatever you type here will form the link learner‘s click on to view the
workshop, so it is helpful to give it a name that suggests its purpose.
o Description: Add a description of your workshop here. Click "Show editing tools"
to display the rich text editor, and drag the bottom right of the text box out to expand
it.
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If —Display description on the course page boxl is ticked, the description will
appear on the course page just below the name of the workshop.

In the Grading Settings Section:
0 Grading strategy: What you choose here determines the assessment form students

will use and also the strategy for grading submissions.

*** Grading strategies can't be changed once we have entered the submission
phase of a workshop.

= Accumulative grading: Comments and a grade are given regarding the
aspects of the workshop specified.
= Comments: Comments are given but no grade can be given to the specified
aspects
= Number of Errors: A yes/no assessment is used and comments are given for
specified assertions
= Rubric: A level assessment is given regarding specified criteria. o Grade for
submission:  This setting specifies the maximum grade that may be
obtained for submitted work. It is scaled between 0-100.
Grade for assessment: This setting specifies the maximum grade that may be
obtained for submission assessment. It is also scaled between 0100.
Decimal places in grade: Decide here how many decimal places are allowed in the
grade.

In the Submission Settings Section:

o

Instructions for submission: Explain here what students must submit and related
instructions.

Maximum number of submission attachments: If you wish students to attach files,
select how many here, up to a maximum of 7. If you leave it at 0 then they can only
enter text.

Maximum File Size: Decide here how large file students can upload. The size will
depend on the course upload limit.

Late Submissions: If enabled, students may submit their work after the submissions
deadline or during the assessment phase. Late submissions cannot be edited though.

In the Assessment Settings Section:

o

Instructions for assessment: Here you can write instructions for assessments online.
This is very useful to help students have a better understanding about the important
points of a task before assessing their classmates® submissions.

Use Self-Assessment: If enabled, a user may be allocated their own submission to
assess and will receive a grade for assessment in addition to a grade for their
submission.

In the Feedback Section:

o

Overall feedback mode: If enabled, a text field is displayed at the bottom of the
assessment form. Reviewers can put the overall assessment of the submission there,
or provide additional explanation of their assessment.
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Decona praces o grades

Figure 14-2 Adding a new workshop activity

o Maximum number of overall feedback attachments: Choose here how many (if
any) files you wish reviewers to attach to their overall feedback, up to a maximum
of 7.

o Maximum overall feedback attachment size: Decide here how large a feedback file
students can upload. The size will depend on the course upload limit.

o Conclusion: Itis possible to add some custom text which the students will see once
they reach the end of the workshop process. This might be a general summary or
suggestions on what should be done next, such as writing a blog post to reflect on
the experience.

+ In the Example Submission Section:

o Useexamples: If enabled, users can try assessing one or more example submissions

and compare their assessment with a reference assessment.
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The grade is not counted in the grade for assessment.

Mode of examples assessment: If you check the box above then you will find three
options in this drop down menu: The first option means that the assessment of the
example submission is voluntary, while the second and the third ones make it
mandatory, which either requires students to assess example submissions before
submitting their own work or after their own submission but before peer-
assessment.

*** Assessments of the example submission are not counted when calculating the
grade for assessment.

In the Availability section: This section deals with setting submission times and assessment
times for the workshop. That is the time when students can start submitting as well as the
deadline for submitting, and similarly the time assessments for other students® work start
and when they must finish assessing other students work. You can choose your settings
accordingly to facilitate the students within your class.

In the Common Module Section:

@)

@)

o

Visible: Select Show/Hide to display or hide the activity to your students.
ID Number: Provide an ID number for the activity to be shown in the Gradebook.
Group Mode: Select the group mode for the workshop activity. There are three
options:
= No Groups: There are no sub groups, everyone is part of one big community
= Separate Groups: Each group member can only see their own group, others
are invisible
= Visible Groups: Each group member works in their own group, but can also
see other groups. o Grouping: Select grouping type if you want to make an
activity (such as an assignment or a quiz) visible to only one set of users
within a course.

Click "Save and Return to the course" to save the workshop activity.

Setup Phase
In order to set the criteria for an assignment, you as a teacher need to fill out an assessment form
during the setup phase. Students can view this assessment form in the submission phase and

USING WORKSHOP ACTIVITY

When you click on the workshop activity in the course main page it will take you to the Setup
phase of the workshop activity.
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focus on what is important about the task when working on their assignment. In the next phase-
the assessment phase, students will assess their peers® work based on this assessment form.

Setup phase

Set the workshop
description
Provide instructions

for submission

Edit asse=zsment

form

Figure 14-3 Edit the assessment form

According to the grading strategy chosen in the grading settings while setting up the activity, you
will get corresponding original assessment form to edit by clicking _Edit assessment form* button
in the first page of the workshop setup for the assignment. The grading strategy can be one of
Accumulative grading, Comments, Number of errors or Rubrics. Teachers can set each criterion
in detail in the assessment form.

Submission phase

Once the workshop has been made we can then set more settings relating to submissions. This is
done through clicking on the menu highlighted below which is found when you click on the
workshop‘s link or after clicking —Save and Displayl on completion of the workshop. To access
the menu simply click on —Allocate

Submissionsl. It is highlighted in the picture by the red box.

When you click on the "Allocate Submissions™ link E-leaning will take you to the submission
allocation page where you can allocate the submissions to different students. There are 3 tabs on
the page:
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Setup phase

Set the workshop =~ Pro

description

Provide instructions =
for submission
Edit assessment

form

Figure 14-4 Submission Phase

- Manual Allocation: Here, a teacher can manually choose which students review whose
work. A student can review work even if they have not submitted anything themselves.

Manual allocation Random allocation
Participant is reviewed by Participant Participant is reviewer of
Student 5
Add reviewer Choose user... [Z] Add reviewee Choose user... E]
Student 4X Gent from Hyde 1sam student X
Student 3X Hogiace yet Student 3X
m Student X Student 4X
Student 6
Add reviewee | Choosg user... E]
Student 7
Add reviewee | Choose user... E]
i i Sally Student
Add reviewer | Choose user... E] Add reviewee | Choose user... E]
Fly
No grade yet

Figure 14-5 Random allocation of submissions
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- Random Allocation: The teacher is given 5 settings that determine how the random
allocation will work.

o

Number of reviews: Here the teacher picks between 0 and 30 reviews for either
each submission or per reviewer. That is the teacher may choose to either set the
number of reviews each submission must have or the number of reviews each
student has to carry out

Prevent Reviews: If the teacher wishes for students of the same group to never
review each other‘s work, as most likely it is their work too in a group submission,
then they can check this box and E-leaning will ensure that they are only allocated
other students out of their group‘s work to access

-Allocation settings

Group mode Visible groups

Number of | g E per submission |Z|
reviews
Prevent reviews [T
by peers from
the same group

Remove current [
allocations

Participants can [
assess without
having
submitted
anything

Add self- [
assessments

Manual allocation Random allecation

=1

[Save changes| [Cancel

o

Figure 10-6 Random allocation settings

Remove current allocations: Checking this box means that any manual allocations
that have been set in the Manual Allocation menu will be removed

Can access with no submission: Having this box checked allows students to assess
other students‘ work without having already submitted their own work.

Add self-assessments: This options when checked make sure that as well as
assessing other students‘ work they must also assess their own.

This is a good option to teach students how to be objective to their own work.
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« Scheduled Allocation: If enabled, the scheduled allocation method will automatically
allocate submissions for the assessment at the end of the submission phase. The end of the
phase can be defined in the workshop setting 'Submissions deadline'.

Internally, the random allocation method is executed with the parameters pre-defined in this
form. It means that the scheduled allocation works as if the teacher executed the random
allocation themselves at the end of the submission phase using the allocation settings below.

Assessment phase

Examples

Students can assess example submissions for practice before assessing their peers' work if this
feature is enabled. They can compare their assessments with reference assessments made by the
teacher. The grade will not be counted in the grade for assessment.

You need to upload one or more example submissions and the corresponding reference
assessment to support this function. You can also edit the reference assessment later by clicking
the _reassess‘ button in the first page.

Peer Assessment:

If this feature is enabled, a student will be allocated a certain amount of submissions from his
peers to assess. He will receive a grade for each assessment, which will be added together with
the grade for his own submission and this will be used as his final grade for this assignment.

This is the key feature of workshop: To encourage students to assess the work of their peers and
learn from each other. Through this, they will see the strengths of their classmates® submissions
and have a better understanding about how to do a good job. In addition, the advices they get
from their peers will give them a more comprehensive view of their own work: The comments
from their peers will point out the weakness of their work, which is generally difficult to find out
by themselves.

Self-Assessment:

If this option is turned on, a student may be allocated his own work to assess. The grade he
receives from assessment of his own work will be counted into the grade for assessment, which
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will be added together with the grade for submission and used to calculate his final grade for this
assignment.

This setting enables teachers to see whether students can find out the strength and weakness of
their own submissions and judge them objectively. It is a good way to help students think more
comprehensively.

Grading evaluation phase
Grading evaluation settings - Here you can choose your settings for calculation of the grade for
assessments.

Grade calculation method - This setting determines how to calculate grade for assessments.
Currently there is only one option- comparison with the best assessment.

The Comparison with the best assessment tries to imagine what a hypothetical absolutely fair
assessment would look like.

Comparison of assessments

This setting determines how quickly the grades fall down when the assessments differ from the
best assessment. This setting has 5 options: very lax, lax, fair, strict and very

strict. It specifies how strict the comparison of assessment should be. By using comparison with
the best assessment method, all assessments will be compared with the best assessment picked up
by workshop. The more similar one assessment is with the best assessment, the higher grade this
assessment will get, and vice versa.

Workshop toolbox

« Clear all aggregated grades: Clicking this button will reset aggregated grades for
submission and grades for assessment. Teachers can re-calculate these grades from scratch
in Grade evaluation phase.

« Clear assessments: By clicking this button, grades for assessments along with grades for
submission will be reset. The assessment form will remain the same but all the reviewers
need to open the assessment form again and re-save it to get the given grades calculated
again.
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Closed Phase

Whenever the Workshop is being switched into this phase, the final grades calculated in the
previous phase are pushed into the course Gradebook. This will result in the Workshop grades
appearing in the Gradebook and in the workshop (new in E-leaning 2.4 onwards). Participants
may view their submissions, their submission assessments and eventually other published
submissions in this phase.

GRADING A WORKSHOP ACTIVITY

The grades for a Workshop activity are obtained gradually at several stages and then they are
finalized.

MOODLE WORKSHOP MODULE CALCULATION OF GRADES IN WORKSHOP 2.0

GRADEBOOK
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Figure 14-7 Grade calculation in workshop

Grade for submission:
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The final grade for every submission is calculated as weighted mean of particular assessment
grades given by all reviewers of this submission. The value is rounded to a number of decimal
places set in the Workshop settings form.

You can influence the grade for a given submission in two ways:

by providing their own assessment, possibly with a higher weight than usual peer reviewers
have
by overriding the grade to a fixed value

Grade for assessment:

Grade for assessment tries to estimate the quality of assessments that the participant gave to the
peers. Grades for assessment are displayed in the brackets () in the Workshop grades report. The
final grade for assessment is calculated as the average of particular grading grades.

WORKSHOP CAPABILITIES

The capabilities for the workshop activities are:

«  Allocate submissions for review: This allows a user to allocate a submission for assessment
and set the weight of the assessment for a workshop activity. This capability is allowed for
the default roles of manager, teacher and non-editing teacher.

Edit assessment forms: This allows a user to define and modify assessment forms. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

« Ignore time restrictions: This capability allows a user to submit or assess without any time
restrictions i.e. he is not bound to follow the deadlines.

« Manage example submissions: This allows a user to submit example submissions. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

« Override calculated grades: This capability allows a user to override calculated grades for
submission and assessment.

« Peerassess: All users with this capability are considered as potential reviewers during the
allocation. Submissions can be allocated to these users for assessment.

+ Publish submissions: This allows a user to publish submissions that is to make them
available when workshop is closed.

« Submit: This allows a user to submit own work. All users with this capability are expected
to participate in the workshop as authors.

«  Switch phase: This allows a user to change the current phase of the workshop.

«  View workshop: This allows a user to see workshop title and introduction during the setup
phase.
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« View all assessments: This allows a user to view all assessments in the workshop.

«  View all submissions: This allows a user to view all submissions in the workshop.

«  View author names: This allows a user to see the name of submission author. This is
typically used to control whether reviewers should know who they are assessing or whether
the assessment is anonymous.

« View authors of published submissions: This capability allows a user to see the names of
authors of published submissions.

«  View published submissions: This allows a user to view published submissions when the
workshop is closed.

«  View reviewer names: This allows a user to see the name of reviewer. This is typically
used to control whether submission authors should know who they are assessed by or
whether the reviewers are anonymous.

SUMMARY

Workshop activity is an activity which is quite similar in nature to assignment but takes the
functionality to a much more extended level. Some of the extended facilities provided by the
workshop activity are:

« Workshop coordinates the collection of assignments and the distribution of these
assignments to peer reviewers.

« Peer markers assess the submissions using a structured assessment form defined by the
teacher, which permits multiple criteria to be used.

«  Workshop supports several types of assessment forms (e.g. full rubric, commenting only).

« Course participants are graded on their own submission and on how well they assessed
their peers. These 2 grade items are created in the course Gradebook and can be aggregated
there as needed.

« Students can practice peer assessment and the use of rubrics in advance using example
submissions and a reference assessment provided by the teacher.

Chapter 11: Glossaries

Part of becoming an expert in any field is learning the vocabulary used by practitioners. Experts
in an area of study develop new language and word usage to communicate new ideas or subtle
variations of old ones. As communities develop within a field and experts communicate with
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each other over time, new languages emerge. Many experts find it increasingly difficult to
communicate with novices as they become more immersed in the language of their field.

Fortunately, E-leaning has a tool to help you and your students develop glossaries of terms and
embed them in your course. On the surface, the glossary module doesn‘t seem to be more than a
fancy word list. In practice, however, it‘s a powerful tool for learning. The glossary module has a
number of features that make it easy for you and your class to develop shared vocabulary lists,
add comments to definitions, and even link every appearance of a word in a course to its glossary
entry.

The glossary activity module allows participants to create and maintain a list of definitions, like a
dictionary.

Glossary can be used in many ways. The entries can be searched or browsed in different formats
and definitions can 'pop up' over instances of the word whenever the term appears in the module.
A glossary can be a collaborative activity or be restricted to entries made by the teacher. Entries
can be put in categories. The auto-linking feature will highlight any word in the course which is
located in the glossary.

The glossary also allows teachers to export entries from one glossary to another (the main one)
within the same module. Student entries can be set to be approved by a tutor before they are
made available and students can also comment on entries.

CREATIVE GLOSSARY USES

» Favorite Websites collection: You can setup the glossary to create a collection of the
favorite websites that students find appropriate for the class.

» Annotated book reports: Students can submit their response to the glossary with concept
being their name and title of book; teacher allows rating (by teacher) and comments (by
all) so that it is easy for both the instructor to grade the original work (indexed by student
name) AND students can share their work for peer review/comments prior to instructor
grading.

* FAQ:s for the course compiled by the instructor from feedback from students in prior term
courses.

» Biographies of people in the field

» Collaborative Encyclopedia - Have students create an encyclopedia of what they are
learning about a person, or a people, a concept, a place, an event, a thing etc.
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» Student of the Week - With glossary, you can add a photo of each student without
identification. The random glossary block shows the photo of that student as student of the
week; every student gets displayed.

» Another great idea is to use the random glossary entry block to do quotes of the day or
vocab word of the day.

CREATING GLOSSARIES

Each E-leaning course has its own set of glossaries. Only teachers can edit the main glossary.
Secondary glossaries may be configured to allow student entries and comments.

Your E-leaning course may contain one main glossary and as many secondary glossaries as you
want. You can export entries from any secondary glossary into the main glossary.

To create a glossary:

«  With the editing turned on, in the section you wish to add your glossary, click the "Add an
activity or resource"” link and choose Glossary.
+ In the General Section:

o

o

Name: Give your new glossary a descriptive name.

Description: Describe the purpose of the glossary and provide instructions or
background information, links etc.

Display description on course page: If this box is ticked, the description will appear
on the course page just below the name of the glossary.

Glossary type: Here you can decide whether the glossary will be main or
secondary. The glossary system allows you to export entries from any secondary
glossary to the main one of the course. In order to do this, you should specify which
glossary is the main one. You can only have one main glossary per course.

« In the Entries Section:

@)

Approved by default: If set to "yes" then new entries appear automatically. If not,
then the teacher must approve each one first.

Always allow editing: If set to "yes", students can edit their entries at any time. If
not, then they can only edit for a certain period.

Duplicate entries allowed: This allows the entry of more than one definition for a
given word.

Allow comments on entries: Students and teachers can leave comments on glossary
definitions. The comments are available through a link at the bottom of the
definition.
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Figure 11-1 Adding a new glossary

Automatically link glossary entries: If the Glossary auto-linking filter is enabled by
an administrator, then turning this on allows individual entries in this glossary to
be automatically linked whenever the concept words and phrases appear throughout
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the rest of the same course. This includes forum postings, internal resources, and
week summaries and so on.

+ In the Appearance Section:

o

@)

Display format: This specifies the way that each entry will be shown within the
glossary. The default formats are:
= Simple, dictionary style - This looks like a conventional dictionary with
separate entries. No authors are displayed and attachments are shown as
links.
= Continuous without author - Like the simple style. Shows the entries one
after other without any kind of separation but the editing icons, but only if
your theme supports it, you usually have to modify the theme if you want
an alternative appearance to the simple setting.
= Full with author - A forum-like display format showing author's data.
Attachments are shown as links.
= Full without author - A forum-like display format that does not show
author's data. Attachments are shown as links.
= Encyclopedia - Like 'Full with author' but attached images are shown inline.
= Entry list - This lists the concepts as links.
= FAQ - Useful for displaying lists of frequently asked questions. It
automatically appends the words QUESTION and ANSWER in the concept
and definition respectively.
Approval display format: It is possible to set an alternative display format for when
entries are approved that can differ from the display format on the course page. This
could be useful for instance if a tutor wants to see who made a particular glossary
entry before approving it but doesn't want the students' name to be displayed for
others on the course page.
Entries shown per page: Decide here how many entries to show per page.
Show alphabet links: If set to "yes", users can browse the glossary by letters of the
alphabet.
Show 'ALL" link: If set to "yes", users can browse all the entries at once.
Show 'Special' link: If set to "yes", users can browse the glossary by special
characters, such as @ and #.
Allow print view: This provides a printer-friendly version link for students.

+ In the Ratings Section:

o

o

Roles with permissions to rate: Glossary entries can be rated using a scale. By
default, only teachers can rate glossary entries, though students can be given
permission to do so if desired from Administration>Glossary administration. This
is a useful tool for giving students participation grades. Any ratings given are
recorded in the gradebook.

Aggregate type: The aggregate type defines how ratings are combined to form the
final grade in the gradebook.

= Average of ratings - The mean of all ratings
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= Count of ratings - The number of rated items becomes the final grade. Note
that the total cannot exceed the maximum grade for the activity.

= Maximum - The highest rating becomes the final grade

=  Minimum - The smallest rating becomes the final grade

= Sum - All ratings are added together. Note that the total cannot exceed the
maximum grade for the activity.

= If"Noratings" is selected, then the activity will not appear in the gradebook.

« Scale: Select the type of grading used for the glossary. If "scale" is chosen, you can then
choose the scale from the "scale” dropdown. If using "point" grading, you can then enter
the maximum grade available for this activity.

 Restrict ratings to items with dates in this range: You can set the time range to restrict the
ratings within the time range.

+  Click "Save and Display" to display your newly created glossary activity.
USING GLOSSARY

Once you‘ve created your glossary, it‘s a good idea to seed it with a couple of entries so students
have a model to work from. When you click the "Save and Display" button then it will
automatically take you to the view glossary page where you can add entries to glossary, search
entries, print and approve the entries within the glossary.

The main view of the glossary can be a bit confusing at first, as you can see from Figure 9-2.
Under the main E-leaning navigation bar, you‘ll find the glossary description. Directly below the
glossary description, you‘ll see the search bar. Checking the —Search full textl box allows
searching for a given word in any position in the text. Below the search bar is the —Add a new
entryl button, then four browse tabs:

«  Browse by alphabet - Students can look for glossary entries by the first letter of a word
when they select this tab.

- Browse by category - You can create word categories and make them available for
students to use when they are searching the glossary.

- Browse by date - You can view entries based on the date they were last edited.

«  Browse by Author - If you want students to add entries, this is a useful way to keep track
of who has entered what.
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Glossary: Indian Gloassry

Moodle

Figure 9-2 A glossary

Adding Entries
Clicking the —Add a new entryl button gives you access to the definition entry page.

To Add a glossary entry:

«  From the Glossary page, click the —Add a new entryl button.
« Inthe General Section:
o Enter the word you want to define in the Concept text field, as shown in
Figure 9-3 0 Add the definition of the word or
concept.

o If there are synonyms you want to include with the entry, add them to the
Keyword(s) text area. Make sure to Enter one word per line only.

« If you want to add an attachment, such as a picture or an article, you can either drag/drop
it or click the "Add" button to upload via the File picker.
+  Inthe Auto-linking Section:

o This entry should be automatically linked: If site-wide glossary autolinking has
been enabled by an administrator and this is set to "yes", the entry will be
automatically linked wherever it appears.

o This entry is case sensitive: This setting specifies whether matching exact upper
and lower case is necessary when performing automatic linking to these entries. For
example, if this is turned on, then a word like "html" in a forum posting will NOT
be linked to a glossary entry called "HTML".
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o Match whole words only: If automatic linking is enabled, then turning this setting
on will force only whole words to be linked. For example, a glossary entry named
"construct” will not create a link inside the word "constructivism".

Glossary: Indian Gloassry

Genecal

Dehnimen

Waywordis

Aftas hment

Autoslinking

PHIe aniry shoull he autometicatly
Inkey

This entry (4 case sensitive

Mater mheve wormy anly

Figure 9-3 Adding a new glossary entry

«  Click the —Save changesl button to add your word to the glossary.

Search options
You can also search for a given word using the Search field. Checking the 'Search full text'
option (on the right side of the Search box) allows searching for a given word in any position in
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the text. This can take longer and return more entries than you might wish, but it is thorough. If
you do not check the "Search full text" box, the search only looks for the term names. The index
below lets you browse the glossary according to a given letter.

GLOSSARY CATEGORIES

Categories can help organize your glossary entries. If you‘ve enabled autolinking, the category
names can be linked along with individual entries. To create a glossary category:

* Click the —Browse by categoryl tab in the main page of the glossary.

* Click the —Edit categories| button on the left side of the page.

* Click the —Add categoryl button on the resulting Categories page.

* Give the category a name.

» Choose whether you want the category name autolinked as well. (1 Click the —Save
changesl button.

If you autolinked the category name, any occurrence of those words will be linked. When a
student clicks on the link, he will be taken to the —Browse by categoryl page of the glossary.

AUTOLINKING

Once you‘ve added an entry to the glossary and enabled autolinking, any instance of a glossary
term anywhere in E-leaning will have a link to its definition. For example, if you create an entry
for the word —E-leaning| in the glossary, whenever someone uses the word in a forum,
assignment, HTML or text page, or even in a description field, it will be clickable, as shown in
Figure 9-4. Once you click on the word, a new window with the glossary entry will pop up.

I love Moodle
by Aagmn User - Monday, 17 Noyember 2044, 652 AM
ove Y_‘_(_| Q0

Glossary- Indian Gloassry: Moodle

Figure 9-4 An autolinked word in a forum
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IMPORTING AND EXPORTING

As you build your glossaries, you may want to share them between classes or with other
instructors. Fortunately, there‘s a way to export and import glossary entries without needing to
share your entire course structure.

To export glossary entries:

« In Settings > Glossary administration > Export entries click the "Export entries to file"
button.
«  Save the automatically generated XML file on your computer.

To import glossary entries via an XML file:

« Go to Settings > Glossary administration > Import entries

«  Click the "Choose a file" button and browse for the exported entries XML file on your
computer

+  Select the destination for the new entries: either the current glossary or a new one

« If you want to import category information, click the checkbox. [J Click the "Submit"
button.

You'll then see a report of the entries and categories added to the glossary. If you enabled
duplicate entries when you created the glossary, the import process will add all of the new
definitions. Otherwise, it will not allow you to import any duplicate entries.

*** \WWhen the entries are imported into another glossary, the user performing the import will be
listed as author of all the entries.

COMMENTING ON ENTRIES

If you enabled comments on the glossary entries, users can annotate the definitions in the word
list. When you look at a word in the glossary list, you'll see a blue "Comments" link in the lower
left-hand corner.

When you click the link, a comments box opens up. Add your comment then click the "Save
changes" button.
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Once you've saved your comment, E-leaning will display all of the comments for the entry.
When you return to the main glossary page, you'll see a new message next to the speech balloon
telling you how many comments there are for the entry.

PRINTING A GLOSSARY

At the top right of the main glossary page, you'll see a little printer icon. If you click the icon, E-
leaning will open a new browser window and present all the words and definitions in a printer-
friendly format.

To print the glossary:

1. Click the printer friendly version icon ‘at the top of the main glossary page.
Print

2. From the newly opened window, clickin the top right side of the page.

*** Teachers are always provided with a printer-friendly format link. To enable students to print
a glossary, set "Allow print view" to Yes on the edit glossary page.

GLOSSARY CAPABILITIES

The glossary module has a number of capabilities available to create roles. With capability
overrides, you can enable your students to have a high degree of control over their glossaries.

Glossary capabilities are:

« Approve and undo approved entries: This allows a user to approve and undo the approval
of glossary entries. This capability is allowed for the default roles of manager, teacher and
non-editing teacher

« Create comments: This allows a user to add a comment to glossary entries. This capability
is allowed for the default roles of manager, teacher, non-editing teacher and student

« Export entries: This allows a user to export glossary entries to another glossary. This
capability is allowed for the default roles of manager, teacher and non-editing teacher

«  Export single entry: This allows a user to export single glossary entries to a portfolio. This
capability is allowed for the default roles of manager, teacher and non-editing teacher
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«  Export single entry of yours: This allows a user to export their own glossary entries to a
portfolio. This capability is allowed for the default roles of manager, teacher, non-editing
teacher and student

« Import entries: This allows a user to import glossary entries via XML file. This capability
is allowed for the default roles of manager, teacher and non-editing teacher

« Manage categories: This allows a user to categories for glossary entries. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

- Manage comments: This allows a user to delete comments to glossary entries. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

« Manage entries: This allows a user to add, edit and delete glossary entries. This capability
is allowed for the default roles of manager, teacher and non-editing teacher.

- Rate entries: This allows a user to rate glossary entries. This capability is allowed for the
default roles of manager, teacher and non-editing teacher

«  View glossary: This allows a user to view glossary entries within a glossary and also in the
recent activity block, random glossary entry block, RSS feed for the glossary and any auto-
linking glossary keywords. This capability is allowed for the default roles of manager,
teacher, non-editing teacher and student.

« View all raw ratings given by individuals: This allows a user to view all rating given to
glossary entries. This capability is allowed for the default roles of manager, teacher and
non-editing teacher

« View total ratings that anyone received: This allows a user to view the total rating that
anyone received for their glossary entries. This capability is allowed for the default roles
of manager, teacher and non-editing teacher

« View the total rating you received: This allows a user to view the total rating which they
received for their glossary entries. This capability is allowed for the default roles of
manager, teacher and non-editing teacher.

« Create new entries: This allows a user to add glossary entries. This capability is allowed
for the default roles of manager, teacher, non-editing teacher and student.

EFFECTIVE GLOSSARY PRACTICES

A glossary can be an important part of your course. As we discussed earlier, acquiring
vocabulary in a new field can be one of the biggest challenges to new learners. As an expert in
your field, you are comfortable using the important terms and concepts in your area of expertise.
Your students, however, are not experts. They may be just starting to learn new words
representing new ideas and concepts. More advanced students will need to refine their learned
definitions with subtle improvements to make the definitions more useful.
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Glossary Basics

At its most basic, E-leaning‘s glossary can be used like a regular word list for a class. You can
develop a list of terms you know students find difficult or confusing and make the list and
definitions available for your class.

If you want to get more in-depth, we recommend creating either a weekly or chapter- based word
list. Students can use it as they do weekly readings and assignments. A weekly glossary can
make it easier for students to organize their learning process.

Creative Glossary Strategies

While a basic glossary is important, creatively applying the glossary can really make an impact
on your class. Autolinking is very useful for integrating glossaries with other course activities. In
addition, you may want to make use of the Random Glossary Entry block to display glossary
entries on your course page. With the introduction of the database module, many activities can
now be either glossary or database activities. Glossary has two advantages over the database at
this point. First, many instructors find using the Random Glossary Entry block motivates students
to submit high-quality entries, because they know the entries will be shared with the class on the
front page of the course. The automatic term-linking is also useful to integrate the glossaries with
other activities in the course.

Collaborative glossaries

Instead of creating a glossary on your own, why not have the students create it as they encounter
unfamiliar terms? A collaborative glossary can serve as a focal point for collaboration in a
course. Each member of the class could be assigned to contribute a term, a definition, or
comments on submitted definitions. Multiple definitions can be rated by you and by the students,
with the highest-rated definitions accepted for the final class glossary.

When students are responsible for creating the definitions, they are much more likely to
remember the word and the correct definition. Engaging in the process of learning, debating, and
refining a glossary can go a long way toward helping students begin using new terms. E-leaning
community member Leslie Smith has created a glossary for students to submit entries that
contain the definition, part of speech, an original sentence using the word correctly, and some
type of mnemonic or visual device to help classmates remember the word‘s meaning. The visual
devices the students use are quite creative and definitely help with memorization.
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You can also structure multiple glossaries over the course of a semester. Break them up by unit,
chapter, week, or any other organizational structure. If you have a large class, assign student
teams to come up with definitions and answers.

One strategy for managing large courses is to make each team responsible for one week‘s worth
of definitions, while all the other teams must rate and comment. Alter- natively, each team could
be responsible for one definition per chapter and then rate and comment on the other teams*
work.

To set up a collaborative glossary, create a new glossary for each unit with the following options:

* Glossary type: Secondary glossary
» Duplicate entries allowed: If you want teams to be able to submit multiple definitions for
rating, select Yes
* Allow comments on entries: Yes
* Approved by default: Yes
» Allow entries to be rated: Yes—by everyone
The other options are up to you. Once you‘ve selected the above options, students can add their

own definitions, rate each other‘s, and add comments.

Mini-projects

Mini-projects are small research projects where students create small resources for each other.
One high school teacher has the students do research on organs in the body, then create an
encyclopedia-style entry in the glossary, including pictures and other resources.

Collaborative quiz questions

One of the most creative uses we‘ve heard about is using the glossary to create collaborative quiz
questions. Students are given the E-leaning question formats and they create questions in the
glossary matching one of the import types. The teacher has the glossary set to require approval,
which hides the submitted questions from other students.

When the students have all submitted their questions, the teacher exports the glossary and then
imports it into a question bank. The quiz can then be built from student- submitted questions.

Credit for word use
This is a combination strategy using the forum and the autolinked feature of the glossary.
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After you and your students have defined the glossary terms, it‘s important for students to begin
practicing using the words in realistic contexts. Students, however, are usually reluctant to
experiment with new terms. With the autolinking feature, it‘s easy to spot when a glossary word
has been used in a forum or in a posting on the web site.

To encourage word use, assign a portion of the credit students receive for their forum postings
for correct use of glossary terms. As you or other students rate posts, you can quickly scan for
highlighted glossary words and award points for usage. You may even want to break the score
down further. Perhaps award one point for using the word and two points for using it correctly.

SUMMARY

At first glance, the glossary doesn‘t seem to be a very interesting tool. You could simply create a
word list in a word processor and upload it. The power of the glossary tool in E-leaning comes
from its ability to automatically create links in your course for every word in the list, and to
easily build collaborative glossaries.

Use the glossary tool to help your students learn the vocabulary of your field and encourage them
to experiment with new terms. Collaborative glossaries give your students even more practice
using the new words and negotiating their meaning.
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Chapter 12: Lesson

The lesson module presents a series of HTML pages to the student who is usually asked to make
some sort of choice underneath the content area. The choice will send them to a specific page in
the Lesson. In a Lesson page's simplest form, the student can select a continue button at the
bottom of the page, which will send them to the next page in the Lesson.

There are 2 basic Lesson page types that the student will see: question pages and content pages.
There are also several advanced navigational pages which can meet more specialized needs of
the Teacher. The Lesson module is designed to be adaptive and to use a student's choices to
create a self-directed lesson.

The main difference between a Lesson and other activity modules available in E-leaning comes
from its adaptive ability. With this tool, each choice the students make can show a different
teacher response/comment and send the student to a different page in the lesson. Thus with
planning, the Lesson module can customize the presentation of content and questions to each
student with no further action required by the teacher. The question page presents the student
with a question, and the student has to enter a correct answer. After a student submits his answer,
he will see the response you‘ve created and will be taken to another page or looped back.
Question pages are scored and added to the student‘s cumulative grade.

A branch table‘s page presents the user only with the option to select a branch. There is no
correct or incorrect answer for each response, and the student‘s selections do not impact his
grade.

The authors of the lesson tool envision branches as tables of contents giving students access to
chains of questions. At the end of a chain, the user will return to the branch table, access another
one, or end the lesson. Of course, you don‘t have to create a lesson this way. You can use the
branch table to create a simulation in which the student‘s choices present him with consequences
and new decisions.

Creating a lesson isn‘t complex, but the math of branching lessons means you have to plan
carefully. Unless you prune your branching lesson, you will end up with a huge number of
options for students and a large number of pages to write.
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CREATING A LESSON ACTIVITY

Before you begin creating a lesson, it‘s a good idea to draw a flowchart. Lessons require more
advanced planning than many of the other tools. They have the potential for branching on each
page, so advanced planning is critical before you begin to develop your lesson. Even with two
choices per page, if every choice results in a new page, you will quickly need a very large
number of pages. The first page will require two additional results pages, and each of these will
require two more—for a total of seven pages from an initial two choices. The key to minimizing
the number of pages is to reuse as many as possible.

Take a few minutes to draw a flowchart for your lesson. What will the first page display? What
are the options? Where will the options take the student? It‘s important to answer these questions
for each page of the lesson to avoid getting lost while you are actually creating the content.

Once you have your flowchart, it‘s time to start creating a lesson.

To create a lesson:

«  Click the —Turn editing onl button.
+ In the section you wish to add your lesson, click the "Add an activity or resource” link and
Select "Lesson™,
« On the "Adding a new Lesson™ page give a descriptive name to your lesson in the Name
field.
+ In the Appearance Section:
o File pop: If you want to include a link to a file on the lesson page for students to
refer to, upload it here.
o Progress bar: Choose this to show a bar at the bottom of the page showing how far
into the lesson the student has got.

*** | esson Progress bar only works correctly for lessons with a "straightforward"
navigation, such as page 1 -> page 2 -> page n -> end of lesson.

o Display ongoing score: Choose this to let students see their score as they work
through the lesson.

o Display left menu: Choose this if you want to show a list of the pages in the Lesson
S0 a student can see what is coming up.

o Minimum grade to display menu: Choose this if you want the student to go through
the lesson once and get a grade before they can (on review) see and navigate
through all the different pages.
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Slideshow: If enabled, the lesson is displayed as a slideshow, with a fixed width
and height.

Maximum Number of Answers: This setting specifies the maximum number of
answers that may be used in the lesson.

Use default feedback: If enabled, when a response is not found for a particular
question, the default response of "That's the correct answer"” or "That's the wrong
answer" will be shown.

Link to next activity: To provide a link at the end of the lesson to another activity
in the course, select the activity from the dropdown list.
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Adding a new Lesson to 7 November - 13 November
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Figure 12-1 Adding a new lesson

In the Availability Section:
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Available from/Deadline: Here you can set a start and end date and time for your
Lesson.

Time limit: This allows you to set a time limit on the lesson. Students will see a
countdown counter as they work.

***The timer does not stop them doing the lesson when the time is up, but correct
answers are no longer scored.

Password protected lesson: Change to "Yes" and enter the password if you want
students only to access it when they know the password.

In the Prerequisite Lesson Section:

o

o

Dependent on: This allows access to the lesson to be dependent on students'
performance in another lesson in the same course.

*** You can also do the same thing by using the Conditional Activities.

Time spent: Decide here how long you want the student to have spent in the chosen
previous lesson.

Completed: Check this box if you want the student to have completed a previous
lesson.

Grade better than: Enter the grade from the previous lesson which you want the
student to have exceeded before they can attempt the current lesson.

In the Flow Control Section:

@)

Allow student review: If enabled, students can navigate through the lesson again
from the start. This puts a "Review Lesson" button on the last screen of the lesson
to encourage the students to navigate through the lesson again from the start.

*** The students will not be able to change their answers, only view them.

Provide option to try a question again: If enabled, when a question is answered
incorrectly, the student is given the option to try it again for no point credit, or
continue with the lesson.
Maximum Number of Attempts: This setting specifies the maximum number of
attempts allowed for each question. If answered incorrectly repeatedly, when the
maximum is reached, the next page of the lesson is displayed.
Action after correct answer: Choose here where you want a student to be sent to if
they get a question right, there are 3 options for the following page:
= Normal - Follow lesson path
= Show an unseen page - Pages are shown in a random order with no page
shown twice
= Show an unanswered page - Pages are shown in a random order, with pages
containing unanswered questions shown again.
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= Number of pages to show: This setting specifies the number of pages shown
in a lesson. It is only applicable for lessons with pages shown in a random
order. If setto zero, then all pages are shown.

« In the Grade Section:

o

Grade: Select the type of grading used for this activity. If "scale” is chosen, you
can then choose the scale from the "scale™ dropdown. If using "point" grading, you
can then enter the maximum grade available for this activity.

Grade category: This setting controls the category in which this activity's grades
are placed in the gradebook.

Practice lesson: A practice lesson does not appear in the gradebook. Use this if you
don't need the lesson to be scored/graded but just need students to work through
some pages.

Custom Scoring: If enabled, then each answer may be given a numerical point value
(positive or negative).

Re-takes allowed: If enabled, students can attempt the lesson more than once.

*** Note that this setting only applies to lessons containing Question pages.
Lessons consisting only of Content pages can be re-taken even if 'Re-takes
allowed' is set to No.

Handling of re-take: If you allow your students to re-take the lesson, then decide
here if the grade for all lesson attempts is the mean or the maximum.
Minimum number of questions: This setting specifies the minimum number of
questions that will be used to calculate a grade for the activity. Students will be told
how many they have answered and how many more they need to answer.
= |If you are using Content pages, then set this to 0.
= |If you use this setting, then add some explanatory text at the start of the
lesson so the student knows how many questions they must answer as a
minimum.

+ In the Common module settings section:

o

@)

Visible: Make the lesson activity Visible/Hidden from the students.

ID number: Provide an ID number for the lesson for grade calculation purposes.

. Click "Save and return to course".

BUILDING LESSON

Once you click the Lesson name on the course page then E-leaning will take you to the edit
lesson page as shown in the following screenshot.
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Preview Edit Reports Grade essays
Collapsed Expanded

What would you like to do
first?

Import questions
Add a content page
Add a cluster

Add a question page

Figure 10-2 Building lesson page

But Before proceeding to the edit lesson page and adding content and questions to the lesson, we
must first plan about the lesson.

PLANNING YOUR LESSON

« Alesson is made up of pages which may have content for the student to read or questions
for them to answer. The questions can be created by the teacher or imported. The teacher
decides the order in which these pages appear.

« You need to have a clear idea beforehand of what you want to do with this lesson. Is it to
be a graded, linear learning experience? Or an ungraded, nonlinear practice session? Will
students be able to go back and revisit areas or is it just a once-only opportunity?

« Even those who are very comfortable working directly online might find it useful to note
down on paper the direction they want their lesson pages to go in, rather than having to
remember and visualize the navigation in their head.
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ADDING CONTENT AND QUESTIONS TO YOUR LESSON

Import questions

[ If you have some questions in the following formats, you can import them to use in your
lesson by clicking the Import questions link.

Import questions @

File format*

Gift format v
i Aiken format A
Blackboard

Blackboard

Embedded answers (Cloze)
Examview

Learnwise format

Missing word format

Moodle XML format

WebCT format

Figure 10-3 Importing questions to lesson
Add a content page
- This is a page where a teacher can provide information to move the lesson forward but
without requiring the student to answer specific questions.
« The student sees the page's title, some information and then one or more buttons at the

bottom to select.
«  When the student clicks on a button, they go to the next page but their choice is not scored.

Title

« The title of a content page appears to the student at the top of the page.
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A teacher will also see the title in the collapsed edit mode when they are working on the
Lesson, and they will also be able to choose the title (and hence this page) from the drop
down "jump” lists.

The title in a content page is also used with the "display left menu" setting.

Page contents

[1 This is where the teacher can add information for the student, making use of the Text

editor and its multimedia features.

Content

Here the teacher writes the words they want the student to click on to get to the next part
of the lesson.

These words will appear to the student as a button.

The teacher can check the box to have the buttons appear horizontally, or uncheck it for
them to appear centered vertically.

Format

There are 4 format types to choose from when editing text in the content description box.
If you wish to have the usual rich text editing icons, choose HTML format. (Note - once
you have selected an option, you cannot then go back and change your mind!) However, if
you DO choose HTML format, be warned that the student will not see the changes (such
as bold or different colors) in the button.
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Content 1

Description*

Paragraph -

Let's move on \

Psth: p I HTML format chosen I
Jump
This page v
~ Content 2 \

choose the next
page to move to

Description

Figure 10-4 Add a content page in lesson

Number of options available
How many of these you have depend on your choice in the Maximum Number of

Answers setting in Lesson settings

The Jump

« Each Description in a Content page has a Jumps menu. "Jumps" take a student from one
page to another.

- A relative jump" is "next page" or "end of lesson" whereas an "absolute jump" gives the
actual name of a page.

«  The teacher chooses from the dropdown the correct page to send the student to if they click
on the button that will be made from this particular description. Any pages created by the
teacher will have their titles appear in this dropdown, allowing them to be selected.

« When a student clicks on a description button, they are sent to the page defined in the Jump
associated with the button.

Add a cluster

A cluster is a group of question pages which will be offered randomly to a student as they work
through the lesson. It is best if you have made the question pages beforehand and can then decide
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where to mark the start and end of the cluster. The start is marked by a "cluster" page and the end
by an "end of cluster" page.

Add a question page

«  From this link you can choose from a variety of question types which will then be added
as pages to your lesson:

~ Create a question page
Select a question type | Multichoice v
| Essay
Matching f
Numerical |
| Short answer
True/false

Figure 10-5 Select a question type

«  The format of question pages is similar to content pages.
v Create a question page

Page title*
Country moftio
Page contents*
Paragrapgh  ~ R | | ‘=

Which country has the motto One People, One Goal, One Faith?

Path: p » strong

Figure 10-6 Add a question page

«  Atypical question page could include:
o Title - the name the student sees at the top of the question page.
o Page contents - the actual question
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o Answer/Response/Format/Jump/Score as in the screenshot below

Answer 1

Answer® Senegal

L type an answer l

[Moodle auto-format v |

Response [Correct! Well done!

type feedback [

[Moodie auto-format ~|
Jump @ [Next page -,

_ S |1 l “
decide the * decide where to
score send student to

next

Figure 10-7 Response form for the question page

Question types:

Multichoice

The student is given a question and a list of answers. The answer list will be shuffled every time
the question is view by a student. By default they choose one answer but you can check the box
"multiple answers" to allow them to choose more than one answer.

Essay
Students can write a longer answer as part of the lesson and this can be graded manually by the
teacher.

Matching
This allows you to set up lists which must be matched against other lists, for instance, words,

pictures, numbers etc. The student must match all correctly to receive the score.
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1)

Truetaise

Moodie Is & course managemaent system?

Figure 10-8 Lesson construction

Numerical

This requires a number as an answer. A number within a range may also be accepted as correct.

The range separator to be used is the colon (:).
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---------

Wirnrg raner e

Wroeg preeer tiory

Short answer

A student must provide a single word or short phrase answer. The teacher must anticipate the
possible answers and enter them in the Jump dropdown boxes, using ** wild cards if appropriate.

True/false

Figure 10-9 Adding true/false question page
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The student is given a sentence and must decide if it is true or false.

MOVING YOUR LESSON FORWARD

Once you have added your first content or question page, you reach the next screen which
displays your page title/type/jumps (i.e. where the responses take the student to) and actions
you can take next:

The Actions icons allow you to move (if you have more than one), edit, and preview or
delete your pages.

The drop down allows you to create another page of your choice:

Preview Edit Reports Grade essays

Collapsed Expanded

Page title Page type Jumps Actions

Essay on using Moodle in blended learning Essay Next page

@

# Q X Addanewpage E‘

Figure 10-10 Collapsed view of Edit lesson page

Note the different view options:
0 Collapsed view: This gives a brief outline of the lesson structure. o

Expanded view: This shows more detail as in the screenshot below:

Preview Edit Reports Grade essays

Collapsed Expanded

Import questions | Add a content page | Add a cluster | Add a question page here

Essay on using Moodle in blended learning 4 # Q X

You need to write an essay on the usage of Moodle in the field of Blended leaming

Essay

ETEH  Next page

Import questions | Add a content page | Add a cluster | Add an end of branch | Add an end of cluster | Add a question page here

Figure 10-11 Expanded view of the edit lesson page
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ENDING YOUR LESSON

« To bring the lesson to a close, select the "End of Lesson™ option from the Jump menu on
any relevant pages.

«  The student will then see a generic message as in the next screenshot, with a direction back
to the main course page or to view their grades:

Congratulations - end of lesson reached

Return to Bloiogy Level 2

Vigw grades

Figure 10-12 End of lesson

MANAGING LESSONS

When you click on the lesson then you will see tabs at the top offering the chance to preview,
edit, view reports or grade essays in the lesson.

« Preview Tab: The lesson opens up in preview mode for the teacher. However, it will not
show the score unless the teacher switches their role to a student.

- Edit Tab: The Edit tab allows teachers to alter the lesson once it has been set up. There are
two views - Collapsed and Expanded.

+ Reports Tab: The reports tab shows the performance of students taking the lesson. There is
a general "Overview" and a "Detailed Statistics" tab.

o Overview Tab: By clicking on the specific attempt, the teacher can view the
student's answers to specific questions. It is also possible to delete a student attempt
by checking the attempt and using the pull down menu to change "Choose™ to
"Delete". Below the "Overview" can also be seen general statistics: Average score,
Average time, High score, Low score, High time, Low time.

o Detailed Statistics: More detailed reports on individual questions are available from
this tab.

« Grade essays Tab: Any essay questions which have been set in the lesson can be accessed
and graded here.
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As students complete the lesson, their scores will be recorded in the gradebook. If you‘ve
allowed students to attempt each lesson multiple times, their scores may change as they repeat
the lesson.

LESSON CAPABILITIES
The lesson module has only two capabilities:

- Edit a lesson activity - This allows a user to edit a lesson. If you create a blank lesson and
allow students to edit it, they can create a new lesson for the rest of the class.
« Manage a lesson activity - This allows a user to manage a lesson and grade essay questions.

Name Eanays Email

Figure 10-13 Grading an essay

EFFECTIVE LESSON PRACTICES

Lessons can be an interesting change of pace for your students. They may require more upfront
development time than many other types of tools, but they do provide some benefits. The two
basic lesson types, branching quizzes and flash cards, are relatively easy to set up.

Branching Quizzes

The most basic lesson structure is a branching quiz. You use branches to organize sets of
questions around different topics or concepts in your course. Each branch of the quiz leads to a
linear series of pages and test questions, then returns to the main branch.

The main-branch page acts as a table of contents for the lesson, if you decide to build this type of
lesson, be sure to include a link to the end on the main page. If not, the students will have no way
of ending the lesson and recording their scores.

If you create a lesson with a branch table and strings of questions, be sure to set a reasonable
minimum number of questions. Otherwise, students will be able to visit one branch and receive a
maximum score for the lesson, even though they didn‘t look at any other branches.
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.
Branching
Table
;|—/

I T 1
Question Question Question
Page Page Page

| | |
Question Question Question
Page Page Page
| | |
Question Question Question
Page Page Page

Figure 10-14 Branching quiz schematic

To create a branching quiz:

» Create the lesson and the first question page by following the instructions.

» Create a question page for the first question in each branch.

» Create a branch table with a branch for each of the questions you just created.

» Be sure to make the last branch a link to the end of the lesson.

» After you‘ve saved the branching table, move it to the top of the pages list.

» Under the first question for the first branch, create the second question page for the next
step in the branch.

» Fill in the question page for the second question. Put the correct answer in the first answer
slot if you are creating a true/false or multiple-choice question.

» Continue adding questions to the branch until you are finished.

» Add an end of branch after the last question in the branch.

» Below the first question for the each of the remaining branches, repeat steps 6 through 9.

* When you have added all your pages, review your lesson by clicking the Check Navigation
link.

Flash Cards

Flash cards can be a useful way to practice recalling basic facts and definitions. Flash cards allow
students to practice rapidly recalling definitions as an initial step toward learning how to
communicate in a new field. The lesson module can act like a deck of flash cards, presenting
either the whole deck or a subset of cards to students when they want to study the new terms.
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Each question page is a separate card, and students can rapidly react to each one in turn. This is a
very different structure than the branching quizzes. Setting up a flash-card lesson requires
specifying options when you first create the lesson.

To create a flash-card lesson:

1.
2.

Follow steps 1 through 4 for creating a lesson in the —Creating a Lessonl section.
Consider setting a low value for the maximum grade. You want to reward students for
using the flash cards but also make them a valuable learning tool.

Use the following options:

o

Maximum grade: Consider setting a low value for the maximum grade. You want
to reward students for using the flash cards but also make the cards a valuable
learning tool.

Student can re-take: Unless you have a very specific reason for limiting re-takes,
it‘s best to set this to yes. Flash cards are used to practice recalling information
rapidly. Save the assessment of students‘ recall skills for a quiz.

Handling of re-takes: If you set this to use maximum, it will encourage students to
reuse the flash cards to attempt to get the maximum score. o Action after correct
answer: Set this to unseen or unanswered. This tells the lesson module you don‘t
want it to present the next page in order.

Minimum number of questions: Keep this at zero. The students shouldn‘t have a
choice about the number of cards they see.

Number of pages (cards) to show: If you want to limit the number of questions
students see each time they practice with the cards, set this to a nonzero number.
Make it large enough to give students enough practice, but not so large that they
become fatigued by the sheer volume of questions.

4. Once you save the lesson options, simply create question pages. The order doesn‘t matter.
You‘re basically creating a deck of questions to draw from.

Once you‘ve created the deck of flash cards, you can release it to your students so they can
practice answering the questions you‘ve created.

CREATIVE LESSON USES

While branching quizzes and flash cards are interesting applications, there is a hidden potential
in the lesson module that makes it much more interesting than it at first appears. If you take
advantage of the ability of each answer in a question page to link to any other page, you can
create branching Choose Your Own Adventurestyle simulations or case studies.
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Self-directed learning of a new topic

Use the lesson to introduce a new topic. The learner starts out knowing nothing but can progress
at his own pace, reviewing what he is not sure of and moving on when he feels ready.

Allow for different learning styles

When using the lesson to introduce a new topic, offer pages that deliver the content in different
ways, according to how the students prefer to learn. For example the button "do you prefer to
read?" goes to a page of text; "do you prefer to watch a video?" goes to a screencast; ""do you
prefer to listen to instructions?” - goes to a podcast and so on.

Role play simulations/Decision-making exercises

Use the lesson to set up situations where the learner has to make a choice each time and the
scenario changes according to their selection. This could be a medical emergency for example,
deciding upon the correct treatment, or a customer relations exercise, learning how best to deal
with an awkward client. In an educational establishment it could serve well in Humanities
subjects considering moral/ethical issues.

Interactive fiction

For younger (and not so younger!) students, the lesson can be used to create a "choose your own
ending" type of story where the student reads a page (or even watches a video/listens to an audio
file) and then decides upon the character's next move. Apart from the entertainment value of this,
it could be used to help guide preteens to behave responsibly by taking decisions for a character
that is in a potentially dangerous situation.

Differentiated revision guides

Students can be taken to different sets of revision questions according to their answers, allowing
them to progress from basic to intermediate to advance according to their prior knowledge.

SUMMARY

A lesson activity is self-directed learning tool. The lesson activity‘s adaptive ability is what
makes it unique. Questions in a lesson can be used to create branch points where students are
taken down different paths in the lesson depending on how they answer the question. When each
answer to a question takes a student to a different series of pages, the lesson becomes a self-
directed teaching tool.
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Chapter 13: Wikis

A wiki is a collection of collaboratively authored web documents. A good example of such a tool
is WikiPedia which has become a knowledge encyclopedia for world information. Basically, a
wiki page is a web page everyone in your class can create together, right in the browser, without
needing to know HTML. A wiki starts with one front page. Each author can add other pages to
the wiki by simply creating a link to a page that doesn't exist yet.

A wiki is indeed a fast method for creating content as a group. It's a hugely popular format on the
Web for creating documents as a group. There is usually no central editor of a wiki, no single
person who has final editorial control. Instead, the community edits and develops its own
content. Consensus views emerge from the work of many people on a document.

In E-leaning, wikis can be a powerful tool for collaborative work. The entire class can edit a
document together, creating a class product, or each student can have their own wiki and work on
it with you and their classmates. You can also consider using wikis for online collaborative
assignments ranging from peer reviewing of papers to group reports, to even a new Wikipedia
like page based upon your course or a single assignment learning outcomes.

A history of previous versions of each page in the wiki is kept, listing the edits made by each
participant.

Wikis have many uses, such as

«  For group lecture notes or study guides

« For members of a faculty to plan a scheme of work or meeting agenda together

« For students to collaboratively author an online book, creating content on a topic set by
their tutor

« For collaborative storytelling or poetry creation, where each participant writes a line or
verse

« As a personal journal for examination notes or revision (using an individual wiki)

L

Creating a wiki is very simple and most of the work involved with creating wikis becomes easier
once you start using them.

CREATING WIKIS
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To add a wiki to your course:

Click Turn Editing On if you are not already in the editing mode.
Click 'Add an activity or resource' link, then in the activity chooser, select "Wiki" and click
the Add button.

&% Adding a new Wiki to 17 October - 23 October

General
WR| Name

Description

DInpiisy @escriplion on coutee
page

Wiki moas
First page name
Format
Deteunt format

Fares tormat

Common module sottings

Figure 13-1 Adding a new wiki

Enter a name* and describe the purpose of the wiki and what you expect students to
contribute in the description* field.
The wiki mode determines whether everyone can edit the wiki - a collaborative wiki - or
whether everyone has their own wiki which only they can edit - an individual wiki.
Enter the first page name of the Wiki in the "First Page Name"* field.
In the Format Section, you can set the Format of the Wiki. There are 3 options to choose
from:

HTML- The HTML editor is available

Creole - A common wiki markup language for which a small edit toolbar is

available

o Nwiki - Mediawiki-like markup language used in the contributed Nwiki module.
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- If the format is forced (checkbox ticked), there is no option to choose a format when editing
a wiki page.

+ In the "Common Module Settings™ section, You can choose to either completely hide the
Wiki from students by choosing Hide in the Visible dropdown .

« You can also set an ID number: Setting an ID number provides a way of identifying the
activity for grade calculation purposes.

« The group mode defined at course level is the default mode for all activities within the
course. Each activity that supports groups can also define its own group mode, though if
the group mode is forced at course level, the group mode setting for each activity is ignored.
This setting has 3 options:

o No groups - There are no sub groups, everyone is part of one big community

o Separate groups - Each group member can only see their own group, others are
invisible

o Visible groups - Each group member works in their own group, but can also see
other groups

« A grouping is a collection of groups within a course. If a grouping is selected, students
assigned to groups within the grouping will be able to work together.

+ Click Save and Display at the Bottom of the page.

There are two wiki types (modes), collaborative and individual. In addition, like any activity, the
wiki has the E-leaning group modes: —No Groupsl, —Separate Groups| and —Visible Groupsl.

According to the wiki mode and the group options selected by you the format of wiki which will
be displayed to the students and the permissions for them will be different.

- Collaborative

o No Groups: There is only one wiki. The teacher and all students can view and edit
this wiki.

o Separate Groups: There is one wiki per group. Students can view and edit the wiki
of their own group only.

o Visible Groups: There is one wiki per group. Students can change the wiki of their
own group only. They can view the wikis for all groups.

« Individual

o No Groups: Every student has their own wiki which only they and their teacher can
view and edit.

o Separate Groups: Every student has their own wiki, which only they and their
teacher can edit. Students can view the wikis of other students in their group.

——
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o Visible Groups: Every student has their own wiki, which only they and their teacher
can edit. Students can view the wikis of all other students in the course.

CREATING FIRST PAGE OF YOUR WIKI

After you create the wiki activity, E-leaning will itself take you to the first page; there also you
can change the format of the wiki. Click "Create Page" to proceed. On the edit page screen:

+ Enter the content of the first page of your wiki in the HTML format field, if you are using
the HTML format.
« You can use the E-leaning's native HTML editor for showcasing your content.

Adding more pages:

«  Type the name of your page inside double brackets. (as shown in fig 11-2 below) You can
preview it by clicking the "preview" button towards the bottom of the screen.

«  Press the "save" button.

«  Now click the (red) link for one of the pages (as shown in screenshot below) and you will
be prompted to create it in the same way you create the first page. [1 A page once created
has a blue link.

*** |f you use the New option from the navigation block you will still need to copy and paste the
name of the new page onto the immediate parent page and surround it with double brackets. This
creates a link to your new page and makes it accessible from the main Wiki page. Otherwise
nobody will recognize the so called lost new page.

EDITING WIKI ACTIVITY

Depending on the type of the wiki, there are several ways to edit your page. The best thing of a
wiki is, that nothing is lost. The old version will be there - and if someone changes your version
of the page - your version will also be there.

*** The options for editing, commenting viewing history, map and files may all be accessed both
from tabs at the top and links in the navigation block:

View: The View tab at the top or link in the navigation block allows users to display and view
the wiki page.

——
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Edit: The Edit tab at the top or link in the navigation block allows users to edit the wiki page.

Moodle features

Moodle activities

=TML formae

Editing this page 'Moodie activites

Figure 11-2 Editing a wiki page

Comments: The Comments tab at the top or link in the navigation block allows users to see and

add comments about the wiki.

History: The History tab at the top or link in the navigation block allows users to see what has
been altered in the wiki. You can compare the edits by clicking the "Compare Selected™ button.
You can also restore by clicking the "Restore™ button of the version you wish to restore if the
latest edit is unsuitable as shown in the figure 11-4.
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Map: The Map tab at the top or link in the navigation block allows users to view areas of the
wiki such as a list of pages (as in the following screenshot), updated or orphaned pages etc. To
select what you want to see, click the Map menu dropdown box.

Files: The Files tab at the top or link in the navigation block allows users to access any files
which have been added to the wiki. By default, the Teacher role can add and manage files to the
Files tab, but the Student role can only view them. You could change this though with a
permissions override to the Manage wiki files capability (mod/wiki:managefiles) in any
particular wiki.

Administration: The Administration tab at the top or link in the navigation block is available to
editing teachers in the course so they can delete page versions or selected pages. Clicking the
"list all" button will list available pages to delete. The first page of the wiki cannot be deleted.

Moodle features

Moodie activities

Tags

Figure 11-3 Viewing a wiki page

WIKI CAPABILITIES

«  Create new wiki pages: This allows a user to create new pages in a wiki. This capability is
allowed for the default roles of manager, teacher, non-editing teacher and student

« Add comments to pages: This allows a user to add a comment to wiki pages. This capability
is allowed for the default roles of manager, teacher, nonediting teacher and student.

- Save wiki pages: This allows a user to edit the wiki pages. This capability is allowed for
the default roles of manager, teacher, non-editing teacher and student.

« Manage wiki comments: This allows a user to delete comments on wiki pages. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.
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- Manage wiki files: This allows a user to manage, delete files attached to the wiki. This
capability is allowed for the default roles of manager, teacher and nonediting teacher.

Moodle features

Moodle actlvities

D Vervon user Moginee

Figure 11-4 History of a wiki page

« Manage wiki settings: This allows a user to edit the wiki settings. This capability is allowed
for the default roles of manager, teacher and non-editing teacher.

« Override wiki locks: This allows a user to override locked wiki pages. This capability is
allowed for the default roles of administrator, teacher and nonediting teacher.

«  View page comments: This allows a user to view comments on wiki pages. This capability
is allowed for the default roles of manager, teacher, non-editing teacher and student.

«  View wiki pages: This allows a user to view the wiki pages. This capability is allowed for
the default roles of manager, teacher, non-editing teacher and student.

*#* If you have group wiki projects, consider assigning the —Override locked pagesl capability
to the students so they can manage their own wikis.

EFFECTIVE WIKI PRACTICES

Wikis are gaining popularity as a collaborative tool in many environments. There are now several
commercial vendors offering wikis for group collaboration in corporate settings. Many social
web sites also have wikis to allow their members to collaborate on documents. Effective
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management practices are the key to a wiki‘s success. You‘ll need to think about your wiki‘s
editorial policy, as well as its educational objectives.

Moodle features

Moodle activities

Figure 11-5 A Version diff

Wiki basics

Wikis are a simple, flexible tool for collaboration. They can be used for everything from simple
lists of web links to building entire encyclopedias. Wikipedia is the largest wiki in the world
(http://www.wikipedia.org). The entire Wikipedia site is written by volunteers from around the
world. An article is started by someone with an interest in the subject, and then anyone in the
community can add content, edit other people‘s work, or add another page elaborating on a sub-
topic. It has become so large and so frequently used that there is a lively debate about how
authoritative a collaborative work without a central editor can be.

Of course, wikis in your own class won‘t be that extensive. But it‘s important to have a plan for
your wiki before you release it to the class. Students need to know the purpose of the wiki and
how it fits in with the class. If it‘s a personal wiki, will they be graded? Is it simply a staging area
for group work that will be submitted later? Students need to know so they can submit
appropriate work. A brainstorming wiki is very different from one that will be submitted for a
grade.

You‘ll also need to decide on an editing policy. Will you be a central editor? Or will you let the
students be completely responsible for the work? How will you deal with offensive content?
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In most circumstances, you‘ll find that you can trust students. But on the rare occasion a student
does do something offensive, you will need to have a policy to deal with it. Will you roll back the
changes by that author? Or will you create a new version by deleting her content? Creating a new
version leaves a trail you can use for evidence later, but it also makes it easier for the perpetrator
to restore her comments.

CREATIVE WIKI PRACTICES

The free-form, collaborative nature of wikis makes them easy to apply in creative ways. Any sort
of group process can be facilitated using a wiki.

Group lecture notes

Creating a wiki for group lecture notes after a lecture gives students a chance to combine all their
notes. Those that missed information can get it from their peers. The group can also decide what
information is critical and give it proper emphasis. Group lecture notes could be done with the
entire class, if it is small enough, or with small working groups. Groups can also compare notes
for further discussion and refinement.

Group Project management

A teacher assigning a group project can give students a place to work by creating a wiki with the
group mode enabled. This will give each group their own space to record research, to develop
outlines and to create the final product.

Idea Generation

Idea generation is a non-judgmental group creative process in which group members are
encouraged to give voice to any ideas they personally consider relevant to the group exercise. In
a face-to-face meeting, a facilitator will usually stand in front of a big piece of paper and elicit
ideas from the participants in the room. A teacher can create an online version of this process by
setting up a wiki for the entire class or for smaller student groups and asking people to submit
ideas around a topic. People can add ideas as they occur and link to other pages for elaboration.

Contribute to other wikis

A teacher might assign his or her class the task of contributing to Wikipedia, Wikiversity, or to
another wiki on the Web, on any class topic, perhaps by assigning students to groups (or making
it a class project if the class is small enough and the topic broad enough) and challenging them to
collaboratively create an article they would feel confident posting to a public-information space.
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Students will use the course wiki to create drafts of the article they will eventually publish to the
community at the end of the semester.

Collaborative story-telling
Younger students could be encouraged to work together on a wiki to build up a story each adding
a sentence following on from the previous contribution.

SUMMARY

Wikis can be used to help promote group-based learning by providing spaces for students to
work together to create pages built on ideas, constructive feedback, and current projects. Wikis
are flexible tools for collaboration that you can implement to improve your course and students*
understanding of the material. In the next chapter we will take a look on Blogs and how it
inspires course participants for purposeful online writing.
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Chapter 14: Blogs

Blogs are a form of online journal used by millions of people around the world for selfexpression
and communicating with family and friends. Blogs are usually organized as a chronological
series of postings created by the author of the blog. Blogs usually are written by one person,
although some blogs can be authored by groups of people. The word 'blog' is a contraction of
'web log'.

As the role of technology in the classroom continues to grow, teachers are turning to blogging to
give students a voice, inspire purposeful writing, provide an authentic audience, and publish
student work. Blogging is a powerful tool that gets students excited about writing and allows
them to connect with others around the world.

Blogs are growing in importance around the world. They are used by everyone from teenagers
posting who they like or dislike at school to CEOs communicating directly with their customers
to dissidents in oppressed populations expressing their political views.

Blogs in E-leaning are user based - each user has their own blog. Users can also register their
external blogs, such as Blogger or Wordpress, so that entries are automatically included in their
E-leaning blog.

USING BLOGS

Blogs in E-leaning are user-based—each user has his own blog, which is non-coursespecific.
Your profile page contains a Blog tab for accessing your blog page, as shown in Figure 12-1.

Adding a blog entry
To add a blog entry:

«  From the Navigation block, click on Blogs>Add a new entry or Alternatively, if the Blog
menu block is enabled in the course, click Add a new entry there.
«  Write your entry and give it a title.

——
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« If you want to attach a file, click the Add button to access the File picker to locate a file.
Be sure your document is smaller than the maximum attachment size. Alternatively, drag
and drop your file into the box provided.

«  Choose who you wish to publish the entry to i.e. who may see the entry. There are three
options:

o Yourself i.e. your blog
entry is a draft

o Anyone on your site 0
Anyone in the world

- Select appropriate official tags for your entry and/or add one or more user defined tags. If
you add more than one, they should be comma separated. [1 Click on the "Save changes"
button.

Blog entry by Admin User

Figure 14-1 A blog page

You can edit your blog entry at any time using the Edit link at the bottom of the entry. You may
want to change the publish option from yourself to anyone on the site. You can also delete the
blog entry completely if you wish.

Viewing Blog Entries

You can view all of your entries by Navigation Block >My Profile >Blogs > View all of my
entries or else from Blog Menu Block > View all of my entries if the Blog Menu block

is enabled.

You can also access all the entries in your course, your entries in the course and add a new entry
from the Blog Menu block.

Alternatively, you can choose to view all blog entries with a particular tag via links in the Blog
Tags block (which we‘ll cover in the next section).

Blog visibility
By default, all site users can view all blog entries via the Navigation Block > Site Pages > Site
Blogs link in the Navigation Block if it‘s enabled by your site administrator. However, your
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system administrator may have restricted blog visibility site-wide so that users can only see blog

entries for people with whom they share a course or a group.

L

Figure 12-2 Adding a new blog entry

BLOG PREFERENCES

The —Blog preferencesl link in the Administration > My Profile Settings > Blog > Preferences -
allows you to choose how many blog entries are displayed on a page. The default number of

entries is 10.

Blog Tags

——
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A tag is a relevant keyword or term associated with a blog entry, describing it and enabling
keyword-based classification of information for the purpose of retrieval. Typically, a blog entry
will have one or more tags associated with it.

You can add new blog tags when adding or editing a blog entry. There are two types of tags:

+ User-defined tags : Personal tags that any user can add
- Official tags: Added by an administrator and available for any site user

Blog Tags block

To encourage the use of blogs in your course, you may wish to add a Blog Tags block, as shown
in Figure 12-3, to your course page. A Blog Tags block displays a —tag cloud,l i.e., a list of tags
where more frequently used tags appear in a larger font size. Tags can be listed in alphabetical
order or according to the last date used, depending on how the Blog Tags block is configured.

To add a Blog Tags block to your course page:

- Enter the Editing Mode by clicking the Turn Editing Mode On. [J Select Blog Tags from
the —Add blocksl menu.

« If appropriate, move the Blog Tags block up and/or left, using the * drag and drop icon
under the block title..

To configure a Blog Tags block:

«  Click on the gear icon in the block header with link "Configure Blog Tags Block™.

« On the Blog Tags configuration page, as shown in Figure 12-4, adjust the settings as
required or leave them as default.

«  Click the —Save changesl button.

Blog tags = |1

Exam French
Homework
Learning manara

Maths Science
Weekend

Figure 12-3 Blog tags block
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BLOG CAPABILITIES

Blog capabilities focus on entries and tags, as you might expect.

*** These capabilities are set at the global level, so as a teacher you may not have the ability to
change them.

«  Create new blog entries: This allows a user to write blog entries.

- Edit and manage entries: This allows a user to edit and delete other users' blog entries. The
default manager, teacher and non-editing teacher roles have this capability set to allow.

- Edit and manage external blogs: This allows a user to register external blogs, such as
Blogger or Wordpress so that entries are automatically included in their E-leaning blog.
This capability is allowed for the default authenticated user role.

« Search blog entries: This allows a user to search blog entries via the Blog menu block.

« View blog entries: This allows a user to view another user's blog entries. The default
authenticated user role has this capability set to allow. If you prohibit this capability, the
user will not be able to read any blogs on the system.

« View draft blog entries: This allows a user to view another user's draft blog entries. Only
the default manager role has this capability set to allow.

«  See all user blogs: This allows a user to view the blogs of other users. The capability is
set to allow by default for the Manager, Teacher, Non-editing teacher and Student role. (It
is not set for Guests and Course Creators.)
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Configuring a Blog tags block

Block settings
Ulog tags pjock nee
Number of tags 10 display

OI1800y LGS USEA wiThin e many

days

S0t the tay display by
Whete Ihis block appears

Onginal hlock loeation

PFage contexts
Detaun region

Cufault wasghi

On this page

e € e

Figure 12-4 Configuring blog tags block

EFFECTIVE BLOG PRACTICES

253

——

Associate blog entries with courses: This allows a user to associate blog entries with
courses. This makes it possible for a user to blog "about™ a particular course. This capability
is allowed for the default roles of manager, teacher, nonediting teacher, student and
authenticated user.

Associate blog entries with activity modules: This allows a user to blog about a particular

activity. This capability is allowed for the default roles of manager, teacher, non-editing
teacher, student and authenticated user.

Blogs in E-leaning are a relatively new feature, which many people are still learning how to use.
There are currently very few examples of good usage of blogs. Most blogs are either blogging for
the sake of blogging, or an ill-defined —learning journall where students engage in
unstructured reflection on what they are learning. It‘s difficult to maintain students®
motivation for either of these activities. Students who are engaging in purposeful blogging for the
first time will have a difficult time successfully posting without scaffolding and some clear goals.
Perhaps a weakness in blogging assignments comes from a lack of first-hand experience on the
part of teachers but | am sure that my readers must be having enough experience with the
blogging so that they can provide the required scaffolding and clear goals to their students.

'



How to use E-leaning

To begin to understand blogging, we would strongly recommend starting your own blog in E-
leaning. This experience will help you understand blogs better, and it will also give you another
channel to communicate with your students and/or colleagues. As you develop your blog, notice
which posts are easy to write and which are a struggle. Do you post regularly? Or do you need to
remind yourself to post? Creating interesting posts on a regular basis is not easy, nor is making
time to post regularly. However, if you set a good example for your students, you will find it
easier to create good blogging activities.

The most important element of running an effective blog as part of your course is to have a
clearly defined goal for student blogging.

At the beginning of a course, do a quick poll of your students. How many of them are blogging
now? Why are they blogging? Many of your students will have either Twitter or Facebook
accounts where they can post updates of their activities to their friends. But social blogging is
different from blogging in a learning environment, and you will need to work closely with your
students to create effective blogs.

It‘s recommended that you allow each student to create his own blogging goals. As David
Hawkins writes in his book The Roots of Literacy, —Children can learn to read and write with
commitment and quality just in proportion as they are engaged with matters of importance to
them, and about which at some point they wish to read and write.|

Blogging is essentially a writing exercise but you should also keep the audience in mind. It can be
a personal, reflective exercise, or it can be a forum for posting about the ideas and concepts
important to the author.

Once your students have started blogging, they may respond better if they have an audience.
Knowing someone is reading your posts is a great motivator to continue writing. Be sure to
comment, either via messages or in class, on posts students have made public. If students want to
keep their posts as private reflections, allow them to do so. Blogging is always personal, and your
blogging authors need to feel a sense of control over their personal posts.

One simple way to incorporate blogging into nearly any course is to create a single class blog and
post case studies, news items, or topics for commentary. Another option is to assign students to
post notes on each class along with their thoughts on the material, and assign other students to
comment on the postings.

Blogging Etiquettes for students:
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Be honest and fair: bloggers should avoid plagiarism, always cite (and possibly link to)
their sources, never post inaccurate information, distinguish between facts and
commentary, and refrain from distorting facts.

Treat human beings with respect: bloggers should be polite and considerate when
addressing other Internet users, especially in the case of children, and avoid intruding into
anyone's privacy.

Be responsible: bloggers should admit and correct their mistakes, explain the aim of each
blog and invite dialogue with readers over the blog's content.

Be polite: Write in a positive, friendly way. Do not use sarcasm or nasty language. Also,
avoid using ALL CAPS, as this indicates yelling. Remember, the way you write shows
your personality to everyone who reads the blog.

Be accurate. Make sure that any information you write is correct. This includes facts,
names, and web addresses. Do not exaggerate.

Write intelligently. Make sure your message is clear and easy to understand. Remember to
stick to the topic; don‘t be overly humorous or creative.

Be a conscientious student. Proofread carefully before clicking —Submit Commentl.
Your writing is for school, so be sure to check spelling, punctuation and grammar, as you
would for any other type of school project.

CREATIVE BLOG PRACTICES

As blogs are so new, there is a lot of room for new and creative applications. As the blogs
continue to develop in future versions of E-leaning, there will be more capabilities to apply to
interesting activities. But even now, there are a few creative activities you can develop using the
blog tool.

Group work with tags

Blog tags are used to categorize and locate blog entries. Usually general categories are used, like
—teachingl or —trips.l However, creating assignment-specific tags can turn the blog tool into a
brainstorming tool. If you have an assignment on understanding evolution, create a set of tags for
your students to tag research findings, claims, counter-claims, evidence, etc. Once students have
begun to create entries, they can collate the work of the entire class by selecting the appropriate
tags, and every post with that tag will be displayed.
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One-minute responses

Effective feedback is important for learning. This is true for both the teacher and the student.
One-minute-response blog posts are an easy way to get informal feedback from students about a
lesson or activity and keep them posting in their blogs. Usually, the instructor gives the students
a few prompts to get quick feedback on the effectiveness of the lesson.

You can use three questions when asking for a one-minute response to a lesson:

* What was the muddiest (i.e., least clear) point in the lesson?
* What was the most important point?
» How useful/interesting was the lesson?

Obviously, there are many more prompts you can use to get the feedback you want from your
students. You may want students to reflect on how they feel about the class itself, or about a test,
or ask other questions about how they perceive various aspects of your course. Alternatively, you
could ask them for quick answers to more specific, content-related questions that you know
students frequently have problems with.

Assign students a one-minute response as a blog assignment. Post the questions in a prominent
place in your course, and ask them to tag the post with the name or date of the activity. Clicking
on the tag will make it easy to collate all of the student responses.

SUMMARY

At first glance, the blogging doesn‘t seem to be very interesting but if you allow your students to
post online for their audience then it can inspire them for purposeful writing and publishing their
work. In the next chapter we will take a look at the Swiss army

knife of E-leaning known as Database and can be used to in a variety of ways e.g. for collection
of entries submitted by students.
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Chapter 15: Database

The database activity module allows the teacher and/or students to build, display and search a
bank of record entries about any conceivable topic. The format and structure of these entries can
be almost unlimited, including images, files, URLS, numbers and text amongst other things.

It is a simple, easy-to-use, general purpose database not meant to be very complex or powerful;
it‘s simply a way for multiple people to add structured data to a shared resource. The database
module provides a tool for collaborative development of a database within the course.

You can use database module in a lot of creative uses which are limited by your imagination.
You could use the database to create glossaries, catalogs, taxonomies, registrations, paper
submissions, maps, or anything where the students in your class can fill in a form to add data.

You could use the database module to:

- allow collaboration on building a collection of web links/books/journal references related
to a particular subject

- display student created photos/posters/websites/poems for peer comment and review

« gather comments and votes on a shortlist of potential logos/mascot names/project ideas

« provide a student file storage area

- Maintain a log of what was done in a face-to-face class each day, so that absent students
can get caught up themselves.

Creating database activities is a little more involved than most of the E-leaning activities, but it‘s
not as complex as lessons. You also have the option of using a preset of an empty database
activity, rather than creating your own from scratch.

The visual layout of information when listing, viewing or editing database entries may be
controlled by database templates. Database activities may be shared between courses as presets
and a teacher may also import and export database entries.

If the database auto-linking filter is enabled, any entries in a database will be automatically
linked where the words or phrases appear within the course.
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A teacher can allow comments on entries. Entries can also be rated by teachers or students (peer
evaluation). Ratings can be aggregated to form a final grade which is recorded in the gradebook.

Database activities have many uses, such as

« A collaborative collection of web links, books, book reviews, journal references etc.
 For displaying student-created photos, posters, websites or poems for peer comment and
review

CREATING DATABASE

A database is made up of fields and templates. Fields define the type of data the database will
store: text, dates, files, URLS, etc. Templates allow you to control the visual layout of
information when listing, viewing, or editing database entries.

A database activity has three basic template types:

List template

The list template allows you to control the fields used and their layout when viewing multiple
entries. Usually an overview of each entry is provided, with more detailed information available
by clicking on an entry to access the single view.

Single template
The single template is for displaying the detailed view of a single entry. All the data the user
entered should be visible here.

Add template
The add template creates the interface form used when adding or editing database entries.

As with many of the activity modules, a little preplanning can go a long way when you are
thinking about developing a database activity. The field definitions determine the fields in the
add template, which determine the data you can display on the list and single templates. Before
you begin digging into the database, try to sketch out the fields you think you need the students
to enter, and how you might want to lay them out in each template.

Once you have a rough sketch, creating the database itself will be easier and you will less likely
need to go back and add fields later (although you can if you need to).
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ADDING A DATABASE

The first step to creating a database is adding it to the appropriate section of your course. As with

most E-leaning activities, you first set the options for the database, then create the fields and
templates.

To create a database activity:

«  With the editing turned on, in the section you wish to add your database, click the "Add an
activity or resource"” link and choose Database.
« In the General Section, Give your new database a name and a description.
+ In the Entries Section:
o Approval required? - If set to "yes", the entry will only be visible once a teacher
has checked and approved it.

Adding a new Database

General
Hame

Dwscripton

,,,,,

Meplay Sescripton om cowrse
page

Entries

Avadability

Grade

Ratings

Commen module settings

Figure 15-1 Adding a new database
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o Allow comments on entries - If set to "yes", users will be able to comment on
database entries.

o Entries required for completion - Select here how many entries you wish the student
to add before the activity can be considered "complete".

o Entries required for viewing - Select here how many entries you wish the student
to add before they are allowed to see entries by other people.

*** |f entries are required before viewing, the database auto-linking filter should
be disabled. This is because the database auto-linking filter can't determine
whether a user has submitted the required number of entries.

o Maximum number of entries - Select here the maximum number of entries you wish

students to make.
In the Availability Section:

o Available from/to - Select here when you want the database to be visible to students.

o Read only from/to - If you wish, select here the dates you want students to be able
to see entries in the database but not be able to add their own. For example you
could make a database 'available from' January 1st until March 1st, but 'read only'
from January 1st to February 1st. This means students can only view entries for a
month before being able to add their own.
***The 'available from/to’ settings override the ‘read only from/to’ settings. So if a

database has 'read only' from 1st January, and "available from" 1st February,
students will not be able to view its content during January.

In the Ratings Section:

o Roles with permission to rate: To submit ratings users require the E-
leaning/rating:rate capability and any module specific capabilities. Users assigned
the following roles should be able to rate items. The list of roles may be amended
via the permissions link in the administration block.

o Aggregate type: The aggregate type defines how ratings are combined to form the
final grade in the gradebook.

o Scale: Select the type of grading used for this activity. If "scale" is chosen, you can
then choose the scale from the "scale” dropdown. If using "point"” grading, you can
then enter the maximum grade available for this activity. o Restrict ratings to items
with dates in this range: Select the time range for which you want to restrict the
ratings.

In the Common Module Section:
o Visible: Select Show/Hide to display or hide the activity to your students. o ID
Number: Provide a ID number for the activity to be shown in the Gradebook.
o Group Mode: Select the group mode for the workshop activity. There are three
options:
= No Groups: There are no sub groups, everyone is part of one big community
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= Separate Groups: Each group member can only see their own group, others
are invisible
= Visible Groups: Each group member works in their own group, but can also
see other groups. o Grouping: Select grouping type if you want to make an
activity (such as an assignment or a quiz) visible to only one set of users
within a course.
«  Click the —Save changesl button and you will be taken to the database setup page.

BUILDING DATABASE

When you visit the database activity then it will be displayed like as shown in figure 132.

View list View single Search Add entry Export Templates Fields Presets
There are no fields defined for this database

Please create some below or choose a predefined set to get started

Create a new field (Z

Choose E|

Default sort field

Time added E| Ascending E) Save

Figure 13-2 Adding fields to database

There are multiple tabs on the top of the activity which we will discuss one by one. First it will
show you an error message with Red background that "There are no fields defined for this
database.” So, first you need to define some fields or else you can use Presets.

Let‘s start by defining some fields for your database:

Creating Fields

The field definitions create the basic structure of the database and determine what kind of
information students can enter into your database. For example a database of famous paintings
may have a picture field called painting, for uploading an image file showing the painting, and
two text fields called artist and title for the name of the artist and the painting. By combining

261

——
| —



How to use E-leaning

several fields with appropriate names and types you should be able to capture all the relevant
information about the items in your database. Alternatively, you can use a database preset. You
are provided with a choice of 12 data field types.

«  Checkbox: This allows you to offer checkboxes for the user to select. Add the options one
under the other. The word will appear next to a checkbox when the user clicks to add an
entry. They can check more than one box.

- Date: This allows a user to enter a date by picking a day, month and year from a drop down
list.

- File: Users can upload a file from their computer. If it is an image file then the picture field
may be a better choice.

 Latitude/longitude: Users can enter a geographic location using latitude and longitude.
When students view the entry, links are automatically generated to geo- graphic data
services such as Google Maps, Google Earth, or Multimap.

« Menu: For students to select an option from a drop-down menu. Enter each option on a
different line in the options text field.

« Menu (multiselect): For students to select multiple options from a drop-down menu (by
holding down the Control or Shift key as they click).

« Number: For students to enter a number (positive, negative, or zero).

« Picture: For students to upload an image file from their computer.

« Radio buttons: For students to select just one option from a list. If used, —radio buttonsl is
a required field; a student may only submit his database entry after selecting an option.

«  Text: For students to enter text up to 60 characters in length. For longer text, or for text that
requires formatting—such as headers and bullet points—the textarea field should be used.

« Textarea: For students to enter text longer than 60 characters in length and/or include
formatting such as headers and bullet points.

« URL: For students to enter a URL. Selecting —Autolink the URLI will make the URL a
clickable link, and entering a forced name for the link means that the name will be used for
the hyperlink. You can choose to have the URL open in a new window if so desired.
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Database: Nations Flags

Fowid name Fiwiet typu Fueta Sescription Action

Figure 13-3 Database fields
To create the fields for your database:

«  On the database setup page, select the field type you want to add from the —Create a new
fieldl dropdown menu.

- Enter a field name and a field description. The field name is used to create the templates,
so make it unique and long enough to be descriptive, but not too long to retype.

 If necessary, add/select the options for each field type. For example, you can set the height
and width of the text area generated by the textarea field.

Once you‘ve defined the fields you want to use in your database, as shown in Figure 13-3, you
are ready to begin editing your templates.

EDITING TEMPLATES

Once you have created the fields for your database, you will probably want to edit the templates
that define the user interface. Creating the fields produces a default template, as shown in figure
13-4. Templates for the Database activity module allow you to control the visual layout of
information when listing, viewing or editing database entries.

Database templates all work on the same principle. They are basically HTML pages with a new
set of tags for the database module to interpret. When editing a template, E-leaning displays a list
of available tags on the left side of the editing screen. Double clicking on any of the tags adds it
to the template. The database activity interprets these new tags before sending the template‘s
HTML to the browser for display. It looks for words enclosed in either two square brackets ([[)
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or two hash signs (##), representing two different types of interface elements it can add to the
template.

The square brackets define data tags, which tell the module to replace the word in the brackets
with the value or form element of the field with the same name. So if you have a database with a
name field, you would represent it in the template with [[name]]. In the single or list template,
the module would replace it with the data in the name field for that entry. In the list template, the
module would replace it with a text field, and put the value in the text field if you‘re editing the
entry instead of creating a new one.

The ## tags indicate the word should be replaced by an icon or link for interacting with the
module. These tags are used to place the edit and delete icons, and links for More, Approve,
Comments, and User. If you want to add the edit icon to a template, you just add a tag that looks
like ##edit##. When the user looks at the page with the tag, the database module replaces it with
the edit icon. If the user then clicks on the icon, it takes her to the edit template.

*** The edit and delete icons only appear for users with appropriate capabilities allowed. The
Approve and Comments links only appear if these options are enabled AND only for users with
appropriate capabilities allowed.
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Database: Nations Flags

Figure 13-4 A single template

Aside from the replacement tags, creating a template is just like creating an HTML page. Use a
table to lay out the data elements (this is an acceptable use of tables for layout), add descriptive
text around the replacement tags, and publish. The database makes it easy to rapidly view your

changes by flipping between the Templates tab and the tab for the template you are working on.

*** Don‘t forget to save the template before you switch views! It‘s easy to forget, and very
frustrating to switch views and have the template look exactly the same because you forgot to
save!

When you are editing the template, you may find the HTML editor gets in your way, especially
when editing the list template (more on the list template below). Fortunately, E-leaning has a
toggle button for enabling and disabling the HTML editor in the template editing screen. Just
below the —Reset templatel button on the left side of the template page, you‘ll see the
—Enable/Disable editorl button. Disabling the editor allows you to get your hands dirty with the
raw HTML code rather than trying to use the editor‘s GUI. Most of the templates are quite
simple, and switching the editor off is a great way to learn how the templates are structured.
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As mentioned previously, there are three basic templates necessary to use the database: list,
single, and add. The three other templates—RSS, CSS, and JavaScript— are more advanced
templates and aren‘t necessary for basic database use.

To edit a template:

1. On the database page, click the Templates tab.
2. Click one of the template links below the row of tabs.
3. When you are done, click the —Save templatel button.

ADD TEMPLATE

Add template is used to create and edit new entries. In this template, data tags are replaced with
the form element for the field. If the user is editing an entry, the field will have the data from the
field in the form element for editing as well.

If you have a lot of form elements, consider grouping them together logically. For example, if
you have a database asking students to build a catalog of insects found during a field trip, you
may want to separate the description and taxonomy from the location data. It will make it easier
for students to fill in and organize their data.

***]t*s important to list every field you want the user to fill in on this template. If you leave off a
field, the user won‘t be able to add or edit its data.

Single template

The single template, as shown earlier in Figure 13-4, is the detailed view of an entry. This
template should list all of the available data. Again, consider organizing the data if you have a lot
of fields in your database. This is used to display a single entry at a time and so has more space
for display and can use, for example, larger versions of images or optionally provide more
information than shown in the list view.

List template
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The list template is the first page students will see when they come to your database. The list
template should give an overview of the entries and enable users to click through to the single or
edit template.

Organizing a good list template is a bit of a challenge. First, you should identify the fields that
will be most helpful to users for selecting the entries they want to view. The default layout
almost always has too much information and is not laid out well. The form has three areas: the
Header, Body, and Footer. If you lay out the list template as a table, you‘ll want to use the
Header area as the table header, the Body for the data, and the Footer to close the table, But the
HTML editor puts a full table in each area, which makes it difficult to get proper alignment of the
elements and not repeat the headers for every entry.

To make the entire list template as one table:

« On the list template page, turn off the HTML editor.

« In the Header area of the template, open the table and add a row for your header text. Each
column should contain one element of the header.

« Inthe Body, create another row with the data and command replacement tags.

+ In the Footer, close the table.

+  Save the template. DO NOT switch the HTML editor on while editing this template. If you
turn the editor back on, it will create tables in each of the areas.

RSS template

The RSS template allows you to structure the RSS feed from the database. If you have enabled
RSS feeds for the database in the database options, the database will publish the entries in a feed.
This template allows you to structure how the entries in the feed appear to the readers.

CSS template
The CSS template defines the CSS styles for all of the templates in the database. If you know
CSS, you can adjust the template‘s fonts, spacing, colors, and other display information.
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JavaScript template

Like the CSS template, the JavaScript template is used by the other templates. The JavaScript
template allows you to add new behaviors to the templates by defining JavaScript routines that
can be loaded when the template page loads.

You can use JavaScript to manipulate the way elements are displayed in the List, Single or Add
templates. Basically you need to enclose the part you want to manipulate in any named html
element. The naming is essential as it allows you to identify the element for manipulation.

MANAGING DATABASES

Once you have set up your database, you and your students can begin to enter data. Managing
your database as students begin to populate it with data is an important factor in the success of a
database activity. Someone will need to maintain the quality of the entries and give students
credit for participating.

Quality Data

Once students have started to add entries to your database, you will need to track their data to
help ensure they are making useful contributions. Managing the quality of database entries can be
a tedious exercise, but it can also be a learning opportunity for your students. Students will enter
their data according to their interpretation of the activity and their abilities. An inaccurate or
disorganized entry from a student is a potential opportunity for feedback to help the student

learn.

The database module has a few tools that will be useful to you in ensuring data quality:

« Comments: Comments are a great tool for feedback to motivate your students and help
them improve their entries.

« Require approval: The ultimate quality assurance tool is the —Require approvall option in
your database options. As mentioned earlier, this option hides an entry from the rest of the
class until you or someone with approval capability approves it. You might want to use this
capability to help students produce good material by giving them feedback before
approving an entry.
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Rating

Giving grades for entries is the single most powerful motivator for students. It also rewards
students for their time and effort. As always, if you don‘t want to assign a numerical grade to an
entry, you can create a custom scale and assign a qualitative grade. When you rate an entry, the
grade is added to the gradebook, like a rated forum post.

We would strongly recommend combining rating and comments, as shown in Figure 135. Rating
allows you to assign a numerical value to an entry, but it doesn‘t give you a method to tell the
student why she received her particular grade. The comments box enables you to communicate
the reason.

Rating and comments can be turned into a collaborative venture with your students. By default,
students are allowed to add comments, but only teachers are allowed to rate entries. However,
you can enable collaborative rating by setting a student role override.

***[f you don‘t see the —Override rolesl link in the Roles tab, ask your system administrator. By
default, teachers are unable to override roles, so this ability must be granted by your system
administrator, as well as setting which roles can be overridden by the teacher role.
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Database: Nations Flags

Thin database conains a toliechon of mage f Offecerd Nation Flag

wiure of Flag

Name of the Country indGua
e of Adang 17 November 2014

AUthor Name Jaswinde ngt

Figure 13-5 Viewing single item in database

DATABASE PRESETS

To avoid the necessity of always having to create a new database from scratch, the database
activity module has a presets feature. An image gallery preset is currently included in the
database module to help get you started. You can create your own presets as well and share them
with others.

Creating a new preset
To create a new preset:

» On the database page, click the Presets tab.
» Inthe "Save as Preset"” section, provide a name for the current preset.
» Check the Overwrite checkbox to override an existing preset and click Continue.
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Importing a preset
To import a preset:

» On the database page, click the Presets tab.

Override permissions for role 'Student’ in Database: Database: Nations
Flags

Casatrrty (2 S T LT T

Figure 13-6 Setting a student role override

» The usual way to import a preset is clicking the "Choose file" button in the Import Section
and browsing to the ZIP file containing the preset (e.g. "preset.zip™) stored on the server. If
there does not yet exist a preset ZIP file on the server, upload it from your local machine.
Choose the desired preset file by clicking on its action "Choose". Finally, press the "Import"
button.

» Alternatively, you can choose a previously loaded preset.

» After the import, you can start to add or import entries. All the hard work of setting up the
fields and templates has been done for you. If you desire, you can still customize the fields
and templates.
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You will see an "Overwrite current settings™ checkbox after the "Import" button has been
pressed. If checked, the database activity overwrites some of its current general settings by those
stored in the preset:

+ the "Introduction” HTML text

*  "Required entries"

» "Entries required before viewing"
* "Maximum entries"

« "Comments"

* "Require approval?"

+ rssarticles

Exporting a preset
If you wish to share your database presets with others, you have two options:

« Export as a ZIP file, which can then be imported to another course or E-leaning site.
« Save as a preset, which publishes the database for other teachers on your site to use. It will
then appear in the preset list. (You can delete it from the list at any time.)

*** Only the fields and templates of the database are copied when exporting or saving it as a
preset, not the entries.

Using an Existing Preset
From the presets tab, you can choose to use an existing preset saved by you earlier. In the "Use a
Preset" section select the existing preset from the list.

DATABASE ACTIVITY CAPABILITIES

« Approve unapproved entries: This allows a user to approve and undo the approval of
Database activity module entries. This capability is allowed for the default roles of
manager, teacher and non-editing teacher.

«  Write comments: This allows a user to add comments to Database activity module entries.
This capability is allowed for the default roles of manager, teacher, non-editing teacher and
student.

« Export all database entries: This allows a user to export all Database activity module
entries. This capability is allowed for the default roles of manager, teacher and non-editing
teacher.

272

——
| —



How to use E-leaning

Export a database entry: This allows a user to export Database activity module entries. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.
Export own database entry: This allows a user to export their own Database activity module
entries. This capability is allowed for the default roles of manager, teacher, non-editing
teacher and student.

Manage database activity comments: This allows a user to edit and delete database activity
module comments. This capability is allowed for the default roles of manager, teacher and
non-editing teacher.

Manage database activity entries: This allows a user to add, edit and delete database activity
module entries. This capability is allowed for the default roles of manager, teacher and non-
editing teacher.

Manage templates: This allows a user to manage database templates. This capability is
allowed for the default roles of manager and teacher.

Manage all template presets: This allows a user to manage database presets. This capability
is allowed for the default role of manager only.

Rate entries: This allows a user to rate database activity module entries. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

*** You may want to select a small group of students as moderators and create a role for
them to provide feedback to others.

View all raw ratings given by individuals: This allows a user to view all ratings given to
database activity module entries. This capability is allowed for the default roles of manager,
teacher and non-editing teacher.

View presets from all users: This allows a user to view database presets from all users. This
allows also a user to export entries. This capability is allowed for the default roles of
manager, teacher and non-editing teacher.

View total ratings that anyone received: This allows a user to view total ratings for database
activity module entries. This capability is allowed for the default roles of manager, teacher
and non-editing teacher.

View entries: This allows a user to view database activity module entries. This capability
is moderated by any submission requirements in the database set-up, such as the number
of entries required before viewing. This capability is allowed for the default roles of
manager, teacher, non-editing teacher, student and guest.

View the total rating you received: This allows a user to view all ratings which they have
received for database activity module entries. This capability is allowed for the default roles
of manager, teacher and non-editing teacher.

Write entries: This allows a user to add entries to a database activity and edit or delete any
entries which they have previously added. This capability is allowed for the default roles
of manager, teacher, non-editing teacher and student.

Add a new database activity: This allows a user to add a new database activity to the course.
This capability is allowed for the default roles of manager and teacher.
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EFFECTIVE DATABASE PRACTICE

The database activity is both powerful and complex. It is probably the most technical module to
set up, though a complex lesson may take longer, but it has tremendous power. The database is a
veritable Swiss Army knife, useful in many situations with a little ingenuity and work.

To reduce your workload creating databases, make use of one of the presets available on
Itecrwanda.com. If a preset doesn‘t meet all of your requirements, it‘s easier to customize an
existing database than create one from scratch.

You can also share the work of creating a database. If you want your students to create and
submit a database for a project, you can override the student role and grant them authoring
capabilities. If you then use the separate groups mode, each group can create its own database of
research and submit it at the end for grading.

*** Remember to use roles and groups functionality to create additional flexibility to your
database.

CREATIVE DATABASE PRACTICES

With a little creativity, the database activity can become a useful tool for collaboration. The
structure provided by the field definitions and the templates makes it easier for students to
understand what you expect of them and to provide each other with good data. Combined with
less structured activities, like wikis and forums, you have a powerful combination of thinking
tools to enable your students to produce good work.

SUMMARY
Database activity is the Swiss army knife in the E-leaning course. It is also most complex to

setup a database activity but it can be used to cater lot of creative uses which makes it a quite
useful activity module.
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Chapter 16: Surveys, Choices and Feedback

E-leaning has three tools specifically designed for collecting ungraded feedback from your
students: surveys, choices and feedback.

The Survey module is a course activity that provides a number of verified survey instruments,
including COLLES (Constructivist On-Line Learning Environment Survey) and ATTLS
(Attitudes to Thinking and Learning Survey), which have been found useful in assessing and
stimulating learning in online environments.

The Constructivist On-Line Learning Environment Survey (COLLES) was designed to help
assess key questions about the quality of an online learning environment from a social
constructivist perspective (Taylor & Maor, 2000).

The Attitudes Towards Thinking and Learning Survey (ATTLS) is an instrument developed by
Galotti et al. (1999) to measure the extent to which a person is a _connected knower® (CK) or a
_separate knower* (SK).

Teachers can use these to gather data from their students that will help them learn about their
class and reflect on their own teaching. The current survey focuses on getting feedback from
students about the nature of the course.

Choices are small, one-question surveys. They act as small web polls that you may have seen on
other web sites. You can use a choice to get rapid feedback from your students about any topic
you wish, as long as it‘s only one question long.

The feedback activity module enables a teacher to create a custom survey for collecting feedback
from participants using a variety of question types including multiple choice, yes/no or text input.

So, let‘s start with Surveys first:

En
SURVEYS LiLL

There are three broad types of Survey activity in E-leaning which you can give:
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Attitudes to Thinking and Learning Survey (ATTLS) - ATTLS seeks to measure the extent
to which a person is a 'connected knower' (tends to find learning more enjoyable, and is
often more cooperative, congenial and more willing to build on the ideas of others) or a
'separate knower' (tends to take a more critical and argumentative stance to learning).
People with higher CK scores tend to find learning more enjoyable, and are often more
cooperative, congenial and more willing to build on the ideas of others, while those with
higher SK scores tend to take a more critical and argumentative stance to learning?.
Critical incidents survey - The Critical Incidents survey asks students to consider recent
events and answer questions about their relationship to those events.

Adding a new Survey to 19 September - 25 September

oenada
Name

Servey npe

TNIDIIy FeIATEGE OO toLTIe
page

10 rumoer
Crewo mode

Qroumng

Figure 15-1 Adding a new survey

Constructivist On-line Learning Environment Survey (COLLES) - For monitoring the
extent to which the interactive capacity of the World Wide Web may be exploited for
engaging students in dynamic learning practices. The COLLES comprises an economical
24 statements grouped into six scales, each of which helps us address a key question about

1 A preliminary scale to measure connected and separate knowing: Knight, K. H., Elfenbein, M. H., Messina, J. A.

(1995)
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the quality of the on-line learning environment: o Relevance: How relevant is on-line
learning to students' professional practices?
o Reflection: Does on-line learning stimulates students' critical reflective thinking?
o Interactivity: To what extent do students engage on-line in rich educative dialogue?
o Tutor Support: How well do tutors enable students to participate in on-line
learning?
o Peer Support: Is sensitive and encouraging support provided on-line by fellow
students?
o Interpretation: Do students and tutors make good sense of each other's on-line
communications?

The COLLES has been designed to enable you to monitor the extent to which you are able to
exploit the interactive capacity of the World Wide Web for engaging students in dynamic
learning practices. It includes the ideal and actual experience feedbacks from the students.

Creating Surveys:
The limited nature of the surveys tool makes surveys very easy to create. Basically, you select
the set of prewritten questions you‘d like to give, edit the introductory text, and you‘re done.

To create a survey:

«  Click the —Turn editing onl button.

+  Select Survey from the —Add an activityl drop-down menu in the course section where
you would like to add the survey.

«  On the —Adding a new survey page,| as shown in Figure 15-1, give the survey a name.

«  Select the type of survey you want to give from the drop-down menu. The options are:

o ATTLS (20 item version) o Critical Incidents o0 COLLES (Actual) o COLLES
(Preferred)

o COLLES (Actual and preferred)

« Add a description of your survey in the description field. To display it on the course page
just check the "Display description on the course page" check box.
«  Select the common module options:

o Visible - This determines whether students may view the activity or not.

o ID Number - Setting an ID number provides a way of identifying the activity for
grade calculation purposes. If the activity is not included in any grade calculation
then the 1D number field may be left blank.

o Group mode - This is another location in which to set the group mode for the
activity. If group mode is forced in the course settings then this setting will be
ignored.

277

——
| —



How to use E-leaning

o Grouping - A grouping is a collection of groups within a course. If a grouping is
selected, students assigned to groups within the grouping will be able to work
together.

«  Click the —Save and displayl button.

Administering Surveys

Once you‘ve created the survey, students can begin to give their feedback. They simply click on
the survey name in the course section and answer the questions. Once students have begun to
answer the survey questions, you can track results via the —View xx survey responsesl link at
the top right of the survey page where xx stands for the number of the responses submitted.

The survey report page contains links at the top right for viewing the data by Scales, by
participants, or by questions. You can also download the data in a choice of three formats: Open
Document Spreadsheet, Excel, or text.

COLLES Survey

COLLES Survey

Figure 15-2 A COLLES survey report summary

« The COLLES and ATTLS questions are five-point scales that range in responses from
Almost Always to Almost Never. These results are reported in graphical form when you
view them.

« The Critical Incidents survey is a free-response survey where students must type their
answers. You can see what students have typed for each answer.
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Survey Capabilities
The survey module has three capabilities:

« Download responses - This allows a user to download survey responses.

« Respond to survey - This allows a user to participate in a survey.

« View responses - This allows a user to read survey responses via the —View xx survey
responsesl link at the top right of the survey page.

CHOICE ACTIVITY ?

A choice activity is very simple — the teacher asks a question and specifies a choice of multiple
responses. It can be useful as a quick poll to stimulate thinking about a topic; to allow the class to
vote on a direction for the course; or to gather research consent. Unlike surveys, the choice tool
allows you to ask any question you‘d like, as long as it‘s multiple-choice.

Once you‘ve set up your choice, it acts as a poll in your course. Students click on the choice and
select their answer. You can choose when and if students see the results of the choice and even
let them change their minds.

A choice activity may be used

« As aquick poll to stimulate thinking about a topic

« To quickly test students' understanding

« To facilitate student decision-making, for example allowing students to vote on a direction
for the course

Creating Choices
To create a choice:

*  Click the —Turn editing onl button if you are not in the editing mode already.

* Select "Choice" from the —Add an activity or resourcel drop-down link.

* On the —Adding a new choicel page, as shown in Figure 15-3, given the choice a
descriptive name.

« Type the question that you want your students to answer in the description field. An
example of the choice text could be "What is your favorite color?" There is also an option
to display the choice description on the course page below the link to the activity.
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Adding a new Choice to 19 September - 25 September
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Figure 15-3 Adding a choice activity

Display mode for the options: Choose "Display horizontally" if you only have three or four
choices maximum; choose "display vertically™ if you have a large number of choices.
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* Inthe Options Section:

o

Allow choice to be updated - If this is set to "Yes", students can change their mind
after they have voted. If it's set to "No", students cannot change their choice.

Limit the number of responses - Enabling this option allows you to limit the number
of participants who can select each particular choice. When that number has been
reached, no one else can select that choice.

Option 1,2,3,4,5 - Here you can specify the options that participants have to choose
from. They will become radio buttons when the choice is saved. You can fill in any
number of these. If you leave some of the options blank, they will not be displayed.
If you need more than 8 options, click the "Add 3 fields to form™ button.

Limit 1,2,3,4,and 5 - Here you can specify the limit of the number of participants
who can select each particular choice. If Limits is disabled, then any number of
participants can select any of the options.

*** If you unintentionally check the limit of responses check box but don't add a
number then your students won't be able to select any choices and will get confused.

* Inthe "Availability" Section:

@)

Restrict answering:
1. If you check this box you can set an "open and close" date for your choice.
2. Ifyou leave it, they can respond at any time.

* Inthe "Results" Section:

@)

o

Publish results:
1. This determines whether (and when) the students will be able to view the
results of the choice activity. They may:

1. Do not publish results to students - Students will never see the
results of the choice.

2. Show results to students after they answer
Students will see the results only after they have given the answer
themselves.

3. Show results to students only after the choice is closed Students will
see the results only after the closing date of the choice.
4. Always show results to students - students will always see the
results.
Privacy of results: If "Publish™ was chosen above, then this dropdown in unlocked.
You can decide whether to show names of students or merely the number who
responded but without names.
Show column for unanswered: If set to "Yes", this will display a column showing
how many participants have not answered the choice activity yet. If set to "No", the
results will only include the participants who have already voted.
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» Select the common module options:

o Visible - This determines whether students may view the activity or not.

o ID Number - Setting an ID number provides a way of identifying the activity for
grade calculation purposes. If the activity is not included in any grade calculation
then the ID number field may be left blank.

o Group mode - This is another location in which to set the group mode for the
activity. If group mode is forced in the course settings then this setting will be
ignored.

o Grouping - A grouping is a collection of groups within a course. If a grouping is
selected, students assigned to groups within the grouping will be able to work
together.

* Click the —Save and displayl button.

Administering Choices

After students have answered the choice, you can see their responses via the —View xx
responsesl| link at the top right of the choice page. Unlike the students® view of the results,
irrespective of whether results are published anonymously, you‘ll see a column for each response
with the student‘s picture and name, as shown in Figure 154.

Test Choice

Responses

wamDer of paTitipaTie

J3€¢ TNOSSE ™™ DEDON

Figure 15-4 Viewing choice responses

Selected responses may be deleted if you wish. You may like to delete any test response you
made.

As for surveys, results may be downloaded in a choice of three formats (Excel, ODS or Text) by
clicking the appropriate button at the bottom of the choice responses page.

282

——
| —



How to use E-leaning

Choice Capabilities
The choice module capabilities are restricted to managing the responses from students:

« Record a choice - This allows a user to answer the choice.

« Read responses - This allows a user to view other users* responses.

« Delete responses - This allows a user to delete choice responses.

« Download responses - This allows a user to download the full dataset of responses from
other users.

ol

FEEDBACK

Feedback responses may be anonymous if desired, and results may be shown to all participants
or restricted to teachers only. Any feedback activities on the site front page may also be
completed by non-logged-in users.

However, feedback module is disabled by default. If you are not able to see the feedback activity
in the "Add an activity/resource drop down" then please contact your site administrator for
enabling the same.

Why use Feedback

Apart from the obvious use here of evaluating a course, feedback surveys have a variety of uses,
both within a course and for non-logged in users on the front page. The ability to set them as
"anonymous" means also those sensitive issues can be surveyed without students worrying who
might see their responses.

Some ideas:

Guest surveys
Anonymously, on the front page, non-logged in users such as parents can be questioned on their
opinions about, e.g., the website design, school policies, school meals.

Sign up!

Guests can be invited to sign up for events/courses via the feedback module.

Contact us

Non-logged in users can use an instance of the feedback module as a "contact us™ form.
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Anti-bullying surveys

Students can be asked to highlight anonymously any incidences of bullying, along with their
location and type.

Making choices
Students can select course modules or subjects they wish to study in a subsequent year/semester.
The results can be exported and easily collated to match availability

IT Skills audit

Staff - or students - can be surveyed to discover their IT skills and weaknesses to highlight
training needs.

Use of E-leaning!
Staff can be surveyed on which E-leaning modules they use/would like more training in

CREATING FEEDBACK
To create a Feedback activity:

*  Click the —Turn editing onl button.

* Select "Feedback" from the —Add an activity or resourcel drop-down link.

* Onthe —Adding a new feedbackl page, as shown in Figure 15-5, enter a descriptive name
of the choice activity.

» Add a description for your Feedback instance in the description field.

* Inthe "Availability" section you can choose the period when users can complete feedback.

* Inthe " Question and submission settings" section:

o Record User Names: Choose here whether to show the names of users who
complete the feedback or not.

o Allow multiple submissions: Choose here whether or not to allow users to complete
the feedback more than once. This is important when using Feedback for
anonymous surveys on the front page as it will allow nonlogged in users to complete
the feedback.

o Enable notification of submissions: If enabled, teachers will receive notification of
feedback submissions.

o Auto-number questions: If set to "Yes' then the questions will be automatically
numbered.

* Inthe "After Submission" section:

o Show analysis page: The summary results can be shown to respondents, or shown

only to teachers.
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o Completion message: This allows you to present users with a personalized message
after they have answered the questions.

o Linkto nextactivity: After submitting the feedback, a continue button is displayed,
which links to the course page. Alternatively, it may link to the next activity if the
URL of the activity is entered here.

* In the "Common module settings" section:

o Visible - This determines whether students may view the activity or not.

o ID Number - Setting an ID number provides a way of identifying the activity for
grade calculation purposes. If the activity is not included in any grade calculation
then the ID number field may be left blank.

o Group mode - This is another location in which to set the group mode for the
activity. If group mode is forced in the course settings then this setting will be
ignored.

o Grouping - A grouping is a collection of groups within a course. If a grouping is
selected, students assigned to groups within the grouping will be able to work
together.

* Click the —Save and displayl button.

t |{Adding a new Feedback to 19 September - 25 September

Sanera
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D1ty 003n000m o0 COUrIR
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Figure 15-5 Adding a new feedback activity
Building Feedback
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After setting a new Feedback you have to design it by adding questions.

Select the type of question from the drop down list. Add your question details and click 'Save
question'.

The following options apply to all or most question types.

Position

This number controls the order of the questions. Position 1 is the question nearest the top of the
page, so when you create or edit a question, you can choose from the dropdown of available
positions. You can also rearrange questions by clicking the position up and down arrows on the
main add questions screen.

Required

These questions are required to be answered and will prompt the user if they are left unanswered.
These questions are highlighted with a red star for users, and have a yellow exclamation point
beside them when editing Feedback questions.

Question Types
The available question types are:

[1 Captcha

A test to make sure a real person is filling in the form and not an automatic spamming
program of some sort. Asks a person to write out some distorted text which is displayed on
screen. You normally won't need this unless you find you are getting spammed a lot.

« Information
This allows you to choose to display one of three types of information: the time of
responding; the course and/ or the category where the feedback is located.

« Label
Like a standard E-leaning label, this allows you to add arbitrary text between questions
allowing for extra explanation or to divide the Feedback into sections.

« Longer Text Answer
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This option is for creating a text box (you specify how big it will appear in rows and
columns) which people can write a long answer into.

« Multiple choice - multiple answers

This will give you a series of options with a checkbox next to each one. The respondent can
check as many as they want and there is currently no way to specify a limit to how many they
can choose which is lower than the total.

« Multiple choice - single answer allowed (dropdownlist)
This will give you a dropdown list from which only one answer can be selected.

« Dropdownlist (rated)
This is similar to the dropdownlist option, except that each option has a numerical value
associated with it.

« Numeric answer

Here, you ask a question which must have a number as an answer and specify the acceptable
range e.g. "How many arms would you like, if more than 2 were possible? (please specify 0-
10)" with a range of 0-10 set in the options. It helps if you specify the acceptable range in the
question text.

« Multiple choice - single answer

This will give you a series of radio buttons, which starts on 'Not selected' and then has your
options afterwards. Only one can be chosen and 'Not selected' is a valid answer if the
question is not set to 'required'.
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Course Feedback

Mode: User's name will be logged and shown with answers

How do you rate the guality of the course?#*
® Not selected
Excellent
Good
Satisfactory
Unsatisfactory

Which if the activities in the course you find as most valuable*
Wiki
Database
Assignment
Lesson
Quiz
SCORM
Glossary
Forum

Submit your answers

Cancel

There are required fields in this form marked *

Figure 15-6 Viewing a feedback activity

« Multiple Choice (Rated)

This is similar to the other multiple choice options, except that each option has a numerical

value associated with it.

« Short Text Answer

This option lets you specify a single line answer, with an input box which is a set number of
characters long (you choose). You also specify the maximum number of characters you will
accept, so that the answer is not too long and/or does not run over the length of the box on

screen.

Dependence item and Dependence value

It is possible to direct the user to specific questions depending on a previous answer. For
example, if they say "Yes' to the question "Do you have a car?" they will be directed to a different

question from if they answer 'No'. To set dependent questions:

«  Set up your initial question and give it a name in the Label field:

« Add a Page break

« Add the question to go to if (for example)the user replies 'Yes'.
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« In'Dependence item’, select the Label of your first question.
- In'Dependence value' type your dependent answer (such as "Yes' in our example.)
+ Follow the same process for the other response (such as 'No’)

Managing Feedback:
When you first visit the feedback activity page just after creating it, then you will find several
tabs in the top bar like: Overview, Edit Questions, Templates, Analysis and show responses.

Overview: When a feedback survey has been completed the teacher will see, via the Overview
tab, the number of students who have responded so far including the numbers of questions,
submitted answers, description and completion message of the activity.

Edit questions: The Edit Questions tab allows you to add/edit the questions in the feedback
activity.

Template: The Template tab allows you to save this particular survey's questions as a template
for future use, or to use a template that has already been created.

Analysis: This screen shows a graphical summary of the results of each question, along with the
option to download the results to Excel.

Show responses: This screen allows the teacher to see and then delete individual responses.

Show non-respondents: Unless the responses are set to "anonymous”, there will also be a "Show
non-respondents” tab where the Teacher or Feedback activity administrator can select some or all
users who have not yet completed the feedback and send them a reminder message.
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Course Feedback

PTG ) TRt ¥ Ihg ATeENgs W ThE COUFIA oy TS gt mes! AlLAte

Figure 15-7 Feedback analysis

FEEDBACK TEMPLATES:

Within the Feedback Module you can create and re-use sets of Feedback questions using the
Template tool. The Templates tab provides the following template features:

Use a template
Previously saved Templates will be listed in this area and can be selected using the dropdown
menu.

After selecting a Template, E-leaning will display a preview of the Feedback questions contained
within the Template and confirm Are you sure you want to use this template?

You will also be required to select one of two options:

» Delete old items: Remove any questions/text types previously added to the Feedback
Activity you are viewing before importing items from the selected Template

» Append new items: Add items stored within the selected template to the current Feedback
activity, to any existing questions/text types.

Once you have made your selection click —Save changesl to copy across the Feedback items or
press Cancel to exit from the template copy process.
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Unet pectate w! Name [ Jname Seatus Selwct

Figure 15-8 Sending messages to non-respondents students

Save these questions as a new template

After creating a new Feedback activity and populating it with questions, you can save it as a
Template for re-use by yourself or others.

When saving a new Template enter a descriptive title in the Name field and choose whether you
wish to make this Template available for use by others via the Public tickbox. A Public template
may be viewed and re-used by users with appropriate access rights such as administrators and
teacher/trainers. When a Public template is used as a basis for a new Feedback, the activity
settings and questions within it may be edited by the teacher/trainer; however the original
Template remains unchanged.

Delete Template

To remove a Template you have created or have appropriate permissions to edit, from your E-
leaning site, use the Delete template... link and click the delete icon next to the corresponding
template name.

Export Questions
The Export Questions tool allows you to save the questions/text types within your Feedback
Activity in .xml format. Clicking the Export questions link will prompt you to
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Save or Open this file

Import Questions

When you have previously exported and saved questions from a Feedback activity in .xml
format, you can reimport them into a new Feedback activity.

The Import questions tool is particularly useful where you need to import questions from a
different instance of E-leaning and the Template tool is not applicable.

*** You can also use the Import/Export ability to combine multiple Imports from multiple
templates; also it can be used to avoid creating duplicates when using Append.

After clicking on the Import questions link you will be prompted to select one of the following
options:

» Delete old items - The current questions and all your user's responses will be deleted within
the current Feedback activity

* Append new items - All old questions and the assigned values will be preserved within the
current Feedback activity and the imported questions will be added to the existing
questions.

Use the Choose a file button to navigate to the course Files area and upload and/or select the
relevant .xml file. Once selected, use the Import from this file button to import the questions or
use Cancel to return to the Templates general tab.

FEEDBACK CAPABILITIES:

«  Complete a feedback: This allows a user to complete a feedback form. This capability is
allowed for the default role of student only.

- Create private template: This allows a user to create templates for their own use in the
feedback module. This capability is allowed for the default roles of manager and teacher

« Create public template: This allows a user to create templates for others to use in the
feedback module. This capability is allowed for the default roles of manager and teacher.

+ Delete completed submissions: This allows a user to delete feedback module submissions.
This capability is allowed for the default roles of manager and teacher.

«  Delete template: This allows a user to delete feedback module templates. This capability is
allowed for the default roles of manager and teacher.
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- Edit items: This allows a user to edit feedback module items. This capability is allowed for
the default roles of manager and teacher.

«  Map courses to global feedbacks: This allows a user to map courses to global feedback for
the feedback module. This capability is allowed for the default role of manager only.

« Receive email notification: This allows a user to receive email notification of feedback
module submissions. This capability is allowed for the default roles of teacher and non-
editing teacher.

« View a feedback: This allows a user to view a feedback activity. This capability is allowed
for the default roles of manager, teacher, non-editing teacher, student and guest.

« View the analysis page after submit: This allows a user to view the feedback module
analysis page after submitting the form. This capability is allowed for the default roles of
manager, teacher and student.

« View reports: This allows a user to view feedback module reports. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

« Add a new feedback: This allows a user to add a new feedback activity to the course. This
capability is allowed for the default roles of manager and teacher

SUMMARY

This chapter deals with the different tools for gathering feedback data from students. E-leaning
surveys are formal and based in theory. Choices are quick and simple for both you and your
students. They can both provide useful data about your course and your students success.
Feedbacks can be used to create surveys which can be utilized to gather data about some
sensitive issues.

Chapter 17: SCORM & External Tool (LTI)

E-leaning provides a number of ways to share the tools and educational resource created in some
other systems. A teacher can utilize the videos, quizzes and other activities which are created in
standard packages like SCORM, LTI compliant systems to be utilized in his E-leaning course.

SCORM PACKAGES

A SCORM package is a collection of files which are packaged according to an agreed standard
for learning objects. The SCORM activity module enables SCORM or AICC packages to be
uploaded as a zip file and added to a course.
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Content is usually displayed over several pages, with navigation between the pages. There are
various options for displaying content in a pop-up window, with a table of contents, with
navigation buttons etc. SCORM activities generally include questions, with grades being
recorded in the gradebook.

SCORM activities may be used

«  For presenting multimedia content and animations
+ As an assessment tool

Note: E-leaning does not generate SCORM content. E-leaning presents the content in SCORM
packages to learners, and saves data from learner interactions with the SCORM package.

_i_
Adding SCORM Activity ~—

To add a SCORM package to your course

First method:

» Click the 'Turn editing on' button at the top right of the course page

+ Drag and drop the SCORM package zip file onto the course section where you'd like it to
appear

« Answer 'Add a SCORM package' to the popup dialogue asking what you want to do with
the zip file then click the upload button

» If necessary, edit the title of the file by clicking the pencil icon, or edit other options by
clicking the editing icon.
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% Adding a new SCORM package to 21 November - 27 November
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Figure 16-1 Adding a new SCORM activity

Second method:

» Click the 'Turn editing on' button at the top right of the course page.

Click the 'Add an activity or resource' link in the section you wish to add your SCORM
package, then in the activity chooser, select SCORM package then click the Add button (or
select 'SCORM package' from the 'Add an activity' dropdown menu)

* Inthe General Section:

o Enter a name and a description (which may be required or optional according to the
admin settings) [ In the Package Section:
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o Either drag and drop a SCORM package zip file into the box with an arrow or click
the Add button to open the File picker menu in order to choose a file from your
computer or a repository.

o Auto Update Frequency: If you access your SCORM package from a repository
(such as File system repository or Private files) you can choose to create an
alias/shortcut to it and then set an update frequency to set how often E-leaning
should check to see if there is an updated zip. [1 In the Appearance Section:

o Display Package: Choose from current or new window. Note that if you choose a
new window, students need to ensure pop ups are enabled.

o Display activity name: Whether or not to display the activity name above the
SCORM player.

o Display course structure on entry page: If this is enabled then the table of contents
of the package will be displayed when the students clicks to access the package.

o Display attempt status: This preference allows a summary of the users attempts to
show in the course overview block in My home and/or the SCORM entry page. 0
Width*: Stage size width as a css value, either % or pixels. Default is
100%

Height*: Stage size height as a css value, either % or pixels. Default is 500 pixels.

o Options (Prevented by some browsers)*: There is a series of check boxes for: Allow
the window to be resized ad scrolled, displaying directory links, location bar, menu
bar, toolbar and/or status.

o Student skip content structure page*: This setting specifies whether the content
structure page should ever be skipped (not displayed). If the package contains only
one learning object, the content structure page can always be skipped.

o Disable preview mode*: Preview mode allows a student to browse an activity
before attempting it. If preview mode is disabled, the preview button is hidden.

o Display course structure on entry page*: If enabled, the table of contents is
displayed on the SCORM outline page.

o Display course structure in player*: How the table of contents is displayed in the
SCORM player.

o Show Navigation*: This setting specifies whether to show or hide the navigation
buttons and their position. There are 3 options:

= No - Navigation buttons are not shown

= Under content - Navigation buttons are shown below the SCORM package
content

= Floating - Navigation buttons are shown floating, with the position from the
top and from the left determined by the package

o Display attempt status*: This preference allows a summary of the users attempts to
show in the course overview block in My home and/or the SCORM entry page.

* In the Availability Section: Choose here the dates you wish the SCORM package to be
available to students.
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In the Grade Section:
o Grading method: The grading method defines how the grade for a single attempt of
the activity is determined. There are 4 grading methods:

= Learning objects - The number of completed/passed learning objects

= Highest grade - The highest score obtained in all passed learning objects

= Average grade - The mean of all the scores

= Sum grade - The sum of all the scores o Maximum grade: Not applicable if
Grading Method is Learning objects. Usual setting is 100. If your SCORM's
high score is something other than 100, you should adjust this value
appropriately. When grading Method is one of the score settings, then the
gradebook grade is package score divided by this number.

In the Attempts Management Section:

o Number of attempts: This setting enables the number of attempts to be restricted.

o Attempts grading: If multiple attempts are allowed, this setting specifies whether
the highest, average (mean), first or last completed attempt is recorded in the
gradebook.

o Force new attempt: If enabled, each time a SCORM package is accessed will be
counted as a new attempt.

o Lock after final attempt: If enabled, a student is prevented from launching the
SCORM player after using up all their allocated attempts.

In the Compatibility Settings Section:

o Force completed: If enabled, the status of the current attempt is forced to
"completed”. o Auto-continue: If enabled, subsequent learning objects are
launched automatically; otherwise the Continue button must be used.

In the Common Module Settings:

o Visible: Check whether to show/ hide the activity from the students.

o ID Number: Provide an ID number for the activity if you want to identify the
activity for the grade calculation purpose.

Click Save and Display to show up the SCORM activity.
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SCORM Activity

Info Reports

This is an example of a SCORM activity in Moodle course

Number of attempts allowed: Unlimited
Number of attempts you have made: 0
Grading method: Highest attempt
Grade reported: None

Mode: ©) Preview @ Normal
Enter

Figure 16-2 Viewing a SCORM activity

Using SCORM Activity

Like a E-leaning course, each SCORM package will vary with the modules used in its
construction by the teacher and by the SCORM activity settings established by the teacher. The
Info tab displays the general information about the activity. A teacher can access 3 report types
for the SCORM activity via the reports tab:

+ Basic report: The basic report page shows a table of attempts for the SCORM activity. If
you have the SCORM activity set up to allow multiple attempts, there may be more than
one attempt for some users. The basic report may be downloaded in ODS, Excel or text
format. A detailed report of each user's attempts may be obtained by clicking on the number
in the attempts column. The track details link provides information on specific SCORM
values recorded in E-leaning by the SCORM object.

«  Graph report: The graph report displays graphs of percentage obtained against number of
participants.

« Interactions report: The interactions report shows students' responses to questions together
with the correct answers.

«  Objectives Report: The objectives report shows the objectives data.

SCORM Capabilities

* Delete own attempts: This allows a user to delete their own SCORM attempts. This
capability is not set for any of the default roles. This capability is intended
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for use by developers to run ADL tests, as it makes it easier if the student can clear their
own attempts.

Delete SCORM attempts: This allows a user to delete SCORM attempts. This capability is
allowed for the default roles of manager, teacher and non-editing teacher.

Save tracks: This allows a user's SCORM tracks (scores etc.) to be saved. This capability
is allowed for the default roles of manager, teacher, non-editing teacher and student.

Skip overview: This allows a user to skip SCORM/AICC overviews. This capability is
allowed for student‘s role only.

View reports: This allows a user to view SCORM/AICC reports. This capability is allowed
for Administrator, teacher and non-editing teacher.

View scores: This allows a user to view SCORM/AICC scores. This capability is allowed
for Administrator, teacher and non-editing teacher and student.

SCORM Activity

ail acdcirmn e Attt Started on Lant pccessed on

Fraferances Just for this page

ihow 1 -

Preferenceas for this report

Fage size

Track detats 10 -

Figure 16-3 SCORM activity reports page

EXTERNAL TooLs (LTI) ™

The external tool is an activity module supporting LTI (Learning Tools Interoperability). It is
similar to SCORM as a standard for educational objects, but instead of being a package of
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content that is uploaded to E-leaning, LTI is a way of integrating the functionality provided by
another system into your course.

The external tool enables E-leaning users to interact with LTI-compliant learning resources and
activities on other web sites. For instance, an external tool could provide access to a new activity
type or learning materials from a publisher.

To create an external tool activity, a tool provider which supports LTI (Learning Tools
Interoperability) is required. A teacher can create an external tool activity or make use of a tool
configured by the site administrator.

External tool activities differ from URL resources in a few ways:

« External tools are context aware i.e. they have access to information about the user who
launched the tool, such as institution, course and name

- External tools support reading, updating, and deleting grades associated with the activity
instance

« External tool configurations create a trust relationship between your site and the tool
provider, allowing secure communication between them

A teacher can add an external tool from their course page and an administrator can make an
external tool available to all teachers on the site.

Adding a new external tool

To add a new external tool to your course:

«  With the editing turned on, in the section you wish to add your external tool, click the "Add
an activity or resource” link (or, if not present, the "Add an activity" drop down menu) and
choose External tool.

«  This will take you to the settings page titled "Adding a new external tool". All settings may
expanded by clicking the "Expand all" link top right.

I the external tool has not been configured by the administrator, you will need to have in
advance the correct configuration URL, Launch URL, consumer key and secret. These
should have been provided to you by the managers of the LTI compliant website you are
going to be connecting to.

 In the General Section:

o Activity Name: Provide the title you wish the students to see on the course page.
o External Tool Type: this is how E-leaning communicates with the tool provider. If
in doubt, leave as default. If your administrator has made a tool available sitewide,
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you will be able to select it here. Otherwise, you can add an external tool by clicking
on the "+" icon besides the field which will open in a new tab.
= To add an external tool: Enter the Top Base URL (Configuration url),
consumer key and secret in the respective fields.
= Click Save changes and it will take you back to the same page. o Launch
URL: This is the URL for connecting to site. The Launch URL indicates
the web address of the External Tool, and may contain additional
information, such as the resource to show.
o Launch container- this is how the external tool will be displayed.
= Default -if in doubt; leave as default
= Embed - the external tool will be embedded in the E-leaning course page
with blocks and navigation bar
= Embed without blocks - the external tool will be embedded in the E-leaning
course page but without blocks
= New Window - the external tool will open in a new window. (A new
window or tab will open with the External tool and the old browser window
containing the course page will not change.)

The following settings are available by clicking ""Show more":

Activity description - give a short description here
Display description on course page - choose to show the description along with the
activity name

o Display activity name when launched - have this appear when the student clicks the

link.
o Display activity description when launched - have this appear when the student
clicks the link.

o Secure launch URL — If you want to launch it in a secured manner then mention the
URL with https:// in this field.

o Consumer key -this tells the connecting LTI compliant site that your E-leaning is
allowed to connect. The "tool provider”, i.e. the manager of the connecting LTI
compliant site will issue you with this key. If you are merely linking to a tool with
no secure access or gradebook sharing then you won't need a consumer key.
Shared secret - this is the "password" to connect to the tool - the LTI compliant site.

o Custom parameters - most times you can leave this blank. The tool provider might
use this to allow you to display a specific resource.

o lcon URL - you can display a different icon from the default External Tool icon by
entering its URL here

o Secure Icon URL - enter the URL of a different icon here if your students are
accessing E-leaning securely via SSL.

+ Inthe Privacy Section:
o Share launcher's name with the tool: this checkbox means that the student's name
will be displayed on the connected site.
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o Share launcher's email with the tool: this means that the student's email will be
displayed on the connected site
o Accept grades from the tool: if this is checked, the connecting site will send back
grades to E-leaning's gradebook.
+ In the Common Module Settings:
o Visible: If you want to Show/Hide activity from the students then you can choose

here.
o ID Number: Setting an ID number provides a way of identifying the activity for

grade calculation purposes.
+ Click "Save and Display" and E-leaning will display the resource from the external LTI

tool within the E-leaning site.

Adding a new External Tool to 21 November - 27 November

* General
Activity Name*

External tool type ( Automatic, based oo Launch URL |=ls
Launch URL

Launch Container el -

» Privacy

» Common module settings

Save and retum 10 course Save and dispiay Cancel

Figure 16-4 Adding a new External Tool

Why use an external tool?

Many websites provide materials and interactive learning exercises different from and
complementary to E-leaning's own resources and activities. The External tool module offers a
way for teachers to link to these activities from within their E-leaning course page and where
available to have grades sent back into E-leaning. Students only need to log in to E-leaning; they

do not have to log in a second time to the connecting site.

External Tool Capabilities:
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« Add external tool: This allows a user to add an External tool activity to the course. This
capability is allowed for the default roles of manager, teacher and non-editing teacher

+  Submit a tool to admins for configuration: This allows a user to submit an External tool to
admins for configuration. This capability is allowed for the default roles of manager,
teacher and non-editing teacher.

- Grade external tool activities: This allows a user to grade External tool activities. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

- Edit external tool activities: This allows a user to edit External tool activities. This
capability is allowed for the default roles of manager, teacher and non-editing teacher.

« View external tool activities: This allows a user to view External tool activities. This
capability is allowed for the default roles of manager, teacher, non-editing teacher, student
and guest.

« Add a new external tool activity: This allows a user to add a new external tool activity to
the course. This capability is allowed for the default roles of manager and teacher.

graph builder LTI

Figure 16-5 Graph builder LTI in E-leaning

List of LTI Apps
You can find a lot of useful LTI tools compliant to E-leaning from the link: http:/Itihttp://Iti-
examples.herokuapp.com/index.htmlexamples.herokuapp.com/index.html

You may need to contact the specific vendor to provide the URL, consumer key and secret which
can be integrated within your E-leaning. Some popular LTI tools are: Youtube, Khan Academy,
Chemvantage, Wordpress, Piazza and many more.
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SUMMARY

Using an SCORM or external tool can help the teachers to share the functionality provided by
other systems within the E-leaning course. Teachers can use the quizzes, videos and other
resources provided by the other systems to integrate within the E-leaning course and improve the
student interaction to enhance the learning experience.
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Chapter 18: Grades and Scales

Grades are a necessary evil in modern education. They take a complex task—Ilearning a new
subject—and reduce it to a single measure. Grades can function as both carrot and stick for
motivating students, and they are the primary measure of success in a course. Tracking and
calculating grades are serious and tedious tasks. Fortunately, E-leaning has a great tool to help.

The E-leaning grades area is a sophisticated tool for tracking student scores in your course. You
can use it for scored activities in the classroom, in E-leaning and in extracurricular activities.

Grades aren‘t the only way to give feedback to students. With E-leaning"s scales, you can create
lists of nonnumeric feedback options for assessing student work. E-leaning comes with one scale
by default, —Separate and Connected ways of knowing,| which we*‘ll discuss later in this
chapter. You can easily create your own additional scales for feedback options that are
meaningful to you and your students.

GRADES INTERFACE

You can access the grades area for each student in a course in the course gradebook, or 'Grader
report' in Administration > Course administration > Grades.

The grader report collects items that have been graded from the various parts of E-leaning that
are assessed, and allows you to view and change them as well as sort them out into categories
and calculate totals in various ways. When you add an assessed item in a E-leaning course, the
gradebook automatically creates space for the grades it will produce and also adds the grades
themselves as they are generated, either by the system or by you.

*** Note that various default options for the gradebook are set at system level by the
administrator and can be marked as being overridable by you, or fixed. This means that the
options will not always be set up the same way for every user when they see the grader report for
the first time.

The View Grades page, as shown in Figure 17-1, contains several rows: first the course, then the
category, then the columns for each graded activity (for example: Assignment, Quiz, and
Lesson). Any activities settings which were left "uncategorized™ will appear in the general
category which is named after the course by default.

There are three ways that the categories can be displayed:
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«  Grades only - without the category totals column
« Collapsed - Category total column only
- Full view - grades and the aggregates (the totals column for the category)

Each section has a small icon immediately to the right of its name. Clicking this will cycle
through these display modes for that category. + Goes to grades only view, o goes to full view
and - goes to collapsed view.

Grader report
All participants: 1/1

t pams

Alad
Urname

All A B

Figure 17-1 Viewing Grades
EDITING

Editing anything in the gradebook refers to editing the grades only and none of the available
operations bear any relationship to editing the main course page i.e. the appearance of your
course page cannot be influenced by anything you do in the gradebook. The "Turn editing on™
button functions separately from the main course one, so editing can be on in the gradebook, but
simultaneously off when you switch back to course view. This is because editing grades and
editing the course page are separate capabilities.

Highlighting rows and columns

When your gradebook starts to grow, it can be hard to keep track of which student and which
assignment a cell refers to. Highlighting solves that.
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« Clicking on empty space in the cell that contains the students name will toggle the
highlighting of that entire row

+  Clicking on empty space in the cell at the top of each column will toggle highlighting of
the entire column.

Sorting by columns

You can sort by any column. Click the symbol near the top of a column to sort by that
column. This will change the symbol to a single down arrow. Clicking again will sort lowest-to-
highest (ascending), changing the symbol to an up arrow. The arrows will toggle between these
two states until you click on a different column.

The student name columns do not have the symbol. Clicking on either the first or last name will
cause the report to sort.

Highlighting scores that are either adequate or unacceptable in red and green

Turn editing on and click on the edit icon in the controls cell at the top of the column. You can
then (maybe need to click 'show advanced') see the option to enter a 'grade to pass'. Once set, any
grades falling above this will be highlighted in green and any below will be highlighted in red.

*** Note that the highlighting will not show if the Grader report is viewed in the editing mode.

Horizontal scrollbar
A horizontal scrollbar enables teachers to scroll grades in the grader report. The horizontal
scrollbar is available both at the bottom and at the top of the grader report.

Mouse-over tooltips
Whenever you move your mouse each grade cell in the table displays a tooltip indicating the user
and grade item to which the grade belongs.

Hiding columns or individual grades

In the context of the gradebook, hiding refers to whether a student will be able to see that grade
or grade item in their user report. You can have an activity available on the course page for
which you would not want the students to know their grade. Also in reverse - an offline activity
that is hidden in the course page, but which you want the students to know their grade for.
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To hide/show columns or individual grades just click - "Turn editing On" & then clicking the
Gear Icon link will take you to the control page of that individual activity/ column where you can
check the "Hidden" checkbox for hiding the grades.

Altering the grades

You can click "Turn editing on" at the top right to show an edit icon next to each grade. Clicking
on the icon will bring up the editing screen for that grade which will allow you to set the grade,
its written feedback and a number of other attributes.

Alternatively, you can choose "Quick grading™ and "Quick feedback™ in 'My preferences' to
make the report appear with editable boxes containing each grade, so you can change many at
once.

SET PREFERENCES

You can set your personal preferences for the grader report via 'My preferences'. These settings
will apply to all courses for you as a teacher. You can change them at any time. The Set
Preferences page contains the following settings:

« Show calculations: If enabled, when editing is turned on, a calculator icon is shown for
each grade item and category, with tool tips over calculated items and a visual indicator
that a column is calculated.

«  Show show/hide icons: If enabled, when editing is turned on, a show/hide icon is shown
for each grade for controlling its visibility to the student.

« Show column averages: If enabled, the grader report will contain an additional row
displaying the average (mean) for each category and grade item.

« Show locks: If enabled, when editing is turned on, a lock/unlock icon is shown for each
grade for controlling whether the grade can be automatically updated by the related activity.

« Show user profile images: You can choose to display user profile pictures for easy
identification of students.

«  Show activity icons: If enabled, activity icons are shown next to activity names.

« Show ranges: If enabled, the grader report will contain an additional row displaying the
range for each category and grade item.

«  Show grade analysis icon: If the activity module supports it, the grade analysis icon links
to a page with more detailed explanation of the grade and how it was obtained.

«  Grades selected for column averages: This setting determines whether cells with no grade
should be included when calculating the average (mean) for each category or grade item.

« Show number of grades in averages: If enabled, the number of grades used when
calculating the average (mean) is displayed in brackets after each average.
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« Quick grading: If enabled, when editing is turned on, a text input box appears for each
grade, allowing many grades to be edited at the same time. Changes are saved and
highlighted when the update button is clicked.

*** Note that when a grade is edited in the grader report, an overridden flag is set, meaning
that the grade can no longer be changed from within the related activity.

Grader report preferences

it ts Set Cege
Pom oo sctve encTImeets

T=asaw Adr

Figure 17-2 Setting Grade report preferences

[1 Show quick feedback: If enabled, when editing is turned on, a feedback text input box with
a dotted border appears for each grade, allowing the feedback for many grades to be
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edited at the same time. Changes are saved and highlighted when the update button is
clicked.

*** Note that when feedback is edited in the grader report, an overridden flag is set, meaning
that the feedback can no longer be changed from within the related activity.

 Students per page: This setting determines the number of students displayed per page in
the grader report.

« Show only active enrolments: This setting determines, if only active enrolled users will be
visible in gradebook report. If enabled suspended users will not be shown in gradebook.

- Enable AJAX: Adds a layer of AJAX functionality to the grader report, simplifying and
speeding up common operations. Depends on JavaScript being switched on at the user's
browser level.

GRADE CATEGORIES

Grades can be organized into grade categories. A grade category has its own aggregated grade
which is calculated from its grade items. There is no limit to the level of nesting of categories (a
category may belong to another category). However, each grade item may belong to only one
category. Also, all grade items and categories belong to at least one, permanent category: the
course category.

Adding a grade category
To add a grade category:

» Select "Categories and items™ from the gradebook dropdown menu.

» Click the "Add category" button near the bottom of the page.

» Give the grade category a meaningful name.

» Select the aggregation method for the grades: The aggregation determines how grades in a
category are combined, such as o Mean of grades - The sum of all grades divided by the
total number of grades

o Median of grades - The middle grade when grades are arranged in order of size

o Lowest grade o Highest grade
Mode of grades - The grade that occurs the most frequently o Sum of grades - The
sum of all grade values, with scale grades being ignored

* Inthe "Category Total" Section:

o Grade Type: There are 4 grade types:
= None - No grading possible
= Value - A numerical value with a maximum and minimum
= Scale - Anitem in a list
= Text - Feedback only
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*** Only value and scale grade types may be aggregated. The grade type for an
activity-based grade item is set on the activity settings page.

Scale: This setting determines the scale used when using the scale grade type.
Maximum and Minimum Grade: Enter the maximum and minimum grades for the
category. You can also set passing marks for the category by clicking the "Show
More" link.

o Select grade category settings as appropriate. Advanced settings may be made
available by clicking the "Show More" button. o Click the "Save changes" button.

Edit categories and items: Simple view

e ENa S wegm M3a gage Arscrs I F el
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Figure 17-3 Setting weights on edit category page
GRADE CALCULATIONS

A grade calculation is a formula used to determine grades, based (optionally) on other grade
items. Calculations for the gradebook follow the pattern of formulas/functions in popular
spreadsheet programs. They start with an equal (=) sign, and use common mathematical
operators and functions to produce a single numerical output. This output is then used as the
computed value for the grade item you are editing.
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Setting a grade calculation

To set a grade calculation:

» Click on Grades in the course administration block
» Click the 'Categories and items' tab (or select it from the gradebook dropdown menu)

* Click the "calculator symbol' = (in the 'Actions' column, on the category total line) for the
category you wish to set a calculation for

Start with an equal sign (=)

* Choose a function; Example: =sum()

* Plug in your ID numbers enclosed in double square brackets, for example
=sum([[item1]][[item2]][[item3]])

» Separate each 1D number with a comma, for
example
=sum([[item1]],[[item2]],[[item3]]) [I
Click the "Save Changes" button.

Assigning ID numbers

You can include the values of other grade items by using their ID number as references in your
formulas. The ID number is surrounded by double square brackets, for example if you have a
grade item with Quiz.3 as ID number, you will refer to this item as [[Quiz.3]] in your calculation.

Below the calculation field is a list of your course with its grade categories and grade items. Next
to each item or category's total is displayed the ID number you can use in your calculation
(already surrounded with double square brackets). However, since the ID number is optional,
some items may not yet have one. These items without an ID number have instead a form field
which lets you enter an ID number directly.

As soon as you have assigned the ID numbers you need, you can click the "Add ID numbers"
button, and the page will reload and show you the same list with the ID numbers you have just
assigned.

Calculation functions

Every calculation must start with an equal sign (=). Following is a list of the functions supported
by the calculation. The comma (,) character is used to separate arguments within function
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brackets. The comma can also be used to separate different functions. (The separator character
could be a semicolon (;) in other languages, see below).

« average([[item1]], [[item2]]...): Returns the average of a sample

« max([[item1]], [[item2]]...): Returns the maximum value in a list of arguments

«  min([[item1]], [[item2]]...): Returns the minimum value in a list of arguments

« mod(dividend, divisor): Calculates the remainder of a division

«  pi(): Returns the value of the number Pi

« power(base, power): Raises a number to the power of another

« round(number, count): Rounds a number to a predefined accuracy [ floor(number): Maps
a real number to the largest previous integer

« ceil(number): Maps a real number to the smallest following integer

« sum([[item1]], [[itemZ2]]...): Returns the sum of all arguments

« an asterisk (*) gives the product of two items: [[item1]]*[[item2]]

GRADE LETTERS

Grade letters, also called letter grades, are symbols used to represent a range of grades. You may
choose letters (e.g., A, B, C, D, E) or words (e.g., Below Pass, Pass, Merit, Distinction).

To set your grade letter scale
Grade letters are set initially at site level. To use different grade letters in a particular course:

» Follow the grades link in the course administration block.

» Select Letters from the from the gradebook dropdown menu.

» Click the edit tab in the middle of the page.

» Check the override site defaults box.

« Change grade letters and/or boundaries as required. (You may wish to use words, for
example Below Pass, Pass, Merit, Distinction, rather than letters.) [J Scroll to the bottom
of the page and click the "Save changes" button.

Displaying letter grades

To change particular grade items, category and course summaries (called aggregations) in the
grader report and user reports to display letter grades:

» Follow the grades link in the course administration block.
» Select "Categories and items" from the gradebook dropdown menu.
» Click the edit icon for Category total or Course total.
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» From the Grade display type menu, select letter.
» Click the "Save changes" button at the bottom of the page.
Repeat this for any other totals that you want displayed as letters.

Alternatively, to display ALL grades as letter grades:

» Follow the grades link in the course administration block.

» Select "Course settings" from the gradebook dropdown menu.
» From the Grade display type menu, select letter.

* Click the "Save changes" button.

STUDENT GRADE VIEW

Students can check their grades by clicking the Grades link in their Administration block. They
can see only their own grades, not the other students®, as shown in Figure 17-4.

User report - student user

Gracte ilem Gmde Range Percentage Fesaback

B using mocche

0 Graces Moodie

\ Catwgory total - -0

v Course total . o1

Figure 17-4 Viewing grades as student

Export Grades (Backing up your gradebook)

We recommend that you regularly download your gradebook for backup. Your system
administrator should be backing up the entire server on a regular basis, but you can never be too
certain. After all, your students will complain to you if they lose their grades, not to the system
administrator.

314

——
| —



How to use E-leaning

To download your gradebook:

* Navigate to Administration > Grade Administration > Export and choose the format in
which you want to export the gradebook.

» Select the preferences for exporting the grades like items to be included and including
feedback in export etc. and click Submit.

« It will take you to the preview page where you can take a preview of the exported file.
» Click Download to download the gradebook to your computer.

If you follow the backup procedure on a regular basis, you will have a record of student grades if
there is a catastrophic loss of data on the server. You can always recover students‘ grades up to
that point in the semester if you have a regular backup.

Import Grades

Grades may be imported as a CSV or XML file. The import file format is the same as the
corresponding export format.

To import grades into the gradebook:

* Navigate to Administration > Grade Administration > Import & Select your chosen import
format from the gradebook dropdown menu.

« Browse and upload your previously saved file.
« Set options as required.
» Click the "Upload grades™ button

SCALES

Scales are a way of evaluating or rating a students' performance. Administrators can create
standard scales which are available across the site, and teachers can create custom scales just for
their own course. Scales may be used in Forums, Glossaries and Assignments for rating and/or
grading a student's activity.

Creating a new scale
To create a scale for your course:

« Click the "Add a new scale" button in Course administration > Grades > Scales.
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«  On the next page give your scale a name in the Name box that will identify it among other
scales.

- 'Standard’ scale is a scale which can be applied to every course in E-leaning. Only those
with site permissions such as administrators can make a new scale 'standard’. A regular
teacher can only create a scale for their own course.

« Inthe Scale box, create your scale. Each item in the scale should be separated by a comma.
You can use as many options here as you require. You must order the comma separated
elements in increasing order of value. For example, an A,B,C,D scale must be entered as
D,C,B,A.

«  Write a detailed description in the Description box to remind you (or other teachers) of how
the scale is to be used.

g Save the changes.

Hame

Stantare srae

Scale

Figure 17-5 Creating a new scale

USING SCALES

You can select a scale by going to the Edit settings screen of any activity, for example an
assignment, scrolling to 'Grade' and then selecting 'Scale' from the Type dropdown: Which will
then open up the 'Scale’ dropdown, allowing you to choose the scale you wish to use.

CREATIVE GRADE USES

The gradebook can be as useful in a business context as it is in traditional education. Most
business training tends to be shorter and more focused than traditional education, but scores are
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still important. Usually, managers and trainers are only interested in exceptional/pass/fail or other
simple scales for both activities and final scores. But trainees will still want to be able to track
their progress and see how they are performing.

Gradebook scores can also be used to track progress against competency models. Try creating a
category for each competency and track student scores on activities designed to measure the
students‘ performance against the performance standard.

Custom scales

Standard scales

Seate e £an

Figure 18-6 Viewing Scales

SCALE PRACTICES

Scales give you the ability to provide qualitative, rather than quantitative, feedback, but they
require careful wording. When creating scales, ensure that your word choices are meaningful to
the students and provide information they can use to improve their performance in the future.

Summary

This chapter deals with the most important aspect of online learning environment i.e. grading. E-
leaning has got sophisticated grading tools through which you can grade the work of students. In
the next chapter, we will take a glance on the administration part of the E-leaning site.

Chapter 19: E-leaning Administration
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If you are the administrator for your E-leaning site, there are a lot of options at your fingertips.
Most of the time, the default settings that come with your E-leaning installation will work well.
But there are a lot of options for customization and performance that can make your version of E-
leaning work exactly as you‘d like.

The number of administration settings has increased a lot in recent versions of E-leaning and it
can take a while to understand it all. We can only provide a brief mention of each setting in this
book; however, the —E-leaning Docs for this pagel links at the bottom of each page in E-leaning
provide access to further information.

This chapter is organized into sections that are the same as the links in the Site Administration
block, which you‘ll find on your E-leaning front page when you log in as an administrator. We‘ll
finish with a section on E-leaning support, just in case!

*** A good way to learn about E-leaning administration is to download and install a E-leaning
package on your own computer. Create some test user accounts and assign them the roles of
student and teacher. Try logging in as a student or a teacher in a different browser from the one
displaying you logged in as an administrator. You can change an administration setting, and then
see how it affects students or teachers by refreshing the page (or logging out, then logging in
again for role changes).

NOTIFICATIONS

In the middle of the Notifications page you'll find a link "Check for Available updates” clicking
which will give you the updates available for your E-leaning core and plugins installed on your
E-leaning site.

It will also warn you about your server settings which are not recommended, if any.

If you haven't setup cron task then some of your E-leaning functions may not work on scheduled
basis like sending Email copies of new forum posts. The cron is a script that is run regularly and
checks whether certain tasks need performing. So, it is important to setup the cron job for your
site.

And, in the bottom of the page, there is a button which will show that "your site is not
registered.” Registering your site with Itecrwanda.com is recommended in order to receive
security alert notifications, to contribute E-leaning usage statistics
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(http://E-leaning.net/stats/) and to share your courses on E-leaning.net, if you want to.

*** You can also find a lot of courses shared by the other E-leaning users on E-leaning.net for
getting started with the courses.

Below the E-leaning Registration button is your E-leaning version number. If you are asking any
questions on E-leaning Community forums or else if you add a bug report to the E-leaning
tracker (http://tracker.ltecrwanda.com/), you should state your E-leaning version number.

e plugins overview
Check for available updates

he cron.php maintenance script

Register your site

Moodle 2.7 2+ (Build: 20140911)
Copyright © 1999 onwards, Martin Dougiamas
and many other contributors.

GNU Public License

Figure 19-1 Site Notifications
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REGISTRATIONS

The registrations link will take you to a form where you have to fill the details about your E-
leaning site and some statistics are chosen by default like Site URL, E-leaning Version, Number
of courses etc. You can also opt out from the list of registered sites by choosing "Please do not
publish this site".

ADVANCED FEATURES

This link contains a lot of advanced features which are enabled by the Site Administrator as per
the policies adopted for the institutions. It contains features like Badges, Conditional Access, and
Completion Tracking etc.

We will go through the links in Advanced Features page one by one:

« Enable Outcomes: Outcomes are specific descriptions of what a student has demonstrated
and understood at the completion of an activity or course. Each outcome is rated by some
sort of scale. Other terms for outcomes are Competencies and Goals. In simple terms
outcomes are similar to sub components of a grade. A grade is an assessment of overall
performance that may include tests, participation, attendance and projects. Outcomes assess
specific levels of knowledge through a series of statements, which maybe coded with
numbers or letters. Thus an overall grade can be given for a course, along with statements
about specific competencies in the form of outcomes.

« Enable Comments: Enabling Comments enables users to add comments to glossary,
database activities and blog entries. The comments interface uses AJAX so that comments
are added instantly without needing a page refresh.

- Enable Tags functionality: Tags allows students and teachers to describe their interests in
a way that is easy for people with similar interests to find them. The user's profile has a
place to enter interests, which will create or add the user to an existing tag. Tag pages can
be viewed and blog posts can be tagged.

- Enable Notes: The Notes feature is a way to attach information about a user by another
user. For example, a teacher might attach a note to a specific student about the hobbies and
interests that seems to engage that student.

- Enable Portfolios: Portfolios in E-leaning make it easy for a student to export their work
to an external portfolio. For example, student work might include forum posts or
assignment submissions that they believe demonstrates their knowledge.

320

——
| —



How to use E-leaning

Enable Web Services: Web services enable other systems to login to E-leaning and perform
operations. E-leaning comes with a built-in web service designed for mobile applications.
It is required to run the official Mobile app. Enable it only if you want people to use the
official app or if a third party app explicitly requires it.

Advanced features

Enabie oulcomes

Enable comments v

£nabie tags functionaity

Enabée notes

Figure 19-2 Enabling/Disabling Advanced features

Enable Messaging System: "Messaging" refers both to automatic alerts from E-leaning
about new forum posts, assignment submission notifications etc., and also to conversations
using the instant messaging feature.

Hide Read Notifications: This option will Hide read notifications of events like forum posts
when viewing messaging history.

Delete Read Notifications: Read notifications can be deleted to save space. You can choose
the time delay for deleting the read notifications.

Notification email override: This option allows users to have email message notifications
sent to an email address other than the email address in their profile.

Enable Statistics: If you choose 'yes' here, E-leaning's cronjob will process the logs and
gather some statistics. If statistics are enabled for the site, graphs and tables of user activity
may be generated. The statistics graphs and tables show how many hits there have been
on various parts of your site during various time frames. They do not show how many
distinct users there have been. They are processed daily at a time you specify.
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« Enable RSS Feeds: RSS (really simple syndication) feeds in E-leaning enable people to
stay up to date with forum posts, glossary entries and other events within E-leaning. You
can also use a Remote RSS feeds block which enables RSS feeds (either from within E-
leaning or from an external site) to be displayed on pages in E-leaning.

- Enable Blogs: Blogs are a form of online journal used by millions of people around the
world for self-expression and communicating with family and friends. You can enable
blogs for complete site using this option.

« Networking: The E-leaning network feature allows a E-leaning administrator to establish a
link with another E-leaning or a Mahara site and to share some resources with the users of
that E-leaning. Users go from the first E-leaning to the linked site via the Network server‘s
block.

« Enable Completion Tracking: Activity completion allows the teacher to set completion
criteria in a specific activity's settings. A check (tick) appears against the activity when the
student meets this criterion. The criterion might be viewing, receiving a certain score or a
student marking it as complete.

*** |f Completion tracking has been enabled, the teacher will see the Activity completion group
in their course settings. However, it is possible to track activity completion without using the
Course completion feature. It is also possible to use this feature with the Conditional activities
feature. These 3 features can be used separately or in various combinations in an activity.

« Default Completion Tracking: The default setting for completion tracking when creating
new activities.

- Enable Conditional Access: Conditional activities enable teachers to restrict the availability
of any activity or even a course section (in E-leaning 2.3 onwards) according to certain
conditions such as dates, grade obtained, or activity completion. When it is enabled by the
administrator, a "Restrict access" setting appears in the settings of activities or resources
and also when editing a course section.

- Enable Plagiarism Plugins: Plagiarism is when a student submits content they have copied
and the real author was not given credit for the words. Plagiarism prevention detects when
this form of cheating or academic dishonesty has happened. E-leaning doesn't come with
any pre-installed plagiarism prevention methods - they need to be added by a site
administrator.

- Enable Badges: Badges are a good way of celebrating achievement and showing progress.
Badges may be awarded based on a variety of chosen criteria and are fully compatible with
Mozilla Open Badges. Badges created in E-leaning may be displayed on a user's profile or
pushed to their Open Badges backpack and public badge collections in their backpack will
display in their E-leaning profile.
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USERS

User management can be one of the most time-consuming jobs for an administrator. As your
system grows, the number of users who lose their password or have difficulty creating a new
account grows as well. Fortunately, there are a few tools to help make the job of user
management easier.

Accounts
Each user on your E-leaning site has an account that contains profile information, forum posts,
blog entries, and activity reports.

[ Browse list of users: The —Browse list of usersl page provides a list of all user accounts.
You can also add a new user using the link on the top of the page "Add a new user”. You
can also filter the users using the advanced filter tools on the top of the page.

If you are using email-based self-registration and a user has a problem confirming his account,
you can confirm his account for him by clicking the confirm link opposite his name.

You can also search for a particular user, using her name or email address as the search term, and
then edit her profile. You will need to do so in order to reset user passwords if users are unable to
log in. Another reason for editing a user‘s profile is to disable her email address if you are
receiving lots of undelivered mail!

*** |If you want to temporarily disable an account (i.e., prevent a user from logging in to E-
leaning), you can do so by clicking the "Eye icon™ in the Edit column to suspend the user.

« Bulk User Actions: The bulk user actions feature enables administrators to select users by
creating a filter and then perform any of the following actions:
o Confirm user accounts created through Email-based self-registration which are
not yet confirmed by the user
o Send a message (requires Messaging to be enabled) o Delete user accounts o
Display a list of users on a page o Download user data in text, ODS or Excel file
format o Force users to change their passwords o Add users to a cohort
« Add a new user: This link will take you directly to add a new user page where you can
provide the details for the user like Name, Email, Country, etc. You can choose to force
change the password on first login.

323

——
| —



How to use E-leaning

User profile fields: You can create new user profile categories and fields which may be
a menu of choices, text area, text input or a checkbox and may be required or not. New
profile fields will appear on each user*s profile page and can be displayed on Signup
page also.

Cohorts: Cohorts are site-wide or category-wide groups. Cohorts enable all members of a
cohort to be enrolled in a course in one action, either manually or synchronized
automatically.

« Upload Users: The —Upload usersl page allows you to import a list of users via a text
file. E-leaning creates an account for each user and, if you want, can also enroll students
in courses and arrange them in groups. The user data text file must follow a certain format,
as described in the upload users help file. There are many robust options for uploading
information (fields associated with a user) with this method: from enrolling users in
multiple courses with course specific roles to updating user information in the User profile
to deleting users from the site. Rather than uploading the text file, it can also be simply
dragged from the desktop and dropped into the upload area. The format of the file should
be as follows:

o Each line of the file contains one record o Each record is a series of data
separated by commas (or other delimiters) o The first record contains a list of
fieldnames defining the format of the rest of the file

o Required fieldnames are username, password, firstname, lastname, email o
Upload User Pictures: Site Administrator can also upload the user pictures in
bulk to the E-leaning site. You need to create a zip file containing the image
files. The names of the files should be named in username.extension format.

Permissions

User Policies: This page will enable you to define policies for the default users. The
available options are:
o Role for Visitors: Users who are not logged in to the site will be treated as if they
have this role granted to them at the site context. The default role is Guest.
Role for Guest: This role is automatically assigned to the guest user.
Default Role for all users: All logged in users will be given the capabilities of the
role you specify here, at the site level; in ADDITION to any other roles they may
have been given.
o 'Creators' role in new courses: If the user does not already have the permission to
manage the new course, the user is automatically enrolled using this role.
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'Restorers’ role in courses: If the user does not already have the permission to
manage the newly restored course, the user is automatically assigned this role and
enrolled if necessary.

Auto-login guests: Should visitors be logged in as guests automatically when
entering courses with guest access?

Hide user fields: Select which user information fields you wish to hide from other
users other than course teachers/admins.

Show user identity: When selecting or searching for users, and when displaying
lists of users, these fields may be shown in addition to their full name.

Full name format: This defines how names are shown when they are displayed in
full.

Maximum users per page: Maximum number of users displayed within user
selector in course, group, cohort, webservice etc.

Enable Gravatar: When enabled E-leaning will attempt to fetch a user profile
picture from Gravatar if the user has not uploaded an image.

- Site Administrators: Users may be assigned the role of site administrator by using this
setting. Select the user whom you wish to assign the site administrator role and click Add
in the middle of the page.

Figure 19-3 Define Roles
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0
*** Note: The primary administrator (created when the site was created) cannot be removed

from the site administrator role.

Define Roles: This is the place to add custom roles or modify existing roles. The
"Manage roles" tab, allows the system administrator to edit any one of over 350 different
capabilities associated with any role. The "Allow role assignments”, "Allow role
overrides” and "Allow role switches" contain a matrix which give the ability for a
specific role to work with other specific roles.

« Assign System Roles: In E-leaning, apart from the site administrator, users do not
normally have a global, site-wide role. You may have a role of teacher in some course
whereas you can also be a student in some other course. By assigning a role to a user in a
context, you are granting them the permissions contained in that role, for the current
context and all lower contexts. By default there are two roles to choose from: Manager
and Course Creator.

« Check System Permissions: To check the permissions of a particular user in System
Context you can use this page. It will display the complete list of capabilities of the user
in the System context.

- Capability Overview: This report shows, for a particular capability, what permission that
capability has in the definition of every role (or a selection of roles), and everywhere in
the site where that capability is overridden.

« Unsupported Role Assignments: Unsupported role assignments are role assignments in
contexts that make no sense for that role, such as the course creator role in the course or
activity context, or the teacher role in the user context.
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Figure 19-4 Role Assignments

Courses
You, as the administrator, together with any colleagues you have assigned as course creators,
are responsible for adding courses to E-leaning.
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Manage Course and Categories: Course categories organize courses for all E-leaning
site participants. The default course category on a new E-leaning site is "Miscellaneous”.
Although you are certainly free to put all your classes in the miscellaneous category,
your students will find it easier to find their classes if they are organized in descriptive
categories. The list of courses within a category by default shows the teachers and the
summary of each course.

The page is having 3 different view options:

o Course Categories and courses: All categories are shown on the left side and the
courses within the selected category are shown on the right side. o Course
Categories: Display only the categories within the E-leaning site.

o Courses: Display the courses within a particular category which can be chosen
from a drop down menu on the top right corner.

- Add a category: Most people organize their courses by department and college or by topic.
Be sure to test the organizational scheme with a few users before entering a large number
of courses, to save time in moving them later. You can add a new category by:

0 Go to Administration > Site administration > Courses > Add a category o
Complete the details required and click ‘Create category.'

***Alternatively, you can go to Administration>Site
administration>Courses>Manage courses and categories and click the link 'Create
new category'.

Course and category management

Course categories Miscellaneous

Morve 1eiedted toures o

MIve 10Cing CHeQOES 10
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Figure 19-5 Course and category management

You now have a new course category, which you can move up or down or into an
existing category to create a subcategory.

Once you set up a few course categories, you are ready to create a course.

Restore Course: A course backup file (mbz) may be restored from within any existing
course for which you have permission. During the restore process, you will be given the
option to restore as a new course or into an existing course.

*** If your new course has fewer sections than the course you are restoring, the extra sections
will appear as "orphaned activities". Increase the number of sections in the new course to make
them visible.

Course Default Settings: You can enter the default settings for the new courses like the
format of the course, no. of sections, course layout, news items to be displayed etc.
Course Request: By default a regular teacher can't add a new course. This page will allow
any authenticated user on the site to request a course to be created. You can define the
default category for course requests and course request notification.

Backups:

o General Backup Defaults: A course can be saved with some or all of its parts by
using the course backup. On this page you can define the default settings for the
items which will be included in the backup of the course like Users, Activities,
Blocks, Filter‘s etc.

o General Import defaults: On this page you can provide the number of courses that
are listed during the first step of the import process.

o Automated Backup setup:

Upload Courses: You can upload multiple courses via text file. In addition to creating
new courses, this functionality may also be used to update or delete courses, or import
content from another course. The format of the file should be as follows:

o Each line of the file contains one record o Each record is a series of data separated
by commas (or other delimiters) o The first record contains a list of fieldnames
defining the format of the rest of the file

o Required fieldnames are shortname, fullname, and category

Grades

General Settings: Here you can set the general grades settings which will be applicable
sitewide. You can define the roles to be graded, the report available
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on the user profile page, navigation method, maximum grade points and the default
grade points for an activity.

Grade Category Settings: This page enables you to choose which options appear for
teachers when adding/editing a grade category in their course gradebook, and their default
values. There are 2 check boxes next to most features on this page. The "Force" check
box eliminates any options the teacher will see. For example, if you check the Forced
checkbox besides the Aggregation dropdown, then the teacher will only see and are able
to use the "mean of all grades™ as an aggregation. The "Advanced" checkbox will hide the
specific feature until the "Show advanced" button is used by the teacher. This will reduce
initial menu choices for teachers but allow them to see them if they wish.

Grade Item Settings: Grade item settings are the various settings that the administrator is
able to edit for all gradebooks used by teachers. These settings will change what items are
displayed for each grade. Let's suppose that you want the grades to be displayed on the
form of Letters (to represent a range of percentages) to the students then you have to set
the grade display type option to letters so that the actual grades entered by the teachers will
be displayed as letters to the students.

Scales: Scales are a way of evaluating or rating a students' performance. Administrators
can create standard scales which are available across the site, and teachers can create
custom scales just for their own course. We have discussed about Scales in chapter 17.
Letters: TO define the range of percentage in the form of letters you can define the letters
on this page. E-leaning will provide you with some default letter grades. You can
customize the same by clicking Edit Letter Grades anytime.

Report Settings:

o Grader Report: Here you can define the default preferences for the Grader report
to be displayed sitewide to all teachers. You can define how many students to be
displayed on a page, quick grading, quick feedback, AJAX to be enabled by default
or not, etc. However, teachers can still be able to change the default settings by
using the "My Report Preferences” link.

o Overview Report: The overview report lists all the courses a student is enrolled in
together with the total grade for each course. You can define whether to Show the
rank of the students in relation to the rest of the class for each grade item and
whether totals which contain hidden grade items are shown to students or replaced
with a hyphen symbol.

o User Report: The user report shows the currently logged in user's grades in the
current course. It includes:

1. A breakdown of the grades for each assessment (grade item) in the
course.
2. The optional teacher-given feedback for each grade.

3. The overall grade for the course (called course total).
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*** Teachers can choose whether to show or hide rank and percentages in the Gradebook course
settings.

Badges

Badge Settings: Here you can set the name and email address of the badge issuer. You may
set the name of the institution in this field as this name will be displayed while viewing the
badges. You can also set the connection to the external backpacks like Mozilla's Open
Badges.

*** You can also enable the course badges on this page which allows the teachers to
create and award badges.

Manage Badges: On this page you can manage the Site Badges. Site badges can only be
awarded to users for site-related activities. These include completing a set of courses or
parts of user profiles. Site badges can also be issued manually by one user to another.

Badges for course-related activities must be created at the course level. Course badges
can be found under Course Administration > Badges.

You will find a link on this page to "Add a new Badge" to add a new badge to the Site
badges.

Add a new badge: You can add a new site wide badge using this link. You have to enter
the details like the name and description of the badge along with the badge image.

You have to enter the Issuer details on this page like the Name and Email address in the Issuer
Section.

You may also enter the expiry date for the badges awarded by your institution. Optionally,
badges can expire on a specific date, or the date can be calculated based on the date when the
badge was issued to a user.

Location

Location Settings: The location settings page includes the following options:
o Default TimeZone: This sets the default time zone for date display. This can be
overridden by a user‘s profile setting unless the default time zone is forced.
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Default Country: Select your country so that it appears by default on the new
account page.

IP Address Lookup: By default E-leaning uses the free online NetGeo (The Internet
Geographic Database) server to lookup location of IP addresses, which is not
maintained anymore. It is recommended to install local copy of free GeoL.ite City
database from MaxMind. IP address location is displayed on simple map or using
Google Maps.

« Update Timezones: This page will search for new information about world timezones
(including daylight savings time rules) and update your local database with this
information.

Language

One of E-leaning‘s many strengths is its language-handling capabilities. As we mentioned in
Chapter 2, you can provide users with a choice of language or force a language in a particular
course. Even if you want your site in English only, you may well find the language editing
facility useful for making changes to the standard text in E-leaning.

[1 Language Settings: The language settings page includes the following options:
o Default language: This sets the default language for the site. The setting can be

overridden by users using the language menu, or the setting in their personal
profile.

*#% If a preferred language is set in a user‘s browser, then this will override the default site

language.

Display language menu: This sets whether the language menu is displayed on the
login page and the front page. If it is turned off, the only places where a user can
change the language setting are in her user profile or in the course settings if she is
a teacher.

Languages on the language menu: If you want to limit the number of languages
students and teachers can select from, enter a reduced list here.

Cache language menu: If enabled, the list of available translations is cached.
Cache all language strings: Caches all the language strings into compiled files in
the data directory.

Sitewide locale: It's generally best to leave this setting empty, as it's set through
each language pack.

Excel encoding: Leave as default (Unicode) unless you have a particular reason
for wanting Latin encoding.
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« Language Customization: The language editing interface enables you to easily change any
word or phrase used on the site. For example, you may want to change the word —Coursel

to —Unit.|

= Filter strings

backup.php

Customised only —
Help only =
Modified only =
Only strings containing
String identifier
Show strings

Page 123456780910 11 (Nex)

Apply thanges and continue editing

Component String Standard text

core_admin  accessdenied Access demed
core_admin  accounts Accounts
core admin - 2ddcateqory Add 2 category

Save changes to the language pack

Local customisation

——
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Figure 19-6 Editing word or phrases

To change a word or phrase:

Go to the Administration > Site administration > Language> Language
customization page.

Pick the language to customize from the pull down list.

Click on the "Open language pack for editing” button. This may take some time to
process.

Once the language pack has loaded, click on the "Continue" button.

Click or Ctrl+Click to select the files in the "Show strings of these components™ list.
Notice that the files are grouped. For example, you will find the lesson strings under
"mod" and E-leaning.php under “core".

After selecting the file(s), it is possible to use the "Only strings containing™ filter
along with other filters. For example, to look at only the string text that has the word
"teacher" the file(s) you selected.

Click on "Show strings".

Make your changes in the appropriate "Local customization™ box.

Click on "Apply changes and continue editing™ if you want to use another filter or
edit other file(s).

Click on "Save changes to the language pack™ to save all of the changes you have
made.

« Language Packs: At the time of this writing, over 100 language packs are available for you
to install on your E-leaning site. Simply select the languages you require from the list of
available language packs and click the —Install selected language packl button.

*** All language packs, apart from English, are stored in the E-leaningdata/lang folder.

Plugins

As mentioned in the beginning of this book, E-leaning is an acronym for Modular Object
Oriented Developmental Learning Environment. It has a modular design which can be extended
by using the Plugins designed by the community members.

You can extend the functionality of your E-leaning site by choosing Plugins from the large
collection of plugins on E-leaning Community site.
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Install Plugin
In E-leaningyou can install the plugins right within the E-leaning site from your browser either

directly from the E-leaning plugins directory or by uploading a ZIP file. No need to install
plugins through your FTP interface. Alternatively, an add-on code may be deployed manually at
the server.

*** The web server process has to have write access to the plugin type folder where the new add-
on is to be installed in order to use either of these methods.

To install a plugin from the E-leaning plugins directory to your E-leaning site:

«  Go to Administration > Site administration > Plugins > Install plugins.

+  Click the button 'Install plugins from E-leaning plugins directory".

« Search for a plugin with an Install button, click the Install button then click Continue.

« Check that you obtain a "Validation passed!" message, and then click the button 'Install

plugin’.

Plugins Overview
The Plugins overview page in Administration > Site Administration > Plugins > Plugins overview
lists all installed plugins, together with the version number, release, availability (enabled or

disabled) and settings link (if applicable).
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Figure 19-7 Installing plugins

A 'Check for available updates' button enables admins to quickly check for any updates available
for plugins installed on the site (from the plugins directory). Any updates available are
highlighted, with further information and a download link in the notes column opposite the

plugin.

Activity Modules
The activities page, as shown in Figure 19-8, enables you to manage E-leaning‘s activity
modules.

The Hide/Show column allows selected modules to be hidden, so they do not appear in any
course —Add an activityl drop-down menu and cannot be used in any course. To hide a module,
click the eye icon so that it changes to a closed eye.

For various reasons, few modules are hidden by default. For example, the Assignment 2.2 and
Feedback modules are included in E-leaning for historical reasons but kept as disabled by
default.
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Activities
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Figure 19-8 Managing activities

The activities page also lists how many activities for each module there are on your E-leaning
site. If you click on a number, the list of courses containing that activity will be displayed.

Apart from the basic standard modules, any module can be deleted using the link in the Delete
column.

There is no reason for standard modules to be deleted. However, nonstandard modules may need
to be deleted before upgrading.

*** To delete a module completely, in addition to deleting it on the activities page, you also need
to remove/delete the actual module folder from the E-leaning/mod folder. Otherwise, E-leaning
will reinstall it next time you access the site administration. This also applies to blocks.
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Many of the modules have additional settings, which can be accessed via the links in the Settings
column. Settings you may want to change include:

« Assignment: You can set the default feedback plugin, submission statement and various
other default assignment settings.

- Book: Here you can define the available options for chapter formatting and the default
option for chapter formatting.

+ Chat: By default the chat method is Ajax which can be changed to Normal method or Chat
Server daemon. Ajax method works everywhere but if many people are using chat
simultaneously then it can put a large load on the server. On this page you can define the
settings for the chat method you have chosen.

« Database, Forum & Glossary: If you have enabled RSS across the site (in the Server > RSS
section of the Site Administration block), you will also need to enable RSS in the Database,
Forum, and Glossary modules. You can also set the default settings for Forum and Glossary
activities.

« IMS Content Package: IMS content package settings page allows you to set whether the
description for the activity is required or not and how many packages should be archived.

« Label: Label module settings page allows you to set whether E-leaning should offer to
create a label when media files are dragged & dropped onto a course and the resized height
and width of the image.

« Lesson: You can define the slideshow and popup media settings and the action which has
to be taken after a correct answer.

« External Tool (LTI): You can add external tools providers (LTI providers) from this page.
We have discussed about external tools in Chapter 16.

« Page: You can define the available display options for the page resource. By default only
open is selected. You can also display a page resource in a popup window.
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Quiz: You can define the default values that are used in the settings form when you
create a new quiz. You can simplify the —Add a new quizl page by selecting a number
of options to be hidden from teachers by default and only displayed when teachers click
the —Show Morel button.

- File: You can define the available display options and the default values available to the
teacher while adding a file resource.
SCORM: SCORM settings page will allows you to define the default settings like whether
to display the course structure on entry page, the directory links, location bar, menu bar
etc. You can also define the grading settings for the SCORM activity packages.

- URL: This page allows you to define the available display options for URL resource and
the popup height /width.
Workshop: Workshop settings page allows you to default grade settings for submission
and assessment along with the maximum attachment size and grading strategy etc.

Admin Tools

You can uninstall the default available admin tools from the manage admin tools link. The page
will display a table containing the name of the tool along with the version number and a link to
uninstall it.

Authentication

One of the first things you need to consider when setting up your E-leaning site is user
authentication, i.e., enabling people to log in to your E-leaning site.

In Chapter 2, we covered how to create a user account using email-based selfregistration.
You created the account and E-leaning sent you an email with a link to confirm your address.
While this is an effective and efficient way to create new accounts, particularly for smaller sites,
E-leaning provides a number of other authentication methods as well. If you are in a university
environment and have access to a university email or directory server, you can tell E-leaning to
use them to authenticate new user accounts instead. External servers prevent users from creating
multiple accounts and prevent people from outside your organization accessing your server when
they shouldn‘t.

Authentication methods (also known as authentication plug-ins) include:

« Manual accounts: This method requires the administrator to manually create all user
accounts. It may be used together with the upload users facility
Email-based self-registration: With this method, users can create their own accounts. They
then receive an email at the address they specified in their account profile to confirm their
account.
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External database: This method uses an external database to check whether a given
username and password are valid. You can choose whether certain E-leaning user profile
fields are filled with information from the external database.

FirstClass/POP/IMAP/LDAP/NNTP server: These methods use an external server to
check whether a given username and password are valid. If the name and password match,
an account with the same username is created in E-leaning.
MNet Authentication: E-leaning Networking is a feature enabling resources to be shared
between E-leaning sites using a single sign-on. You can also use the MNet authentication
method to login to the external portfolio sites like Mahara.

Manage authentication
Available authentication plugins
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Figure 19-9 Manage Authentication plugins

No authentication: Users can create accounts with no external validation. This option
should only be used for testing purposes.

Shibboleth: Shibboleth is open source software that provides a single sign-on across or

within organizational boundaries.
« Web Services Authentication: Web Services Authentication method should be used for

accounts that are exclusively for use by web service clients.
To set the authentication method:

Click on Authentication in the Site Administration block.
On the authentication page, as shown in Figure 16-1, click on the closed-eye icon to enable

your chosen authentication plug-in.

If you want, you may choose to use more than one authentication method. Use the up/down
arrow icons to arrange the plug-ins in order, with the plug-in handling the most logins at the top
of the page. This will minimize authentication server load.

If you have courses with guest access, set the Guest login button to show.

Click the —Save changesl button.
Click on Settings opposite the authentication plug-in(s) you have chosen.
Configure the required settings and click the —Save changesl| button.

Blocks
The blocks page, which looks similar to the activities page, enables you to manage blocks in E-

leaning. As for activity modules, you can show, hide, and delete blocks.

The blocks page also lists the number of instances of each block. Clicking on a number results
in the list of courses containing that block being displayed.

A few blocks have additional settings, which can be accessed via the links in the settings
column. Settings that you may want to change include:

Remote RSS feeds
You may want to allow teachers or even everyone to be able to add new RSS feeds. If not, then

teachers will have to contact you to add new RSS feeds.
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To add a new RSS feed:

*  Click the —Add/edit feedsl link at the bottom of the —Remote RSS feeds settingsl page.
*  Onthe —Add/edit feedsl page, add the news feed URL and a custom title
(optional).
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*  Click the Add button.

Course Formats
You as a site administrator can manage which Course formats are available for courses. Course
formats can be disabled (hidden), re-organized or deleted.

Enrolments

By now you should have set up user authentication, i.e., enabled people to log in, created some
courses, and assigned teachers to them. The next thing to consider is course enrollment, which is,
assigning users the role of student in a course.

By default, students can enroll themselves in whatever courses they choose. They do so by
clicking on the course name, then answering Yes to the question —You are about to enroll
yourself as a member of this course. Are you sure you wish to do this?l This method of
enrollment is called self-enroliment.

Whilst self-enrollment is an effective and efficient way of managing course enrollment,
particularly if you don‘t have a lot of courses, E-leaning also provides a number of other
enrollment methods (or enrollment plug-ins). They include:

« Paypal: This method allows you to set up an e-commerce system so students can pay to
enroll in a course. If you are running a business selling E-leaning-based courses, you can
use this method to enable students to use a credit card.

 External database: This method looks up enrollments in another database. You‘ll need to
configure the login settings so E-leaning can access the remote server and map the fields
in E-leaning to the fields in the external database.

« Flat/IMS Enterprise file: Like the upload users tool, these methods allow you to import
user enrollment data via a specially formatted text file. IMS Enterprise file format is
described in a help file, and flat file format is described on the flat file settings page.

«  Self-Enrollment: This is the default enrollment method, as described above.

« LDAP: You can use an LDAP server to manage enrollment as well as manage
authentication. Setup instructions can be found in the E-leaning documentation.
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Manage enrol plugins
Available course enrolment plugins
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Figure 19-10 Managing enroliment plugins

To set the enrollment method:

«  Click on the Site Administration > Plugins > Enrollments > Manage Enrollments.
+ On the enrollments page, as shown in Figure 19-10, click the closed eye icon opposite to
your chosen enrollment plug-in to enable it.

As for authentication methods, you may choose more than one enrollment method, if you wish.
For example, if you have some courses that students must pay for and some free courses, you can
use PayPal and self-enrollment.

+  Click on Settings link opposite the enrollment plug-in(s) you have chosen.
«  Configure the required settings and click the —Save changesl button.

Filters

Filters allow for the automatic transformation of entered text into different, often more complex
forms. For example, the titles of resources can automatically become hyperlinks that take you to
the relevant resource, or URLS pointing to MP3 files can become Flash controls embedded in the
web page that let you pause and rewind the audio. There are a number of standard filters included
with E-leaning and many more specialized filters available from the ltecrwanda.com modules
and plug-ins database.
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The filters included in the standard download are:

« Activity names auto-linking - This scans text for activity titles that exist in the same course
and creates a link.

- Algebra notation - This filter will convert algebra code into GIF images

«  Convert URLs into links - This filter converts URLSs in selected formats, such as E-leaning
auto-format, to click-able links

- Database auto-linking - As the name suggests, this filter enables automatic linking of
Database module entries

- Display emoticons as images - This converts emoticon (smiley) characters into images

- Email protection - This obfuscates email address links to make them more difficult for
spammers to harvest

+ Glossary auto-linking - This scans text for glossary entries that exist in the same course and
creates a link

« MathJax - For adding Mathematical equations and expressions using an equation editor

Manage filters
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Figure 19-11 Managing Filters

«  Multimedia plugins - This finds a link in text that points to a multimedia resource and
replaces the link with an appropriate multimedia player code which can play the resource
«  Multi-language content - This filter enables resources to be created in multiple languages
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« Word censorship - This filter "blacks out" words found on a list

To enable a filter:

« Go to Administration > Course administration > Filters or if you are in an activity
Administration > Activity administration > Filters [J Set each filter on or off as required [
Click the 'Save changes' button.

Certain filters have additional settings, which can be accessed via the links in the settings
column.

Licences

You can enable/disable any/all of the licences in Administration > Site administration > Plugins >
Licences > Manage licences for user selection when publishing a course to a Community Hub or
uploading a file from a File Repository.

Local Plugins
You can manage any local plugins from this page. It is basically meant for plugins developed by
your own or any local customization of a standard plugin.

Logging
You can define which log stores are available, and in which order. Available stores are:
Standard, Legacy and External database.

The default Standard log is very detailed and should meet most requirements. The Legacy log
should be disabled unless you have old custom reports that need it. An External database log
store also allows you to connect to an external log database.

*** A new E-leaning site will have Standard logging enabled and Legacy logging disabled. A
site which has been upgraded will have both enabled.

Message Outputs

There are four default types of output methods for messaging: popup notices, Jabber IM type
messages, messages sent as email and mobile notifications. By default Popup and Email are both
enabled, though email will only work of course if the site has been properly configured to deliver
email. Jabber and Mobile notifications are off by default and needs to be configured first.
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Question Behaviors

On this page you can disable few question types or even uninstall them if you are not going to
use them. You will also find out the information about No of question attempts and the version
number.

Question Type

You can manage the question types available for the teachers on your E-leaning site to choose
from. You can see the no of questions are there for a particular question type and a link to
uninstall a few of them.

Reports
You can manage the available reports on your site from the manage reports page.

Repositories
You can enable/disable the repositories available for your E-leaning site using this page. You can
set any repository plugin to:

- Enabled and visible - appears in the file picker
- Enabled and hidden
+ Disabled - default setting

The order in which repositories are shown in the file picker may be set using the up and down
arrows. You can also change the common repository settings using this link and change the
individual repository settings. We have discussed about repositories in Chapter 5.

Text Editors

Manage Editors page will show you about the available text editors on your E-leaning site. You
can enable/disable, uninstall and change the order of the text editors according to your
preference.

Apart from this you can access the settings page of any text editor using the settings link where
you can define the settings for the individual text editor like Atto or TinyMCE text editor.
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Web Services
In the sub links you can manage the web services to be enabled and activated on your E-leaning

site.

Security

The E-leaning project takes security seriously and is continuously improving E-leaning to fix any
security issues that may arise. We recommend that you take the following basic security
measures:

Update E-leaning regularly on each release. Published security holes draw crackers*
attentions after release. The older the version, the more vulnerabilities it is likely to contain.
Disable register globals. This will help prevent against possible XSS problems in third-
party scripts.

Ensure that administrators and teachers use strong passwords. This protects against —brute
forcel cracking of accounts.

Only give teacher permissions to trusted users and avoid creating public sandboxes with
free teacher accounts.

*** Further security advice can be found in the E-leaning documentation.

You will find the following links in the Security tree:

IP Blocker: If you are using E-leaning on your own local server then you can define the list
of the allowed IP addresses and blocked IP addresses. You can also define whether to
process the allowed IP's or the blocked IP's first.
Site Policies: You can set site policies affecting the security and privacy of the site on the
Site Policies Page. The site policies page includes the following options:
o Protect Usernames: It will enable to hide the user name in case of any forget
password reset attempt. It will not provide any hint to guess the username.
o Force Users to Login: Requires everyone to login before being able to view the
front page also.
o Force users to login for profiles: Requires any visitor to login to the site with a valid
account before being able to access any user‘s profile.
o Force users to log in to view user pictures: If enabled, users must be login in order
to view user profile pictures.
o Open to Google: Enabling this setting allows Google‘s search spiders guest access
to your site. Any part of the site that allows guest access will then be searchable on
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Google. In addition, people coming into your site via a Google search will
automatically be logged in as a guest.

Profile visible roles: You can select the list of roles that are visible on user profiles
and participation page.

Maximum uploaded file size: Upload file sizes are restricted in a number of ways—
each one in this list restricts the following:

= The Apache setting LimitRequestBody

= The PHP settings post_max_size and upload_max_filesize

= The site-wide maximum uploaded file size setting in the Security > Site
policies section of the Site Administration block

= The course maximum uploaded file size setting in the course settings

= Certain activity module settings

User quota: The limit of file size area for the user‘s private files. By default it is
set to 100MB.

Allow EMBED and OBJECT tags: As a default security measure, normal users are
not allowed to embed multimedia (like Flash) within texts using explicit EMBED
and OBJECT tags in their HTML. If you wish to allow these tags then enable this
option.

Enable trusted content: By default E-leaning will always thoroughly clean text that
comes from users to remove any possible bad scripts, media etc. that could be a
security risk. The Trusted Content system is a way of giving particular users that
you trust the ability to include these advanced features in their content without
interference. To enable this system, you need to first enable this setting, and then
grant the Trusted Content permission to a specific E-leaning role. Texts created or
uploaded by such users will be marked as trusted and will not be cleaned before
display.

Maximum time to edit posts: This sets the editing time for forum postings. The
editing time is the amount of time users have to change forum postings before they
are mailed to subscribers.

Allow extended characters in usernames: Enable this setting to allow students to
use any characters in their usernames.

Site policy URL: If you have a site policy that all registered users must see and
agree to before using this site, then specify the URL to it here, otherwise leave this
field blank.

Site policy URL for guests: If you have a site policy that all guests must see and
agree to before using this site, then specify the URL to it here. o Keep tag name
casing: Check this if you want tag names to keep the original casing as entered by
users who created them.

Profiles for enrolled users only: To prevent misuse by spammers, profile
descriptions of users who are not yet enrolled in any course are hidden. New users
must enroll in at least one course before they can add a profile description.
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o Cron execution via command line only: If this is set, then the cron script can only
be run from the command line instead of via the web. This overrides the cron
password setting below.

o Cron password for remote access: This means that the cron.php script cannot be
run from a web browser without supplying the password.
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Account lockout threshold: Select number of failed login attempts that result in
account lockout. This feature may be abused in denial of service attacks.

Account lockout observation window: Observation time for lockout threshold, if
there are no failed attempts the threshold counter is reset after this time. o Account
lockout duration: Locked out account is automatically unlocked after this duration.
Password policy: Turning this on will make E-leaning check user passwords
against a valid password policy i.e. whether the password should contains
minimum number of digits, uppercase, lowercase, numerical letters to be included
in the password.

Maximum time to validate password reset request: This specifies the amount of
time people have to validate a password reset request before it expires. 30 minutes
will be the default value.

Group enrolment key policy: Turning this on will make E-leaning check group
enrolment keys against a valid password policy.

Disable user profile images: Disable the ability for users to change user profile
images.

Email change confirmation: Require an email confirmation step when users change
their email address in their profile.

Remember username: Enable if you want to store permanent cookies with
usernames during user login.

*** Permanent cookies may be considered a privacy issue if used without consent.

o Strict validation of required fields: If enabled, users are prevented from entering a

space or line break only in required fields in forms.

HTTP Security: The HTTP security page contains the following options:

@)

Use HTTPS for logins: HTTPS encrypts the user‘s login data, so it‘s difficult to
sniff out a user‘s username and password on the network. You will need to enable
HTTPS on your server before you turn on this setting, or else you will be locked
out of your site. Every web server has a different method for enabling HTTPS, so
you should check the documentation for your web server.

Secure cookies only: If server is accepting only https connections it is
recommended to enable sending of secure cookies.

Only http cookies: Enables new PHP 5.2.0 feature - browsers are instructed to send
cookie with real http requests only, cookies should not be accessible by scripting
languages.

Allow frame embedding: Allow embedding of this site in frames on external sites.
(*** Enabling of this feature is not recommended for security reasons.)
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Prevent password auto completion on login form: Having this off will let users
save their account password in their browser. Switching this setting on will result
in your site no longer following XHTML strict validation rules.

Notifications:

The notifications page contains the following options:

o

Display login failures to: Set this to Administrators to be warned of anyone
attempting to steal student or teacher logins. When set, a link stating the number of
failed logins appears in the top-right corner of the page when an administrator logs
in. Click the link to access the login error page.

Email login failures: If you‘re concerned about login failures, you can set up email
notification for administrators.

Threshold for email notifications: This sets the number of failed logins for a given
user from a single computer that will trigger notification.

Antivirus:

The use of the open source virus scanner clam AV on uploaded files can be enabled to
make use of E-leaning‘s anti-virus feature. The open source virus scanner ClamAV
should be installed on your server.

*** See http://www.clamav.net for more information.

Appearance

Themes: A theme sets the appearance—colors, fonts, and icons—for your E-leaning site.

- Theme settings: The theme settings page includes the following options:

o

Theme list: This lists the themes available for course and user themes. Leave this
blank to allow any valid theme to be used.

Theme designer mode: Turn this on if you are designing and testing themes as it
will stop the themes being cached and enable you to see theme changes quickly.
Allow course themes: If you enable this, then teachers will be able to set their own
course themes.
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Allow category themes: When enabled, themes can be set at the category level.
This will affect all child categories and courses unless they have specifically set
their own theme.

Allow theme changes in the URL: If this is checked then the theme may be
changed by adding ?theme=theme_name (or &theme=theme_name if there are
other URL parameters) to the URL in the browser.

Allow users to hide blocks: Do you want to allow users to hide/show side blocks
throughout this site? This feature uses JavaScript and cookies to remember the state
of each collapsible block, and only affects the user's own view.

Allow blocks to use the dock: If enabled and supported by the selected theme users
can choose to move blocks to a special dock.

Custom menu items: The custommenuitems setting allows you to create a drop
down menu that can be displayed by themes that support it. Currently all themes
that are provided with E-leaningsupport this custom menu.

Enable device detection: Enables detection of mobiles, smartphones, tablets or
default devices (desktop PCs, laptops, etc.) for the application of themes and other
features.

Device detection regular expressions: This will allow you to customize the theme
selector options. For example, you can add a custom theme for IE6 and another for
Windows CE by entering the identifying expressions the browser sends and the
"Return value" you want to display as the theme selectors "Device type".

Theme Selector: An administrator can set a theme for the site from the theme selector page.
E-leaning has two standard themes: Clean, a responsive, bootstrap based theme which is
used as default, and More, a theme customizable from within the admin interface.

Different themes may be set according to 'device type' - default, legacy (for older browsers),
mobile and tablet.

To change the theme for the device type for which you wish to change the theme:

@)

Go to Administration > Site administration > Appearance > Themes >
Theme selector o Click on the "Select theme™ button next to the type you wish to

change o Scroll down to see the previews of the available themes and click on the

"Use theme™ button to choose the theme o The next screen will provide

information about the theme. Click "Continue"

*** E-leaning caches themes so if you don't immediately see changed settings that you were
expecting, click the "Clear theme caches™ button at the top of the Theme selector page.
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*** The selected theme may be overridden if user/course or category themes have been allowed
in the Theme settings.

Select device

Oevice type

Default

Legacy

Mobile

Tablet

Clean
Teaching with Moodle: An introduction

Week | Gatling Staried with Moodie
I

Figure 19-12 Selecting a theme for device type

Below the theme selector link you will find the links for customizing the individual theme
through the settings page of the theme. By default there will be only Clean and More themes
which can be customized.

- Calendar: You can change the default display settings for the site calendar. The following
options are available:

o

Calendar type: The admin can choose a default calendar type for the whole site
here. Individual users can override this in the course settings or in their user profile.
Admins see all: Whether admins see all calendar events or just those that apply to
themselves

Time display format: Whether a 12 or 24 hour format is used. This setting can be
overridden by user preferences.

Start of week: Default is Sunday o Weekend days: Weekend days are shown in a
different color.

Days and events to look ahead: For determining how many events are listed in the
Upcoming Events block. If the Upcoming Events block becomes too long you can
reduce the number of days and events to look ahead.
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Calendar export days to look ahead and back: A custom range of dates, such as a
school term or year, may be set as a calendar export option.

Calendar export salt: The calendar export salt is a random string of characters used
for improving of security of authentication tokens used for exporting of calendars.
Show source information for iCal events: If enabled, the subscription name and
link will be shown for iCal-imported events.

Blog: Here you can set the default settings applicable to the blogs sitewide. The following
options are available:

o

Enable blog associations: Enables the association of blog entries with courses and
course modules.

Blog visibility: This setting allows you to restrict the level to which user blogs can
be viewed on this site. Note that they specify the maximum context of the VIEWER
not the poster or the types of blog posts. Blogs can also be disabled completely if
you don't want them at all. o Enable external blogs: Enables users to specify
external blog feeds. E-leaning regularly checks these blog feeds and copies new
entries to the local blog of that user.

External blog cron schedule: How often E-leaning checks the external blogs for
new entries.

Maximum number of external blogs per user: The number of external blogs each
user is allowed to link to their E-leaning blog.

Enable comments: Blog comments are enabled by default, though may be disabled
if required

Show comments count: Show comments count, it will cost one more query when
display comments link.

Navigation: There are two standard blocks on every page - the Navigation block and the
Administration block. You can change navigation settings, such as the default home page,
and whether to show course categories in the navigation. The following options are
available:

o

o

Default home page for users: This determines the home page for logged in users
Allow guest access to My home: If enabled guests can access My home, otherwise
guests are redirected to the site front page.

Show course full names: If enabled, course full names will be used in the
navigation rather than short names.

Show course categories: Show course categories in the navigation bar and
navigation blocks. This does not occur with courses the user is currently enrolled
in; they will still be listed under mycourses without categories. 0 Show my course
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categories: If enabled courses in the users my courses branch will be shown in
categories.

Show all courses: This setting determines whether users who are enrolled in
courses can see Courses (listing all courses) in the navigation, in addition to My
Courses.

Sort my courses: This determines whether courses are listed under My courses
according to the sort order (i.e. the order set in Site administration > Courses >
Manage courses and categories) or alphabetically by course setting.

Course limit: Limits the number of courses shown to the user when they are either
not logged in or are not enrolled in any courses.

Use site name for site pages : If enabled the site's shorthame will be used for the
site pages node in the navigation rather than the string 'Site pages'

Link admin categories: If enabled admin setting categories will be displayed as
links in the navigation and will lead to the admin category pages.

Show front page activities in the navigation: If enabled, front page activities will
be shown on the navigation under site pages.

Add links to view user posts: If enabled two links will be added to each user in the
navigation to view discussions the user has started and posts the user has made in
forums throughout the site or in specific courses.

HTML Settings: The HTML settings page has two options only:

@)

Remove HTML tags from all activity names: Uncheck this setting to allow HTML
tags in activity and resource names. By default it is set to remove HTML tags from
the activity names.

Emoticons: You can define the list of images that will be used to replace the
emoticon text. The form table maps the emoticon characters like :) to an image
that will be used to display that emoticon. Images can be provided either by the E-
leaning core itself or by any other installed plugin (like an activity module, block,
theme or your local plugin). For accessibility reasons, alternative texts for these
images should be defined, too. You can also define custom emoticons too for your
E-leaning site.

Media Embedding: You can enable the embedding of media files by selecting appropriate
media players on this page. When players are enabled in these settings, files can be
embedded using the media filter (if enabled) or using a File or URL resources with the
Embed option. When not enabled, these formats are not embedded and users can manually
download or follow links to these resources.

0 The list of available players are:

= YouTube (displays videos hosted on youtube)
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= Vimeo (displays videos hosted on vimeo)

= .mp3 - MPEG Audio Stream, Layer IlI

= .flv - Flash video

= f4v - Flash video

= .swf - Macromedia Flash animation File (Adobe, Inc.)

= .0gg - HTML 5 audio

= .acc - HTML 5 audio

= .mp3-HTML 5 audio

= .webm - HTML 5 video

= .mdv - HTML 5 video

= .0gv-HTML 5 video o Legacy media players: The following legacy media
player formats are also available but not recommended for general usage:

= .mov - QuickTime player (requires QuickTime player or codec)

= .mp4 - QuickTime player (requires QuickTime player or codec) [1 .m4a -
QuickTime player (requires QuickTime player or codec)

= .mpg - MPEG animation - QuickTime player (requires QuickTime player
or codec)

= .wmv - Windows media player (Microsoft)-not guaranteed to work in
browsers other than IE and non-Windows systems

= .avi - Windows media player - not guaranteed to work in browsers other
than IE and non-Windows systems

E-leaning Docs:

By default, managers, teachers and non-editing teachers have "E-leaning Docs for this
page" links at the bottom of each page in E-leaning for accessing contextspecific
documentation. An administrator can change E-leaning Docs settings in Administration
> Site administration > Appearance > E-leaning Docs.

The following options are available:

o E-leaning Docs document root: It defines the path to the E-leaning Docs for
providing context-specific documentation via 'E-leaning Docs for this page' links
in the footer of each page. If the field is left blank, links will not be displayed.

o Language for docs: This language will be used in links for the documentation
pages.

o Open in new window: If you enable this, then links to E-leaning Docs will be
shown in a new window.

Default my home page: You as a site administrator can define which blocks will appear
on the default My Home page. But first you need to turn on the Block editing Mode to
make any changes to the block configuration.
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Default profile page: In a similar manner you can define the default look of the Profile
page i.e. which blocks will appear on the profile page by default for a new user.

Courses: Here you can define the display settings related to course. The options available

are:

o

Course Contacts: This setting allows you to control who appears on the course
description. Users need to have at least one of these roles in a course to be shown
on the course description for that course. By default Teacher's role is selected to
be displayed on the course description.

Display Extended Course names: If enabled, course short names will be displayed
in addition to full names in course lists.

Courses per Page: Enter the number of courses to be displayed per page in a course
listing.

Courses with summaries limit: The maximum number of courses to display in a
course listing including summaries before falling back to a simpler listing.
Course summary files limit: The maximum number of files that can be attached to
a course summary.

Course summary files extensions: A comma-separated list of allowed course
summary files extensions.

AJAX and JavaScript: Ajax is required for drag and drop functionality and is enabled by
default. You can change the default settings related to AJAX and JavaScript for your E-
leaning site. o Use online YUI libraries: Instead of using local files, use online files
available on Yahoo_s servers.

*** This requires an internet connection, or no AJAX will work on your site. This
setting is not compatible with sites using https.

YUI combo loading: This option enables combined file loading optimization for
YUI libraries. This setting should be enabled on production sites for performance
reasons.

Cache JavaScript: JavaScript caching and compression greatly improves page
loading performance. It is strongly recommended for production sites. Developers
will probably want to disable this feature.

Activity chooser default: Should the activity chooser be presented to users by
default?

Activity editing menus: If enabled many of the activity editing icons shown when
viewing a course with editing on will be displayed within a drop-down menu. This
reduces the content on screen when editing a course by hiding the icons until they
are needed.
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o Block editing menus: If enabled many of the block editing icons shown when
editing is on will be displayed within a drop-down menu. This reduces the content
on screen by hiding the icons until they are needed.

Manage Tags: The manage tags page provides a list of tags, together with information on
their creators, how many times they are used, when they were last modified and which
tags have been flagged as inappropriate. Inappropriate tags are shown in red when using
the default theme.

Selected tags may be having their flag reset (in other words remove the inappropriate
flag) or be deleted. Tag names and types may also be changed.

The manage tags page also allows for official tags to be added. Official tags are tags
which are added by a site administrator and are displayed to all users of the E-leaning
site when adding a blog entry. Creating a set of official tags for commonly used topics
can reduce the amount of duplication in blog tags.

Additional HTML: Using the Additional HTML link you can add additional HTML or
CSS or JavaScript to every page. These settings allow you to specify HTML or CSS or
JavaScript that you want added to every page without altering the E-leaning code files.

You can add HTML, CSS or JavaScript, to three sections in the Additional HTML page.

Within HEAD: within the <head></head> tag for the page. (Example: Meta tags, CSS,
JavaScript).

When BODY is opened: above the header section of the main body of the page that is
displayed. (Example: Banner image or text heading, alert message).

When BODY is closed: below the footer of the page. (Example: Google

Analytics).

Doing this allows you add custom headers or footers on every page, or add support for services
like Google Analytics very easily and independent of your chosen theme.

Another way of adding a custom footer or support for Google Analytics is via the settings of
certain themes such as the Clean theme.
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How to use E-leaning

Front Page:

The front page is the initial page seen by someone reaching a E-leaning site after or before a
login. Typically a student will see courses, some blocks of information, displayed in a theme. In
the Navigation bar and Navigation block it is called "Home". In many ways, a Front Page has
similar features and functions to those in a Course. For example, Activities, Resources and
Blocks can be added to the Front Page to give it different looks.

The front page settings link enables you to customize the appearance of the front page of your
E-leaning site. The form has the following options to choose from:

Full site name: This name appears at the top of every page above the navigation bar.
Short name for site: The short name appears at the beginning of the navigation bar as a
link back to your site front page.

Front page summary: This summary can be displayed on the front page using the
course/site summary block.

Front page & Front page items when logged in: The center of the front page can display
any combination of the following: news items, a list of courses, a list of enrolled courses,
a list of course categories, a list of categories and courses, a course search box or none.
The order is determined by a combination box.

It is possible to create one setting for anyone who gets to the front page without logging
in to the E-leaning site, and another look for only those who have logged into the E-
leaning site. There are two combination boxes.

Maximum category depth: This specifies the maximum depth of child categories
expanded when displaying categories or combo list. Deeper level categories will appear
as links and user can expand them with AJAX request.

Maximum number of courses: Maximum number of courses to be displayed on the site's
front page in course listings.

Include a topic section: This adds a topic section to the center-top of the front page. When
editing is turned on, resources and/or activities can be added to the topic section using the
dropdown menus, in the same way as on a course page.

*** The label resource can be used to add text and/or an image to the center-top of the front
page.

«  News items to show: This setting only applies if the front page is set to display news items
or if you are using the Latest News block.

- Comments displayed per page: Each course may include a Comments block which allows
the display of user comments. The number of comments displayed at any time is set here.
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How to use E-leaning

- Default frontpage role: The default frontpage role enables logged-in users to participate
in front page activities. It is recommended that it is set to frontpage role.

Front page settings

Full site name How to Use Moodle 2.7 LTS
Short name for site (eg single word)  Moodle 2.7

Front page summary paagiaph @

Path: p
This summary can be displayed on the front page using the course/site summary block or by including a topic section on the
front page

Front page List of courses E|

None |
None |
None |
None |

The items selected above will be displayed on the site’s front page

Front page items when logged in List of courses E|

None E|
None E|

Figure 19-13 Editing your site's front page settings

Server

- System Paths: An administrator can set the following system paths o Path to du: If you
enter this, pages that display directory contents will run much faster for directories with a
lot of files.

o Path to aspell: To use spell-checking within the editor, you MUST have aspell
0.50 or later installed on your server, and you must specify the correct path to
access the aspell binary.

o Path to dot: To be able to generate graphics from DOT files, you must have
installed the dot executable and point to it here.

——
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Support Contact: can specify a support name, email and/or support page for including in
the confirmation email sent for email based self-registrations.

- Session Handling: Once someone logs in to your E-leaning server, the server starts a
session. The session data allows the server to track users as they access different pages.
The available settings are:

o Use database for session information: E-leaning needs to store the session data in
some storage. By default either file or database session storage is selected, this
option allows admin to change it.

*** This option disappears if you specify session driver in config.php file.

o Timeout: If users don't load a new page during the amount of time set here, E-
leaning will end their session and log them out.
Be sure this time frame is long enough to cover the longest test your teachers
may offer. If a student is logged out while they are taking a test, their responses
to the test questions may be lost.

o Cookie prefix: This setting customizes the name of the cookie used for E-leaning
sessions. This is optional, and only useful to avoid cookies being confused when
there is more than one copy of E-leaning running within the same web site.

o Cookie path: The relative path to this E-leaning installation, this may be used to
force sending of E-leaning session cookie to parent directories. Invalid values are
ignored automatically.

o Cookie domain: This can be used to send session cookies to higher domains instead
of just the server domain. This may be useful for some SSO solutions. Invalid
values are ignored automatically.

- HTTP: here you can change the proxy settings for your server. The settings are:

o Use slash arguments: Files (images, uploads etc.) are provided via a script using
'slash arguments'. This method allows files to be more easily cached in web
browsers, proxy servers etc.

o Reverse proxy: If your server is located behind a reverse proxy you may need to
select appropriate order of headers that is being used in your setup. Contact your
network administrator if not sure.

o Web proxy settings: Your E-leaning server may need to access the Internet through
a proxy server, depending on your network configuration. If you're not sure about
whether you need a proxy server, contact your network administrator or ISP.

- Maintenance Mode: Maintenance mode is for preventing any users other than
administrators from using the site while maintenance is taking place, though it's not
designed to prevent user access during version upgrades.

When users attempt to access a course when your site is in maintenance mode, they obtain a

message informing them that the site is in maintenance mode. If you wish, you can create a

362

——
| —



customized maintenance mode message, perhaps stating when the site will be available again or
giving the reason for doing maintenance.

*** The front page of your site will appear as normal when your site is in maintenance mode.
Users will only see the maintenance mode message when they attempt to access a course.

« Cleanup: You can limit the size of certain tables in the database by setting appropriate
options on this page.

o Delete not fully setup users after: If you are using email authentication, this is the
period within which a response will be accepted from users. After this period, old
unconfirmed accounts are deleted.

o Delete incomplete users after: After this period, old not fully setup accounts are
deleted.

o Disable grade history: Disable history tracking of changes in grades related tables.
This may speed up the server a little and conserve space in database.

o Grade history lifetime: This specifies the length of time you want to keep history
of changes in grade related tables. It is recommended to keep it as long as possible.
If you experience performance problems or have limited database space, try to set
lower value.

Environment: You can check that whether your site meets all system requirements for the
current and future versions of E-leaning in Administration > Site administration > Server
> Environment.

*** |t is important to check system requirements prior to upgrading your site to a new E-leaning
version.

[1 PHP Info: The phpinfo display contains information about the configuration of your PHP
installation. This is useful for checking:

That your PHP installation meets E-leaning's system requirements.
the values that are currently applied to your server's PHP install, e.g. File upload
limits
o That you have installed the required modules needed for E-leaning to work,
e.g. the LDAP module for LDAP authentication.

Performance: Various performance settings can be changed by an administrator in
Administration > Site administration > Server > Performance. The available options are:

o Extra PHP memory limit: Some scripts like search, backup/restore or cron require
more memory. Set higher values for large sites.
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o Maximum time limit: The setting "Maximum time limit" lets you restrict the
maximum PHP execution time that E-leaning will allow without any output being
displayed.

CURL cache TTL: Time-to-live for cURL cache, in seconds.

Bitrate to use when calculating cURL timeouts (Kbps): This setting is used to
calculate an appropriate timeout during large cURL requests. As part of this
calculation an HTTP HEAD request is made to determine the size of the content.
Setting this to 0 disables this request from being made.

Hubs: An administrator can register their site with Itecrwanda.com in Administration >
Site Administration > Registration. When you register your site with Itecrwanda.com : o
You are added to a low-volume mailing list for important notifications such as security
alerts and new releases of E-leaning
o Statistics about your site will be added to the statistics of the worldwide
E-leaning community http://Itecrwanda.com/stats/ o Your site is also registered
with E-leaning.net, allowing users with the publish courses capability (by default
only managers) the option of publishing courses to E-leaning.net.

Update Notifications: You can configure the default update notifications about your E-
leaning site on this page. You can change options like turn off automatic
updates, Alpha maturity plugins to be installed on your site etc. The available options are:

o Automatically check for available updates: If enabled, your site will automatically
check for available updates for both E-leaning code and all additional plugins. If
there is a new update available, a notification will be sent to site admins.

o Enable updates deployment: If enabled, you will be able to download and install
available updates directly from E-leaning administration pages. Note that your web
server process has to have write access into folders with E-leaning installation to
make this work.

*** That can be seen as a potential security risk.

o Required code maturity: Notify about available updates only if the available code
has the selected maturity level at least. Updates for plugins that do not declare their
code maturity levels are always reported regardless this setting.

o Notify about new builds: If enabled, the available update for E-leaning code is also
reported when a new build for the current version is available.

Scheduled tasks: An administrator can schedule routine tasks very precisely from
Administration>Site administration>Server>Scheduled tasks.
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Figure 19-14 Scheduled Tasks settings

*** You still need to run the CRON scripts at regular intervals.

Clicking the edit icon allows the administrator to specify the minute/hour/day/month or day of
the week the task is to be run. It is also possible to reset the task to its default setting or disable it
completely.

*** When typing into the fields, the format is the same as for Unix cron.

Reports
Just as teachers can obtain detailed logs and reports of student activity in their course, as an
administrator you have access to logs and reports for the whole site.

- Comments: You will get a complete list report of comments posted on your E-leaning site
including the author name and the content of the comment. You can also delete the
unwanted/spam comments.

Backups: If you have enabled the automated backups of your courses then this page will
display the reports about the last execution log. The table includes the course name, time
taken, status and next scheduled backup.
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Config Changes: This report enables an Administrator to see at a glance which aspects of
the E-leaning site have been recently altered and, where applicable, by which
administrator.

- Events List: Events are atomic pieces of information describing something that happened
in E-leaning. Events are primarily the result of user actions, but could also be the result of
the cron process or administration actions undertaken via the command line. This report
provides a list of all events happening on your E-leaning site. The list can be filtered to
show specific components (core, Assignment, Book etc.) levels (Teaching, Participating,
Other) and database query types (create, delete, read, update).

- Logs & Live Logs: Logs in E-leaning are activity reports. Logs are available at site and
course level. You can select any combination of course or site, participants, date, activity,
actions, and education level and choose whether they are displayed on the logs page or
downloaded in text, ODS, unpaged XHTML document, tab separated values text file or
CSV text format.

The Live logs page displays the live logs for the events happening on your site. Since E-leaning
you can Stop and restart the live logs by clicking the "Pause Live Updates™ button.

Performance Overview: The performance overview report lists issues which may affect
performance of the site. Recommended values are displayed with a Green background
whereas the others are shown with yellow background.

Question Instances: This report lists all the contexts in the system where there are
questions of a particular type. You can select a question type and click Get the report
button to fetch the data about the context where the question type is used.

Security Overview: This report provides the security overview report about the current
settings for your E-leaning site. Recommended settings are shown with Green background,
warnings are shown with yellow color and critical settings with Red color.

Spam Cleaner: This script allows you to search all user profiles for certain strings and
then delete those accounts which are obviously created by spammers. You can search for
multiple keywords using commas.

Development

- Experimental: An experimental feature is defined as a feature which requires additional
testing and bug-fixing. We recommend you use a test server for testing experimental
features before enabling them on your production site. The available links are:
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o Experimental settings: An administrator can enable certain experimental features
in Settings > Site administration > Development > Experimental > Experimental
settings.

o Database migration: This script will transfer the entire contents of this database to
another database server. It is often used for migration of data to different database
type.

Debugging: Debugging messages are intended to help diagnose problems and/or help E-
leaning developers. If you have a problem with your E-leaning site and ask for help in a
Itecrwanda.com forum, a developer may ask you to turn debug messages on, in order to
locate the cause of the problem. By default E-leaning does not show any error messages
at all. If you are having problems (e.g. blank screens or incomplete screens) turning on
debugging is usually the first thing to try.

Web service test client: Admins can simulate external access to their own Web Services.

*** The web service test client executes the functions for REAL. Do not test functions that you
don't know.

Purge all caches: E-leaning can cache themes, JavaScript, language strings, filtered text,
rss feeds and many other pieces of calculated data. Purging these caches will delete that
data from the server and force browsers to refetch data, so that you can be sure you are
seeing the most up-to-date values produced by the current code.

Third party libraries: This page displays the list of third party libraries used on your E-
leaning site including the libraries used by Authentication plugins, Filters, Themes and
Modules etc.

Acceptance testing: This administration tool helps developers and test writers to create
feature files describing E-leaning's functionalities and run them automatically. For more
details refer E-leaning Documentation

at https://docs.ltecrwanda.com/dev/Acceptance_testing

Make test course: This tool creates standard test courses that include many sections,
activities, and files. This is intended to provide a standardized measure for checking the
reliability and performance of various system components (such as backup and restore).

Courses created using this feature can occupy a large amount of database and file system
space (tens of gigabytes). You will need to delete the courses (and wait for various
cleanup runs) to release this space again.

*** Do not use this feature on a live system. Use only on a developer server.

Make Jmeter test plan: This tool creates a JMeter test plan file along with the user
credentials file. You may refer E-leaning documentation for more details.
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PHPUNiIt tests: PHP Unit is an advanced unit testing framework for PHP. It is installed
as Composer dependency and is not part of E-leaning installation. To run PHP Unit tests,
you must manually install it on your development computer or test server.

. XMLDB Editor: The XMLDB editor is a tool for developers to easily edit
tables/fields/keys/indexes in install.xml files.

Summary

In this final chapter we have taken a glance on the administration part of the E-leaning which is
basically meant for the site administrators who have the responsibility to fix your E-leaning site
in any catastrophic situation.
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